# Table of Contents

## Part 1: Getting Started

<table>
<thead>
<tr>
<th>Chapter 1: Introduction</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is Exponare?</td>
<td>4</td>
</tr>
<tr>
<td>What's New in Exponare 6.0</td>
<td>4</td>
</tr>
<tr>
<td>New Features and Improvements</td>
<td>4</td>
</tr>
<tr>
<td>Exponare Documentation Set</td>
<td>5</td>
</tr>
<tr>
<td>Required Skills</td>
<td>6</td>
</tr>
<tr>
<td>Exponare Enquiry and Exponare Public Users</td>
<td>6</td>
</tr>
<tr>
<td>Exponare Administrator</td>
<td>7</td>
</tr>
<tr>
<td>Getting Technical Support</td>
<td>7</td>
</tr>
<tr>
<td>Introduction</td>
<td>7</td>
</tr>
<tr>
<td>Contacting Pitney Bowes Software</td>
<td>8</td>
</tr>
<tr>
<td>Online Resources</td>
<td>8</td>
</tr>
<tr>
<td>MapInfo-L Archive Database</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2: About Exponare Server and Clients</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>10</td>
</tr>
<tr>
<td>Exponare Server</td>
<td>10</td>
</tr>
<tr>
<td>Exponare Clients</td>
<td>11</td>
</tr>
<tr>
<td>Key Concepts</td>
<td>12</td>
</tr>
<tr>
<td>Workspaces and Work Contexts</td>
<td>12</td>
</tr>
<tr>
<td>Layers and Features</td>
<td>13</td>
</tr>
<tr>
<td>SQL Support Tables</td>
<td>13</td>
</tr>
<tr>
<td>Selections and Queries</td>
<td>13</td>
</tr>
<tr>
<td>Data Binds</td>
<td>13</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3: Exponare Enquiry, Exponare Public and Rest Public</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Features</td>
<td>16</td>
</tr>
<tr>
<td>Commands</td>
<td>16</td>
</tr>
<tr>
<td>Panels</td>
<td>17</td>
</tr>
<tr>
<td>User Interface Layout</td>
<td>18</td>
</tr>
<tr>
<td>Menus and Toolbars</td>
<td>18</td>
</tr>
<tr>
<td>HTML Data in Exponare Public</td>
<td>18</td>
</tr>
</tbody>
</table>
# Part 2: System Administration

## Chapter 4: Installing Exponare

**What’s on the CD**
- Install Products ............................................ 22
- Documentation ............................................. 22
- Contact Information ....................................... 22
- Register ................................................... 22
- Browse CD .................................................. 22

**Platform Requirements** .................................. 23

**Exponare Combination** .................................. 24

**Exponare Server** ......................................... 24
- Software Requirements ..................................... 24
- Pre-Installation Tasks ....................................... 27
- Installation .................................................. 36
- Post-installation Tasks ...................................... 37
- Testing the installation of Exponare Server ............. 41
- Troubleshooting ............................................ 41

**Exponare Sample Data** .................................. 46
- Installation .................................................. 46
- Post Installation Task ....................................... 46

**Exponare Enquiry** ......................................... 47
- Installation - Single Client ................................ 47
- Installation - Enterprise Deployment ...................... 47
- Getting Started ............................................ 48
- Troubleshooting ............................................ 51

## Chapter 5: Upgrading Exponare

**Exponare Server** ......................................... 54

**Post Upgrade Tasks** ....................................... 54
- Upgrades from previous version of Exponare would require ............................................. 54

**Exponare Server in a Web Farm Environment** ........ 55

**Sample Data** ............................................... 55
- Troubleshooting ............................................ 55
- Map view, zoom and center could not be reliably applied .................................................. 55

**Exponare Enquiry** ......................................... 56

## Chapter 6: Uninstalling Exponare

**Exponare Server** ......................................... 58

**Exponare Sample Data** .................................. 58

**Exponare Enquiry** ......................................... 58
# Table of Contents

## Chapter 7: Server Administration Tasks

- Altering 'Live' Workspace and TAB Files ........................................ 60
- Configuring MapXtreme Pooling .................................................... 60
- Publishing the Empty Configuration .............................................. 61
- Restarting the ASP.NET Process .................................................... 63
- Setting File Permissions for the Server .......................................... 63
- Setting the Server Timeout Value .................................................. 64
- Web Site Monitoring ................................................................. 64

### IIS settings to configure Rest Public

- IIS- 6 ................................................................. 65
- IIS 7 & 7.5 ............................................................. 68

### Troubleshooting ................................................................. 70

- Data on network drives is inaccessible ......................................... 70
- Enquiry cannot connect to server— Error 1661 .............................. 71
- Exponare hardware licensing problems ....................................... 71
- Exponare Server process re-starts and loses all session information .... 71
- General server failure (ASP.NET failure) ..................................... 72
- Intermittent errors on the client when using a pooled MapXtreme environment ......................................................... 73
- Oracle connection failure ......................................................... 77
- Public cannot load initial startup page ........................................ 77
- Public Menu/toolbar/map is non-operational ................................ 77
- SQL Support Tables from external databases do not work ............... 78
- Using a web browser to access Exponare.asmx fails ....................... 78
- Work Context cannot load due to permissions .............................. 79
- Unable to display Map.Projection system not found ..................... 79
- Layer Updates Error! while creating a new work context ............... 80

## Chapter 8: Client Administration Tasks ....................................... 83

- Starting Enquiry from the Command Line .................................... 84

### Troubleshooting ................................................................. 84

- Enquiry cannot connect to server ............................................. 85
- Login with Enquiry always fails .............................................. 85
- Enquiry becomes inactive and cannot connect to server ................ 85
- You get an error when saving the configuration ............................... 86

## Chapter 9: Web Farm Environments and Exponare Server ............. 87

### Web Farm Environment Requirements ...................................... 88

### Web Farm Setup ................................................................... 88

- InstallExponare.SQL ............................................................ 88
- aspnet_regsql.exe ............................................................... 89
- Updating web.config ............................................................. 89

### Reverting Web Farm Environment to Single Web Server ............ 91
# Part 3: Configuration Manager Essentials

Chapter 10: Overview

- Starting the Exponare Configuration Manager
- Viewing Configuration Changes
- Configuration Files
- Concurrent Exponare Administration

Menu Bar

- File Menu
- Configuration Menu
- Help Menu

Toolbar

- Tree View
- Tree View Context Menu

Property Grid

- Common Tasks
- Property Grid Input Helpers
- View Helper
- URL Properties
- File Path Properties
- Help Panel

Chapter 11: Application Settings

- Annotation Properties
- Exponare Public Point Export Property
- External Authentication Properties
- General Properties
- Raster Quality Properties
- Selection Properties

Chapter 12: Work Contexts

- Configuring a Work Context
- Work Context Nodes

Chapter 13: Work Context Groups

- Creating a Work Context Group

Chapter 14: Menus and Toolbars

- Configuring Menus and Toolbars
  - Basic Commands
  - Sub-menus
  - Separators
# Table of Contents

- List Commands ........................................................................ 143
- Customizing Toolbar Icons in Rest Public ................................. 143

**Chapter 15: User Interfaces** ............................................... 145

- Introduction ........................................................................ 146
- User Interface Configurable Components ............................... 147
- User Interface Configuration ................................................ 151

**Chapter 16: Users** ............................................................. 155

- Overview ........................................................................... 156
- User Types ......................................................................... 156
- Configuring External Authentication ....................................... 157
- User Profiles ....................................................................... 158
- User Passwords ................................................................... 160
- The Login and Authentication Process ................................... 160
- No External Authentication .................................................. 160
- External Authentication Specified ......................................... 160
- Single Sign On .................................................................... 162
- Troubleshooting ................................................................... 165

**Part 4: Additional Configuration Manager Features** .............. 167

**Chapter 17: Global Layer Groups** ...................................... 169

- Organising Data ................................................................... 170
- The Exponare Sample Data ................................................... 170
- Creating a Global Layer Group ............................................. 170
- Overriding Global Layer Settings ......................................... 172
- Overriding Global Data Binds ................................................ 172
- Completing the Reorganisation ............................................. 172
- Working with Multiple Global Layer Groups ....................... 174
- Duplicate Layers .................................................................. 174
- Missing Layers ..................................................................... 174
- Global Query Settings .......................................................... 175
- Troubleshooting .................................................................. 175
<table>
<thead>
<tr>
<th>Chapter 23: SQL Support Tables</th>
<th>223</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Table Names</td>
<td>224</td>
</tr>
<tr>
<td>SQL Support Tables</td>
<td>224</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 24: Data Binds</th>
<th>227</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>228</td>
</tr>
<tr>
<td>The '_Selection' Table</td>
<td>228</td>
</tr>
<tr>
<td>The 'mi_key' Field</td>
<td>229</td>
</tr>
<tr>
<td>Table Joins</td>
<td>229</td>
</tr>
<tr>
<td>The 'as' Syntax</td>
<td>229</td>
</tr>
<tr>
<td>The 'order by' Syntax</td>
<td>230</td>
</tr>
<tr>
<td>Uniqueness of Column Names</td>
<td>231</td>
</tr>
<tr>
<td>Data Bind SQL Example</td>
<td>231</td>
</tr>
<tr>
<td>Configuring a Data Bind</td>
<td>231</td>
</tr>
<tr>
<td>Remote Data Binds</td>
<td>234</td>
</tr>
<tr>
<td>Data Bind Hyperlinks</td>
<td>236</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 25: Queries</th>
<th>239</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Processing Overview</td>
<td>240</td>
</tr>
<tr>
<td>Running a Query on a Remote Server</td>
<td>242</td>
</tr>
<tr>
<td>Query Types and Parameters</td>
<td>242</td>
</tr>
<tr>
<td>Parameterless Queries</td>
<td>243</td>
</tr>
<tr>
<td>Basic Queries</td>
<td>243</td>
</tr>
<tr>
<td>Query Parameters</td>
<td>243</td>
</tr>
<tr>
<td>Advanced Queries</td>
<td>247</td>
</tr>
<tr>
<td>Advanced Query Parameters</td>
<td>249</td>
</tr>
<tr>
<td>Running a Query on a Remote Server</td>
<td>249</td>
</tr>
<tr>
<td>Creating a Query</td>
<td>249</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 26: Database Connections</th>
<th>257</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>258</td>
</tr>
<tr>
<td>Configuring a Database Connection</td>
<td>258</td>
</tr>
<tr>
<td>Database Connection Types</td>
<td>259</td>
</tr>
<tr>
<td>Native</td>
<td>259</td>
</tr>
<tr>
<td>ODBC</td>
<td>260</td>
</tr>
<tr>
<td>OLE</td>
<td>260</td>
</tr>
<tr>
<td>Oracle</td>
<td>261</td>
</tr>
<tr>
<td>SQL Server</td>
<td>261</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 27: Print Templates</th>
<th>263</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>264</td>
</tr>
<tr>
<td>Creating a Microsoft Word Print Template</td>
<td>264</td>
</tr>
<tr>
<td>Microsoft Word Print Tags</td>
<td>264</td>
</tr>
</tbody>
</table>
Map and Scale Bar Size Units .................................................. 267
Creating a PDF Print Template ............................................... 267
Creating a Mail Merge Print Template ..................................... 267
  Tracking Printing Progress ................................................. 268
Creating a HTML Print Template ........................................... 269
  HTML Print Tags ........................................................... 270
Creating Rest Public HTML Print Template ............................. 273
  HTML Print Tags ........................................................... 275
Configuring a Print Template .............................................. 279
  Troubleshooting ............................................................ 281
Chapter 28: External Application Links ..................................... 283
  Application Link-Ins ....................................................... 284
    Enquiry Command Line Arguments .................................. 284
    Configuring an Application Link-In .................................. 284
    Configuring a Link-In Using a Selection Description .............. 285
    Creating an Application Link-In ....................................... 287
  Application Link-Outs .................................................... 288
    Configuring a Link-Out Using the Selection Description .......... 289
    Creating an Application Link-Out ..................................... 291
Chapter 29: Watermarks .................................................... 295
  About Watermarks ......................................................... 296
  Adding a Watermark ....................................................... 297
Chapter 30: Coordinate Export .............................................. 299
  Coordinate Export Tools .................................................. 300
  Coordinate Export - Exponare Enquiry ................................ 301
  Coordinate Export - Exponare Public .................................. 301
    Procedure ............................................................... 302
    The Hyperlink Target Field ........................................... 303
    Passing the Coordinates to the External Web Application ......... 303
    Accessing the Information Through Javascript ...................... 303
    Test Stubs ............................................................... 304
Chapter 31: Address Search .................................................. 305
  General Properties ....................................................... 306
  Input Field Labels ....................................................... 307
  Mandatory Fields ......................................................... 307
  Search Behaviour Properties ............................................ 308
  Communication With The Server ........................................ 309
# Table of Contents

## Chapter 32: Help
- Introduction .................................................. 312
- Customizing Exponare Help ............................... 312

## Chapter 33: Views
- Introduction .................................................. 314
- Creating a View .............................................. 314
- Global Views .................................................. 316

## Chapter 34: Data Editing
- Overview ...................................................... 318
- Configuration Manager Settings ......................... 318
- Log Functionality under Editing ......................... 322

## Chapter 35: Adhoc Layers
- Overview ...................................................... 326
- Configuration Manager Settings ......................... 326

## Part 5: Exponare Public
- Chapter 36: Creating Exponare Public Pages
  - Introduction .................................................. 332
  - Exponare Example Public Pages ....................... 333
    - Public User .............................................. 333
    - Named Users .......................................... 334
    - Login to Public - Named Users ....................... 335
  - Exponare Public Page Tags ............................. 335
    - Map ...................................................... 336
    - Menu and Toolbar ..................................... 336
    - Banners ............................................... 337
    - Panels .................................................. 337
    - Status Area ............................................ 337
  - Setting Up Pages for Different Screen Resolutions .. 338
  - Map Centre ............................................... 339
<table>
<thead>
<tr>
<th>Chapter 37: Public and Rest Public Start-up Parameters</th>
<th>341</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>342</td>
</tr>
<tr>
<td>Run Query</td>
<td>343</td>
</tr>
<tr>
<td>Page To Load</td>
<td>344</td>
</tr>
<tr>
<td>Change Work Context</td>
<td>344</td>
</tr>
<tr>
<td>Run Address Search</td>
<td>344</td>
</tr>
<tr>
<td>Run View</td>
<td>345</td>
</tr>
<tr>
<td>Run Layer Shortcut</td>
<td>346</td>
</tr>
</tbody>
</table>

**Part 6: New Enquiry Interface**

<table>
<thead>
<tr>
<th>Chapter 38: Ribbons</th>
<th>349</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>350</td>
</tr>
<tr>
<td>Ribbon Toolbar: Configuration Options</td>
<td>350</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 39: Application Menu</th>
<th>355</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>356</td>
</tr>
<tr>
<td>Configuration Settings</td>
<td>357</td>
</tr>
<tr>
<td>Using Hotkeys</td>
<td>358</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 40: Quick Access Toolbar</th>
<th>359</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>360</td>
</tr>
<tr>
<td>Default Settings in Quick Access Toolbar</td>
<td>360</td>
</tr>
<tr>
<td>Customizing the Quick Access Toolbar</td>
<td>361</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 41: Themes</th>
<th>363</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>364</td>
</tr>
<tr>
<td>Customizing Themes</td>
<td>365</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 42: Improved Panels</th>
<th>367</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>368</td>
</tr>
<tr>
<td>Improved Panel controls</td>
<td>369</td>
</tr>
<tr>
<td>Bottom Panel</td>
<td>369</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 43: New Icons</th>
<th>371</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>372</td>
</tr>
<tr>
<td>Large and Small New Icons</td>
<td>372</td>
</tr>
<tr>
<td>Configuring New Icons</td>
<td>373</td>
</tr>
<tr>
<td>New Split Buttons</td>
<td>373</td>
</tr>
</tbody>
</table>
# Table of Contents

**Part 7: Rest Public and Mobile** ................................................. 375  

**Chapter 44: Rest Public** ..................................................... 377  
  Rest Public Features ............................................................ 378  
  Map Toolbar ................................................................. 379  
  Working with Toolbar Option ........................................... 381  
  Left Panel Controls ....................................................... 390  
  Themes ........................................................................ 403  
  Watermarks ................................................................. 404  
  Administration Properties ............................................. 404  
    Authorized Rest Public Pages ....................................... 404  
    Configurable Features ................................................ 405  
    Public Vs Rest .......................................................... 406  

**Chapter 45: Exponare Mobile** ................................................. 409  
  Introduction ................................................................. 410  
  Home ........................................................................ 411  
  Quick Info Tool ............................................................ 412  
  Layers Tab ................................................................. 413  
  Search Tab .................................................................. 414  
  Measure Tab .................................................................. 417  
  Search Results Tab ....................................................... 418  
  Watermarks ................................................................. 419  
  Geolocate .................................................................... 419  
  Authorized Mobile Pages ............................................... 420  
  Login to Exponare Mobile Application ......................... 421

**Part 8: Supporting Information** .................................................... 423  

**Appendix A: Feature Usage Guidelines** ..................................... 425  
  Feature Usage Guidelines ................................................ 426  

**Appendix B: Raster Images** ...................................................... 429  
  About Raster Images ....................................................... 430  
  Supported Raster Imagery File Types .............................. 431
# Appendix C: Support for Workspace Files

- **MWS Features Supported by Exponare**
- **Other MWS Features**
  - Limitations on Names of MapInfo Professional TAB Files
- **Creating MWS files in MapInfo Professional**
  - Selectable State of Layers
  - Autolabel Differences
- **Troubleshooting**
  - Transparent background fills not displayed as transparent

# Appendix D: Workspace Manager

- **Features of the Workspace Manager**
- **Workspace Format and Contents**
- **Workspace Manager Menu Commands**
  - File Menu Commands
  - Map Menu Commands
  - Tools Menu Commands
- **Layer Control**
  - Layer Control Tools
  - Layer Tree
  - Layer Control Tabs
  - Layer Settings
  - Theme Settings
  - Label Settings

# Appendix E: Line Styles and Fill Patterns

- **Line Styles**
- **Fill Patterns**

# Appendix F: Confirm Integration

- **Introduction**
- **Confirm Integration Feature**

# Glossary

# Index
Part 1: Getting Started

Topics

- Introduction
- About Exponare Server and Clients
- Exponare Enquiry, Exponare Public and Rest Public
Introduction

In this chapter...

- What is Exponare?
- What's New in Exponare 6.0
- Exponare Documentation Set
- Required Skills
- Getting Technical Support
What's New in Exponare 6.0

What is Exponare?

Exponare® is an integrated suite of out-of-the-box applications that provide the gateway to an organization's corporate data, both spatial and non-spatial. With a strong emphasis on ease of use, integration, customisability, standards compliance and multi-platform support, the Exponare product suite has been built from the ground up using Pitney Bowes Software's .NET products, based on the Microsoft® .NET platform.

Sharing a common code base, all product modules have a consistent look and feel, similar functionality, and a common configuration manager. Exponare allows users to access, analyse and manipulate spatial and related information and can be deployed within an organization, out in the field, or across the Internet.

This guide provides you with the information required to administer and maintain your Exponare installation.

What's New in Exponare 6.0

Exponare 6.0 comes with a more organized and intuitive user interface enabling efficiency and ease of use.

New Features and Improvements

Rest public and Enquiry Improvement

Global view: Global Views can be configured and used along with the local views. This will decrease the hassle of creating views separately for different work contexts.

Enquiry Improvement

Individual Labeling of Objects: Labels can now be selected from enquiry client using newly introduced Label column which can be seen below Layer Column in Legend panel. Label column values will appear dynamically based on the Layer selected in Layer column.

Rest Public Improvements

Update Cursor: Icon on the map will now change as soon you select the tool from toolbar in Rest public giving better user experience. Change in appearance of the cursor will help user while making selections on the map.

Bug Fixes and Improvements

EXP-9346: Https URLs are not working in data bind hyperlinks. As a workaround text "http://localhost/Exponare" can be removed which was getting added before actual hyperlink. Https hyperlinks were not configurable as data bind hyperlinks.
EXP-9230: When import a configuration one can see that all the settings are imported along with user settings, but as soon as configuration was saved updated configuration was losing user settings.

User settings were getting reset.

EXP-9340: In mobile browser hyper-links defined as part of a data bind does not open.

EXP-9243: When performing point select at a location, it's selecting random nearby objects on different layers as well. This issue was present due to visibility of various layer as different zoom levels.

Random selections were appearing on the map apart from point selection.

EXP-9337: GPS location button was not panning the map except when default work context was open.

Map was not panning when GPS location button is used for a Workcontext other than default.

Exp 9437: Now, checking of Active directory (or single sign-on) is being taken care when the /reuse switch is passed to Exponare on launch.

Known Issues

• Known issues with Rest-Public page:
  In Internet Explorer (IE) 8 browser, at certain zoom levels the selected feature does not render complex region objects (such as regions with greater than 10,000 nodes).

Exponare Documentation Set

The following documents provide you with information directly relevant to Exponare; they can be found in the Documentation directory on your CD ROM.

- The Exponare Server installer copies the documentation into the Exponare virtual folder. The on-line help for Exponare Enquiry is installed by default to:
  C:\Program Files\MapInfo\Exponare\Server\Help\Default
  All other documentation is installed by default to:
  C:\Program Files\MapInfo\Exponare\Server\documentation.

- AdministrationGuide.chm: On-line help for the Configuration Manager feature in Exponare Enquiry.
- ReleaseNotes.htm: Exponare Release Notes which explains last minute changes and known defects that are not described in the Administration Guide.
Required Skills

**Getting Started.pdf**  
The Getting Started guide, which explains how to install and upgrade Exponare Server, Exponare Enquiry and Exponare Public.

**Deployment Guide.pdf**  
The Deployment Guide, which covers everything in the Administration Guide and an additional section that explains how to use the Generic Link Framework application.

**MapInfoSQL.chm**  
MapInfo SQL Reference Manual

Most Windows installations will not let you open compiled help file pages from a network server, therefore you may have to copy this file to a local hard drive to be viewed.

---

Required Skills

- **Exponare Enquiry and Exponare Public Users**
- **Exponare Administrator**

**Exponare Enquiry and Exponare Public Users**

You are required to have the following minimum skill sets to effectively use Exponare Enquiry and/or Exponare Public:

- The ability to perform typical Windows application tasks (e.g. start an application, use a menu, find and understand user help, etc).
- The ability to use Internet based applications and understand associated concepts (e.g page history, hyper-link usage, etc.).
- Knowledge of common spatial concepts (e.g Layers, Features, Legends, etc.).

In addition the following skill sets may be required depending on the configuration chosen by the Exponare administrator:

- The ability to use Microsoft Word to print, and optionally modify, a document.
- The ability to use Internet Explorer or Firefox to print a web page.
- The ability to use the Windows file system explorer.
- The ability to use typical Windows dialogs to save and open files to and from the file system.
Chapter 1: Introduction

Exponare Administrator

You require the following skills to effectively administer Exponare:

As above, plus the following additional skills.

- The ability to configure the Windows operating system (eg use the event viewer, modify file permissions, manage windows services, etc).
- The ability to setup, configure, and maintain IIS (eg create virtual directories, modify access permissions, diagnose defects, etc).
- The ability to setup, configure and maintain ASPX web applications (eg enable ASP.NET applications, modify ASP.NET user permissions, etc).
- The ability to use Pitney Bowes Software products to configure workspaces (eg MapInfo Professional, Workspace Manager, etc).
- Knowledge of spatial concepts in the context of Pitney Bowes Software technology (eg workspaces, TAB Files, Thematic Maps, etc).

In addition you may also require the following skills, dependent on your chosen Exponare configuration:

- The ability to configure and utilize database connections (eg create connection strings, SQL statements, ODBC links, etc).
- The ability to configure a web application in a clustered environment (eg enterprise deployment, network load balancing, ASPNET session state management, IIS web farm setup and configuration, etc).
- Knowledge of any third party applications to be 'linked' with Exponare (eg databases such as Access, Oracle or SQL Server, property and ratings systems such as Authority, Proclaim One or Pathway, etc).
- The ability to create and maintain HTML and ASPX pages (includes CSS, JavaScript usage).
- The ability to perform advanced tasks in Microsoft Word (eg configure mail merges, create and maintain macros, etc).

Getting Technical Support

- Introduction
- Contacting Pitney Bowes Software

Introduction

Pitney Bowes Software Inc. offers a free support period on all new software purchases and upgrades, so you can be productive from the start. Once the free period ends, Pitney Bowes Software Inc. offers a broad selection of extended support services for individual, business, and corporate users.

Please remember to include your serial number, partner number or contract number when contacting Technical Support.
Online Resources

Contacting Pitney Bowes Software

Full technical support for MapInfo Exponare is provided for the currently shipping version plus the two previous versions. To use Technical Support, you must register your product. This can be done very easily during installation or anytime during normal business hours by contacting Customer Service directly.

Technical Support Contact Information

Extended support options are available at each of our technical support centers in the Americas, Europe/Middle East/Africa, and Asia-Pacific regions. Contact information for all Pitney Bowes offices is located at:

http://www.pb.com/contact-us/

For any product related query, you may also write to:

software.support@pb.com

Online Resources

MapInfo-L Archive Database

Pitney Bowes Software, in conjunction with Bill Thoen, provides a web-based, searchable archive database of MapInfo-L postings. The postings are currently organized by Discussion Threads and Postings by Date. The MapInfo-L information page is at http://groups.google.com/group/mapinfo-l/.

Disclaimer: While Pitney Bowes Software provides this database as a service to its user community, administration of the MapInfo-L mailing list is only provided by Bill Thoen.

To subscribe to MapInfo-L, go to the information page listed above and either log in with your current Google account or click on 'Join' to create a new one.

To unsubscribe from MapInfo-L, go to the information page listed above, sign in and click on "My Groups" and then click on "Manage my Subscriptions".

To contact the list owner, go to the information page listed above, sign in and click on "Help", "Joining and Subscribing" and then "How do I contact the owner of a specific group?"

To post messages to MapInfo-L, send e-mail to: mapinfo-l@googlegroups.com. Any messages sent to the list can be read by anyone on the list.

GISnet Online is a web page authored by our partner Bill Thoen. There are many links to GIS information in general and specific links to Pitney Bowes Software resources. You can reach Thoen's Web at http://www.gisnet.com
About Exponare Server and Clients

This chapter provides a brief overview of the modules that make up an Exponare installation and the key GIS concepts used in the Exponare products and this document.

In this chapter...

- Introduction
- Exponare Server
- Exponare Clients
- Key Concepts
Introduction

This section provides a brief overview of the modules that make up an Exponare installation, and the key GIS concepts used in the Exponare products and this document.

Exponare consists of an Exponare Server, and a number of Exponare Clients (Exponare Enquiry and Exponare Public).

Figure 2-1: Exponare Overview

Exponare Server

Exponare Server is a web service written for Microsoft .NET and running under Microsoft IIS. It communicates with Exponare Enquiry across a TCP/IP network, using HTTP and SOAP/WSDL. Typically, you deploy Exponare Enquiry across an intranet, although it can also be used across the Internet. The Public client can be used either on an intranet or the Internet. All you need is a TCP/IP and HTTP connection between the clients and the Exponare Server.

The Exponare Server machine typically also holds the spatial and non-spatial data sets. If preferred, you can host the files, spatial and aspatial databases and datasets on a remote machine with a sufficiently fast network. The diagram below shows a more complex, multi-tiered solution using an external database server.
Chapter 2: About Exponare Server and Clients

Figure 2-2: Exponare Server Overview

Exponare Clients

When you use Exponare, your access is through Exponare Enquiry, Exponare Public, Exponare Rest Public or Exponare Mobile (which are collectively called the Exponare clients). Whether you use Enquiry or Public, most of the data processing, such as running a Query or drawing a new map, is performed by Exponare Server. It is possible to have a single Exponare server that handles the work for multiple Enquiry and Public clients.

Exponare Enquiry is a .NET windows application that provides you with a traditional Windows application experience on your desktop computer. Enquiry can easily interact and integrate with other applications on your client computer. You also access the configuration tool for the Exponare product suite through Enquiry. The Configuration Manager allows you to administer most aspects of your Exponare deployment remotely.

Exponare Public is an Internet application that runs through Internet Explorer or Firefox and thus does not require any deployment. Public is similar to Enquiry, but differs in a number of ways such as the layout customisation options and the tools that are available. Despite the differences, both Exponare Enquiry and Exponare Public interact with the Server in the same way. Note that most of the configuration for Public is handled through the Configuration Manager in Enquiry.

The bulk of this Administration Guide applies to the setup of both Exponare Enquiry and Exponare Public. The particular differences between the two clients are discussed in Chapter 3: Exponare Enquiry, Exponare Public and Rest Public.

Rest Public interface is based on OpenLayer architecture. Rest Public is viewable in most recent web browsers, with no server-side dependencies. For more details, refer Chapter 44: Rest Public.

Exponare on mobile is a map service that allows users to access mapping and business data at the convenience of your mobile browser. For more details, refer Chapter 45: Exponare Mobile.
Key Concepts

Exponare is a suite of GIS (Geographic Information Systems) software that allows the viewing and manipulation of spatial data.

All GIS software operates with the general notions of a map, associated data, and operations that can be performed. However, some of the terminology used in this document is specific to Pitney Bowes Software software. The principal concepts required for an understanding of Exponare are summarised in this section. Readers who are familiar with Pitney Bowes Software software, particularly MapInfo Professional, may skip this section.

- Workspaces and Work Contexts
- Layers and Features
- SQL Support Tables
- Selections and Queries
- Data Binds

Workspaces and Work Contexts

When working with a map, there is generally associated information and a set of useful commands that apply to the map. Also, many maps are a set of different map Layers that are superimposed to create a compound map. A workspace is a file that contains information about a map, its Layers, and related data. You can use the Workspace Manager (see Appendix D: Workspace Manager for more information) to create a workspace.

Exponare uses workspace files to define the maps on which it can operate. However, there is additional information, such as the Queries that can be run and how the workspace should be printed, that is not contained in the workspace. Exponare uses the concept of a Work Context, which is the combination of a workspace and the additional information required by Exponare. A Work Context can also refer to SQL Support Tables that are external to the workspace.

When you create data to use in Exponare, you first create a workspace, and then configure one or more Work Contexts that use that workspace.
Chapter 2: About Exponare Server and Clients

Layers and Features

As mentioned above, a key part of a workspace is the definition of different map Layers. Each Layer normally represents only one type of information. For example, a map for displaying residential areas might have separate Layers for properties, roads, sewerage, electricity, water and so on. Each Layer has a set of Features that represent physical objects or other map data. When working with a map, the user can select Features from one or more Layers and view information about those specific Features.

SQL Support Tables

SQL Support Tables are tables of spatial or non-spatial data used in the processing of Data Binds and Queries. SQL Support Tables can be part of the workspace file, or loaded separately from TAB Files. Only workspaces and TAB Files can be loaded into a Work Context, but TAB Files can refer to external database tables if required. Only those tables that are explicitly loaded are available for use in a Work Context.

Selections and Queries

Exponare offers the ability to work with selected Features on the Layers of a map. Indicating the Features to work with can be achieved in two separate ways: (1) by using map selection tools, or (2) by activating Queries. The first method, map selection tools, is the most simple and suffices for most requirements.

Queries are a more complex (and more powerful) selection method than the visual tools. A Query is a logical statement that defines the Features that should be selected. For example, a simple Query might read:

Select all the Avenues in Smallville.

This Query indicates that all of the roads in ‘Smallville’ whose type is ‘Avenue’ should be selected, regardless of what is currently visible in the map display.

Once a set of Features has been selected, either by map selection tools, or by Queries, two separate actions occur. The first is that the selected Features are visually defined on the map. For example, linear Features might be highlighted and area Features shown with a shaded background. The second is that information related to the selected Features may be displayed. The system for linking Features to a set of information is called Data Binding.

Running a Query only causes Features to be selected. A Data Bind must be configured for information to be displayed regarding the selected Features.

Data Binds

Data Binds are links from Feature identifiers to Feature information. Any loaded SQL Support Table can be used for a Data Bind. For example, on a map containing a set of roads, we may have information about each of the roads, such as ‘Name’, ‘Maintenance schedule’, and ‘Current condition’. To set up the Data Bind, each road is given a Feature ID, and a database table is created that has a primary column of Feature IDs, and associated columns for ‘Name’, ‘Maintenance
Key Concepts

schedule’, and “Current condition’ and other information. Whenever a set of roads is selected, the set of Feature IDs is obtained and the database table can be consulted to access the associated information.
Exponare Enquiry, Exponare Public and Rest Public

The Exponare clients, Exponare Enquiry, Exponare Public and Rest public are broadly similar but have certain distinguishing characteristics. This section describes the major differences and other points of interest.

Exponare Enquiry and Exponare Public are also referred to as Enquiry and Public in this publication.

In this chapter...

- Features
- Commands
- Panels
- Menus and Toolbars
- HTML Data in Exponare Public
The key features of the Exponare clients are summarized in the table below:

### Table 3-4 Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Exponare Enquiry</th>
<th>Exponare Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customisable commands and panels</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Adjustable location of toolbar, menu, panels, and the map</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Login as specified user</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Zero deployment effort</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Multiple concurrent sessions on one PC</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Application Link-Outs</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Status bar commands</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Word print templates</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>HTML Print Templates</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>User-defined Favourites</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Two separate panel areas</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Customisable raster quality</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Data Editing</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Tile Layer</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
</tbody>
</table>

The bulk of the configuration for the Exponare components is handled through the Configuration Manager. This includes the configuration of the Public user and the corresponding User Interface.

### Commands

Enquiry, Public and Rest Public have different sets of available commands and panels. The following table describes the tool availability:

### Table 3-5 Command

<table>
<thead>
<tr>
<th>Command</th>
<th>Exponare Enquiry</th>
<th>Exponare Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map – Zoom In, Pan, etc.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Overview Map</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Selection – Point Select, Rectangle Select, etc.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Public does not offer a Radius Select tool.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session – Login, Logoff, Clone Session</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Measure – Measure Distance, Measure Area</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Chapter 3: Exponare Enquiry, Exponare Public and Rest Public

<table>
<thead>
<tr>
<th>Command</th>
<th>Exponare Enquiry</th>
<th>Exponare Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map adornment – Scale Bar, Auto Labels</td>
<td>✔</td>
<td>✔</td>
<td>✘</td>
</tr>
<tr>
<td>Views</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Layer shortcuts</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Online help</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
</tr>
<tr>
<td>View/Set Zoom Width control</td>
<td>✔</td>
<td>✘</td>
<td>✘</td>
</tr>
<tr>
<td>Edit Data</td>
<td>✔</td>
<td>✘</td>
<td>✘</td>
</tr>
<tr>
<td>Tile Layer</td>
<td>✔</td>
<td>✔</td>
<td>✘</td>
</tr>
</tbody>
</table>

Panels

The following table lists the panels that are available for use in the clients. Note that panels may behave differently depending on the client.

Table 3-6 List of Panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Exponare Enquiry</th>
<th>Exponare Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Queries</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Feature Details</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Data Bind Details</td>
<td>✔</td>
<td>✘</td>
<td>✘</td>
</tr>
<tr>
<td>Print</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Public only uses HTML Print Templates.

Address Search          | ✔                | ✔               | ✘           |
Coordinates             | ✔                | ✘               | ✔           |
Edit Data               | ✔                | ✘               | ✘           |
Annotations             | ✔                | ✘               | ✔           |

Rest public supports only .htm and .html extension in printing.

Scale bar is available in Rest public but Auto Label is not available.
Exponare Public allows greater freedom of layout for its components than Enquiry. Public also allows the possibility of embedding the public components within a different ASP.NET web application. The process for creating or modifying the layout of the Public application is described in Chapter 36: Creating Exponare Public Pages.

Menus and Toolbars

The same menu and toolbar structures can be used for Enquiry, Rest Public and Public. However, if a menu or toolbar command is not relevant or not supported for one of the clients, it is silently ignored. For example, Public does not support the inclusion of Queries Menu Items onto the toolbar. If it is included, it is skipped. Similarly, Rest Public does not support the inclusion of Circle and Ellipse items onto the toolbar. If it is included, it is skipped.

In Public, putting the Views Menu Items and Layer Shortcut Menu Items directly onto the toolbar results in a drop-down button that lists each of the Views or shortcuts, whereas Enquiry displays one toolbar button for each item.

HTML Data in Exponare Public

All data that is displayed in Public, such as administrator-defined labels or the results of Data Binds, is rendered as literal text. That is, if the data contains HTML markup, Public does not process or interpret the HTML.

For example, if a Data Bind returns a value for StreetName of

\[<b>Bob St</b>\]

the displayed result is

\[<b>Bob St</b>\] rather than Bob St.
Part 2: System Administration

The chapters in this section describe how to install, upgrade and un-install Exponare on both server and client machines. Day-to-day server and client administration tasks are discussed here. The section concludes with a chapter that describes how to run Exponare in a web farm environment.

We recommend that you contact our Professional Services Group if you are installing Exponare for the first time.

Topics

- Installing Exponare
- Upgrading Exponare
- Uninstalling Exponare
- Server Administration Tasks
- Client Administration Tasks
- Web Farm Environments and Exponare Server
Installing Exponare

This chapter describes the Exponare platform requirements and the processes for installing Exponare components and preparing them for use.

If you are installing Exponare on multiple servers, refer to the Web Farm Environments and Exponare Server.

All Exponare components, Server, Enquiry and Sample Data, must be installed using a Windows user account that has administration privileges. This includes full file system, registry and event log privileges.

The order for performing a full Exponare installation is to install Exponare Server then Exponare Sample Data then Exponare Enquiry.

In this chapter…

- What’s on the CD
- Platform Requirements
- Exponare Combination
- Exponare Server
- Exponare Sample Data
- Exponare Enquiry
What's on the CD

Install Products
It includes a sub-menu of Exponare Server, Exponare Sample Data and Exponare Enquiry installers.

Documentation

Contact Information
It lists Pitney Bowes Software’s main offices worldwide.
http://www.pb.com/contact-us/

Register
Advice concerning the registration of Exponare and MapXtreme 2005.

Browse CD
Click to open a Windows Explorer window. In the Prerequisites folder, you will find additional software that you may need to install:
• Adobe Reader v11.0
• Microsoft .Net Framework version 4.0
• Windows Installers for Windows XP and Windows 2003 Server
• Original MapInfoCoordinateSystem.xml available as a backup Exponare 5.1 onwards
• Install MiFonts.exe to be used in specific upgrade scenarios (For 32 bit installers) only
• Front page server extension for 2008
• VC++ 2012 Redistributable Package
• Web.config files
## Platform Requirements

The following table lists the system requirements for the Exponare components.

### Table 4-1 Exponare Platform Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Exponare Server</th>
<th>Exponare Enquiry</th>
<th>Exponare Public (client)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 2008 Server R2 (64 bit) Standard</td>
<td>Windows 8.1 (x64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 2008 Server R2 (64 bit) Enterprise</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012 (x64) standard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File system</td>
<td>NTFS recommended</td>
<td>NTFS, FAT32</td>
<td>NTFS, FAT32</td>
</tr>
<tr>
<td>Service Packs</td>
<td>latest available</td>
<td>latest available</td>
<td>latest available</td>
</tr>
<tr>
<td>.NET Framework</td>
<td>v 4.0</td>
<td>v 4.0</td>
<td>n/a</td>
</tr>
<tr>
<td>Internet Information Services (IIS)</td>
<td>IIS v6.0, IIS v7.0, v7.5 plus FrontPage Server Extensions (not required for IIS v7.5 onwards)</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>IIS 8 (for 64 bit)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Installer</td>
<td>v 3.1</td>
<td>v 3.1</td>
<td>n/a</td>
</tr>
<tr>
<td>Public</td>
<td>Internet Explorer (IE) v 8.0, 9.0 (Browser mode: IE 9 Document Mode: Quirks), IE 10 (Browser mode: IE 10 Compatibility View, Document Mode: IE 5 Quirks) Firefox</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RestPublic</td>
<td>Internet Explorer (IE) v 8.0, 9.0, 10, 11, Firefox, Google Chrome, and Safari</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mobile</td>
<td>Tested for iOS default browser. iOS 4S and above recommended</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Word (optional)</td>
<td>n/a</td>
<td>Microsoft Word 2003, 2007, 2010, and 2013</td>
<td>n/a</td>
</tr>
<tr>
<td>Citrix Xenapp 6.5</td>
<td>n/a</td>
<td>Citrix Xenapp 6.5</td>
<td>n/a</td>
</tr>
</tbody>
</table>
Exponare Combination

1. 32Bit Enquiry communicating with 64Bit Server
2. 32Bit Enquiry communicating with 32Bit Server
3. 64Bit Enquiry communicating with 64Bit Server

It is not recommended to configure 64Bit Enquiry communicating with 32Bit Server.

Exponare Server

The Exponare Server installer provides the following products:

- Exponare Server
- Exponare Public
- MapXtreme 2005 Workspace Manager

Software Requirements

The Exponare Server requires a number of pieces of software to be present and appropriately configured prior to its installation in order to function properly. These requirements are discussed below, with information on how to remedy common problems.

To assist administrators in determining if their system meets the Exponare Server software requirements the Exponare Server installer will test for most requirements. All requirements discussed below are tested except ASP.NET activation and existing virtual directories.

Microsoft .NET Framework version 4.0

The .NET Framework version 4.0 is required. An installer for Microsoft .NET 4.0 is provided on the Exponare CD-ROM.

IIS

Exponare requires IIS v6.0, v7.0, v7.5, v8.0. To install IIS, use the following steps:

Windows 2008/2008 R2
1. Go to “Program and features” section in Control panel.
2. Click on “Turn windows features on or off”.
3. Add Role “Web Server (IIS)”.

Windows 2003
1. Go to “Add/Remove Programs” tool in Control Panel and select “Add/Remove windows components”.
Chapter 4: Installing Exponare

2. Locate Application Server, click on Details button.
3. Locate and select IIS.

Please take care of the following:

The FrontPage Server Extensions item should be selected (For IIS 7.0 FrontPage 2002 Server Extensions (FPSE 2002) needs to be installed, not required for IIS v7.5 onwards).

For IIS 7.0/7.5 “IIS 6 compatibility components” should be selected.

If given the option, select ASP.NET for installation.

For more details refer Pre-Installation Tasks.

FrontPage Server Extensions
The FrontPage Server Extensions component is required for IIS v6.0, v7.0. See IIS above for installation details. Note that it is necessary to register (or re-register) the ASP.NET system after installing FrontPage Server Extensions. See ASP.NET registration for details.

ASP.NET registration
The ASP.NET system must be registered for use. Typically this is performed when the .NET Framework is installed, but manual installation is sometimes necessary, particularly if IIS or FrontPage Server Extensions have been manually installed. Ensure .NET Framework, IIS and FrontPage are installed and then run the following commands at the command prompt to register ASP.NET (use C:\WinNT if appropriate):

```
C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe/u
C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe/i
```

ASP.NET activation
IIS v6.0, v7.0, v8.0 have options to disable specific application handlers. Ensure that ASP.NET is allowed by using the IIS control panel.

For IIS V6.0, check that ASP.NET v4.0.30319 is set to “allowed” by checking Internet Information Service>local computer>Web Service Extensions>ASP.NET v4.0.30319.
For IIS v7.0, v8.0 ASP.NET v4.0.30319 is set to allowed at system level through ISAPI and CGI Restrictions at machine level.

1. Go to IIS Manager.
2. Go to Machine name and choose "ISAPI and CGI Restrictions"

For all versions of ASP.NET 4.0 AND 2.0 -Set the restriction as "Allowed".

This setting is not applicable for 64 bit integrated mode install.
Existing virtual directories

The virtual directories from previous installations of Exponare or other products may be left behind after uninstallation. Before installing the current version of Exponare, review the virtual directories that are registered in IIS and remove or rename any that will conflict with your preferred Exponare virtual directory name. The virtual directories are not checked by the installer and conflicts may cause the installation to partially or completely fail.

Pre-Installation Tasks

64 bit Install

Exponare 64 bit should not be installed on such environment where 32 bit Exponare is already installed. In this environment both Exponare installations could get corrupted. Thus, user should perform and complete uninstall of existing Exponare server, sample data and Enquiry also including the backup files. A fresh install should be taken up only after a complete uninstall.

Exponare Installation on Windows Server 2012

Before you install Windows Server 2012 you will have to add few roles for Exponare Installation.

1. Open Server Manager and Click Add Roles and features. Click Next.
2. Add Server Roles and Features dialog appears. Click Installation type and select the "Role based and feature-based installation" radio button.
3. Click Next. Click on Select a server from server pool radio button and add Your Server. Click on Next button.
4. From Server Roles select Web Server (IIS) check box and click Next.
5. Application Server dialog appears. Click Next.
7. Select the following from the check boxes.
Figure 4-4: Server Role

[Diagram showing server role and installed features]

- Application Server (Installed)
- JET Framework 4.5 (Installed)
- COM+ Network Access
- Distributed Transactions
- TCP Port Sharing
- Web Server (IIS) Support (Installed)
- Windows Process Activation Service Support
- DHCP Server
- DNS Server
- Fax Server
- File And Storage Services (Installed)
- File and iSCSI Services
- Storage Services (Installed)

- Web Server (IIS) (Installed)
- Default Document (Installed)
- Directory Browsing (Installed)
- HTTP Errors (Installed)
- Static Content (Installed)
- HTTP Extension (Installed)
- WebdAV Publishing
- Health And Diagnostics (Installed)
- HTTP Logging (Installed)
- Custom Logging
- Logging Tools (Installed)
- ODBC Logging
- Request Monitor (Installed)
- Tracing
- Performance (Installed)
- Static Content Compression (Installed)
- Dynamic Content Compression (Installed)

- Security (Installed)
- Request Filtering (Installed)
- Basic Authentication (Installed)
- Centralized SSL Certificate Support
- Client Certificate Mapping Authentication (Installed)
- Digest Authentication (Installed)
- HTTP Client Certificate Mapping Authentication (Installed)
- IP And Domain Restrictions (Installed)
- URL Authorization (Installed)
- Windows Authentication (Installed)

- Application Development (Installed)
- .NET Extensibility 3.5
- .NET Extensibility 4.5 (Installed)
- Application Initialization
- ADO
- ASP.NET 3.5
- ASP.NET 4.5 (Installed)
8. Click Next.

9. Add Features roles as shown below:

   [Image of Feature Role]

   Figure 4-5: Feature Role

10. Click Install.

11. After completion of the installation process click Close.
Exponare Server

12. Go to User Account Control Settings.
13. The User Account Control Settings should be Never Notify (minimum).

⚠ Please ensure that Windows Update is on.

14. You should restart your Windows Server 2012 machine after setting the User Account Control Settings.
15. Install Exponare on your system. For installation refer Installation.

Exponare Installation on Windows Server 2008 R2
Before you install Windows Server 2008 R2 you will have to add few roles for Exponare Installation.

1. Open Server Manager and Click Add Roles. Click Next.

2. Add Server Roles dialog appears. Click Server Roles and select the Application Server and Web Server(IIS) check boxes. A popup will appear, Select the .Net Framework 4.0 features and click the Add Required Features.

3. From Server Roles select Web Server (IIS) check box and click Next.

4. Application Server dialog appears. Click Next.

5. Select Roles Services dialog appears. .Net Framework 4.0 should be selected from the check box. Click Next.


7. Select Roles Services dialog appears. Select the following from the check box.
8. Click **Next > Install**.

9. After completion of the installation process click **Close**.

10. Go to **User Account Control Settings**.


   **Note:** Please ensure that Windows Update is on.

12. You should restart your Windows Server 2008 R2 machine after setting the User Account Control Settings.

13. Install Exponare on your system. For installation refer **Installation**.
Exponare Server

32 bit Install

Exponare Installation on Windows Server 2008 R2

Windows 2008 R2, supports Exponare install in both - 32 bit and 64 bit mode. To maximize performance output, 64 bit install is recommended.

Before you install Windows Server 2008 R2 you will have to add few roles for Exponare Installation.

1. Open Server Manager and Click Add Roles. Click Next.

2. Add Server Roles dialog appears. Click Server Roles and select the Application Server and Web Server(IIS) checkboxes. A popup will appear, Select the .Net Framework 4.0 features and click the Add Required Features.

3. From Server Roles select Web Server (IIS) check box and click Next.

4. Application Server dialog appears. Click Next.

5. Select Roles Services dialog appears. .Net Framework 4.0 should be selected from the check box. Click Next.


7. Select Roles Services dialog appears. Select the following from the check box.

   Figure 4-7: Role Services Dialog Box

   ![Role Services Dialog Box](image)

8. Click Next > Install.
9. Click Close after completion of the installation process.

10. Go to User Account Control Settings.
    The User Account Control Settings should be Never Notify (minimum). For further details on

Please ensure that Windows Update is on.

11. You should restart your Windows Server 2008 R2 machine after setting the User Account
    Control Settings.

12. Go to IIS Manager > Application Pool and click on Set Application Pool Defaults. Set value
    as True for "Enable 32-Bit Application"

13. Install Exponare on your system. For installation refer Installation.

Windows Server 2008 Standard

1. Open Server Manager and Click Add Roles. Click Next.

2. Add Server Roles dialog appears. Click Server Roles and select the Web Server(IIS) check
    boxes.

3. From Server Roles select Web Server (IIS) check box and click Next.


5. Select Roles Services dialog appears. Select the following from the check box.
6. Click **Next > Install**.

7. After completion of the installation process click **Close**.

8. Goto **Control Panel>User Accounts** and click on **Turn User Account Control On or Off**.

9. The **User Account Control** check box should be unchecked.

   Please ensure that Windows Update is on.

10. You should restart your Windows Server 2008 machine after setting the **User Account Control Settings**.

11. Install Exponare on your system. For details refer **Installation**.

**Exponare Installation on Windows Server 2003 Standard**

No specific settings are required for Windows Server 2003 except the standard pre-requisite installs and.net framework settings

**Exponare Server License Application**

Exponare Server is copy protected by a licensing system. For the first 60 days after installation a trial license will allow use of Exponare. After this time the copy protection system will prevent the use of Exponare Server until a full license file is obtained from Pitney Bowes Software.
Chapter 4: Installing Exponare

Given that it can take several days to receive a license file it is advised that you make an application for a license prior to installing Exponare Server. An application for a license can be made through the following process:

1. Use the Exponare Hardware Identity Generator to gather the information necessary to make an application. This wizard can be launched from the Register option on the Exponare CD main menu, or under the Exponare Server start menu folder after installation.

2. You can copy the hardware identity details to clipboard and email the same to 'asiapackeys@pb.com'.

3. After installing Exponare Server, copy your license file to the /Common Files/MapInfo/MapXtreme/7.2.0 folder.
   In case of a 64 bit installation on a 64 bit machine, the permanent license has to be copied to \Program Files (x86)\Common Files\MapInfo\MapXtreme\7.2.0 folder

4. A license file is bound to a single computer. It is not possible to take a valid license file from one computer and have it work on another. For the same reason you must make an application for a license for each computer you install Exponare Server on.
   • If a hardware change is made on a computer hosting Exponare Server it may be necessary to apply for a new license.

Server Name

If the name of your server contains characters other than alphanumeric characters and dashes then you should rename your server so that the name only contains alphanumeric characters and dashes, access the server by the IP Address, or access the server by an alternate HTTP address.

Windows Event Log

Messages from Exponare Server and Exponare Public will be written to the Event Log on the machine Exponare Server is installed on. Messages from Exponare Enquiry will be written to the Event Log on the machine Exponare Enquiry is installed on.

When configuring an Exponare Server, many messages can be written out to the Application Log on the server. The Application Log default size is comparatively small and so we recommend you increase the default size of the Application Log before installing and configuring or upgrading to Exponare 3.0 and above.

Messages will be written out by default. There is no need to alter any configuration settings to cause the generation of messages.
Exponare Server

Installation

Install Exponare Server from the CD-ROM by inserting the Exponare CD in the CD drive. If the installer does not run automatically, it can be accessed directly by running the `index.html` (using Internet Explorer) file in the root folder on the Exponare CD.

Click on **Install Products** followed by **Exponare Server / Exponare Public** and follow the screen prompts.

**Note:** Unless upgrading, Exponare should never be installed to a folder or virtual directory which already contains files.

IIS is suspended during the installation of Exponare Server. This will affect other web applications on the server.

CAUTION: To facilitate future upgrades to Exponare Server, do not modify the files that are installed by Exponare Server. Rather, create new files and subdirectories if required. New files are not deleted during uninstallation and can be migrated more simply to future versions.

Visual C++ 2012 redistributable package

Exponare Server requires Visual C++ 2012 redistributable package to be installed on the system. When Exponare server installation starts, it will prompt you to install redistributable package as shown in figure below:

**Figure 4-9: Installing Redistributable Package**
Chapter 4: Installing Exponare

Click on Install button to install the redistributable packages. The Exponare Server installation begins.

Post-installation Tasks

64 bit install

For Windows Server 2008 R2 for 64 Bit and 2012 for 64 Bit
1. Add New Application Pool, Set its values as:
   • Name: Exponare
   • Framework 4.0
   • Managed Pipeline Mode to Integrated
2. Go to Set Application Pool Defaults of Exponare:
   • Set.NET framework version to "v4.0"
   • Set value as false for "Enable 32-Bit Application"
   • Change the Identity to Built-in account >Network Services.
   • Check that the Managed Pipeline Mode is set to integrated
3. Click Ok to save the settings.
4. Go to Sites > Default Web Site > Exponare.
   • Change the Application Pool to Exponare (via Advance Settings).
5. Ensure that handlers available in "Handler mapping" section such as -*.asmx,*.aspx,*.rest are mapped to C:\Windows\Microsoft.NET\Framework64\v4.0.30319
6. Do IIS Reset.
7. Start Exponare Enquiry for further configuration settings.

32 bit Install

For Windows Server 2003
In case you are a Win 2003 user, you would particularly need to alter the current IIS settings to use Rest public. For IIS settings, refer to IIS settings to configure Rest Public.

For Windows 2008 Standard

2. Right Panel of the IIS Manager click on Advanced Settings.
3. Set Managed Pipeline Mode to Classic.
4. Do IIS Reset.
5. Start Exponare Enquiry for further configuration settings.

For improved performance, refer section- “Switching to integrated mode” and increase Mapxtreme pool size.
For Windows Server 2008 R2 for 32 Bit (classic mode)

1. Go to Set Application Pool Defaults... and set value as false for "Enable 32-Bit application"

2. Add New Application Pool, Set its values as:
   - Name: Exponare
   - Framework 4.0
   - Managed Pipeline Mode to Classic

3. Go to Set Application Pool Defaults of Exponare:
   - Set value as True for "Enable 32-Bit Application"
   - Change the Identity to Built-in account >Network Services.
   - Click Ok to save the settings.

4. Go to Sites>Default Web Site>Exponare.
   - Change the Application Pool to Exponare (via Advance Settings).

5. Do IIS Reset.


For improved performance, refer section- "Switching to integrated mode" and increase application pool size.

Switching to Integrated mode (IIS 7 & above)

For improved performance, it is recommended to switch to integrated mode in IIS versions 7 and above.

To set up integrated mode, please follow the below steps:

1. Run through the steps above for "Classic mode" installation.

2. Copy the web.config file from "Prerequisites\Web_Config\IntegratedMode" folder from Exponare CD.

3. Replace the web.config file under server directory with the copied one.

4. Access the IIS Manger.

5. Change the Application pool's(which is mapped to Exponare server) Manage Pipeline Mode option to "Integrated".

6. Reset IIS.

Copying Your License File

7. Copy your Exponare Server license file to the /Common Files/MapInfo/MapXtreme/7.2.0 folder.
8. Restart your ASP.NET process. This process is called either aspnet_wp or w3wp depending on your operating system.

New installations of Exponare also require activation. This procedure is explained in Activation Keys.

Updating web.config

Ensure to add requestValidationMode="2.0" in httpRuntime tag in web.config for the upgrade of Exponare. For example:

```xml
<httpRuntime executionTimeout="3600" maxRequestLength="1048576" requestValidationMode="2.0"/>
```

Setting File Permissions for Your Data

The data files that you use for defining workspaces, tables, images, and so on must be readable by the ASP.NET user account so that the Exponare Server process can gain access to them. If the data is on the Exponare Server machine then this process is not complicated. However, if your data files are on an external machine, then the process is more difficult as the ASP.NET user cannot access the network by default. Note also that there is a distinction between files that are accessed via the file system and those that are accessed directly via IIS.

In general, if a file is accessed via a URL, such as http://localhost/Exponare/file.txt, then you must ensure the file is readable via IIS (normal web publishing).

However, if the file is accessed directly, such as the workspace definition files, then you must ensure that the ASP.NET user account can read those files.

Files Accessed via IIS (Web-published Files)

Any files that are accessed via IIS are specified using URL syntax.

Files that are accessed via IIS include:

- Layer Icons
- Custom Legend images
- Special Data Bind image thumbnails
- Special Data Bind targets

These files must exist in an web-shared directory and have read permission specified. The files may exist on any server machine that runs a web server. The ASP.NET user account has nothing to do with the accessing of these files.

Direct Access Files

Files that are accessed directly by the Exponare Server are:

- All workspace definition files: *.mws
- All MapInfo Professional TAB Files: *.tab
Exponare Server

- All images that are used by raster Layers in workspace files: eg *.jpg, *.ecw

If the data files are on the same machine as the Exponare Server, then you must ensure they are readable by the ASP.NET user.

However, if some or all of the data files are on a network machine then you may need to change the ASP.NET user to be a network-recognised user account first and then ensure that the ASP.NET user can access those network files, this is discussed below.

Configuring ASP.NET Impersonation

Changing the ASP.NET user account is called User Impersonation and is a feature of IIS and .NET. The ASP.NET user can be changed on a machine-wide basis by editing the machine.config file, however this is not generally recommended. A preferred solution is to alter the ASP.NET user account for Exponare only.

User Impersonation With IIS

Choose a network user to run the ASP.NET process. Where possible, limit the permissions of this user to prevent unexpected or malicious access to data. As an example, assume that the username is MYDOMAIN\ExponareUser, with a password ExponareUserPassword.

Setting Up User Impersonation For IIS

1. Make a backup copy of the Exponare web.config file
2. Add the following line in the <system.web> section of the Exponare web.config file:
   
   `<identity userName="MYDOMAIN\ExponareUser" password="ExponareUserPassword" impersonate="True" />

3. Restart the Exponare Server

The only problem with this approach is that the password for the named user is stored without any form of encryption and it may be possible for someone to access the web.config file and obtain this password. A more secure method is described below.

Encrypted Password

To use an encrypted password, references to special entries in the Registry are used instead of plain text information in the web.config file.

The additional security is achieved by

1. Storing the password in an encrypted form in the registry, and
2. Restricting access to the registry entry.

Full details can be found in MSDN.
Testing the installation of Exponare Server

If you have upgraded your existing Exponare installation, you can access Exponare Public from the Start menu. For new installations you must install Exponare Enquiry (see page 47) before you can access Exponare Public.

The Workspace Manager and Exponare documentation are available from the Start menu after Exponare Server installation is complete.

The Exponare Server version 6.0 installation process will not upgrade versions of Exponare Server prior to version 4.5. Earlier versions must either be upgraded to Exponare version 4.5 or uninstalled.

If an earlier version of the Exponare Server has been run since the server was last rebooted it may be necessary to restart the ASP.NET process (called either aspnet_wp or w3wp on Windows 2003) before Exponare Enquiry version 5.5 clients can successfully connect.

Troubleshooting

Error due to VC++ 2012 Redistributable package not installed on server

Symptom

Exponare crashes on first run and you see the following page on accessing public or service page, this is because VC++ 2012 redistributable package might not have installed on server.

Resolution

Try to install VC++ 2012 redistributable package from Prerequisites folder included in the Setup CD/ISO image.

If you are setting up 64bit server then both 32 bit and 64 bit redistributable packages are required. If you are setting up 32 bit server then only 32bit VC++ redistributable package is required to be installed.
Server Installation Fails

**Symptoms**
A failure with the message ‘Cannot load one or more installer types’ is generally related to the use of incorrect Exponare components. Other failures may be caused by a lack of space on the target hard disk, or insufficient privileges to install.

**Resolution**
Uninstall any prior versions of Exponare products and try again. Ensure that the logged in user has Administrator rights and ensure there is sufficient space on the hard disk that hosts IIS.

Installer Gives Error Messages About File Permissions

**Symptoms**
The Exponare Server installer attempts to set file permissions so that the server can modify files in the Config subdirectory of the Exponare Server virtual directory. If this process fails, error messages may be displayed during the operation of the Installer such as:

*Cannot set permissions on Config\Configuration.xml*

**Resolution**
The username that is assigned to the ASP.NET system must have write/modify permissions to the following files and directories:

- `Exponare Virtual Directory\config`
- `Exponare Virtual Directory\config\*.x` (ie all files that are installed in the config directory)

You can set permissions by navigating to the files and directories with Windows Explorer, and then choosing **File>Properties>Security**.

```plaintext
i The Security tab is only available for NTFS file systems. Also, ensure that the individual files are not marked "read only" (this does not apply to the directories).
```

**Resolution for IIS 6.0**
The correct username for ASP.NET can vary depending on your installation. For full details, review the IIS 6.0 information on MSDN.

The Exponare Server installer assumes that you are logged in as a local administrator and that IIS is using Default Application Pooling. The installer sets permissions for the local "NETWORK SERVICE” username. This may or may not be correct for your situation. A quick way to check is to use **Task Manager>Processes** and observe the username associated to the `w3wp.exe` or `aspnet_wp.exe` process. This should give you a good idea of the username used by ASP.NET.
Chapter 4: Installing Exponare

Error during Server installation

During install of Exponare server on installation is interrupted with following error:

Figure 4-10: Exponare Server Installer Information

Resolution

This issue is resolved by choosing the appropriate IIS settings. It is recommended that the IIS setting are in sync with the Webserver configuration steps suggested in Pre-Installation Tasks.

Error on upgrading Exponare Server - Error 404.17 or Error 405 (In Enquiry)

Symptoms

On running locally .aspx or .asmx page, below HTTP error occurs after upgrading the server.

Figure 4-11: HTTP Error 404.17 - Not Found

Or Enquiry throws an exception 405: Method not found.

Resolution

Please add these three handlers manually after completing the installation of server at the following executable path:

"Drive:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\...."
Exponare Server

1. "axd" handler from path:
   "C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll".

2. "asmx" handler from path:
   "C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll".

3. "aspx" handler from path:
   "C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll".

Zoom/pan control will not work in old public on upgrading the server if above "axd" handler is not added. Check the Event Log for information.

Unable to see symbol fonts after upgrading to version 6.0

Symptoms
After upgrading to 6.0, if symbol fonts do not appear on the Exponare, then fonts used in Exponare may be missing.

Resolution
1. Go to "Prerequisites" folder in the available Exponare CD setup.
2. Check folder "MIFonts" and Run the InstallMIFontsfonts.exe.
3. Restart the machine for fonts to take effect.

Coordinate system in Exponare showing unexpected values as "SRID: XXXX"

Symptoms
Due to underlying engine changes, the coordinate system in Exponare might unexpectedly show up as a "SRID: XXXX". If it happens, follow the steps below to resolve the issue.

Resolution
1. Open the work context in Workspace Manager.
2. Choose the tab corresponding to "Co-ordinate Systems".
3. You would notice that the expected co ordinate system has been selected and greyed out.
4. Reselect that co ordinate system and save workspace file.
5. Reset IIS to observe the co-ordinate systems taking effect.
Chapter 4: Installing Exponare

The page requested cannot be served because of the ISAPI and CGI Restriction list settings on the Web server

Figure 4-12: Server Error in Application

Symptom
After installation if the error shown above is displayed, there could be problem with .Net framework 4.0.

Resolution
For IIS V6.0, check that ASP.NET v4.0.30319 is set to "allowed" by checking Internet Information Service>local computer>|WebService Extensions|ASP.NET v4.0.30319.

For IIS v7.0, ASP.NET v4.0.30319 is set to allowed at system level through ISAPI and CGI Restrictions at machine level.

1. Go to IIS Manager
2. Go to Machine name and choose "ISAPI and CGI Restrictions"
   For all versions of ASP.NET 4.0 AND 2.0 -Set the restriction as "Allowed".

Installed 64-bit installer on 32-bit machine

Symptom:
Exponare crashes on first run, this is because you might have installed a 64-bit version on a 32-bit machine.

Resolution:
Exponare 64 bit should not be installed on machine where 32 bit Exponare is already installed. It is not recommended environment as the old Exponare could get corrupted.
Exponare Sample Data

The Exponare Sample Data is a separate installer that can be launched from the CD browser after the Exponare Server has been installed. It acts as an add-on to the Exponare Server, placing files on the system as may be seen in a typical installation. It is designed to both verify that an installation of Exponare has been successful and to demonstrate Exponare functionality.

Installation

Install the Exponare Sample Data from the CD-ROM by inserting the Exponare CD in the CD drive and following the links in the CD browser which is displayed (see page 22). The Exponare Sample Data installer can also be accessed directly by running the setup.exe file in the Exponare Sample Data folder on the Exponare CD.

By default, the Exponare Sample Data is copied to a directory under the Exponare Server directory.

Post Installation Task

Before you can use the sample data, you must import the sample data configuration file.

To configure Exponare to use the sample data:

1. In Exponare Configuration Manager, select Configuration>Import from file

2. Browse to the location of the sample data folder and select Configuration.xml—the default path is C:\Program Files\MapInfo\Exponare\Server\SampleData

3. You will be asked if you want to import password information.
   Answer:
   Yes if you are installing Exponare for the first time
   No if you want to keep your current passwords.

4. In Application Settings, enter your Customer name.

5. Check/enter your Activation keys.
   See Registering an Activation Key.

The Exponare Sample Data is not intended for use. If you alter it your changes may be lost when the Exponare Sample data is uninstalled. If you intend to make modifications, and you do not want to lose those changes, first copy the Sample Data files to a data directory of your choice that lies outside the Program Files area. Then update your Exponare Configuration to refer to this new data directory - For details, refer Exponare Server.
Exponare Enquiry


Installation - Single Client

Install the Exponare Sample Data from the CD-ROM by inserting the Exponare CD in the CD ROM drive and follow the links in the CD browser refer to What’s on the CD. The Exponare Enquiry installer can also be accessed directly by running the setup.exe file in the Exponare Enquiry folder on the Exponare CD.

The installation of Enquiry will create shortcuts for and enable use of the application for all users on the machine.

Installation - Enterprise Deployment

In a standard enterprise model, there is one Exponare Server, but many Exponare Enquiry clients. To avoid the need to install each Enquiry on your client machines, you can make use of a number of deployment strategies.

Enterprise deployment strategies are not part of Exponare; rather, they are part of your Windows operating system or third-party software. Please see your system documentation for full details on enterprise deployment.

The simplest enterprise deployment strategy is to use Windows Server login scripts. All that is required is to specify a call to msiexec (a component of Microsoft Installer v2.0) that executes the Enquiry Installer. In order to do this, copy the Enquiry Installer onto a network drive that is accessible to all of your users (and which is accessible during login script processing). You also need to know the URL of your Exponare Server virtual directory. This is typically something like:

http://my.server.com/Exponare

When specifying the call to msiexec, you can make use of various command-line parameters. The most common ones are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/i msifile</td>
<td>Install the msifile</td>
</tr>
<tr>
<td>/x msifile</td>
<td>Uninstall the msifile</td>
</tr>
<tr>
<td>/qb-</td>
<td>Only show the progress bar during installation.</td>
</tr>
<tr>
<td>/qn</td>
<td>Don’t show any user interface at all</td>
</tr>
</tbody>
</table>

The complete list of options for msiexec is available on MSDN.

You can specify the Exponare Server address by including the following installer parameter:

SERVER_OVERRIDE="http://server/Exponare"
Exponare Enquiry

Overall, a common command-line to use in login-script deployment is

```msiexec /qb- /i "MapInfo Exponare Enquiry.msi"
SERVER_OVERRIDE="http://my.server.com/Exponare"
```

To uninstall Enquiry in a login script, use

```msiexec /qb- /x "MapInfo Exponare Enquiry.msi"
```

Using these two processes you can ensure that your users have access to Enquiry with minimal effort.

The most common problem that you will face with your deployment of Enquiry is an incorrectly specified Server URL. The Server URL used by Enquiry is stored in the Program Files area, in a file called `ExponareEnquiry.exe.config` (eg `C:\Program Files\MapInfo\Exponare\Enquiry\ExponareEnquiry.exe.config`).

If your Enquiry clients cannot connect, make sure that they have an appropriate URL. Note that the URL contained in the `ExponareEnquiry.exe.config` file must include “Exponare.asmx” at the end, eg

```
http://my.server.com/Exponare/Exponare.asmx
```

You should be able to cut-and-paste the URL from the configuration file into a web browser and see a list of Exponare web service functions.

Getting Started

Exponare Enquiry must be configured to point to a live Exponare Server before it can be used. Typically this configuration is done during installation by providing information about the server when prompted. Once installation is complete, configuration of the Exponare Server can be done by editing the `ExponareEnquiry.exe.config` file located in the Exponare Enquiry application folder.

Exponare Enquiry can be started by accessing the Exponare Enquiry shortcut in the Start menu or by using the Exponare Enquiry shortcut installed to the desktop.

If you are installing Exponare for the first time, Exponare Enquiry will launch the Configuration Manager. You can log in using the `admin` account which has a password of `admin` (both are case-sensitive). It is recommended that you create a standard Windows shortcut on your desktop which starts Enquiry and adds the command line argument `/admin`. For example, `"Program Files\Exponare\Enquiry\ExponareEnquiry.exe" /admin`

Refer Client Administration Tasks - Starting Enquiry from the Command Line for further information.
Using the Sample Data

The Exponare Sample Data configuration file provides the following User Profiles:

<table>
<thead>
<tr>
<th>Name</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>User</td>
</tr>
<tr>
<td>Guest</td>
<td>&lt;blank&gt;</td>
</tr>
</tbody>
</table>

You can only log in as the admin user if you have not activated Exponare (see below).


The sample data can be viewed in Exponare Public either by accessing the Exponare Public shortcut in the Start menu on the Exponare Server or by navigating to http://my.server.com/Exponare/Public.html (substitute the appropriate server name and virtual directory name as required). The supported browsers are Internet Explorer and Firefox.

Activation Keys

Activation Keys are used to unlock the functionality of Exponare. Until a feature is activated it will be limited in some manner.

If you start Exponare Enquiry before it is activated, the Exponare Configuration Manager will be automatically started where you can request and specify Activation Keys.

Exponare Public can be started but the map will contain a Watermark until activated.

Activation Keys are linked to your customer name and the custom data specified for the feature (such as number of users). Any change to these values will invalidate existing Activation Keys.

New Activation Keys are not required when upgrading an existing Exponare installation.

Requesting an Activation Key

Requests for Activation Keys for the various Exponare features is made through Product Support.

To request an Activation Key:

1. Start the Exponare Configuration Manager (see page 98).
2. Select the Application Settings item in the tree.
3. Make sure your Customer name setting is correct.
4. Click the Activation Key button in the toolbar to display the Activation Key entry window.
5. Select the feature you would like to activate.
6. Enter any additional details for the feature, such as number of users.
7. Click the request button. This copies a snippet of XML to the clipboard.
8. Open an email and address it to asiapackeys@pb.com.
9. Include in the email your Exponare serial number (which is written on the Exponare product box).
10. Paste the XML snippet into the email.
11. Optionally, if you require multiple Activation Keys perform steps 5-7 again and add the XML snippet(s) to the email.

12. Send the email.

13. We will respond, sending you an email containing your Activation Keys (which are also XML snippets).

Registering an Activation Key

Once you have requested and received an email containing one or more Activation Keys, you can add the Activation Keys to the Exponare configuration to enable the corresponding feature(s).

To register an Activation Key:

1. Start the Exponare Configuration Manager (see page 98).

2. Select the Application Settings item in the tree.

3. Make sure your customer name setting is correct.

4. Click the Activation Key button in the toolbar to display the Activation Key entry window.

5. In your email program, select the XML snippet that you received from Product Support, and copy it to the clipboard.

6. In the Activation Key entry window, click the paste button.

7. The Activation Key is registered and any custom data information is entered automatically. A message is displayed in the bottom of the dialog box indicating whether it is valid or not. If your Activation Key is invalid, contact product support.

8. Click Close to close the dialog box.

9. Save the configuration.

Access Denied on editing Exponare Enquiry config file on Windows7

Symptoms

When trying to edit and save the ExponareEnquiry.exe.config file on Windows7 Platform, an Access Denied message pops up.

Resolution

This issue is related to editing rights on this folder. Theses rights have to be granted to the file or the containing folder.

To set these rights

1. Select the folder and right click to go to Properties.

2. Go to Security tab and select Edit to add your individual username and grant write access.
Troubleshooting

Error during Enquiry installation

Earlier during install of Exponare Enquiry, it can be directly installed by clicking on setup.exe or through the Index.html launch page.

But if the user is installing on Windows 7, it is interrupted with following error:

Figure 4-13: Exponare Enquiry Installer Information

Resolution

This issue is resolved by right click the setup.exe and Run as Administrator.

If user is installing through Internet Explorer using "Index.html" & "run as administrator", then Internet Explorer should open as administrator.
Upgrading Exponare

This chapter describes how to upgrade to Exponare 6.0 from previous version 4.5, 5.0, 5.1, or 5.6. Refer to Platform Requirements for details on system requirements.

⚠️ All Exponare components, Server, Enquiry and Sample Data, must be upgraded using a Windows user account that has administration privileges. This includes full file system, registry and event log privileges.


In this chapter...

- Exponare Server
- Sample Data
- Exponare Enquiry
To perform an upgrade of an existing Exponare Server installation start the Exponare Server installer and follow the prompts provided in the installer.

During an upgrade two backup tasks are performed to ensure that data loss does not occur. Specifically these tasks are:

- Any live configuration files, AccessKeys.xml, Configuration.xml and Information.xml, will be backed up to the folder [Exponare Server Directory]\Config\_ConfigBackup_yyyy-mm-dd where yyyy-mm-dd is the current date. If this folder already exists on the machine, then a number is appended to the end of the name to ensure a new folder is used.
- Folders that are envisaged as storage locations for administrator created files have their entire contents moved to the backup folder [Exponare Server Directory]\_ExponareBackup_yyyy-mm-dd during the upgrade process.

The moved folders are the root folder, Help, Printing, Images, Logs and Themes. A folder called Stylesheets is created holding all the stylesheets in the Scripts folder.

After the upgrade process is complete, user-created files that are still required can be manually moved back to their correct location.

It may be necessary to reset IIS after these files have been copied back into place.

---

The Exponare Server version 6.0 installation process will not upgrade versions of Exponare Server prior to version 4.5. Earlier versions must either be upgraded to Exponare version 4.5 or uninstalled.

If an earlier version of the Exponare Server has been run since the server was last rebooted it may be necessary to restart the aspnet process (called either aspnet_wp or w3wp on Windows 2003) before Exponare Enquiry version 5.5 clients can successfully connect.

---

Post Upgrade Tasks

Upgrades from previous version of Exponare would require

1. Add handlers manually from the path given below:
   
   "C:\Windows\Microsoft.NET\Framework\v4.0.30319..."

2. "axd" handler from path:
   
   path:"C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll"

3. "asmx" handler from path:
   
   "C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll"

4. "aspx" handler from path:
   
   "C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll"
5. On upgrading Exponare Server, go to the folder **Prerequisites > MI Fonts**. Run the executable "InstallMIFonts.exe". For improved performance, refer section- Switching to Integrated mode (IIS 7 & above).

6. Do IIS Reset.

7. Restart the system.

### Exponare Server in a Web Farm Environment

You must drop the existing ASPState database and create a new ASPState database using the `aspnet_regsql.exe` utility.

See [Web Farm Environments and Exponare Server - aspnet_regsql.exe](#)

You will need to update the newly installed `web.config` file with your SQL Server settings. You can cut and paste the settings from your backed up `web.config` file (see above).

### Sample Data

The Exponare Sample Data is intended for verification and demonstration purposes only. It is not intended to be upgraded. If a newer version of Exponare Sample Data is desired, uninstall the old version and install the new version.

### Troubleshooting

**Map view, zoom and center could not be reliably applied**

Map view, zoom and center could not be reliably applied because the View has no associated coordinate system or Projection system categories not seen in configuration manager.

**Symptom**

This issue occurs if the during the installation process "MapInfoCoordinateSystemSet.xml" has turned corrupt. This would be faced by users either during upgrade or incase of fresh install where an older configuration.xml is being imported.

**Resolution**

1. Copy MapInfoCoordinateSystemSet.xml this file from \Prerequisites\MapInfoCoordinateSystem\n
2. Paste it in ..\Common Files\MapInfo\MapXtreme\7.2.0

3. Import the `configuration.xml`.

4. Save and check configuration manager and views.
To perform an upgrade of an existing Exponare Enquiry installation start the Exponare Enquiry installer and follow the prompts provided in the installer.

Exponare Enquiry can also be upgraded using an Enterprise deployment model.

See Installing Exponare - Installation - Enterprise Deployment for further information.

The Exponare Enquiry version 5.5 installation process will not upgrade versions of Exponare Enquiry prior to version 4.5. Earlier versions must either be upgraded to Exponare version 4.5 or uninstalled.

If the Exponare Server has been upgraded from an earlier version it may be necessary to reboot the server before Exponare Enquiry version 5.5 clients can connect.

It is recommended that you create a standard Windows shortcut on your desktop which starts Exponare Enquiry and adds the command line argument /admin. For example,

```
"Program Files\Exponare\Enquiry\ExponareEnquiry.exe"\admin
```

See Client Administration Tasks - Starting Enquiry from the Command Line for further information.
Uninstalling Exponare

This chapter describes the procedures for uninstalling Exponare components.

In this chapter...

- Exponare Server
- Exponare Sample Data
- Exponare Enquiry
Exponare Server

To uninstall Exponare Server use the Add/Remove Programs component of the Windows Control Panel.

Notes:

• When uninstalling Exponare Server, any files that were not installed by Exponare will remain. To complete the uninstallation, you may wish to manually remove any remaining files.
• Exponare configuration files are not installed as part of the Exponare Server install. As a result these files are not removed when the Exponare Server is uninstalled.

CAUTION: Any files that were installed by Exponare Server and that you have changed will be deleted. To protect against data loss, you may wish to perform a backup of the Exponare Server directory prior to uninstalling the Server.

Exponare Sample Data

To uninstall Exponare Sample Data, use the standard windows Add/Remove programs application (available through the Windows control panel).

Exponare Enquiry

To uninstall Exponare Enquiry, use the standard windows Add/Remove programs application (available through the Windows control panel).
Server Administration Tasks

Installing, configuring, and administering Exponare involves working with Windows Server operating systems, Internet Information Services,.NET and ASP.NET. This chapter describe some common tasks that may need to be performed to get the most out of Exponare Server and discuss troubleshooting Exponare Server problems.

In this chapter...

- Altering 'Live' Workspace and TAB Files
- Configuring MapXtreme Pooling
- Publishing the Empty Configuration
- Restarting the ASP.NET Process
- Setting File Permissions for the Server
- Setting the Server Timeout Value
- Web Site Monitoring
- IIS settings to configure Rest Public
- Troubleshooting
Altering 'Live' Workspace and TAB Files

Changes made to Workspace definition files and/or their underlying TAB Files are not immediately applied throughout Exponare Enquiry or Exponare Public. For example, a change to a map Feature's style may immediately become visible in your map but not in your Legend associated with that Feature's map layer.

To update workspace and TAB files used by Exponare Enquiry and/or Exponare Public:
1. Alter Workspace and/or TAB Files.
2. Restart the ASP.NET process.
3. Open the Exponare Configuration Manager, make a simple change and save the configuration.

Configuring MapXtreme Pooling

Based upon internal testing using native TAB files, Pitney Bowes Software recommends that you configure the Maximum Pool Size so that there are 1 to 2 objects per CPU. It is recommended to start at one object per CPU and if the CPU usage on the server remains low during periods of high Exponare usage, the Maximum Pool Size should be increased. This should result in higher CPU usage on the server and better response times for users. Internal testing has shown that the number of processes in a web garden does not significantly affect the overall performance of Exponare. Larger pool sizes tend to result in better performance when slow external data sources are extensively used in Exponare.

To alter the Maximum Pool Size:
1. Open the Component Services management console.

![Component Services]

Figure 7-14: Component Services
2. Right click the MapInfo.Engine.Session+PooledSession object and select Properties.

3. The number of pooled objects per application can be set on the Activation tab of this dialog. The default Minimum Pool Size is 1, and the default Maximum Pool Size is 2.

Figure 7-15: Component Service Activation

---

### Publishing the Empty Configuration

The Exponare Server is installed with an minimal configuration (i.e empty of customised data) of:

- Two users: admin (password admin) and Public (no password)
- Default Menu (File>Exit and File/Login)
- Default User Interface
- Native Database Connection

Optionally, the Exponare Sample Data can be installed with a populated configuration. Either way the installed configuration can be modified and built on by Exponare administrators.

In the event of large system changes (eg an Exponare upgrade, hardware change, operating system upgrade, etc) it may become desirable to make a fresh start with the Exponare configuration. A copy of the empty Exponare configuration is provided with an Exponare Server installation.

**To publish the empty configuration using Configuration Manager:**

1. Open Exponare Configuration Manager on the Exponare Server machine.
2. From the Application Settings properties, take note of your Customer name.
3. Select Configuration>Import From File
4. Browse to \Exponare\Server\System\Recovery\ and select the Configuration.xml file. You will be asked if you wish to import the default password information.
5. In the Application Settings properties, enter your Customer name.
6. Save the configuration.

**To publish the empty configuration if Configuration Manager cannot be started:**

1. Run \ExponareServer\bin\PublishEmptyConfiguration.exe. This tool will overwrite the existing Configuration.xml and Information.xml files with the empty configuration.
2. The tool runs in a DOS Window:
Publishing the Empty Configuration

Figure 7-16: DOS Windows

```
AccessKeys.xml
You will be asked if you would like to overwrite AccessKeys.xml, the file that holds your activation keys. If you do, you may have to request new Activation Keys from Product Support. In most cases you will not need to overwrite AccessKeys.xml.
```

```
Restarting IIS
When finished, you will be informed that you need to restart IIS for these settings to take effect—as illustrated above, the tool will do this for you.
```

```
web.config
<appSettings>
  |   |
  |   <add key="ConfigurationManager.UseSqlServer" value="True" />
  |   <add key="ConfigurationManager.ConnectionString" value="Server=SqlServer;Database=Exponare;UserID=ExponareUser;Password=password" />
</appSettings>
If you have set up Exponare to run in a Web Farm environment, ie the appSettings node in web.config appears as above, then you will also need to delete all rows from the Configuration table in the Exponare database. Delete FROM Configuration is the recommended command for this.
```

4. In the Application Settings properties, enter your Customer name.
5. If you chose to overwrite AccessKeys.xml in step 2, or if your Customer name has changed, request/enter Activation Keys.
6. Set up the configuration.
7. Save the configuration.
Chapter 7: Server Administration Tasks

Restarting the ASP.NET Process

The ASP.NET process can be restarted at any time, however any open sessions to ASP.NET applications (including Exponare Server) will be lost.

1. Go to Start>Run.
2. Type taskmgr and press Enter.
3. Click the Processes tab.
4. Select the ASP.NET process. It is called w3wp.exe for IIS6.0 or 7.0 or 7.5.
   If these processes do not exist then either no action is required, or IIS or ASP.NET is not correctly configured.
5. Click the End Process button.

Setting File Permissions for the Server

The Exponare Server requires read access to all of the files in the Exponare virtual directory, and it requires write access to some of the files. The Exponare Server is an ASP.NET program that runs as a certain system user, and so that user must have the appropriate permissions granted to it.

The Exponare server requires write access to the following files:

- the entire Exponare\Config directory
- the entire Exponare\scripts\autogen directory

These permissions are automatically setup during installation. However, if you move the Exponare virtual directory, or perform a backup and restore, you may need to reinstate these permissions.

To Set Permissions For a File or Directory

1. Locate the file or directory in Windows Explorer.
2. Right-click, choose Properties, open the Security tab, and click Add.
3. Type in the ASP.NET user name or group name and click OK.
4. Select the ASP.NET account and grant Full control or Modify permissions.
Setting the Server Timeout Value

To alter the timeout of the server it is necessary to alter either the web.config file of the Exponare Server virtual directory, or the machine.config file of the machine so that the httpRuntime element is present, and that the executionTimeout is set to the appropriate value.

web.config

```xml
<!-- HTTPRUNTIME SETTINGS
Uncomment the next line in order to set the execution timeout for the Exponare Server. The execution timeout is in seconds, and the default value is 90.
-->
<httpRuntime executionTimeout="90" />
```

machine.config

```xml
<httpRuntime executionTimeout="90" maxRequestLength="4096"
useFullyQualifiedRedirectUrl="false" minFreeThreads="8"
minLocalRequestFreeThreads="4" appRequestQueueLimit="100"
enableVersionHeader="True"/>
```

The Exponare Enquiry client now sets the timeout value for individual calls to be 10 seconds longer than the execution timeout on the server.

There is an ASP Script timeout value that can be set in the property pages of the Internet Information Services console, however this is not the correct way to specify the execution timeout for ASP.NET web service applications.

Web Site Monitoring

Exponare Server is a standard IIS ASP.NET web server application. You can therefore use a range of freeware and commercial tools to monitor the Exponare web site. For example, Power Admin Server Monitor is a freeware tool available from http://www.poweradmin.com/ServerMonitor/free.asp.

This allows you to monitor a web site by searching for a specific piece of text. You can configure Power Admin Server Monitor to perform a set of actions based upon whether that text is present or not. The actions that can be performed include:

- stopping/starting/restarting a windows service
- sending an email
- rebooting the server.
IIS settings to configure Rest Public

To use Rest public, where in the data layers can be seen with base layer of choice, it is important to ensure that the supportive handler called ".rest" handler is available in the IIS settings. While fresh install users need not configure any settings, upgrade users would need to perform specific settings to be able to use Rest Public. Depending on your IIS version please refer the steps illustrated below.

Learn how to add ".rest" handler to be able to access Rest public for

- IIS - 6
- IIS - 7 & 7.5

IIS - 6

1. Install Exponare Server, Sample Data, Enquiry.
2. Add a handler .rest (follow the Steps given below).
   a. Run `inetmgr` command on run.
   b. Right click on Exponare.

   Figure 7-17: Internal Information Services

   ![Internet Information Services](image)

   c. Click on Properties.
d. Click on Configuration.
Chapter 7: Server Administration Tasks

Figure 7-19: Application Configuration

![Application Configuration](image)

- Click Add for adding .rest and .data handler's

Figure 7-20: Add/Edit Application Extension Mapping

![Add/Edit Application Extension Mapping](image)

Executable text box should be "Drive:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll" for both handler's.

Extension should be .rest

And the rest of settings should be the same as mentioned the above screen shot.
IIS settings to configure Rest Public

- Do IIS reset.
- Check Exponare Enquiry is running.
- Restpublicapplication.aspx page should now be able to show your data layers on top of Bing layers.

IIS 7 & 7.5

1. Install Exponare Server, Sample Data, Enquiry.
2. Add a handler .rest (follow the Steps given below).
   a. Run inetmgr command on run.
   b. Right click on Exponare

Figure 7-21: Intenet Information Service

Figure 7-22: Exponare Home

   c. Click on handler Mappings.
   d. Click on "Add script map" (in the right panel).
   e. Add ".rest" for Rest handler.
   f. Point to this file - Drive:\Windows\Microsoft.NET\Framework\v4.0.30319 \aspnet_isapi.dll.
   g. Click "Request permissions"
3. Add verbs - GET, HEAD, POST, SCRIPT.
4. Press OK.

Figure 7-24: Add Verbs

5. Do IIS reset.
6. Check Exponare Enquiry is running.
7. Restpublicapplication.aspx page should now be able to show your data layers.
Troubleshooting

This section covers the following problems:

- Data on network drives is inaccessible
- Enquiry cannot connect to server— Error 1661
- Exponare hardware licensing problems
- Exponare Server process re-starts and loses all session information
- General server failure (ASP.NET failure)
- Intermittent errors on the client when using a pooled MapXtreme environment
- Oracle connection failure
- Public cannot load initial startup page
- Public Menu/toolbar/map is non-operational
- SQL Support Tables from external databases do not work
- Using a web browser to access Exponare.asmx fails
- Work Context cannot load due to permissions
- Unable to display Map.Projection system not found
- Layer Updates Error! while creating a new work context

Data on network drives is inaccessible

Symptoms

Enquiry reports an error with Event ID 1475 if the Data directories configuration setting is a network share. For example, if the setting is ```\\server\data\``` a log message similar to the following may be produced:

```
Unable to locate directory `\\server\data\`
Message - Unable to find workspace file Cadastre.mws in any of the specified data directories.
```

Resolution

The ASP.NET process that runs the Exponare server must be configured to run as a user that has permissions to access the network folder.

Also, the network folder must be fully specified as a UNC. For example, use ```\\server\data\``` rather than a mapped drive such as Z:\data.

Follow the processes described in Configuring ASP.NET Impersonation to configure the ASP.NET user impersonation.
Chapter 7: Server Administration Tasks

**Enquiry cannot connect to server—Error 1661**

**Symptoms**
When Enquiry starts up, it displays a message "Cannot connect to server" rather than a login window or the Enquiry workspace.

**Resolution**
Restart the ASPNET process on the Server machine and try again.

Also, check the server URL that is displayed during the connection attempt. This can be altered by reinstalling Enquiry or by editing the Enquiry configuration file.

For ASP.NET v4.0.30319, in IIS 7.0 by default “ISAPI and CGI Restrictions” setting is not set to be allowed. Set this to allow troubleshooting this error. For IIS 6.0 this setting is set to allow through “WebService Extensions”.

Check the Event Log for information.

**Exponare hardware licensing problems**
If Exponare Enquiry, Exponare Public and/or the Workspace Manager cannot be started it may be the result of Exponare Server hardware licensing issues. If you have already obtained a hardware license check the Event Log on your Exponare Server for more information. Any errors that indicate that a COM+ error has occurred typically indicate licensing problems. If this is the case please contact Technical Support (see page 7).

If you have not yet obtained an Exponare hardware license, see the Register section on the CD for details.

**Exponare Server process re-starts and loses all session information**

**Symptoms**
The Enquiry client no longer allows any state changes to be made. The map is not re-rendered after a Pan or zoom, selections are not made etc. An error may or may not be shown to the user at this point.

**Resolution**
The ASP.NET worker process on the server has re-started. This causes all session, cache and application information to be lost. The only solution for the User at this point is to log out and log back in again.

There are many reasons why the ASP.NET worker process can re-start itself, all legitimate. The primary one you may be experiencing in a live deployment is due to changing files on the server. The ASP.NET worker process monitors the file system under the Web Application root for changes to certain files, and if too many changes are made this can trigger a re-start of the process.

Importantly, if your data is stored under the Web Application directory and you make changes to this...
Troubleshooting

data while the system is live, the worker process may re-start. We recommend storing your data on
a different drive, and if possible making changes to the data when the Exponare Server is not being
used.

General server failure (ASP.NET failure)

Symptoms
The Exponare Server fails to run successfully. For example, Exponare Enquiry can not connect
(may display Message ID: 1603 and/or HTTP status 404 in the error message), Exponare
Public displays error messages, or Exponare Public displays the source code for the Exponare
Public page.

Resolution
Check your system for its ability to run ASP.NET v2.0 applications, then restart the server. The
complete process is:

1. Ensure .NET v2.0 Framework is installed via Add/Remove Programs.
   Alternatively on some operating systems you may need to check Add/Remove Programs -
   Windows Components.
2. Ensure IIS v6.0 or v7.0 or v7.5 is installed via Add/Remove Programs - Windows Components.
3. Ensure FrontPage server extensions are installed via Add/Remove Programs - Windows
   Components.
4. Register ASP.NET by running the following at your command prompt (use C:\WinNT if
   appropriate):
   C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe /u
   C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe /i
   Once ASP.NET has been re-installed, you will need to re-configure the custom HTTP extensions
   used. See Public Menu/toolbar/map is non-operational for further information.
5. If you are using IIS v6.0 or v7.0, ensure that ASP.NET v2.0 is enabled in the IIS manager by
   checking the item Internet Information Service>local computer>Web Server
   Extensions>ASP.NET v2.0.50727 is set to Allowed.
6. Test the Exponare.asmx page by loading the following in your browser (substituting the correct
   virtual directory name):
   http://localhost/Exponare/Exponare.asmx
   The Exponare.asmx page displays a formatted list of function names if your ASP.NET system is
   Identity Impersonation: A common setting is IUSR_MACHINENAME.
Intermittent errors on the client when using a pooled MapXtreme environment

Symptoms

Users experience occasional and intermittent failures when using either Enquiry/Public or Rest Public. The server error log contains errors with the following message:

In case of any of the below errors:

- COM+ activation failed because the activation could not be completed in the specified amount of time.
- Timeout while waiting for a pooled Session object to become available.

Following error can be seen in exponare server logs.
Troubleshooting

Resolution

**Step 1 Configuring Microsoft COM+ Object Pooling**

The MapXtreme Session object is registered with the COM+ services on your system. This system handles configuration and activation of any registered pooled objects. The runtime installer has the logic to register and create default settings for the MapInfo Session object. By default the MapXtreme Session object is configured with two pooled objects and a 60 second time-out.

**Configuring the Pool Size**

The MapXtreme Session is configurable using the system configuration methods for the appropriate section. These settings are available in both the system dialogs in the Control Panel and the .NET configuration files of your application. Web applications must manage these settings when using pooled MapXtreme Sessions.

One important setting is the number of pooled objects created by the COM+ system to service your running application. This setting is accessed using the Control Panel > Administrative Tools > Component Services. Browse through the Component Services > Computers > My Computer > COM+ Applications > MapInfo.CoreEngine > Components. Here you will find the MapInfo.Engine.Session+PooledSession object. Right click the icon and select Properties. The
Chapter 7: Server Administration Tasks

Property dialog allows you to set various properties including the number of pooled objects per application and the activation time-out for session creation. Setting the number of pooled objects correctly directly impacts your applications performance. To set the number of pooled objects correctly you need to understand your application and how it accesses data.

![Property dialog screenshot]

**Step 2 (IIS setting):**

1. Set session state is state server mode using following line web.config file
   
   ```xml
   <sessionState cookieless="UseCookies" mode="StateServer"
   sqlConnectionString="" stateConnectionString="tcpip=127.0.0.1:42424" timeout="20" />
   ```

2. Increase the number of worker process for load balancing (Create Web Garden) You can change the Number of Worker processes in both IIS 6 and IIS 7. For IIS 6, Right click on Application Pool > Properties > Goto Performance Tab.
Troubleshooting

In the "Performance Tab" section, you would have one option called "Web Garden" where worker process sets to “1”, you can set the number of worker processes that you required.

For IIS 7, Right click on **Application Pool > Go To Advance Settings > In Process Model section**, you will have "Maximum Worker Processes". You can change it more than 1 to make it as a web garden.

ℹ️ The configuration of IIS will vary for each customer based on Customer requirements and environmental factors such as the architecture of the solution. The scenario described above is not intended as a formula for a successful deployment rather to highlight some of the considerations that should be carefully planned and implemented during the deployment. The Pitney Bowes Software Professional Services team are available to provide guidance or undertake the implementation if required.
Oracle connection failure

Symptoms
The Oracle client software is installed on the Exponare Server, however, when you execute any function that utilises Oracle the function fails and you are shown a message that contains text similar to "Unable to load dll" or "System.Data.OracleClient requires Oracle client software v8.1.7 or v9i".

Resolution
The permissions on the Oracle home directory need to be set to allow the ASP.NET user (ASPNET or Network Service accounts) read and execute permissions on the Oracle software. See Setting File Permissions for the Server for details of this procedure.

Public cannot load initial startup page

Symptoms
The startup page of Public cannot be loaded. Instead an error page is displayed containing a 'Exception from HRESULT: 0x80131524' error.

Resolution
Restart the ASPNET process, close all browser windows and restart Public. Check the Event log for more information.

Public Menu/toolbar/map is non-operational

Symptoms
On certain operating systems, particularly from the Windows 2003 Server family, the installation process fails to register the required HTTP application handlers used by Exponare Public. As a result, the menu, toolbar and map may not function correctly, or at all.

Resolution for IIS 6.0
1. Open the IIS manager.
2. Navigate to the Exponare virtual directory and open the Properties window.
3. Click the Configuration button.
4. Click Add.
5. Enter the executable:
   C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll
   Note: The correct directory might differ, such as C:\WinNT\
6. Enter the extension: .exp.
7. Ensure the option verify that file exists is not checked.
8. Click OK.
Troubleshooting

Resolution 2
If the name of your server contains invalid characters (other than alphanumeric characters and dashes) then you should either rename your server so that the name only contains valid characters, access the server by the IP Address, or access the server by an alternate HTTP address that does not contain invalid characters.

SQL Support Tables from external databases do not work

Symptoms
An external database cannot be accessed due to missing drivers.

Resolution
External databases must be configured to work with .NET otherwise they cannot be used as the source for SQL Support Tables. A common requirement is to install drivers that enable your databases to inter-operate with.NET programs such as Exponare Server. For example, Oracle 9i requires an Oracle.NET driver to be installed. Please contact your database vendor or see their website for information on using your database with .NET.

Using a web browser to access Exponare.asmx fails

Symptoms
Browsing to the page http://localhost/Exponare/Exponare.asmx generates an error message.

- This page should show a list of Exponare Web Service functions.

Resolution
Most commonly, this indicates that ASP.NET isn't properly installed or configured. See ASP.NET registration for the process to install and configure ASP.NET.
Work Context cannot load due to permissions

Symptoms
Enquiry reports an error with Event ID 1475 of the form Errors during load, eg:
Access to the path C:\Program Files\MapInfo\Exponare\Server\sampleData\Cadastre.mws is denied.

Resolution
The ASP.NET user requires read access to all of the data files. For example, if you use local data, or move the sample data, you may have to configure the appropriate permissions.

The simplest way to achieve this is to grant the ASPNET user read access to the sample data directory, and then ensure that each of the sample data files and sub-directories have the security property "Can inherit permissions from parent" enabled.

The security properties can be access by right-clicking on your files in Windows Explorer, choosing Properties, then clicking on the Security tab.

See Setting File Permissions for the Server for information on checking and assigning file permissions.

Unable to display Map.Projection system not found

Symptoms
This issue can arise under circumstances when EPSG code is missing against the current workcontext Projection String under Proj4jsCodes.js which present under ExponareServer\scripts\Proj4\js directory.

User gets following error message in this case:
"Unable to display Map.Projection system not found. Please add the Proj4js code file in Proj4jsCodes.js"

Resolution
User needs to add the following items in the Proj4jsCodes.js present in the ExponareServer\scripts\Proj4\js directory using following steps:

1. Add the EPSG code at the end of the "availableProjections" array list.
Troubleshooting

For example, if the Projection string is "Sample Projection String" and EPSG code for the Projection string is "EPSG:xxxx". Add the EPSG Code at the end, refer snapshot below.

```
```

1. EPSG code and the Projection string - Secondly the user need to add the Projection string along with the EPSG code in the "availableProjectionString" at the end.

```
```

The user need to update the availableProjectionString as

```
```

2. Proj4js code for the EPSG Code. User needs to add the Proj4js code for the EPSG code at the end of the file. Most of the Proj4js file codes can be found at http://spatialreference.org/ref/

Available Projections

Now add the Proj4js Code at the end of the file.

```
Proj4js.defs['EPSG:10248'] = "+proj=geoz +geoid=NC1600 +datum=NAD27 +no_defs +units=m "
Proj4js.defs['EPSG:10249'] = "+proj=geoz +geoid=NC1600 +datum=NAD27 +no_defs +units=m "
Proj4js.defs['EPSG:20248'] = "+proj=geoz +geoid=NC1600 +datum=NAD27 +no_defs +units=m "
Proj4js.defs['EPSG:20249'] = "+proj=geoz +geoid=NC1600 +datum=NAD27 +no_defs +units=m "
Proj4js.defs['EPSG:3857'] = "+proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs"
Proj4js.defs['EPSG:3857'] = "+proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs"
Proj4js.defs['EPSG:4326'] = "+proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs"
```

Layer Updates Error! while creating a new work context

Symptoms

A layer update error message appears when you copy a work context and make changes in it. Make changes (add some new layers and groups) to existing work context (that has groups) and save it.
Resolution

Fix the work context by updating the Group in all the Layer Settings to the group description.
Client Administration Tasks

In this chapter we describe how to start Exponare Enquiry from the command line and enter Activation Keys. Troubleshooting Exponare Client problems is also discussed.

In this chapter...

- Starting Enquiry from the Command Line
- Troubleshooting
Starting Enquiry from the Command Line

Enquiry can be started from the command line. Using the command line gives full access to the startup options for Exponare Enquiry, and can be used by other programs that need to invoke Exponare Enquiry. To run Exponare Enquiry from the command line, open a command window and navigate to the Exponare Enquiry directory. Typically this is `C:\Program Files\MapInfo\Exponare\Enquiry\ExponareEnquiry`.

The command line format to run Exponare Enquiry is:

```
ExponareEnquiry.exe [options]
```

The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>/username: [username]</td>
<td>Start Enquiry with the named user, password and Work Context.</td>
</tr>
<tr>
<td>/password: [password]</td>
<td></td>
</tr>
<tr>
<td>/context: [work context name]</td>
<td></td>
</tr>
<tr>
<td>/reuse</td>
<td>Instructs Enquiry to reuse an already-open window if possible, rather than creating a new window.</td>
</tr>
<tr>
<td>/linkfile: [link file name]</td>
<td>Perform a link-in from an external application. This is described in External Application Links - Application Link-Outs.</td>
</tr>
<tr>
<td>/admin</td>
<td>Start the Exponare Configuration Manager instead of Exponare Enquiry. If any of the parameters context, reuse, or linkfile are used in conjunction with the admin parameter they will be ignored</td>
</tr>
</tbody>
</table>

If any of the arguments to the command line parameters contain a whitespace character, then the command line parameter and the argument need to be surrounded by quotes, as is standard functionality in the prompt. For example, to start up Exponare Enquiry with a Work Context called Cadastre (Melways), you would run the command:

```
C:\Program Files\Exponare\Enquiry\ExponareEnquiry.exe "\context:Cadastre (Melways)"
```

Troubleshooting

This section covers the following problems:

- Enquiry cannot connect to server
- Login with Enquiry always fails
• Enquiry becomes inactive and cannot connect to server
• You get an error when saving the configuration

Enquiry cannot connect to server

**Symptoms**
When Enquiry starts up but displays an error message prior to showing the login dialog (or the default workspace if an automatic or command-line login are used).

**Resolution**
Check the web site hosting Exponare is running on the Server machine. Restart the ASP.NET process on the Server machine and try again.

Also, check the server URL that is displayed during the connection attempt. This can be altered by reinstalling Enquiry or by editing the Enquiry configuration file.

Check the Enquiry and Server Event Logs for information.

Login with Enquiry always fails

**Symptoms**
The login window displays in Enquiry, but the login attempts always fail.

**Resolution**
Check the username and password (both are case-sensitive).

Restart the ASP.NET process.

Check the Enquiry and Server Event Logs.

Ensure the configuration file has no errors (eg the original sample data, or a backup of a working file).

Ensure the sample data is installed correctly. Check that the ASPNET user has write permissions to the Server's Config directory.

Enquiry becomes inactive and cannot connect to server

**Symptoms**
Enquiry has been working correctly, but then every attempt to access a function causes an error message.

**Resolution**
Close and restart Enquiry. If the problem persists, Restart the ASP.NET process on the server.
Troubleshooting

You get an error when saving the configuration

Symptoms
Clicking the save configuration button generates the error below.

An error occurred while your configuration was being saved. The live configuration was not updated.
It is possible that the configuration is read-only or that the ASPNET user account on the Exponare Server does not have write access to the configuration.

Resolution
The most common problem is that the ASP.NET process does not have the required file permissions to alter the files in the Config sub-directory. Refer to Setting File Permissions for Your Data for details on setting permissions correctly.
Web Farm Environments and Exponare Server

Exponare Server is capable of running in a web farm environment. When configured for a web farm environment Exponare Server uses a SQL Server database to store information that needs to be shared among servers. By default Exponare Server is not configured to run in a web farm environment.

In this chapter...
- Web Farm Environment Requirements
- Web Farm Setup
- Reverting Web Farm Environment to Single Web Server
Web Farm Environment Requirements

Exponare can be deployed onto more than one server in order to support greater numbers of users than can typically be supported by a single server. Network Load Balancing (NLB) is a method of distributing the total load for an application across a number of servers, this collection of servers is called a Web Farm. Exponare is designed to run within a Web Farm of servers setup using the Network Load Balancing Service provided with Windows 2003 Server.

In order to run Exponare Server in a web farm environment you will need the following:

• A correctly configured web farm with Exponare Server and a MapXtreme 2005 license file installed on each web server. See the Register section on the installation CD for details on requesting MapXtreme 2005 license files.
• A SQL Server Instance that is accessible from the web farm.

Hardware licensing may be affected by NLB. Ensure that you use the registration utility AFTER configuring NLB. If you change your NLB configuration, you may need to rerun the registration utility and apply for new licenses.

Web Farm Setup

Ensure that Exponare is configured and working in a non web farm environment with the default web.config settings before attempting to set up a web farm environment.

You will need to action the following on the chosen SQL Server Instance:

• Run the InstallExponare.SQL script
• Run the aspnet_regsql.exe utility
• Update web.config

InstallExponare.SQL

This script can be found in the System/ExponareDatabase subdirectory of each Exponare Server installation. This script creates a database called Exponare that contains a small number of tables that are required by Exponare in order to synchronize data between servers.

Pre-Installation task

It is strongly recommended that you change the password that is used by the ExponareUser to connect to the database by altering the following line:

exec sp_addlogin N'ExponareUser', N'password', N'Exponare'

Replace 'password' with your chosen password. The single quotes must remain around the password.

eg to change the password to p@55w0rd, the line would read:

exec sp_addlogin N'ExponareUser', N'p@55w0rd', N'Exponare'
Chapter 9: Web Farm Environments and Exponare Server

This password is needed when updating web.config.

Running the script
To run the script, you need to:

- Open SQL Query Analyzer.
- Connect to the chosen SQL Server instance using an administrator logon.
- Open the InstallExponare.SQL script.
- Execute the script.

aspnet_regsql.exe
The aspnet_regsql.exe utility is found in the directory %windir%\Microsoft.NET\Framework\v2.0.50727. The utility is used to install and uninstall ASP.NET features on a SQL server.

The aspnet_regsql.exe utility must come from the v2.0.50727 directory, as different versions of .NET may use slightly different versions of this utility. Exponare Server is designed for .NET v2.0.50727 only.

Running the utility
The example command line shown is based upon the following scenario:

- You are logged on to the machine which is running SQL server.
- Your username is sa
- Your password is blank

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319>aspnet_regsql.exe -ssadd -S localhost -U sa -P ""

For help with additional options, enter aspnet_regsql.exe -?

After running the aspnet_regsql.exe utility, you must grant the ExponareUser execute access to all objects in the ASPState database.

If you have used the -sstype p option to specify persisted session state support, you must also add the ExponareUser to the db_datareader and db_datawriter roles in the ASPState database. The ExponareUser must also be given read/write access to the tempdb database.

Updating web.config
Assuming a default installation, the web.config file can be found in C:\Program Files\MapInfo\Exponare\Server
Web Farm Setup

To update the web.config file for an ExponareServer instance you need to alter two sections. The first section is the appSettings section and typically looks like this when initially installed:

```xml
<appSettings>
  <!-- Use this setting to turn Session pooling on/off (True/false) -->
  <add key="MapInfo.Engine.Session.Pooled" value="True" />
  <!-- Use this setting to save Session state automatically (HttpSessionState) or manually (Manual) -->
  <!-- Use this setting to preload a workspace on Session creation -->
  <!-- <add key="MapInfo.Engine.Session.Workspace" value="c:\my workspace.mws" /> -->
  <!-- Use this setting to force the ASP.NET process to shutdown when the application's AppDomain is unloaded -->
  <add key="MapInfo.Engine.Session.ExitProcess" value="false" />
  <add key="MapInfo.Engine.Session.UseCallContext" value="true" />
  <add key="ConfigurationManager.UseSqlServer" value="true" />
  <add key="ConfigurationManager.ConnectionString" value="Server=SqlServer;Database=Exponare;User ID=ExponareUser;Password=password" />
</appSettings>
```

The items we are interested in are marked in bold. You must ensure that each of these two keys are not commented out (comments are started with <!-- and end with -->). Check the following value attribute settings:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value attribute settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConfigurationManager.UseSqlServer</td>
<td>True</td>
</tr>
<tr>
<td>ConfigurationManager.ConnectionString</td>
<td>The correct connection string for your chosen instance of SQL Server. Typically you will have to replace SqlServer with the name (or IP Address) of your SQL Server Instance, and replace password with your chosen password. Refer to Microsoft documentation regarding connection strings.</td>
</tr>
</tbody>
</table>

You also need to change the section that looks like:

```xml
<sessionState
  mode="InProc"
  stateConnectionString='tcpip=127.0.0.1:42424'
  connectionString="Server=SqlServer;User Id=ExponareUser;Password=password"
  cookieless="false"
  timeout="20" />
```
Once again, the items we are interested in are marked in bold. You will need to check/update the following attribute settings:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>mode</td>
<td>SQLServer</td>
</tr>
<tr>
<td>sqlConnectionString</td>
<td>The correct connection string for your chosen instance of SQL Server. Typically you will have to replace SqlServer with the name (or IP Address) of your SQL Server Instance, and replace password with your chosen password.</td>
</tr>
<tr>
<td></td>
<td>Refer to Microsoft documentation regarding connection strings.</td>
</tr>
</tbody>
</table>

Ensure that Exponare is working correctly before adding the next server to the cluster, or if it is an existing cluster, set up each server one at a time, and individually test each one and ensure that the configuration on each server matches that setup on the initial server.

Reverting Web Farm Environment to Single Web Server

To revert to a single web server:

1. Note down your Activation Keys (If you do not, you will have to request new ones from Product Support).
2. Start the Configuration Manager.
3. Select Configuration Menu>Export To File to export the configuration to a local file.
4. Close Configuration Manager.
5. Edit the web.config file
Reverting Web Farm Environment to Single Web Server

```xml
<appSettings>
  <!--Use this setting to turn Session pooling on/off (True/false)-->  
  <add key="MapInfo.Engine.Session.Pooled" value="True" /> 
  <!--Use this setting to save Session state automatically (HttpSessionState) or manually (Manual)-->
  <!--Use this setting to preload a workspace on Session creation-->
  <!--<add key="MapInfo.Engine.Session.Workspace" value="c:\my workspace.mws" />-->
  <!--Use this setting to force the ASP.NET process to shutdown when the application's AppDomain is unloaded-->
  <add key="MapInfo.Engine.Session.ExitProcess" value="false" />
  <add key="MapInfo.Engine.Session.UseCallContext" value="True" />
  <add key="ConfigurationManager.UseSqlServer" value="True" />
  
  <add key="ConfigurationManager.ConnectionString" value="Server=SqlServer;Database=Exponare;
  User ID=ExponareUser;Password=password" />
</appSettings>
```

The items we are interested in are marked in bold.

<table>
<thead>
<tr>
<th>Key</th>
<th>Value attribute settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ConfigurationManager.UseSqlServer</code></td>
<td><code>false</code></td>
</tr>
<tr>
<td><code>ConfigurationManager.ConnectionString</code></td>
<td>You may wish to delete this for security reasons.</td>
</tr>
</tbody>
</table>

You also need to change the section that looks like:

```xml
<sessionState
    mode="InProc"
    stateConnectionString="tcpip=127.0.0.1:42424"
    sqlConnectionString="Server=SqlServer;
    User ID=ExponareUser;Password=password"
    cookieless="false"
    timeout="20"
/>```

Once again, the items we are interested in are marked in bold. You will need to update the following attribute settings:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>mode</code></td>
<td>InProc</td>
</tr>
<tr>
<td><code>sqlConnectionString</code></td>
<td>You may wish to delete this for security reasons.</td>
</tr>
</tbody>
</table>

1. Restart IIS.
2. Start Configuration Manager.

3. Select Configuration Menu > Import From File to import the configuration file exported in step 2.

4. Enter the Activation Keys that were noted in step 1.

5. Save the configuration.
Reverting Web Farm Environment to Single Web Server
Part 3: Configuration Manager Essentials

The look, feel and content of both Exponare Enquiry and Exponare Public is configured by an Exponare administrator. Configuration settings are typically stored in a configuration file on the machine hosting Exponare Server. An installation of Exponare Enquiry includes an application called the Exponare Configuration Manager that enables remote changes to be made to the Exponare configuration.

The chapters in this section are designed to get you up and running with Exponare. See Part 4: Additional Configuration Manager Features for optional features that can be configured.

Topics

- Overview
- Application Settings
- Work Contexts
- Work Context Groups
- Menus and Toolbars
- User Interfaces
- Users
Overview

This chapter explains how to open and work with the Exponare Configuration Manager window.

In this chapter...

• Starting the Exponare Configuration Manager
• Viewing Configuration Changes
• Configuration Files
• Menu Bar
• Toolbar
• Tree View
• Property Grid
• Help Panel
Starting the Exponare Configuration Manager

The Exponare Configuration Manager can be started using a menu option in Exponare Enquiry that is added to the menu of any Exponare Administrator. It can also be accessed by starting Exponare Enquiry using a command line argument. See Starting Enquiry from the Command Line for details.

Only one Exponare Configuration Manager can be used on a computer at a time. Attempts to start a second Exponare Configuration Manager will cause the original window to come to the front of all other windows.

The Exponare Configuration Manager must be logged into before it can be used. Only Exponare administrator accounts can be used to log into the Exponare Configuration Manager.

If Exponare has not been activated, the Exponare Configuration Manager will be automatically started when Exponare Enquiry is started by an administrator. See Activation Keys for how to activate Exponare.

The Exponare Configuration Manager consists of a menu bar, toolbar, tree of configuration items, grid of property settings and a context sensitive help message pane.

Figure 10-1: Exponare Configuration Manager

The tree, grid and help panel can be resized by clicking on a border and dragging the border to the required position.
Viewing Configuration Changes

Exponare configuration changes can be viewed by starting a new Exponare Enquiry or Exponare Public session and logging in using an account that has access to the changed item. Alternatively an existing Exponare Enquiry session and logged in account can be used to view changes using Enquiry's File > Reset Session command.

Configuration Files

Configuration information is held in two files, by default in the 
C:\Program Files\MapInfo\Exponare\Server\Config directory:

- Configuration.xml  All configuration settings with the exception of passwords.
- Information.xml    Passwords - these are encrypted.

When changes are made in the Exponare Configuration Manager and subsequently saved, Exponare will backup the configuration settings. If you are working on a single server installation, the settings are saved to Exponare\Server\Config\backup; for a web farm installation the settings are saved in SQL server. See Save and Activate Settings.

Configuration settings can also be exported to the local machine or network drive. See Configuration Menu > Export To File.

You can import these saved configuration settings, with or without password information. With the exception of user information all existing settings are overwritten. User settings are merged with the current settings, as illustrated below.

1. An administrator creates and saves four users:

<table>
<thead>
<tr>
<th>User</th>
<th>Password</th>
<th>Default Work Context</th>
<th>User Interface</th>
<th>Work context group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anna</td>
<td>anna</td>
<td>Garbage</td>
<td>Full Interface</td>
<td>All</td>
</tr>
<tr>
<td>Helena</td>
<td>helena</td>
<td>Animal Control</td>
<td>Minimal Interface</td>
<td>All</td>
</tr>
<tr>
<td>Luke</td>
<td>luke</td>
<td>Vegetation</td>
<td>Full Interface</td>
<td>Simple</td>
</tr>
<tr>
<td>Sanmay</td>
<td>sanmay</td>
<td>Cadastre (Melways)</td>
<td>Standard Interface</td>
<td>Cadastre</td>
</tr>
</tbody>
</table>

2. The configuration is exported.

3. In Exponare Enquiry, Anna changes her password to cheese.
4. An administrator makes some more changes:

<table>
<thead>
<tr>
<th>User</th>
<th>Password</th>
<th>Default Work Context</th>
<th>User Interface</th>
<th>Work context group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anna</td>
<td>cheese</td>
<td>Aerial Photography</td>
<td>Full Interface</td>
<td>All</td>
</tr>
<tr>
<td>Bob</td>
<td>bob</td>
<td>Trees</td>
<td>Minimal Interface</td>
<td>Simple</td>
</tr>
<tr>
<td>Helena</td>
<td>helen</td>
<td>Animal Control</td>
<td>Minimal Interface</td>
<td>All</td>
</tr>
<tr>
<td>Luke</td>
<td>luke</td>
<td>Vegetation</td>
<td>Full Interface</td>
<td>Simple</td>
</tr>
<tr>
<td>Sanmay</td>
<td>sanmay</td>
<td>Street Furniture</td>
<td>Full Interface</td>
<td>All</td>
</tr>
</tbody>
</table>

Bob is a new user.
The Vegetation Work Context is renamed as Trees.
Helen was initially entered as Helena; if a user’s name is changed, their password becomes invalid and must be reset.
The user Luke is deleted as he has left the organization.
The Standard User Interface and the Cadastre Work Context Group are deleted as they are no longer used.
A new Work Context, Street Furniture is created. Sanmay is promoted and now has administrator privileges.

5. The file exported in step 2 is imported, without password information. The configuration tree is updated to reflect the imported configuration (as described in step 1).

6. The configuration is saved. The tree is updated to reflect the merged configurations:
Chapter 10: Overview

<table>
<thead>
<tr>
<th>User</th>
<th>Password</th>
<th>Default Work Context</th>
<th>User Interface</th>
<th>Work Context Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anna</td>
<td>cheese</td>
<td>Aerial Photography</td>
<td>Full Interface</td>
<td>All</td>
</tr>
<tr>
<td>Bob</td>
<td>bob</td>
<td>&lt;none&gt;</td>
<td>Minimal Interface</td>
<td>Simple</td>
</tr>
<tr>
<td>Helen</td>
<td>helen</td>
<td>Animal Control</td>
<td>Minimal Interface</td>
<td>All</td>
</tr>
<tr>
<td>Helena</td>
<td>helena</td>
<td>Animal Control</td>
<td>Minimal Interface</td>
<td>All</td>
</tr>
<tr>
<td>Luke</td>
<td>luke</td>
<td>Vegetation</td>
<td>Full Interface</td>
<td>Simple</td>
</tr>
<tr>
<td>Sanmay</td>
<td>sanmay</td>
<td>Cadastre (Melways)</td>
<td>Full Interface</td>
<td>All</td>
</tr>
</tbody>
</table>

- Anna’s password is still cheese because password information was not imported.
- Bob has no Default Work Context because Trees does not exist in the imported configuration.
- Helen and Luke existed in the old configuration so appear under the Users node.
- The Vegetation and Garbage Work Contexts are restored under the Work Contexts node; the Standard User Interface under the User Interfaces node and the Cadastre Work Context Group under the Work Context Groups node.
- The Street Furniture Work Context does not exist in the imported configuration; the default Work Context for Sanmay in the imported configuration is therefore used.
- With the exception of Default Work Context, User Interface and Work Context Group, all other user settings are unaffected, so Sanmay retains his administrator privileges.

Concurrent Exponare Administration

Exponare can be simultaneously administered by several administrators, all saving their various changes, at a time. Unfortunately this causes some complexity. For example, what happens if another Exponare administrator deletes the details for a user that I am updating?

In general, Exponare will try to save the configuration changes. If there are any conflicts detected, the Options window will be displayed containing the items that were problematic. Using this dialog you can choose to either merge, overwrite, or cancel. Selecting merge will save all changes that can be applied, reporting any changes that could not be applied. Selecting overwrite will forcibly save your changes, overwriting changes by other administrators. Selecting cancel will cancel the save and give you the chance to either fix the problems, or request the latest configuration from the server and start again.
Configuration Files

The complete list of special situations that can occur when saving the Exponare configuration and the behaviour in each situation are:

- If administrators make changes to separate parts of the configuration then the changes will be merged automatically by Exponare. This does not cause the display of the Options window.
- If two or more administrators make changes to the same item then the last administrator to save the change will overwrite the changes made by other administrators. This does not cause the display of the Options window. An exception to this is if the first administrator renames the item. This case is described below.
- If two or more administrators make changes to different properties of the same item then the last administrator to save will overwrite the changes made by other administrators. For instance, Administrator 1 alters the Public theme of a user interface and saves, Administrator 2 alters the Enquiry theme of the same user interface and saves, the user interface will have the settings from Administrator 2, which include the original Public theme before Administrator 1 altered it. This does not cause the display of the options window. An exception to this is if the first administrator renames the item. This case is described below.
- If an administrator updates a value that is concurrently renamed by another administrator and the rename is performed first then the row will be renamed and the administrator who performed the update will receive an appropriate message in the Options window.
- If an administrator updates a value, that is concurrently deleted by another administrator and the update is saved first then the row will be deleted. This does not cause the display of the Options window.
- If an administrator updates a value, that is concurrently deleted by another administrator and the delete is saved first then the row will be deleted and the administrator who performed the update will receive an appropriate message in the Options window.
- If an administrator deletes a value that is concurrently deleted by another administrator then the row will be deleted regardless of who saves first. This does not cause the display of the Options window.
- If an administrator adds a new item, and another administrator concurrently adds a new item that is the same, the second administrator will receive an appropriate message in the Options window.
- If an administrator imports a new configuration and saves, the saved configuration will overwrite any changes that were concurrently made by other administrators.

When changes are saved using the Exponare Configuration Manager a copy of the old configuration is automatically stored on the Exponare Server and the configuration on the client will be automatically refreshed.

The number of old Exponare Configuration.xml files grows continuously. From time to time it is recommend that you to delete old configuration files. This will free space in your SQL Server database or on your server's file system depending on how you chose to store your configuration. Select Configuration Menu > Delete History to select and delete configuration files.
Menu Bar

File Menu

<table>
<thead>
<tr>
<th>Change Passwords</th>
<th>Opens the Change Password dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Exponare Enquiry</td>
<td>Initiates an Exponare Enquiry session so that the administrator can log on as a user and view configuration changes.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Exponare Configuration window.</td>
</tr>
</tbody>
</table>

Change Password

The Change Password dialog box allows you to change users’ passwords.

**Figure 10-2: Change Password**

You cannot change passwords if you have unsaved changes after importing a configuration file containing password information.

<table>
<thead>
<tr>
<th>User name</th>
<th>Choose a user from the drop-down list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator Password</td>
<td>Enter the administrator’s password.</td>
</tr>
<tr>
<td>New password</td>
<td>Enter the new password.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Re-type the password.</td>
</tr>
</tbody>
</table>
Configuration Menu

This menu allows you to manage the Exponare configuration file.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import From Server</td>
<td>Opens the <strong>Select Configuration</strong> dialog box.</td>
</tr>
<tr>
<td>Import From File</td>
<td>Opens a standard Windows file dialog box so that an existing configuration file can be imported from the local machine or network drive.</td>
</tr>
<tr>
<td>Export To File</td>
<td>Opens a standard Windows folder dialog box so that the current configuration file can be saved on the local machine or network drive.</td>
</tr>
<tr>
<td>Delete History</td>
<td>Opens the <strong>Delete History</strong> dialog box.</td>
</tr>
</tbody>
</table>

Select Configuration

The Select Configuration dialog box allows you to import a configuration file from the server.

**Figure 10-3: Select Configuration**

- **configuration file list**: Lists all available backup configuration files.
- **Import Button**: Click to import the highlighted configuration file.

Delete History

The Delete History dialog box allows you to delete out-of-date configuration files.

**Figure 10-4: Delete History**
configuration file list | Lists all available backup configuration files.
Delete Button | Click to delete the highlighted configuration file(s). You will be asked to confirm this action.

Help Menu

<table>
<thead>
<tr>
<th>Help</th>
<th>Opens on-line help in a browser window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Opens the About Exponare Enquiry dialog box.</td>
</tr>
</tbody>
</table>

About Exponare Enquiry

The About Exponare Enquiry dialog box shows the version, customer name and the name of the Exponare server.

Figure 10-5: About Exponare Enquiry

Support Button | Click to display the custom About Exponare Enquiry text. See User Interfaces - About box message.
## Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Save and Activate Settings</td>
<td>Ctrl + S</td>
<td>Attempts to save and activate revised settings. Your work may conflict with the actions of other administrators. See Concurrent Exponare Administration for advice if this happens.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Refresh Configuration</td>
<td></td>
<td>Loads the latest configuration from the Exponare Server.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Refresh Drop-Down Lists</td>
<td></td>
<td>Loads the latest drop-down list data (e.g., workspace definition files and themes) from the Exponare Server.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>View Default Order</td>
<td></td>
<td>View the property grid in the default order, i.e., the most commonly used properties are listed first.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>View Categorized</td>
<td></td>
<td>View the property grid in property category order. In the chapters that follow, this is the order that is used to document the available properties.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>View Alphabetical</td>
<td></td>
<td>View the property grid in alphabetical order.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Add New Item</td>
<td>Ctrl + N</td>
<td>Adds a new item to the tree.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Delete Item</td>
<td>Delete</td>
<td>Deletes the currently highlighted item from the tree. You will be asked to confirm this action.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Copy</td>
<td>Ctrl + C</td>
<td>Copy the currently highlighted tree item to the clipboard.</td>
</tr>
</tbody>
</table>
### Chapter 10: Overview

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
<td>Pastes the contents of the clipboard as a new item in the tree.</td>
</tr>
<tr>
<td>Modify Activation keys</td>
<td></td>
<td>Available only when the Applications Setting node is selected. Opens the Activation dialog box so that new keys can be requested/added (page 49).</td>
</tr>
</tbody>
</table>
| Update Layer Settings   |          | Available only when a Work Context node is selected. Automatically creates a Layer Settings node for each layer in the Workspace Definition File if the following conditions are satisfied:  
  - The layer has data columns (raster layers, for example the Aerial Photography layer in the Aerial Photography Work Context, do not have data columns).  
  - The layer doesn’t have a Layer Settings node, either at the Work Context level, or one that is inherited from a Global Group. |
| Move Item Up            |          | Moves the selected item up.                                                 |
| Move Item Down          |          | Moves the selected item down.                                               |
| Populate View           |          | Available only when a View node is selected. Opens the Enquiry Selector widow so that you can set a View to have the same coordinate system, centre point and zoom width as a map open in Exponare Enquiry. |
The tree view resides on the left and shows a hierarchy of nodes. Each node represents a related group of properties. For example, a node may represent a User Profile, a spatial layer, or a Database Connection. Some nodes simply group other nodes. For example, the “Users” node groups all the individual users. The node tree hierarchy represents a set of parent-child relationships. For example, each “Work Context” node contains a “Views” node. All Views shown under a specific Work Context apply to that Work Context only. Each property has a name which is displayed in the tree, and a type, which affects the kind of properties it has. For example, a node of type “User” may have its name property set to “Smith”. The highest level nodes in the tree are referred to as top level items.

The following table describes the major sections in the Exponare configuration tree structure:

<table>
<thead>
<tr>
<th>Configuration Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address Search</strong></td>
<td>Application wide settings regarding the connection to an external geocoding engine.</td>
</tr>
<tr>
<td>Adhoc Layers</td>
<td>User defined layers can be opened.</td>
</tr>
<tr>
<td>Application Settings</td>
<td>Application-wide settings such as the location of the data files and default colours.</td>
</tr>
<tr>
<td>Database Connections</td>
<td>Specifications of the connections to external databases used.</td>
</tr>
<tr>
<td>Data Editing</td>
<td>Specifications for Editing Data under Database Edit Settings.</td>
</tr>
<tr>
<td>Global Layer Groups</td>
<td>Specifications for Global Layer Groups.</td>
</tr>
<tr>
<td>Tile Layer</td>
<td>User Defined tile layers can be applied.</td>
</tr>
<tr>
<td>Menus and Toolbars</td>
<td>Specification of menu and toolbar structures that can be used to create the user interface</td>
</tr>
<tr>
<td>Print Templates</td>
<td>Specification of Print Templates.</td>
</tr>
<tr>
<td>Users</td>
<td>User details, such as name, password, Work Context Group, and which user interface to use.</td>
</tr>
<tr>
<td>User Interfaces</td>
<td>Specification of user interfaces, including which menu and toolbar to use and the panel commands that are to be displayed.</td>
</tr>
<tr>
<td>Work Contexts</td>
<td>Specification of the data that is displayed for different Work Contexts, such as data files, Views, Queries, and Data Binds.</td>
</tr>
</tbody>
</table>
Tree View Context Menu

The tree node operations that are done through toolbar buttons can also be done by using context menu. It allows you to copy, paste, delete, refresh configuration and add new node function.

Figure 10-6: Tree View Context Menu

1. Right click on a tree node to open context menu.
2. Click on an active operation that you want to perform on selected node. For example, click on Copy option to copy the selected node.
3. Move the mouse pointer to select the node where you want to copy the copied node.
4. Right click on the node to select it and to open the context menu. Click the Paste option.
5. Check that the node that you selected in step 2 is available as child to the node where you pasted it, provided that the parent of node that you copied and the parent of the node where you pasted are of identical type.
6. Select the Add New Item option of context menu to add new node.
7. Select Delete Item option to delete the node created in Step 6.
8. Use Refresh configuration option to refresh the configuration and load the latest configuration from the Exponare Server.

Property Grid

The property grid appears to the right of the tree view. The property grid shows the properties of a single node. The property grid is empty if no node is selected or if the selected node has no properties.

If required, the property grid can be operated using the keyboard only.

Common Tasks

The following processes describe common tasks for working with the Configuration Manager.

Working with the Configuration Manager Property Grid

To enter and edit properties:

1. Select a configuration node in the tree view.
Property Grid

2. Click on the property that you wish to edit (or select a property using the keyboard shortcuts shown below).

3. Enter the new details.
   After entering the new details, select a different node in the tree view or click Save. If there are any problems with the data you have entered, a message is displayed.

Property entry helpers
Most of the property items take a simple text value. Others require you to select from a list of available options or to specify multiple values. In most cases, these more complex properties have helpers to aid you. A property helper is available whenever the property text entry field has a drop-down arrow or an ellipsis (…) button. The various property helpers are described fully in Property Grid Input Helpers.

Property Grid Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB</td>
<td>Move to the next property and immediately enter editing mode.</td>
</tr>
<tr>
<td>Shift-TAB</td>
<td>Move to the previous property and immediately enter editing mode.</td>
</tr>
<tr>
<td>Ctrl-Alt-DownArrow</td>
<td>Open a drop-down property list when in viewing or editing mode. Applies only to properties that display a drop-down arrow.</td>
</tr>
<tr>
<td>Function key (F4)</td>
<td>Open a property editing window or a drop-down list. Applies to properties that display an ellipsis (…) button or a drop-down arrow.</td>
</tr>
<tr>
<td>Escape</td>
<td>Switch from property editing to property viewing mode.</td>
</tr>
<tr>
<td>Up Arrow, Down Arrow</td>
<td>When in property viewing mode (no cursor displayed), the arrow keys can be used to change the active property. When in property editing mode, the arrow keys move the cursor.</td>
</tr>
</tbody>
</table>

Property Grid Input Helpers
The property grid is, for the most part, a list of text input boxes. Type directly into the fields to enter most data. However, some properties are of a special type such as a filename, a list, a colour, or a reference to another part of the configuration. In most cases, these special input types have input helpers.

- Colour Helper
- Data Bind Helper
- Fill Pattern Helper
- Layer Settings Helper
- Line Style Helper
- List Helper
- Multi-Value Input Helper
- View Helper
Chapter 10: Overview

Colour Helper

Some properties, such as Application Settings > Default Annotation fill style colour require a colour to be specified. For these properties, a colour helper is provided.

Figure 10-7: Color Helper

Data Bind Helper

The Data Bind helper is used to select:

- A Print Template Data Bind
- An External Application Link-out Data Bind

Figure 10-8: Data Bind Helper

Fill Pattern Helper

The Fill Pattern Helper is used when selecting the Selection interior fill pattern.
Layer Settings Helper

New Work Context

When creating a new Work Context, a helper is provided that does most of the fiddly work for configuring the individual Layers. The helper reads the Layer Settings from the workspace file and sets up appropriate Exponare layer configuration information. You can then just add the Exponare-specific settings that are required.

Each new layer setting created contains default information for the layer in the map, and also has a default Data Bind associated with it to retrieve information from that layer when items in the layer are selected.

To activate the Layer Settings Helper:

1. Add a new Work Context.
2. Configure the workspace file.
3. Click Update Layer Settings.
**Existing Work Context**

You also use the Layer Settings Helper if you add or delete layers in the underlying workspace.

**To add/delete layers in a workspace:**

1. Run **Workspace Manager** and add/delete layers as required.
2. Reset IIS
3. Login to Exponare Configuration Manager
4. Select the Work Context that uses the workspace modified in step 1.
5. Click **Update Layer Settings**.
6. Layer settings and data binds are created for the new layers and layers in Global Groups. You will be advised if any layers have been deleted.

The Layer Settings Helper orders the layers in the Configuration Manager in point/line/polygon order. See also **Configuring a Work Context**.

**Line Style Helper**

The Line Style Helper is used when selecting the **Selection line style**.

**Figure 10-10: Line Style Helper**

![Line Style Helper Diagram]

See **Appendix E: Line Styles and Fill Patterns - Line Styles** for a complete list of available line styles.
Property Grid

List Helper

Some properties may only take certain values. In many cases, the Configuration Manager uses a list helper so that you can conveniently select one of the legal values. For example, the property Application Settings|Zoom to selection minimum width unit may only take values from the units list allowed by MapXtreme. To alter this property, select the value area, then click the arrow to display a drop-down containing the legal values. Select one item from the list.

Figure 10-11: List Helper

Multi-Value Input Helper

Properties that allow multiple values require that the items be separated with semicolons. As a result, semicolons are not allowed in the individual list items. To simplify the creation of multiple value properties, a list input helper is provided. For example, the property Application Settings|PrintTemplate scale options is a multi-value property. To activate the helper, click on the value area, then click the ellipse button that is displayed. This causes a helper window to be displayed. In the helper window where you can add, remove, and reorder the list values.

Figure 10-12: Print Template Scale Options

View Helper

When creating a new View, a helper is available to set the coordinates, coordinate system, zoom width and zoom units, based on a map open in an Enquiry session.
To activate the View Helper:

1. Add a new View to a Work Context, or select an existing View.

2. Click Populate View.

3. The Exponare Enquiry Selector dialog box is displayed. Select a view.

4. Click OK.

See also Views.

URL Properties

A number of properties in the Exponare configuration have values that are URLs. In every situation where a URL is required, you may use either an absolute or a relative URL. An absolute URL begins with http and is interpreted exactly as written. A relative URL begins with anything except http and is automatically prefixed with the URL of Exponare Server.

A relative URL can be specified in one of two ways - either with a leading forward-slash (/) character or without. In the case of a leading forward-slash, the URL of the web server root will be prefixed to the URL. If there is no leading forward-slash, then one of two things can happen.

- In Enquiry, the URL is prefixed with the full URL path to the directory containing the web service file Exponare.asmx.
- In Public, the URL is prefixed with the full URL path to the directory containing the Public.aspx file that defines the Public interface.

See the table below for examples of URLs as they are entered and how the Exponare Server interprets them, assuming that the URL of the Exponare server is http://server/exponare/, and the Public.aspx template file is accessed through the URL http://server/exponare/publictemplates/public.aspx.
Property Grid

<table>
<thead>
<tr>
<th>URL as Entered</th>
<th>URL Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://myhost/myfile.txt">http://myhost/myfile.txt</a></td>
<td><a href="http://myhost/myfile.txt">http://myhost/myfile.txt</a></td>
</tr>
<tr>
<td>/myfile.txt</td>
<td><a href="http://server/myfile.txt">http://server/myfile.txt</a></td>
</tr>
</tbody>
</table>
| data/myfile.txt | Enquiry
http://server/exponare/data/myfile.txt |
| data/myfile.txt | Public
http://server/exponare/publictemplates/data/myfile.txt |

**File Path Properties**

A number of settings in the Exponare configuration have values that are paths to files or directories. In many cases these paths can be either absolute file paths or relative file paths. In the case of relative file paths, the paths configured will be searched for in two places on the server file system.

- Relative to the web application root directory on the server.
- Relative to any of the directories specified in the Application Settings|Data directories property.

**Help Panel**

The help panel is located at the bottom of the property grid and displays a short description of the currently selected property.
Application Settings

This chapter describes the Application Settings properties.

In this chapter...

- Annotation Properties
- Exponare Public Point Export Property
- Raster Quality Properties
- General Properties
- Raster Quality Properties
- Selection Properties
Annotation Properties

Annotations properties control the default values for foreground colour, fill colour, and the text typeface and size. The Annotation font setting is a drop-down list populated with the available fonts on the Exponare Server. The Server controls the rendering of Annotations text and so the fonts on the Exponare Enquiry client have no bearing on the available fonts.

With the exception of Annotation font, the default properties can be overwritten if an Annotations Panel is included in the User Interface (see Work Panels).

Figure 11-1: Annotation Panel- Example

<table>
<thead>
<tr>
<th>Annotation Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation font</td>
</tr>
<tr>
<td>Default Annotation fill background colour</td>
</tr>
<tr>
<td>Default Annotation fill style</td>
</tr>
<tr>
<td>Default Annotation fill style colour</td>
</tr>
<tr>
<td>Default Annotation font size</td>
</tr>
<tr>
<td>Default Annotation foreground colour</td>
</tr>
<tr>
<td>Default Annotation Line Style</td>
</tr>
<tr>
<td>Default Annotation Line Width</td>
</tr>
</tbody>
</table>
### Chapter 11: Application Settings

<table>
<thead>
<tr>
<th>Default Annotation symbol angle</th>
<th>The default symbol angle to select when you open the Annotation Panel. The value must be between 0 to 360. Default value is 90.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Annotation symbol font</td>
<td>The default font for annotation symbol.</td>
</tr>
<tr>
<td>Default Annotation symbol size</td>
<td>The default symbol size to select when you open the annotation panel. The value must be between 4 to 24. The default value is 10.</td>
</tr>
<tr>
<td>Default Annotation Text</td>
<td>The default text to display when you open the annotation panel. Default value is <strong>Annotation Text</strong>.</td>
</tr>
<tr>
<td>Default Annotation Text Alignment</td>
<td>The default text alignment to select when you open the annotation panel. By default it is <strong>Left</strong> aligned.</td>
</tr>
<tr>
<td>Default Annotation Text Angle</td>
<td>The default text angle to select when you open the annotation panel. The value must be between 0 to 360. By default the value is 90.</td>
</tr>
<tr>
<td>Default Height - Radius</td>
<td>The default height-radius to use while drawing ellipse.</td>
</tr>
<tr>
<td>Default Radius</td>
<td>The default radius to use while drawing circle.</td>
</tr>
<tr>
<td>Default Width - Radius</td>
<td>The default width - radius to use while drawing ellipse.</td>
</tr>
<tr>
<td>Text Annotation Bold</td>
<td>Enable bold style for text annotation if value is set to true. By default it is <strong>false</strong>.</td>
</tr>
<tr>
<td>Text Annotation Italic</td>
<td>Enable italic style for text annotation if value is set to true. By default it is <strong>false</strong>.</td>
</tr>
<tr>
<td>Text Annotation Shadow</td>
<td>Enable shadow style for text annotation if the value is set to true. By default it is <strong>false</strong>.</td>
</tr>
</tbody>
</table>

#### Exponare Public Point Export Property

| Coordinate Export               | The size of the symbol drawn on the map for the Point **Coordinate Export** functionality in Exponare Public. Must be greater than zero. |

See also **Coordinate Export**

The symbol colour is specified in the Work Context’s **Marquee colour** property.

#### External Authentication Properties

If the Server property is left empty, Exponare does not use external authentication.
General Properties

- **External Authentication**
  - Server: The name of the authentication server
  - User Credentials: The username of the Exponare proxy user.

See [Users](#) which explains how to set up external authentication using Active Directory.

General Properties

- **General**
  - Auto-login expiry time: The auto-login expiry time is the number of days that may pass without a user being asked for their login name and password. This only applies to User Profiles that have can auto-login Enquiry set to True, and to users that check the **Remember my login** checkbox during login.
  - Customer name: The name of the registered customer. This field must contain a value for the application to run. This value is case-sensitive and must be provided when requesting Activation Keys. Changing this value may cause your existing Activation Keys to be invalid.
  - Data directories: A semicolon-separated list of directories where the workspace files (.mws) are to be found. Each path must be an absolute path or a UNC path. A trailing slash is not necessary. The Internet user must have permission to access that directory and the files within. Example:
    ```
    C:\Temp;E:\Data\Project2;\MyServer\Maps
    ```
    Other data files, such as help files or Microsoft Word templates, may appear in any directory that is accessible to the Internet user account on the server machine.
    
    The name of the Internet User is dependent on your operating system, and a variety of IIS settings. If you only require access to data files on the Exponare Server machine, you can typically grant the Internet User permissions to access those files. If you require access to data files on a networked machine, you may need to alter the user account that handles internet connections.
    
    Do not include a network share in this list.
Chapter 11: Application Settings

### Maximum back/forward steps

The Enquiry client has a system for moving backwards and forwards through recent operations in a manner that is very similar to a web browser. To do this, Enquiry must remember the changes that are made by the user, and the setting maximum back/forward steps controls how many changes are tracked.

### Print template scale options

A semicolon-separated list of scale values for the Print Templates. For example: `25000;30000;100000`. All scales must be numeric entries greater than zero.

### Use External Authentication

Indicates whether external authentication is used. If True, the **Raster Quality Properties** must be completed.

---

**Raster Quality Properties**

The format of the map images produced for Enquiry and Public differs depending on the Layers of the active Work Context. Specifically, if the Work Context contains one or more raster Layers, a JPEG image is created. Due to the nature of JPEG map images, a quality setting is provided that allows you to select between high-quality images (with large file sizes) or lower-quality, smaller, bandwidth-saving images.

As a general guide, you might select high quality for Enquiry and both printing scenarios, but a lower setting for Public general use. Each quality setting is an integer between 1 and 10 where 1 through 9 represent different compression levels and 10 represents an exact image from the raster layer. The following table provides a guide to common quality settings and the resulting JPEG image size for the map, based on the Aerial Photo workspace that appears in the Exponare Sample Data.

See also **Appendix B: Raster Images**

<table>
<thead>
<tr>
<th>Image Quality</th>
<th>Visual Appearance</th>
<th>Guide to Image Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Good, may suit Public.</td>
<td>43 KB</td>
</tr>
<tr>
<td>5</td>
<td>Very Good, general purpose.</td>
<td>77 KB</td>
</tr>
<tr>
<td>9</td>
<td>Excellent. Essentially identical to quality level 10</td>
<td>114 KB</td>
</tr>
<tr>
<td>10</td>
<td>Original raster</td>
<td>300 KB</td>
</tr>
</tbody>
</table>
## Raster Quality Properties

<table>
<thead>
<tr>
<th>Raster Quality</th>
<th>The quality level for rendering maps that contain raster Layers. This value is an integer between 1 and 10. The values 1 through 9 represent compressed images, whereas the value 10 produces the map unaltered. Recommended values are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enquiry printing raster quality</td>
<td>quality = 2 to generate low-bandwidth images, quality = 5 for general purpose use, and quality = 9 for high fidelity.</td>
</tr>
<tr>
<td>Enquiry raster quality</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Public printing raster quality</td>
<td>quality = 2 to generate low-bandwidth images, quality = 5 for general purpose use, and quality = 9 for high fidelity.</td>
</tr>
<tr>
<td>Public raster quality</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

**Recommended values:**
- quality = 2 to generate low-bandwidth images,
- quality = 5 for general purpose use, and
- quality = 9 for high fidelity.
## Selection Properties

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to selection buffer width (%)</td>
<td>The buffer around the selection after performing a Zoom to Selections or Zoom to active selection. This setting is a percentage value for example ‘110’ means 1.1 times the zoom required to show the Features.</td>
</tr>
<tr>
<td>Zoom to selection minimum width</td>
<td>The minimum-bounding zoom width to use when the user chooses Zoom to Selections or Zoom to active selection. Must not be empty nor negative, but can be zero. The actual zoom width is also constrained by the Minimum zoom width of the Work Context.</td>
</tr>
<tr>
<td>Zoom to selection minimum width unit</td>
<td>The unit for the minimum zoom width, selected from available MapXtreme units.</td>
</tr>
<tr>
<td></td>
<td>• Centimeter • Chain • Degree • Foot • Inch • Kilometer • Link • Meter • Mile • Millimeter • NauticalMile • Rod • SurveyFoot • Yard</td>
</tr>
</tbody>
</table>
Selection Properties
A **Work Context** is the set of information required to work with a map, such as Layers, Views, or Queries. When a user is working in Enquiry, they view a single Work Context at a time. If users require different maps, or logically different groups of Layers, you should construct a Work Context for each separate task. For example, when working with residential maps, it may be appropriate to have separate Work Contexts for cadastre, utilities, and aerial photography data.

To view the **Work Contexts** that you configure, it is necessary to have also configured a basic **Work Context Group** and assigned that Work Context Group to your administrator **User Profile**; see **Work Context Groups** and **Users**.

In this chapter...

- Configuring a Work Context
- Work Context Nodes
Configuring a Work Context

Before configuring a Work Context, you must have a workspace file (*.mws). You can create a workspace file with the MapXtreme Workspace Manager that is distributed with Exponare - see Appendix D: Workspace Manager for further information.

Place the workspace file and its associated Layers into a folder that Exponare Server can access. You should ensure that your hardware and network configuration allows the Exponare Server fast access to these files. Also, ensure that the directory containing the workspace files is listed in the Application Settings|Data directories property.

The general Work Context settings describe information required to work with the map, such as zoom widths, selections, and the Overview Map. If the Overview Map setting is left blank, then the same.mws file used for the Work Context is also used for the Overview Map for that Work Context.

To configure a Work Context:

1. Create a workspace file (*.mws), and store it in one of the directories specified in Application Settings|Data directories.
2. Create a separate workspace file for the Overview Map if required.
3. If Configuration Manager is running, click Refresh Drop-Down Lists, otherwise load Configuration Manager.
4. Select the Work Contexts node.
5. Click Add New Item to create a new Work Context.
6. Complete the Work Context properties. The only mandatory properties are **Name** and **Workspace definition file**.

<table>
<thead>
<tr>
<th>Appearance</th>
<th>Active Selection highlight colour</th>
<th>The colour to use to highlight the Active Selection on the map. See Colour Helper.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Marquee colour</td>
<td>The colour to use for the marquee drawn over the map with a spatial tool such as Rectangle Select or Zoom in.</td>
</tr>
<tr>
<td></td>
<td>Measure Tool Colour</td>
<td>The colour to use when measuring.</td>
</tr>
<tr>
<td></td>
<td>Measure Tool Width</td>
<td>Select from 1 to 7 pixels. During measuring, the width will always be 1 pixel.</td>
</tr>
<tr>
<td></td>
<td>Selection highlight colour</td>
<td>The colour to use when highlighting selected objects on the map.</td>
</tr>
<tr>
<td></td>
<td>Selection interior fill pattern</td>
<td>The fill pattern to use for selections. See Fill Pattern Helper.</td>
</tr>
<tr>
<td></td>
<td>Selection line style</td>
<td>The line style to use for selection borders. See Line Style Helper.</td>
</tr>
<tr>
<td></td>
<td>Selection line width</td>
<td>The width of the above, in pixels.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
<th>Can user reorder layers</th>
<th>If True, the user can reorder Layers on the Legend Panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Description</td>
<td>The Work Context description, displayed in the Status Panel when the cursor is hovered over the Work Context in the Work Context menu.</td>
</tr>
<tr>
<td></td>
<td>Font for auto-generated legend.</td>
<td>The font to use when auto-generating the Legend for the Layers, selected from a list of available fonts on the server.</td>
</tr>
<tr>
<td></td>
<td>Font size for auto-generated legend</td>
<td>The size of the font to use when auto-generating the Legend for the Layers, must be a value between 6 and 24.</td>
</tr>
<tr>
<td></td>
<td>Maximum selections for Enquiry</td>
<td>The total number of selections that can be made on the map across all Layers from the Enquiry client. Must be one or greater.</td>
</tr>
<tr>
<td></td>
<td>Maximum selections for Public</td>
<td>The total number of selections that can be made on the map across all Layers from the Public client. Must be one or greater.</td>
</tr>
</tbody>
</table>
### Configuring a Work Context

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum zoom width</strong></td>
<td>The maximum zoom width allowed. Must be a positive value, or zero to indicate that there is no upper bound.</td>
</tr>
<tr>
<td><strong>Maximum zoom width unit</strong></td>
<td>The unit for the maximum zoom width.</td>
</tr>
<tr>
<td><strong>Minimum zoom width</strong></td>
<td>The minimum zoom width allowed. Must be a positive value, or zero to indicate that there is no lower bound.</td>
</tr>
<tr>
<td><strong>Minimum zoom width unit</strong></td>
<td>The unit for the minimum zoom width.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The unique name of the Work Context as shown to the user in the window title bar, Work Context menu and drop-down list.</td>
</tr>
<tr>
<td><strong>Workspace definition file</strong></td>
<td>The file that defines the Work Context, selected from a list of available MWS files. Only MWS files that appear in the Application Settings</td>
</tr>
<tr>
<td><strong>Overview Map height</strong></td>
<td>The height of the Overview Map, in screen pixels. Must be greater than zero.</td>
</tr>
<tr>
<td><strong>Overview map marquee colour</strong></td>
<td>The colour to use for the marquee drawn over the Overview Map to select a zoom-to region. See Colour Helper.</td>
</tr>
<tr>
<td><strong>Overview map width</strong></td>
<td>The width of the Overview Map, in screen pixels. Must be greater than zero.</td>
</tr>
<tr>
<td><strong>Overview workspace definition file</strong></td>
<td>The file that defines the Overview Map workspace. Only MWS files that appear in the Application Settings</td>
</tr>
</tbody>
</table>
## Scale Bar

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale bar allow drag in Enquiry</td>
<td>Indicates whether users of Enquiry are allowed to drag the Scale Bar to different locations.</td>
</tr>
<tr>
<td>Scale bar background alpha</td>
<td>The alpha (transparency) value of the background. This is a value between 0 and 1. A value of 0 makes the Scale Bar completely transparent (ie invisible).</td>
</tr>
<tr>
<td>Scale bar background colour</td>
<td></td>
</tr>
<tr>
<td>Scale bar border colour</td>
<td></td>
</tr>
<tr>
<td>Scale bar border width</td>
<td>Scale bar with a grey background and one pixel black border.</td>
</tr>
<tr>
<td>Scale bar border unit</td>
<td>The unit that the width of the border is in. The available units are:</td>
</tr>
<tr>
<td></td>
<td>* Display (1/75 inch) * Pixel</td>
</tr>
<tr>
<td></td>
<td>* Document (1/300 inch) * Point (1/72 inch)</td>
</tr>
<tr>
<td></td>
<td>* Inch</td>
</tr>
<tr>
<td></td>
<td>* Millimeter</td>
</tr>
<tr>
<td>Scale bar font</td>
<td>Font for the Scale Bar selected from a list of available fonts on the server.</td>
</tr>
<tr>
<td>Scale bar font colour</td>
<td>The colour for the scale bar font. See <a href="#">Colour Helper</a>.</td>
</tr>
<tr>
<td>Scale bar font size</td>
<td>The size, in points of the text that will be used within the Scale Bar.</td>
</tr>
<tr>
<td>Scale bar minimum height</td>
<td>The minimum height of the Scale Bar, in screen pixels. Must be greater than zero. If this setting is too low, the Scale Bar will be drawn at the minimum size possible.</td>
</tr>
<tr>
<td>Scale bar position unit</td>
<td>The unit that the x and y coordinates are specified in. The units are the same as those listed under Scale bar border unit.</td>
</tr>
<tr>
<td>Scale bar primary colour</td>
<td>The colour of the top left block of the Scale Bar.</td>
</tr>
<tr>
<td>Scale bar secondary colour</td>
<td>The colour of the bottom left block of the Scale Bar.</td>
</tr>
<tr>
<td>Scale bar size unit</td>
<td>The unit that the width and height are specified in. The units are the same as those listed under Scale bar border unit.</td>
</tr>
</tbody>
</table>
Configuring a Work Context

| Scale bar unit | The distance type that the Scale Bar will display, kilometer, mile, link etc. If Imperial is chosen, the most appropriate out of mile, yard, foot and inch will be used; for Metric the most appropriate out of kilometre, metre and millimetre. |
| Scale bar unit display location | Where to display the unit on the Scale Bar. Choose from Right or Bottom. |
| Scale bar unit display style | The form of the unit to display, e.g., Long = kilometre, short = km. |
| Scale bar width | The preferred width of the Scale Bar, in screen pixels. Must be greater than zero. If this setting is too low, the Scale Bar will be drawn as a hatch pattern. |
| Scale bar X coordinate | The x coordinate, in screen pixels, of where to place the Scale Bar on the map. A negative number indicates the number of pixels between the right-hand side of the Scale Bar and the right-hand side of the map. A positive number indicates the number of pixels between the left-hand side of the Scale Bar and the left-hand side of the map. A value of zero places the left-hand side of the Scale Bar at the left-hand side of the map. |
| Scale bar Y coordinate | The y coordinate, in screen pixels, of where to place the Scale Bar on the map. A negative number indicates the number of pixels between the bottom of the Scale Bar and the bottom of the map. A positive number indicates the number of pixels between the top of the Scale Bar and the top of the map. A value of zero places the top side of the Scale Bar at the top of the map. |

| Start-up settings | Overview map visible on load | If True, the Overview Map is visible when this Work Context is initially loaded |
| Scale bar visible on load | If True, the Scale Bar is visible when this Work Context is initially loaded |

7. Click **Update Layer Settings** to create default layer configurations and default Data Binds.

ℹ️ Before you can view your new Work Context you must add it to one of the Work Context Groups.
### Work Context Nodes

Additional configuration options are available for a Work Context and are discussed in Part 4: Additional Configuration Manager Features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Link-Ins</strong></td>
<td>An Application Link-In is a means of starting Exponare Enquiry from an external application.</td>
</tr>
<tr>
<td><strong>Application Link-Outs</strong></td>
<td>An Application Link-Out is a means of starting an external application from within Exponare Enquiry.</td>
</tr>
<tr>
<td><strong>Coordinate Export Targets</strong></td>
<td>In Exponare Public, coordinates can be exported to an html page.</td>
</tr>
<tr>
<td><strong>Data Binds</strong></td>
<td>Use a Data Bind to specify additional information to be displayed about a selected item on the map.</td>
</tr>
<tr>
<td><strong>Global Layer Groups</strong></td>
<td>Create Global Layer Groups to share common Layer Settings across work contexts.</td>
</tr>
<tr>
<td><strong>Groups</strong></td>
<td>Used to specify what all layers should fall under that group.</td>
</tr>
<tr>
<td><strong>Layer Settings</strong></td>
<td>Once the Layers have been auto-created with the correct settings you can then modify specific settings (eg the auto-generated Data Bind) to the settings you want.</td>
</tr>
<tr>
<td><strong>Layer Settings Shortcuts</strong></td>
<td>A Layer Settings Shortcut is a quick way to invoke a group of changes to the layer settings shown in the Legend panel. A layer setting including Layer Visibility, Layer Selectability, layer order, and auto labelling.</td>
</tr>
<tr>
<td><strong>Print Templates</strong></td>
<td>Print Templates are used to generate printed and/or html output for your Work Context.</td>
</tr>
<tr>
<td><strong>Queries</strong></td>
<td>Queries are used to select Features on a map.</td>
</tr>
<tr>
<td><strong>SQL Support Tables</strong></td>
<td>Use an SQL support table to load data that is non-spatial and so cannot be added to the workspace, or to load data that is spatial but that you do not want to have rendered on the map. SQL support tables can be used in Data Binds and Queries.</td>
</tr>
</tbody>
</table>
Work Context Nodes

**Views**

A View provides a quick way to set the zoom and pan of a map. For example, you can create a View that centres the map over a railway station with a zoom width of 200 metres.

**Watermarks**

A Watermark is an or defined set of text that will be drawn onto the map after the map data has been rendered. It is used for such things as placing a copyright message on top of protected data.
Work Context Groups

Work Context Groups are used to group the individual Work Contexts. Using groups simplifies the configuration of the Work Contexts that each user can access. For example, we might have Work Context Groups called “All”, “Administrative”, “Facilities,” and “Cadastre”. Users can then be specified to have access to one or more of these groups.

In this chapter...

- Creating a Work Context Group
Creating a Work Context Group

To create a Work Context Group:

1. Select the Work Context Groups node.
2. Click Add New Item to create a new Work Context Group.
3. Complete the Work Context Group Name property.

To add Work Contexts to a Work Context Group:

1. Select a Work Context Groups node.
2. Click Add New Item.
3. Complete the Work Context property.

4. Repeat steps 1 through 3 to add additional Work Contexts.
5. Click Save and Activate Settings.
This chapter discusses how to configure the Exponare menus and toolbars. You can take the sample data menus and toolbars and customise them to suit your users’ needs. For example, you could change the tooltip text from "Zoom to selection" to "Zoom to selected properties" in one menu, and "Zoom to selected parks" in another. Alternatively, you can build your menus and toolbars from scratch. For new menus and toolbars, refer New Enquiry Interface.

In this chapter:

- Configuring Menus and Toolbars
- Basic Commands
- Sub-menus
- Separators
- List Commands
- Customizing Toolbar Icons in Rest Public
Configuring Menus and Toolbars

Menus and toolbars are structured lists of commands that allow the user to access the features of Exponare. Three separate user interface items are specified in this way:

- the main menu structure,
- the toolbar structure, and
- the map context menu structure (accessed by clicking the alternative mouse button on the map).

The menus and toolbars are trees of nodes. If a menu item has children, a sub-menu is automatically created. If a toolbar item has children, then a drop-down menu is created. The drop-down menu is just like a regular menu and can have sub-menus if required.

Each of the entries in a menu or toolbar is called a command item. There are four types of command items:

- **Basic Commands**
- **Sub-menus**
- **Separators**
- **List Commands**

A basic command invokes a command such as **Zoom In**. A sub-menu extends the menu hierarchy to another level. A separator is used to draw a line or otherwise separate the items. Finally, a list command expands to a list of items.

### Basic Commands

A basic command causes a single action to be performed, such as changing the current map tool or showing the About box.

A basic command is displayed as a single menu item, or as a single toolbar button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="About" /></td>
<td>About</td>
<td>Shows the About box. For more information, see About Exponare Enquiry and About box message.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td><img src="image" alt="Add Favourite" /></td>
<td>Add Favourite</td>
<td>Creates a new Favourite, using the current View and selections.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td><img src="image" alt="Back" /></td>
<td>Back</td>
<td>Go back a step. For more information, see General Properties.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image" alt="Change Password" /></td>
<td>Change Password</td>
<td>For more information, see Change Password which describes how to reset user passwords.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>
## Chapter 14: Menus and Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Clear Annotations" /></td>
<td>Clear Annotations</td>
<td>Clears all Annotations drawn using the Draw Polygon, Draw Text, Draw Rectangle and other Annotation tools, See Annotation Properties</td>
<td>✔️</td>
<td>❌</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Clear Labels" /></td>
<td>Clear Labels</td>
<td>This allows you to clear all labels from the map.</td>
<td>✔️</td>
<td>✔️</td>
<td>❌</td>
</tr>
<tr>
<td><img src="image" alt="Clone Session" /></td>
<td>Clone Session</td>
<td>Opens a new Exponare Enquiry window, applying the current window settings.</td>
<td>✔️</td>
<td>❌</td>
<td>❌</td>
</tr>
<tr>
<td><img src="image" alt="Coordinate Export - Point" /></td>
<td>Coordinate Export - Point</td>
<td>Allows the export of point coordinates. Coordinate Export.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Coordinate Export - Polygon" /></td>
<td>Coordinate Export - Polygon</td>
<td>Allows the export of polygon coordinates. Coordinate Export.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Coordinate Export - Polyline" /></td>
<td>Coordinate Export - Polyline</td>
<td>Allows the export of polyline coordinates. Coordinate Export</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Copy Map To Clipboard" /></td>
<td>Copy Map To Clipboard</td>
<td>Copies the map to the clipboard so that it can be pasted into another program. See also Save Map To File.</td>
<td>✔️</td>
<td>❌</td>
<td>❌</td>
</tr>
<tr>
<td><img src="image" alt="Draw Circle" /></td>
<td>Draw Circle</td>
<td>Draws a circle Annotation.</td>
<td>✔️</td>
<td>✔️</td>
<td>❌</td>
</tr>
<tr>
<td><img src="image" alt="Draw Ellipse" /></td>
<td>Draw Ellipse</td>
<td>Draws an ellipse Annotation.</td>
<td>✔️</td>
<td>✔️</td>
<td>❌</td>
</tr>
<tr>
<td><img src="image" alt="Draw Polygon" /></td>
<td>Draw Polygon</td>
<td>Draws a polygon Annotation. See Annotation Properties.</td>
<td>✔️</td>
<td>❌</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Draw Polyline" /></td>
<td>Draw Polyline</td>
<td>Draws a polyline Annotation. See Annotation Properties.</td>
<td>✔️</td>
<td>❌</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Draw Rectangle" /></td>
<td>Draw Rectangle</td>
<td>Draws a rectangle Annotation. See Annotation Properties.</td>
<td>✔️</td>
<td>❌</td>
<td>❌</td>
</tr>
<tr>
<td><img src="image" alt="Draw Symbol" /></td>
<td>Draw Symbol</td>
<td>Draws a text Annotation.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="image" alt="Draw Text" /></td>
<td>Draw Text</td>
<td>Draws a text Annotation. See Annotation Properties.</td>
<td>✔️</td>
<td>❌</td>
<td>✔️</td>
</tr>
</tbody>
</table>
## Configuring Menus and Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="" /></td>
<td>Edit Annotations</td>
<td>Click this to select individual annotations to edit, move or delete them.</td>
<td>✔️</td>
<td>✔️</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Exit</td>
<td>Closes the current Exponare Enquiry session.</td>
<td>✔️</td>
<td>☒</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Export Annotations</td>
<td>Saves Annotations to a file so they can be revisited.</td>
<td>✔️</td>
<td>✔️</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Export Favourite</td>
<td>Exports the current View and selections as a Favourite file (.fav extension).</td>
<td>✔️</td>
<td>☒</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Forward</td>
<td>Go forward a step. See General Properties.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Help</td>
<td>Loads the help file for the current User Interface.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Home</td>
<td>Resets the View to the starting View for the Work Context. Selections are not affected. The sample data Home button also provides a drop-down list of the Work Contexts that are available.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Import Annotations</td>
<td>Imports a file containing saved Annotations.</td>
<td>✔️</td>
<td>✔️</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Log Off</td>
<td>Closes the current session and displays the login dialog box.</td>
<td>✔️</td>
<td>✔️</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Manage Favourites</td>
<td>Presents a dialog box that allows the user to rename and delete existing Favourites.</td>
<td>✔️</td>
<td>☒</td>
<td>☒</td>
</tr>
<tr>
<td><img src="Image" alt="" /></td>
<td>Measure Area</td>
<td>With this tool a shape (a polygon) can be drawn on the map and its area can be seen in the status bar.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
### Chapter 14: Menus and Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Measure" /></td>
<td>Measure Distance</td>
<td>With this tool a path (a polyline) can be drawn on the map and its length can be seen in the status bar.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open Favourite</td>
<td>Opens a Favourite file. This can be used to import Favourites from other locations or users. Once opened, Add Favourite can be used to add it to the Favourites menu.</td>
<td>✓</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Pan" /></td>
<td>Pan</td>
<td>Moves the map.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image" alt="Point Select" /></td>
<td>Point Select</td>
<td>Selects all the Features under a single point.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image" alt="Polygon Select" /></td>
<td>Polygon Select</td>
<td>Selects all the Features that lie within a polygon.</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Polyline Select" /></td>
<td>Polyline Select</td>
<td>Selects all the Features that lie underneath a polyline.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image" alt="Radius Select" /></td>
<td>Radius Select</td>
<td>Selects all the Features that lie within a circle.</td>
<td>✓</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Recentre" /></td>
<td>Recentre</td>
<td>Centres the map at the current cursor location.</td>
<td>x</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Rectangle Select" /></td>
<td>Rectangle Select</td>
<td>Selects all the Features that lie within a rectangle.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image" alt="Reset Session" /></td>
<td>Reset Session</td>
<td>Reloads Exponare Enquiry from the server.</td>
<td>✓</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Save Map To File" /></td>
<td>Save Map To File</td>
<td>Saves the map to a .png file.</td>
<td>✓</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Show Label" /></td>
<td>Show Label</td>
<td>This allows you to show a label for an individual feature on the map. Simply click this button and then the desired feature to display its label.</td>
<td>x</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Auto Labels" /></td>
<td>Toggle Auto Labels</td>
<td>Displays/hides Auto Labels.</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
</tbody>
</table>
## Configuring Menus and Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Toggle Overview map</td>
<td>Displays/hides an Overview Map. The Overview Map shows a rectangle indicating the current positioning of the main map. Clicking on the Overview Map causes the main map to recentre around that point. Dragging a rectangle on the Overview Map causes the main map to show the selected area.</td>
<td>✓</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Toggle Scale Bar</td>
<td>Displays/hides a Scale Bar for the map</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Unselect All</td>
<td>Clears the current selections so that there are no currently selected items.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Zoom In</td>
<td>Allows more detail to be seen on the map. Clicking on the map doubles the size of the map and will centre the view on the point clicked. Dragging a rectangle on the map causes the selected area to fill the display. The minimum zoom for the Work Context cannot be exceeded and attempting to move outside the bounds of the Work Context cancels the action.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Zoom Out</td>
<td>Allows more of the map to be seen. Clicking on the map halves the size of the map and will centre your view on the point clicked. Dragging a rectangle on the map causes the current map view to be resized to fit inside the selected area. The maximum zoom for the Work Context cannot be exceeded and attempting to move outside the bounds of the Work Context cancels the action.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>Zoom to active selection</td>
<td>Adjusts the zoom view to fit the extents of the currently active selected item.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Chapter 14: Menus and Toolbars

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom to Selections</td>
<td>Adjusts the zoom view so that all currently selected items fit within the map window.</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>Zoom width</td>
<td>Allows the zoom setting to be set manually</td>
<td>✔️</td>
<td>❌</td>
<td>❌</td>
</tr>
</tbody>
</table>

To add a basic command to a menu or toolbar:

1. Select a **Menu** or **Toolbar** node.

2. Click **Add New Item**.

3. Complete the Command Item properties:

   **General**
   - **Caption**: Enter the menu caption.
   - **Command**: Select a command from the drop-down list.
   - **Description**: Enter a description for this command - this is shown in the status bar when the mouse is hovered over a menu caption or as tool tip text if the mouse is hovered over a toolbar icon.

4. If necessary, adjust the position of the command item by using the position buttons in the command bar of the Configuration Manager.

5. Save the configuration.

*Commands cannot be added to the top level of the Main menu. The top level can only have grouping entries such as **File**, **Edit**, **Help** etc. The top level of the toolbar, however, can only have commands added to it. The toolbar does not support top-level items that do not have an associated command. The map context menu can support commands as well as grouping entries.*
Configuring Menus and Toolbars

Sub-menus

A sub-menu allows a menu or toolbar to be extended. For example, the main menu most likely requires sub-menus called File, Action, and Help. A toolbar item can also have sub-menu items. If a toolbar item has sub-menus and the toolbar item is itself a command item that can be clicked on to perform an action, then the sub-menu is not attached to the toolbar item directly, but a second toolbar item to the right of the item is automatically created, with a visual appearance to indicate that it has a sub-menu, and the sub-menu is attached to this new toolbar item instead.

To add a Sub-Menu to a Command Tree

1. Select a command tree.
2. Add a new command item.
3. Choose <none> as the command.
4. Set the caption to the name for this sub-menu.
5. Adjust the position of the command item by using the position buttons in the command bar of the Configuration Manager.
6. Save the configuration.

To add commands to a sub-menu, select the sub-menu command and press the add node button.

Separators

A separator is used to visually separate other command items.

To add a Separator to a Menu or Toolbar

1. Select a menu or toolbar.
2. Add a new command item.
3. Choose Separator as the command.
4. Adjust the position of the command item by using the position buttons in the command bar of the Configuration Manager.
5. Save the configuration.
List Commands

List commands expand to a list of menu items or as a set of toolbar buttons. These are called list command items.

If a list command item is added to a menu, it expands out ‘in-place’ to be a list of all the available items for use in the current Work Context. The exception to this is if the item is added as a top-level item in either a toolbar or a menu. In this case the list of all available items will expand out into a sub-menu under the item.

The standard list command items are:

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Action/Comments</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>![External Links Menu Items]</td>
<td>External Links Menu Items</td>
<td>List of links to external applications. See Application Link-Outs.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>![n/a]</td>
<td>Favourites Menu Items</td>
<td>Lists the available Favourites.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>![Layer Settings Shortcuts Menu Items]</td>
<td>Layer Settings Shortcuts Menu Items</td>
<td>See Layer Settings Shortcuts.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>![Queries Menu Items]</td>
<td>Queries Menu Items</td>
<td>See Queries.</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>![Work Contexts Menu Items]</td>
<td>Work Contexts Menu Items</td>
<td>See Work Contexts.</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
</tbody>
</table>

Customizing Toolbar Icons in Rest Public

The toolbar icons can be configured by selecting a Theme in Configuration Manager under UserInterface node.

A folder named RestPublicIcons in Themes/<Theme Type> folder at server contains icons of the toolbar. Replacing these icons with desired icons will change the icons of the toolbar in Rest Public. If no image is found for a tool, default <noImage> icon will be displayed.

ℹ️ The name of the tool icon should be same as command name of the tool with no spaces.
User Interfaces

This chapter discusses Exponare User Interfaces and how they can be configured for different users. For new user interface, refer to New Enquiry Interface

In this chapter...

- Introduction
- User Interface Configuration
Introduction

The user interfaces of the Exponare Enquiry, Rest Public and Public clients are configurable, and each different user can be provided with a separate interface.

Figure 15-1: Exponare Enquiry and Public

Figure 15-2: Exponare Enquiry Full User Interface from the sample data, using the Default theme
User Interface Configurable Components

- **Menu Structure**
- **Toolbar Structure and Toolbar Images**
- **Banners** (with upgrade scenario only)
- **Left Panel**
- **Bottom Panel (Exponare Enquiry only)**
- **Status Panel (Exponare Enquiry only)**
- **Panel Specific Images**
- **Layer and Layer Legend Images**
- **Map Context Menu (Exponare Enquiry Only)**
- **Panel Specific Images**

**Menu Structure**

See [Menus and Toolbars](#).

**Toolbar Structure and Toolbar Images**

The toolbar images are taken from the User Interface theme.

**Banners**

The banner images are taken from the User Interface theme.

You can choose from no banner, left banner, top banner and both top and bottom banners. There are two separate banners: Left and Top. Each banner comes in two parts: fixed and variable.

The fixed banner image is displayed in its original size and does not resize if the application window is resized. The variable banner image fills up the remaining space that is available for the banner. Both a fixed and a variable banner should be specified.

Observe the following guidelines when creating banner images:

- For the left banner, both the fixed and the variable banner images should have the same width.
- For the top banner, both the fixed and the variable banner images should have the same height.
- The variable banner image is best set to be a fixed colour, or a pattern that is not disrupted by resizing.

**Left Panel**

The work panel images (Exponare Enquiry only) are taken from the User Interface theme.
The table below lists the available Left and Bottom work panel commands:

<table>
<thead>
<tr>
<th>Image</th>
<th>Command</th>
<th>Further Information</th>
<th>Enquiry</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Legend]</td>
<td>Legend</td>
<td>The Legend Panel</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>![Feature Details]</td>
<td>Feature Details</td>
<td>Layers and Selection Results</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>![Queries]</td>
<td>Queries</td>
<td>Queries</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>![Print]</td>
<td>Print</td>
<td>Print Templates</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>![Annotation]</td>
<td>Annotation</td>
<td>Exponare Enquiry only</td>
<td>✔️</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>![Coordinates]</td>
<td>Coordinates</td>
<td>Coordinate Export - Exponare Enquiry</td>
<td>✔️</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>![Address Search]</td>
<td>Address Search</td>
<td>Address Search</td>
<td>✔️</td>
<td>✔️</td>
<td>✗</td>
</tr>
<tr>
<td>![Data Bind]</td>
<td>Data Bind</td>
<td>Data Binds</td>
<td>✔️</td>
<td>✔️</td>
<td>✗</td>
</tr>
</tbody>
</table>

Exponare Public only uses the left panel, but it can be moved elsewhere by creating an .aspx page with the appropriate formatting.

**Bottom Panel (Exponare Enquiry only)**

The available Bottom Panel commands are listed under **Left Panel**.

You cannot show the same work panel in both the Left and Bottom panels. If a panel is added to the list of left panels for a user interface as well as the list of bottom panels, it will only be displayed in the left panel.

**Status Panel (Exponare Enquiry only)**

There is only one available command for the Status Panel:

<table>
<thead>
<tr>
<th>Image</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Zoom width]</td>
<td>Zoom width</td>
</tr>
</tbody>
</table>

Command for Exponare Enquiry and Public

<table>
<thead>
<tr>
<th>Image</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Map centre]</td>
<td>Map centre</td>
</tr>
</tbody>
</table>
Panel Specific Images

Panel specific images are taken from the User Interface theme.

<table>
<thead>
<tr>
<th>Image(s)</th>
<th>Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Legend" /></td>
<td>Legend</td>
</tr>
<tr>
<td><img src="image2" alt="Legend" /></td>
<td>Legend (Exponare Enquiry only)</td>
</tr>
<tr>
<td><img src="image3" alt="Annotation" /></td>
<td>Annotation (Exponare Enquiry only)</td>
</tr>
</tbody>
</table>

Layer and Layer Legend Images

Any file that is web-readable by an anonymous user.

Map Context Menu (Exponare Enquiry Only)

Cursors

Cursors are taken from the User Interface theme.

User Interface Themes

Themes are a group of user interface items that can be used as a package. Icon and cursors have been updated to have new improved look while keeping the behaviors intact.

The two new themes are Blue and Blue Large.

Once, applied they look like this.

Blue

![Blue](image4)

Blue Large

![Blue Large](image5)

To configure these themes, go to Configuration Manager > User Interface > Enquiry theme & Public theme
The items in a theme comprise:
- icon images
- banner images
- cursor images, and
- Legend panel images.

The themes are stored on the Exponare Server in the directory `ExponareIISDir/Themes`.

The image filenames that can be used in a theme are fixed.

Review the files in the Default theme for the current themed items and their filenames.

To create a new Theme:

1. Locate the themes directory. The themes directory is on the Exponare Server, and by default is at `ExponareIISDir/Themes`.
2. Create a new subdirectory.
3. Name the new directory with the theme name.
4. Copy items from an existing theme, such as the Default theme, into the new directory.
5. Edit the theme items using your favourite graphics utilities.
When configuring a user, you specify which theme to use. Any user interface item that is required for that user will come from the specified theme. If the required items cannot be found in the specified theme, the default theme is tried. If the item does not appear in the default theme, a placeholder is used instead.

The Visual Themes are provided primarily as a set of images to be uploaded. Therefore, when changing the Visual Theme for the Public User and logging in to Exponare Public, it may be necessary to clear the internal cache used by your browser. Clearing the internal cache will ensure that the latest files are uploaded instead of using earlier cached versions.

From 5.0 onwards, the impact of themes in Enquiry is only limited to - icons used in panels. Icons for ribbon toolbar are referred from - RibbonLarge & RibbonSmall folder. This folder has same set of icons for each theme image. To know more about new icons refer, New Icons.

User Interface Configuration

Configuring a user interface for use is a three step process:

1. Configure the user interface specification, including menus, the toolbar, and the work panels,
2. Configure User Profiles to use the new user interface, and
3. Set up a new theme, if different button icons, etc are required.

Configuration of the user interface specification is discussed below. Configuring a new theme is discussed in User Interface Configurable Components. Configuring a User Profile to use a specific user interface is covered in Users.

Each user interface configuration consists of some general settings and the set of work panel commands corresponding to the work panels to be displayed. The user interface configuration also contains a reference to a menu structure, a toolbar and, for Exponare Enquiry, a map context menu. The menus and toolbars are configured separately so that they can be reused by many user interfaces.

To configure a user interface:

1. Select the User Interfaces node.
2. Click Add New Item to create a new user interface.
### User Interface Configuration

3. Complete the User Interface properties:

<table>
<thead>
<tr>
<th>Enquiry Module</th>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enquiry Theme</strong></td>
<td>The theme to use for this account when starting up the Enquiry Module, selected from available themes.</td>
</tr>
</tbody>
</table>
| **Hide panel names in Enquiry** | True: ![True](image1)  
False: ![False](image2) |
| **Map context menu** | The map context menu to use for this user interface, selected the list of configured menus and toolbars. This item only applies to Enquiry.  
See [Menus and Toolbars](#) |
| **Menu bar** | The menu bar for this user interface, selected the list of configured menus and toolbars.  
See [Menus and Toolbars](#) |
| **Name** | The unique name of the User Interface. |
| **About box message** | The message shown to the user in the **Support** dialog of the **About Exponare Enquiry** dialog box. |
| **Banner position(s)** | The position(s) to show banner images. The options are 'None', 'Top', 'Left', and 'Both'. This setting applies to both Enquiry and Public, however Public also requires that you include appropriate **BannerScripter** components in the.aspx page.  
See [Banners](#) |
| **Help directory** | The directory where the user help is stored. This directory can be specified as either an absolute path or a relative path. If it is a relative path, it is treated as relative to the sub-folder /Help/ under the web application root directory.  
See [Help](#) |
| **Initial Selected Tool** | Only for Enquiry.  
Allows you to configure a default tool selection on application startup. You can configure a particular selectable tool in Configuration Manager. On running application, the Initial Selected tool will be highlighted if that is a selectable map tool.  
If "none" tool is selected as initial tool, then nothing will be selected in Enquiry window. If more than one tool name are associated with one command all will come selected. |
4. Add **Work Panels**.

### Work Panels

To add Work Panels to the user interface:

1. Select a **Panels** node.
2. Click **Add New Item** to create a new panel.
3. Complete the Panel properties:

<table>
<thead>
<tr>
<th>General</th>
<th>Choose a command from the drop-down list. For the Left and Bottom panels this can be one of:</th>
</tr>
</thead>
</table>
| Command | Annotation  
Address Search  
Coordinates  
Data Bind Details  
• Feature Details  
• Legend  
• Print  
• Queries  
For the Status Panel, the only command available is **Zoom width**. |
| Description | Tooltip text (i.e., Panel description mouse hover). |
| Name | The unique name of the panel as shown to the user if Hide panel names in Enquiry is False (e.g., Legend in the above screenshot). |

4. Repeat steps 1 through 3 to add additional panels.

5. If necessary, adjust the position of the panels by using the position buttons in the command bar of the Configuration Manager.

6. Click **Save and Activate Settings**.

### Map Centre

In Configuration Manager the administrator has the flexibility to set the functionality for desired user. To add Map Centre command to the user interface:
User Interface Configuration

1. Select the User Interfaces node.
2. Click Full Interface > Status Panels.
3. Click Add New Item to create a new command Map Centre.

Figure 15-4: Create New Map Centre
Users

Exponare User Profiles are the mechanism for granting and restricting access to Exponare. Each profile specifies the connection information such as login name, authentication method, and administrator status. The User Profiles also specify the user interface, user interface theme, and the available Work Context Groups.

In this chapter...

- Overview
- User Profiles
- User Passwords
- The Login and Authentication Process
- Single Sign On
- Troubleshooting
Overview

• User Types
• Configuring External Authentication

User Types

Exponare provides four different types of user:

<table>
<thead>
<tr>
<th>User Type</th>
<th>Authentication</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Native Exponare User</td>
<td>Custom password store for Exponare</td>
<td>Users can change their Exponare password.</td>
</tr>
<tr>
<td>Native Shared Exponare User</td>
<td></td>
<td>Only Administrators can change native shared account passwords</td>
</tr>
<tr>
<td>Externally Authenticated User</td>
<td>External</td>
<td>Typically, users enter their network domain, username and password to login.</td>
</tr>
</tbody>
</table>

Two native Exponare users are created when Exponare is installed:

admin

Password: admin
User Type: Native Exponare User

• The admin user allows you to configure Exponare.

You should ensure you maintain at least one ‘Native Exponare User’ which has admin rights so that you can still connect to Exponare in order to fix any issue that arise with external authentication.

Public

Password: the Public password is set during installation and cannot be changed
User Type: Native Shared Exponare User

• The Public user is the default user for anonymous access to Exponare Public and Rest Public.

Two additional users are created when the sample data is installed. Their User Type is: Native Shared Exponare User

The sample data users are referred to in the Exponare Enquiry User Guide:
Configuring External Authentication

By default, Exponare uses Active Directory for external authentication. However, an alternative external authentication method can be used - Contact the Pitney Bowes Software Professional Services Group for further information.

To configure Active Directory authentication, it is recommended that you follow the steps below:

1. Create an Exponare proxy user account on your Active Directory server with permissions to authenticate only.

2. If necessary, load the Exponare Configuration Manager.

3. Select the Application Settings node.

4. Set the Use External Authentication property to True.

5. Complete the External Authentication properties and click Save and Activate Setting.

<table>
<thead>
<tr>
<th>External Authentication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>The name of the Active Directory server</td>
</tr>
<tr>
<td>User Credentials</td>
<td>Click the button to open the User Credentials dialog box and enter the account name and password created in step 1.</td>
</tr>
</tbody>
</table>
User Profiles

To add or update a user profile:

1. Select the Users node.
2. Click Add New Item to create a new user profile or Click the User node to update an existing user profile.
3. Complete the User properties.

The Enquiry Module properties do not apply to the Public user and are not displayed.

### Enquiry Module

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can use Enquiry</td>
<td>If True, users with this profile can log in to Enquiry. This property is True and read only if Is administrator is set to True.</td>
</tr>
<tr>
<td>Can auto-login Enquiry</td>
<td>If True, users with this profile can auto-login to Enquiry.</td>
</tr>
<tr>
<td>Can store panel state</td>
<td>If True, users with this profile can store the size of their left and bottom panels when they exit Enquiry. The stored state will be restored they next time they use Enquiry. See Left Panel and Bottom Panel.</td>
</tr>
</tbody>
</table>

The General property Is administrator does not apply to the Public user and is not displayed.

### General

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>The unique login name of the user. This must be preceded by the domain name and a backslash if the user is to be externally authenticated. When the login name is changed for native Exponare user profiles, the password becomes invalid and must be set by the administrator. This field is read-only for the Public user and the current user.</td>
</tr>
<tr>
<td>Is administrator</td>
<td>True if this user profile has administrator privileges This setting cannot be changed If you are logged in as this user. To create a new administrator and delete the current administrator: Create and save the new administrator’s account Login as the new administrator Delete the old administrator. If this field is set to True Can use Enquiry must be True.</td>
</tr>
</tbody>
</table>
Chapter 16: Users

General

<table>
<thead>
<tr>
<th>Default Work Context</th>
<th>The default Work Context to load for this account, selected from the list of configured Work Contexts. If set to &lt;none&gt;, the first Work Context found in the list of available Work Contexts is loaded. See Work Context Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporary location for print files</td>
<td>Display the location of temporary print files. Default location is AppData folder of the user.</td>
</tr>
<tr>
<td>User Interface</td>
<td>The user interface to load for this account, selected from the list of configured user interfaces. See User Interfaces</td>
</tr>
<tr>
<td>User Type</td>
<td>Select the User Type from the drop-down list. See User Types</td>
</tr>
</tbody>
</table>

Public Module

| Can use Public | If True, users with this profile can log in to Public and Rest Public. This field is True and read only if Is administrator is set to True |

4. For Externally Authenticated User Groups, adjust the priority of the authentication by using the position buttons in the command bar of the Configuration Manager.

For example, a user logs in as hagworts\hogrid. He is a member of both the Animal_Control_Managers and Animal_Control groups. In this case, he will get the settings for Animal_Control_Managers. However, if he is added to the Cadastre group, he will get the settings for Cadastre as this user profile is higher in the list.

To add Work Context Groups to a user account:

1. Select the user’s node.
2. Click Add New Item.
3. Complete the Work Context Group property

General

| Work Context Group | The Work Context Group to associate with the user. See Work Context Groups |

4. Repeat steps 1 through 3 to add additional Work Context Groups.
User Passwords

5. Click **Save and Activate Settings.**

User Passwords

When a native Exponare user profile has been set up, it cannot be used until the password is set. This is described in **Change Password.**

The Login and Authentication Process

No External Authentication

If the **Use External Authentication** property in Application Settings is False or the External Authentication **Server** property is empty, an attempt is made to authenticated the user against the Native Exponare Users and Native Exponare User Groups.

External Authentication Specified

If the **Use External Authentication** property in Application Settings is True, an attempt is made to authenticate the user using external authentication.

For **Active Directory authentication:**

If the user credentials cannot be found on the Active Directory server, authentication continues as described in **No External Authentication.**

If the user credentials are valid, the user will be logged in as an Externally Authenticated User if their domain and username are present under the Users node. Otherwise, the names of the Active Directory groups that the user is a member of are compared to user profile names under the Users node. If a match is found, the user will be logged in using the corresponding Externally Authenticated User Group.

**Login examples**

1. Dusty Bean
   Domain name: **My Domain**
   Username: **dubean**
   Active Directory groups: **Garbage** and **Public Health**
   • Dusty logs in and is authenticated by the Active Directory server.
   • Dusty’s domain name and user name do not make up a valid Exponare profile so the Active Directory groups that she is a member of are examined.
   • Dusty is logged in using the settings specified in Garbage as this is first group found that she is a member of.

2. Trevor Ash
   Domain name: **My Domain**
Username: trash
Active Directory groups: Garbage, Sewerage and Public Health

- Trevor logs in and is authenticated by the Active Directory server.
- Trevor’s domain name and user name make up a valid Exponare profile. Trevor is logged in using the settings specified in MyDomain\trash.

Figure 16-1: Authentication Process
Single Sign On

Exponare will automatically log you in as an Authenticated Enquiry user based on your windows credentials. Now you will not have to type your username and passwords multiple times.

Configuration Manager:
User Node

As an administrator you will need to create a new user under the User node tree list. Ensure that the new user domain is specified.

Figure 16-2: Configuration Manager - User Node

Provide the credentials of the new user for the following fields:

Default Work Context  Provide the default work context, such as Vegetation.

Login  Provide the login details as a combination of Domain and UserID, such as PBI\SU001DH, where PBI is domain and SU001DH is the user.

User Interface  Provide the user interface, such as Full Interface.

User Type  Set the user type as Externally Authenticated User. The user will be authenticated against external system, such as Active Directory.

User should be associated to a Work Context Group.
Chapter 16: Users

Application Settings Node

As an administrator you will need to provide the respective External Authentication credentials for both Domain and User Credentials.

Figure 16-3: Application Settings Node

Provide the following credentials to effectively administer Exponare:

- Domain and User credentials should be the same that has been specified while creating the new user.
- Field Use External Authentication should be set to True.
- After saving all the respective Configuration Manager changes, open Exponare Enquiry and it should get loaded automatically according to the OS credentials of the logged in windows user.
Single Sign On

- User need not to specify username and password for login now on the machine.

In case as a user you need to login through admin, you should Log Off first and then specify the administrator credentials for login or through different user.

Login through Command Line

Administrator/User can also login through command line by specifying the respective directory of Exponare and providing corresponding credentials.

**Figure 16-6: Login through Command Line**

Password is not in the encrypted form.

In case administrator/user input incorrect username or password, login window dialog will appear asking for user credentials again.

Also, when an administrator provides User Type as Externally Authenticated User Group, any user who falls under that group will be allowed to login appropriately.

Provide the credentials of that new user for the fields:

- Default Work Context: Provide the default work context, such as Sewerage.
- Login: Provide the login as a Group, such as Noida All, where SU001DH UserID belongs to the above group.
- User Interface: Provide the user interface, such as Full Interface.
- User Type: Externally Authenticated User Group. The user will be authenticated against external system such as Active Directory.
In case of Externally Authenticated User Group also it will work through command line.

Troubleshooting

Login.htm page showing blank screen in IIS7 and above

**Symptom:**
If Login.htm page is showing blank screen there could be a problem of Http redirection unavailability in IIS7 or above.

**Resolution:**
A manual installation of HTTP Redirection is required if during installation of IIS7 user forgot to check HTTP Redirection check box under Common HTTP features. To rectify follow below mentioned steps:

1. Open Control Panel\Programs and Features
2. Go to Turn Windows features on or off
3. Select Internet Information Services\World Wide Web Services\Common HTTP features.
4. Check HTTP Redirection and press OK.

5. System will enable HTTP redirection option.
Part 4: Additional Configuration Manager Features

In Part 3: Configuration Manager Essentials, the essential Configuration Manager topics to get you up and running fast were explored. In this section, optional Exponare features are described so that you can deliver a powerful GIS to your internal and public users.

See Part 5: Exponare Public for further features that apply only to Exponare Public.

See Part 6: New Enquiry Interface for further features, such as the Ribbon toolbar Application Menu and Quick Access toolbar.

Topics

- Global Layer Groups
- Layer Settings
- Layer Settings Shortcuts
- SQL Support Tables
- Data Binds
- Queries
- Database Connections
- Print Templates
- External Application Links
- Watermarks
- Coordinate Export
- Address Search
- Help
- Views
- Data Editing
Global Layer Groups

Exponare allows you to group together common layers which are presenting multiple work contexts into Global Layer Groups. Work contexts can then reference these groups. This allows configuration of these common layers to be done once, and inherited by all work contexts which reference the group.

This chapter uses the sample data to illustrate how to create and use Global Layer Groups.

In this chapter…

- Organising Data
- Working with Multiple Global Layer Groups
- Global Query Settings
To minimise the effort involved in maintaining your Exponare platform, it is recommended that you use the Global Layer Groups feature of Exponare to specify common layer settings and data binds.

- The Exponare Sample Data
- Creating a Global Layer Group
- Adding Global Layer Groups to a Work Context
- Overriding Global Layer Settings
- Overriding Global Data Binds
- Completing the Reorganisation

The Exponare Sample Data

The Exponare sample data contains the following layers that are in two or more Work Contexts.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Aerial Photography</th>
<th>Animal Control</th>
<th>Cadastre</th>
<th>Cadastre (Melways)</th>
<th>Garbage</th>
<th>Sewerage</th>
<th>Vegetation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 Roads Overview</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Centrelines</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Drainage</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Easements</td>
<td>X</td>
<td>X</td>
<td>✓</td>
<td>X</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>House Numbers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Parks</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Property Parcels</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Railways</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Road Grey</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Road Names</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Stations</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Suburb Boundaries</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating a Global Layer Group

All work contexts use the House Numbers, Property Parcels, Road Grey and Road Names layers. These layers will be added to a new Global Layer Group.

To create a Global Layer Group using the sample data:

1. Open the Configuration Manager

2. Select Global Layer Groups
3. Click Add New Item.

4. Complete the Name property:

<table>
<thead>
<tr>
<th>Name</th>
<th>The name for the Global Layer Group</th>
</tr>
</thead>
</table>

5. Expand the Cadastre Work Context.


7. Click and hold on the Property Parcels layer.

8. Drag the mouse cursor to the Global Layer Group created above.

9. The Property Parcels layer is added to the Group 1 Global Layer Group, complete with Data Binds.

   Add the House Numbers, Road Grey and Road Names layers.

10. You cannot use the drag/drop approach described in steps 7 and 8 if you cannot see the destination location in the Configuration Tree. The alternative method is to use the Copy and Paste buttons.

11. Create a second Global Layer Group containing the layers common to all Work Contexts except for Cadastre (Melways). The layers are:

   - Centrelines
   - Drainage
   - Parks
   - Railways
   - Stations
   - Suburb Boundaries

12. Create a third Global Layer Group containing the Easements layer.
Adding Global Layer Groups to a Work Context

To add Global Layer Groups to a Work Context:

1. In the Aerial Photography Work Context, select Global Layer Groups
2. Click Add New Item.
   The Name property will be populated with the name of the first Global Layer Group created.

<table>
<thead>
<tr>
<th>Global Layer Group Name</th>
<th>Group 1</th>
</tr>
</thead>
</table>

3. Select Global Layers
4. Click Add New Item.
   The Name property will be populated with the name of the second Global Layer Group created.
5. Click Save and Activate Settings.

Overriding Global Layer Settings

There may be occasions where you want to inherit Global Data Binds but not Global Layer Settings.
For example, in the Aerial Photography Work Context, a different icon is used for the Parks layer.

Global Layer Group 2 Parks icon: ![Park]
Aerial Photography icon: ![Park]

To override Global Layer Settings:

1. If necessary, expand the Aerial Photography Work Context.
2. If necessary, expand Layer Settings.
3. Select the Parks layer.
4. Select True from the Override Global Layer settings drop-down list.
5. Click Save and Activate Settings.

Overriding Global Data Binds

The Aerial Photography work context has Data Binds of the same name as those in the Global Layer Groups. Where this is the case, the Data Binds at the Work Context level take precedence over those in the Global Layer Groups.

Completing the Reorganisation

You can now delete duplicated information in the work contexts.
To complete the reorganisation of the sample data:

1. Add the appropriate Global Layers to each Work Context.

2. Delete all layers that are duplicated in the Global Layers that do not feature in:
   - the Selection layer property of a Query
   - the Layer name property of a Layer Settings Shortcut
   - the Layer property of a Watermark.

3. Delete all Data Binds in the layers that remain after step 2 that are duplicated in the Global Layers.

4. Click Refresh Drop-Down Lists.

5. Expand Print Templates at the global level.


7. Open the Data Bind property drop-down list.

8. Select Global

9. Select Group 1 > Property Parcels > Lot Plan Details

10. Click OK.

11. Click Save and Activate Settings.

When re-organizing your data, you may need to respecify Data Binds used by your Print Templates and Application Link-Outs.
Working with Multiple Global Layer Groups

• Duplicate Layers
• Missing Layers

Duplicate Layers

A layer can exist in more than one Global layer group. However, all Data Bind names under the Global Layers Groups node must be unique. If you copy a a Data Bind that already exists under the Global Layers Groups node, it will be renamed.

If a Work Context uses Global Layer Groups that refer to the same layer (eg Group 2 and Travel both contain Railways and Stations), the layer settings used to display those layers in the Work Context will be arbitrary.

When a duplicate layer is added to a Work Context, a warning is written to the event log.

Missing Layers

If a layer in a Global Layer Group is not included in the Work Context's workspace file, it is ignored.
For example, The Travel workspace does not feature House Numbers or Property Parcels which are referenced in the Group 1 Global Layer Group.
Chapter 17: Global Layer Groups

Global Query Settings

Exponare 5.1 onward user can set the query on global layer too.

For any layer included in the using the global layer group, user can select the layer from query drop down to write queries on it. Refer the snapshot below

As you can see in above picture "Property Parcels" layers is seen under global layers section because it is added by the global layer group.

Note: Only one layer with same name will be available in drop down list between the local and global layer. If the layer is available in work context layer section and global layer section also, then layer available in the list is populating on the basis of "Override Global Layer Setting".

There are three ways to add layers in query

1. Layer exists in workspace, but deleted from workcontext layers listed in configuration manager (Such that legend is rendered but not listed in legend).
2. Layer available at "layer settings" section of workcontext level and global layer groups level and uses "Override Global Layer Setting" set to "false" for particular layer. Global layer given preference.
3. Layer available at "layer settings" section of workcontext level and global level both and uses "Override Global Layer Setting" set to "true" for particular layer. Local layer given preference.

Troubleshooting

Symptom

After upgrade, queries stopped working in work contexts which included global layers and queries defined with local layer of same name.

Resolution

This problem would occur on upgrade when following conditions are met-
Global Query Settings

1. Prior to upgrade work context had local and global layer
2. Queries were defined with local layer
3. Override global layer setting is set to “False”

As a consequence, in case of upgrade to Exponare 6.0 user can see the “none” option against the selection layer name like given below ---

Upon upgrading, the local layer will not be seen against Selection Layer. User will find the selection layer set to <none>. Thus, user would have to re-define the relationship of the query with the global layer by choosing the layer available in global layer section.
Spatial Data Access

This chapter provides the instructions for accessing data from a SQL Server or Oracle database for use with Exponare, which requires setting up a database connection.

Exponare lets you access data where it lives, on your machine or on the network, as native (.tab) files, or in a Database Management System (DBMS).

In this chapter...

- Introduction
- Working with spatial data in a DBMS
- Creating a Data Source Connection
- Creating a Data Source Connection to SQL Server
- Creating a Data Source Connection to Oracle
- Opening a DBMS table
- Adding Spatial Tables to Workspace
Introduction

To access data from a DBMS, you need to set up a connection to it. In addition, any DBMS tables that contain spatial data that you want to see on a map must have a record created for them in a special table called the MapInfo Map Catalog. This record contains information about the spatial data. The process of creating this record is called "making the table mappable".

You can access the following types of spatial database:

• Microsoft SQL Server 2008 (32-bit)
• Oracle 10G R2 (32-bit)
• Oracle 11G R2 (32-bit)

Working with spatial data in a DBMS

Exponare enables you to access remote database data through ODBC connectivity support and the Oracle Spatial Object support using externally downloaded linked tab files created in MapInfo Professional.

In order to create a MWS consisting of externally linked tab files use MapInfo Professional to connect to an external database choosing Oracle OCI/ODBC.

Overview of the DBMS Access Setup Process

Install a Database Driver

Access to a database server is through a DBMS driver, which you install on to your machine and is specific to the DBMS you want to connect to. A driver allows Exponare to connect to the database using an ODBC, OLE, or OCI connection. Each type of database supplies its own driver. You may need to obtain the driver from your database administrator and have your database administrator help you set up properties for the driver after installing it.

The version numbers that Exponare supports are:

• SQL Server 2008
• Oracle 10G R2- Oracle driver version used – 10.02.00.04
• Oracle 11G R2 - Oracle driver version used- 11.02.00.01
Prepare your Connection and Database

To work with your DBMS data in Exponare, you need to set up your database connection by following the steps in the sections:

Creating an Externally Linked (.tab) file

Creating a Data Source Connection

The first step to working with data in a DBMS is setting up a data source connection on your machine to the DBMS. This is necessary for a DBMS installed on to your machine or on the network. SQL Server requires an Open Database Connectivity (ODBC) connection and Oracle Spatial requires an Oracle Call Interface (OCI) connection.

Use an OCI connection to Oracle for spatial data. You can use an ODBC connection to any ODBC compatible database and to older versions of Oracle with non-spatial data.

You must have the ODBC driver or OCI installed on your machine before creating a data source connection. For non-Windows databases, such as Oracle, consult with your database administrator for information on how to obtain and install the driver provided with your database.

Before accessing an external database in Exponare, you need to create a data source connection:

- Creating a Data Source Connection to SQL Server on page 179
- Creating a Data Source Connection to Oracle on page 183

Creating a Data Source Connection to SQL Server

Before you begin, you need a SQL Server driver installed on your machine. Check with your database administrator to install the driver for your database.

You need to know the SQL Server name, and the login ID and password if required.

To create a new SQL Server name, and the login ID and password if required:

1. In MapInfo Professional goto File menu, select Open.
2. Select the Open DBMS Connection from the Open dialog box.
3. If the Open DBMS Connection dialog box displays, select ODBC from the list and then click **New**.

4. In the Select Data Source dialog box, select either the **File Data Source** or the **Machine Data Source** tab and then click **New**.

   You can share the connection information for a file data source with other users on the network if they have the necessary drivers, because it is stored in a file. You cannot share the connection information for a machine data source, because it is stored in the registry on the local computer.
5. In the Create New Data Source wizard:
   a. Select the type of data source to create: User Data Source or System Data Source. Make a selection to display the description for it in the wizard. Click Next to continue.
   b. From the driver name list, select the SQL Server driver you have installed for the database and then click Next.
   c. Click Finish.

6. In the Create a New Data Source to SQL Server wizard set the following:
   a. In the first screen provide the following information:
      Description – Optionally, type a description if you plan on connecting to more than one database and would like a description for this connection.
      From the Server list either select from the list or type the name of the SQL Server to connect to.
      Click Next.
b. In the next screen, select how SQL Server will verify the authenticity of the login ID. Optionally select to connect to SQL Server to obtain default settings for more configuration options. Click **Next**.

c. Keep the default settings (check with your database administrator) and click **Next**.

d. Keep the default settings (check with your database administrator) and click **Finish**.

7. In the ODBC Microsoft SQL Server Setup dialog box, click **Test Data Source**.

8. In the SQL Server ODBC Data Source Test dialog box, click **OK**.

   If there were errors, click **OK** to return to the ODBC Microsoft SQL Server Setup dialog box. Click **Cancel** to return to the Create a New Data Source to SQL Server wizard and use the **Back** button to view your settings and make changes. Return to step 5.

9. In the ODBC Microsoft SQL Server Setup dialog box, click **OK**.

10. In the Select Data Source dialog box, under the Machine Data Source tab, your new SQL Server connection displays in the list of available data source connections. Click **OK**.

11. In the SQL Server Login dialog box, type your login ID and password if required and click **OK**.

   **Figure 18-5: SQL Server Login**
If your data includes spatial data, which can be columns holding X and Y values, such as Latitude/Longitude, or a column holding spatial data in the format specified by the database system.

### Creating a Data Source Connection to Oracle

Before you begin, you will need the following installed on your machine:

- Oracle Client – connects to an Oracle database.
- Oracle 10G R2 or 11G R2
- Microsoft ODBC driver for Oracle
- Oracle SQL*Net – for performing SQL queries to the database (optional).

Have your database administrator check that the:

- `tnsnames.ora` file is correctly configured on your machine for the server you want to connect to.
- Service to the database is configured—they may need to run the Net Configuration Assistant utility that Oracle provides to configure the service.
- TCP/IP working properly (using ping.exe).
- Environment variable `TNS_ADMIN` is correctly set to your client_1 path (the Oracle Client installation directory).

To create a new Oracle Spatial data source connection, set up your Oracle Driver:

1. From the **Start** menu, select **All Programs > Oracle ... > Configuration and Migration Tools > Microsoft ODBC Administrator**.
2. In the ODBC Data Source Administrator, under the **User DSN** tab, click **Add**.
3. In the Create New Data Source wizard:
   a. From the driver name list, select the **Oracle in OraClient** driver and then click **Next**.
   b. Click **Finish** to install the driver.
4. In the ODBC Text Setup dialog box, set the following:
   - **Data Source Name** – Provide a name for this data source. This is the name you will see after setting up this connection in the Select Data Source dialog box.
   - **Description** – Optionally, type a description if you plan on connecting to more than one database and would like a description for this connection.
   - Click **OK**.

To set up your Oracle Spatial connection in MapInfo Professional:

1. From the **File** menu, select **Open**.
2. In the Open dialog box, select the **Open DBMS Connection** button.
3. In the **Open DBMS Connection dialog** box, select **ODBC Connection type to Oracle** from the list and then click **New**.
4. **Create New Data Source** dialog appears. Select the System Data Source radio button. Click **Next**.
5. Select the driver for which you want to set up a data source in the **Create New Data Source** and Click **Next**.

6. **Oracle ODBC Driver Configuration** dialog appears. Click **OK**.
7. If you test the connection User Name and password would be asked for.

8. In the MapInfo Oracle Connect dialog box:

   Figure 18-9: MapInfo Oracle Connect Dialog Box

   - **User Name** – Enter the username for accessing the database.
   - **Password** – Enter the password for accessing the database.
   - **Server Name** – Enter the name of the Oracle database that you want to connect to.

   Click **OK**.

## Opening a DBMS table

Settings for the connection to your SQL/Oracle Server should be ready.

To open a SQL/Oracle Server table:

1. From the **File** menu, select **Open**.
Opening a DBMS table

2. In the Open dialog box, from the Files of type list, select the DBMS type to work with. The remote tables available on the selected data source display in the list.

   ▶ Your connections are at the bottom of the Files of type drop-down list and contain a sequential number indicating the order in which the connection was added.

---

Figure 18-10: Open DBMS Tables Dialog Box

3. Select from the Schema list and from the list of tables and then click Open.

4. In the Open DBMS Table Options dialog box, select the type of view you want of your remote data click OK.
Chapter 18: Spatial Data Access

Figure 18-11: Open DBMS Table Options

Select a mode for opening the table in:

- Click **Standard Mode** to open particular rows or columns of the selected table. The instructions in this description assume you are opening the table using Standard Mode.
- Click **Expert Mode** to create a SQL Query to open particular rows or columns of the selected table.

Select to work with the table as linked:

- To open a linked table, click **Download data (Linked Table)** to download the data and create a linked table.

5. If a message dialog displays asking if you want to overwrite the existing file, click **OK**. You have previously opened this file and there is a temporary copy of the file on your machine.

6. Now your .tab files are ready to be added to a workspace (.mws). Once your Work Context is ready, run queries and data binds keeping the database connection as Native. However, if desired other database connections can also be used.

Adding Spatial Tables to Workspace

As an alternative to externally linked tab files users can browse to the external database for spatial tables using Workspace Manager and can add the layers to the workspace. In this case, associated layers of a map are fetched from the external database at runtime. This approach is however not recommended as this can result in significant performance degradation after addition of more than 5 heavy layers.

To create a workspace file rendered directly from an external database, follow the below listed steps.

1. Select **File > Open**.
Adding Spatial Tables to Workspace

2. In the **Open** dialog box, select the **Open Tables** and click the **Open DBMS Connection** button.

3. Choose the connection type- **ODBC** or **OCI**.

4. Browse to the table you want to add to the workspace.

5. Follow the above steps to add more tables.

6. Save your table as a workspace.

7. After you have saved the workspace file, add the password field to the workspace file. Password is not stored by default.

8. Once the workspace is loaded in Exponare, you would have to run data binds and queries by pointing to the corresponding external database connection.

**Recommended settings for SQL Server 2008**

1. For faster rendering of maps using SQL Server, add the following setting to your connection string:
   
   MARS_Connection=Yes.

2. Also add DLG=0 to your connection string.

   Thus with both inputs in place, your connection string for SQL server 2008 would look like this:

   ```
   <ODBCConnectionString>DSN=Exponare_Sql_2008;UID=sa;PWD=abc123;APP=MapXtreme;WSID=SU005SH-W1;MARS_Connection=Yes;DATABASE=ExponareTest;DLG=0</ODBCConnectionString>
   ```

**Troubleshooting**

**SQL_Driver_NO_PROMPT error when loading a workspace in Exponare**

**Symptoms**

On adding a workspace (created using an ODBC connection) to Exponare and then applying **Refresh layer settings** the following error is displayed:
Figure 18-12: Update Layer Settings

To the connection string used in MWS, add the field - DLG=0 and save the workspace file. You may need to Reset the IIS if you have already added the workspace and saved the configuration file.

Apply Refresh layer settings.

Memory is corrupt, issue with Oracle 10g R2 database

Symptoms

If you are connecting to Oracle 10g with a 10g driver, you might come across an error with the following details:

Resolution

There are some known issues with Oracle 10g driver version 10.02.00.01, wherein memory protected issues are reported at workspace manager and Exponare level during rendering of the map.

It is recommended to upgrade to Oracle 10g client version 10.02.00.04 and use this for establishing connections.
Catalog Browser Tool

This chapter explains how to open and work with the Exponare supported Catalog Browser tool.

In this chapter...

- Catalog Browser
- Getting Started
- How to configure CSW for Upgrade cases
Catalog Browser

The Catalog Browser is a tool used by Exponare that allows you to locate descriptive information about spatial and non-spatial datasets. This information is often referred to as metadata. Metadata describes information about the data, such as its title, creation/modified date, coordinate reference system, and location.

Metadata is stored in a catalog as individual records for each dataset. Organizations, particularly those in the public sector, make their catalogs known to others to describe and advertise the availability of their spatial datasets. The Catalog Browser enables you to see what data is available and how to get it.

The Catalog Browser can search any available CSW-compliant catalog. Note that some catalog capabilities are limited by the organization who owns the catalog, such as the ability to edit metadata and access datasets for free. Information from the owner organization is provided in the metadata for each record.

You can search and view metadata records with the Catalog Browser. MapInfo Manager can be used to create the CSW compliant catalogs which can be searched from both Exponare and MapInfo Professional. Exponare uses the same user interface as MapInfo Professional for catalog searching which provides a consistent look and feel between the products and improves ease of use. MapInfo Manager can automatically harvest metadata from your spatial data files. For more information on MapInfo Manager, please contact your PBBI account manager or authorised partner.

For further instructions on how to work with the Catalog Browser, refer to the Catalog Browser User Guide, which can be accessed by clicking on the Help button in the Catalog Browser dialog.

Getting Started

Exponare now supports full integration with MapInfo Manager's catalog service by enabling users to find data by entering key words or searching in the map window. Users can view metadata for the layers they have searched and applied on the map. Also, users can configure the MapInfo Manager's catalog settings and view the metadata corresponding to all layers in Exponare Enquiry.

Configuring Catalog Search to access files from MapInfo Manager

This feature allows you to search, download and apply tab files directly in the Exponare Enquiry session.

1. Click on Search Catalog Rest Public functionality as shown in the below.

   Figure 19-1: Search Catalog
2. This will open Catalog Browser.
3. Click on Catalogs

![Catalog Browser: Exposure Inquiry](image1)

4. Add the catalog URL by clicking on ADD button as shown in below. If any edits are required to an existing server click EDIT.

![Catalog Servers](image2)

5. Test URL and click on OK.

![Catalog Server Definition](image3)
Getting Started

6. Added URL will be visible as shown in the below. Click on OK button.

7. Use the SEARCH to view the available layers in the catalog.

Catalog Browser enables you to find records that correspond to a Map window to see where a record is located on the current map. You can couple it with a text search, as well, to find specific records within the map.

On upgrade and uninstall operations, the MICSW.XML will be saved in a backup folder corresponding to that date. Users can copy and replace over the xml file to carry on with settings saved for catalogue browser in new Enquiry install.

Search within a Map Window

To search for metadata records within a Map window, follow the steps listed below:

1. In Enquiry, set the map view to a location showing the area where you would like to search for metadata records.
2. In the catalog search use the "Search Within" option. By default the value in this option is "None".
3. Change this to "Map Window".
4. Press "Search"
Text based Search

Searching with text is as simple as entering search terms into the text box and clicking the Search button. Every field in the metadata records are searched for the term(s) specified.

1. On the click on SEARCH button and it will show all the layers available for download.

2. Select a layer and right click on LAUNCH as shown in the below .

3. Click on Launch, it will download the layer from the server.
4. On clicking at green status bar, a dialogue box will appear as shown in below.

5. If the same layer has been already downloaded at server, a dialogue box will appear, if you want to overwrite click on YES otherwise click on NO. This allows you to reuse your downloaded files.

6. After clicking on YES button layer will be visible on the map and added to legend.

7. In order to view meta data click on SHOW CSW META DATA as shown in below.
8. To clear the layer applied click on the "Clear Catalog Layer" option.

Catalog Layer only support vector data.

Troubleshooting Tips
• After session reset, layer will be no longer visible on the map and needs to again referred via confi.
• If you are a windows 7 user, you need to ensure that you have write access to "temp" folder to be initiate the process of downloading files.
• Please ensure that the shared location from which the data is being downloaded allows other uses the rights to access this drive.
• While a user can search files and view metadata harvested in MapInfo Manager, but to be able to download files, the network path should still be shared and accessible.
• Users can access only .tab files harvested in the MapInfo Manager. Any other file format or collection of tab files without map data are not supported.
• Seamless tables are not supported using Catalog browser. Metadata search can be performed, but the layer cannot be applied after downloading.

View Metadata using Enquiry
This feature allows you to see metadata as updated in MapInfo Manager, for all layers loaded as a part of work context. For this a user needs to provide MapInfo Manager settings in the Configuration Manager.

Steps to access metadata for workspace layers
1. Open Exponare Enquiry
2. Open Configuration Manager
Getting Started

3. Select the required layer under Layer Setting as shown in the below.

4. On right side there is a new section called Catalog Setting.

5. Under Catalog Setting add Catalog layer UID as seen in MapInfo Manager.

6. Inside Catalog Server URL add the URL of the MapInfo Manager where TAB files have been harvested.

7. Save the settings

8. The layer for which the catalog setting has been done will appear in bold as shown in below.

9. When you hover over the bold layer it shows a text which says click on layer to see associated metadata.
10. Right click on the layer as shown in the below and click on the first option.

11. It shows the metadata as shown below.

In XML view the highlighted character string is the UID which is to be used in Configuration Manager. However, to set it up, this UID has to be accessed from MapInfo Manager metadata settings. Please refer to the below, highlighting how the identifier looks.
How to configure CSW for Upgrade cases

1. In the Configuration Manager, under the Full Menu > File section, add another node.

2. With the added node, configure the following settings, by choosing the command for Search CSW Catalog.

3. Save your settings. This feature is available only in Enquiry. You can reset the Enquiry window and access the functionality from the File menu.
By default, each layer that is defined under a Work Context is automatically displayed in the Legend panel. This chapter describes the Legend panel and discusses Layer settings.

In this chapter...

- Introduction
- The Legend Panel
- Layer Settings
- Layer Group Expand
Introduction

To make the Layers in the workspace file visible to users, you must create a layer settings node. The layer settings node contains properties such as the layer name, selectability, and the icon to use in the Legend/layer panel.

You use the Update Layer Settings button to create the layer settings for a specific Work Context you have created. Whilst it is possible to create the layer settings from scratch you are strongly advised to use the Layer Settings Helper to create the Layers and then modify the settings appropriately to ensure the correct properties have been created.

Ensure that you have a Global or local Layer Setting for each layer on your map. Deleting Layer Settings may cause unpredictable results when the user re-orders layers.

The Legend Panel

The Legend Panel shows information about each layer, and allows the user to manipulate layer visibility, selectability, labeling, and ordering if you allow them to do so.

The Legend can also display an icon.

- The default icon size is 32*32 pixels.

One of two styles of legend can be specified, if appropriate. You can create a custom or you can specify that an automatic legend is to be generated from the underlying data.

You can choose to make the layer name a link, in which case you must also specify the hyperlink URL.

When a Work Context is opened, the Layers are ordered as they appear in the workspace file. The user may alter the order of the Layers as they work with the Legend Panel, but these changes only affect their current session.

The order of the Layers in the Configuration Manager has no effect on the display of the map or the Legend panel.
Figure 20-1: Legend Panel

Legend

- Layers settings
- A "rolled down" legend row
- Layer hypertext
- Thematic icon
- Active row indicator
- Move up
- Move down

Layer Name:
- Essex St
  - Road Names
  - 134
  - House Numbers
- 132
  - Basements
- Albion
  - Buttons
  - A1 Roads Overview
- Central
  - Centrelines
- Railways
  - Railway
  - Tramway
- Drain
  - Property Parcels
  - Suburb Boundaries
- Planning Zones
- Park
  - Parks
  - Road Gray

Label Layer: [Default]
Layers and Selection Results

Layers and Selection Results

The Feature Details panel has a drop-down selector to choose the layer and the Feature for which information is shown. The layer name is shown in the layer selector. The Feature selector shows the names for the Features which are taken from the SQL Query configured for that layer.

The SQL Query

An SQL Query is written to produces results based on a selection that has been made on the layer. The second value in the Select list is displayed in the Feature selector in the Feature Details panel. The SQL query is run against all currently open spatial tables and SQL Support Tables and must comply with the format for MapXtreme 2005. A special table is available called [LAYER]_Selection that provides the users selection set drawn from the workspace table where [LAYER] is the name of the layer as it appears in the workspace. The first value produced by the query must be the MI_Key from the selection table, but this is not displayed to the user.

For example, the SQL Query

```
Select mi_key, Name from Railways_Selection order by Name ASC
```

creates a Data Bind that displays the names of the selected railway stations in the Feature selector of the Feature Details panel and orders them by the name column in ascending order. All layer and column names should match those in the workspace file.

The SQL Query can be used to create a display item that is a concatenation of two or more columns, or is created from a SQL Support Table. For example, the SQL query

```
Select PropertyParcels_Selection.mi_key,
    OwnerDetails.House_Number + ' ' +
    OwnerDetails.Street_Name + ' ' +
    OwnerDetails.Street_Type as "Address"
from PropertyParcels_Selection, OwnerDetails
where PropertyParcels_Selection.PropertyId = OwnerDetails.PropertyId
```

can be used to create a Feature identifier that is made up of parts of the address of the property.

- Concatenation of columns does result in decreased performance, as the querying engine has to do more work on the fly.

The SQL Query property can include an ORDER BY clause as mentioned above. The ORDER BY can be ascending (ASC) or descending (DESC). An example of a descending order by clause is

```
Select mi_key, Name from Railways_Selection order by Name DESC
```
Chapter 20: Layer Settings

The use of ORDER BY clauses will have an impact on the performance of queries. This is because the query engine is required to do more work by sorting the returned data.

Layer Settings

To set layer properties

1. Select a Work Context

2. Select a Layer Settings node

3. Complete the Layer Settings properties and click Save and Activate Settings.

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer has legend</td>
<td>True if the Legend should display an image for this layer.</td>
</tr>
<tr>
<td></td>
<td>To display an auto-generated, set this property to True,</td>
</tr>
<tr>
<td></td>
<td>and leave the custom Legend URL field empty.</td>
</tr>
<tr>
<td></td>
<td>To display a custom Legend image, set this property to True</td>
</tr>
<tr>
<td></td>
<td>and set the Custom legend URL appropriately.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of this Layer Setting.</td>
</tr>
<tr>
<td>Override Global Layer</td>
<td>True if these Layer Settings should override those specified</td>
</tr>
<tr>
<td>settings</td>
<td>at the global level. Default is False.</td>
</tr>
<tr>
<td>SQL Query</td>
<td>An SQL Query that produces results based on a selection in</td>
</tr>
<tr>
<td></td>
<td>this layer.</td>
</tr>
<tr>
<td>Workspace layer name</td>
<td>The name of the Layer as it appears in the workspace.</td>
</tr>
</tbody>
</table>

This is the name of the layer Alias property which may be different from the name of the TAB File the layer represents.

The layer name is case-sensitive.
### Layer Settings

<table>
<thead>
<tr>
<th><strong>Legend Settings</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom legend URL</strong></td>
<td>The URL of an image to use instead of the auto-generated Legend image. To display a custom Legend image, the Layer has legend property must be True. If this setting is blank and Layer has legend is True, then an auto-generated Legend image is provided. This URL can either relative (to the Exponare virtual directory), or absolute.</td>
</tr>
<tr>
<td><strong>Expand Custom roll down</strong></td>
<td>If true, enables the drop-down to be expanded on first time launch of the map. By default, value of this setting is false. You can change this setting to true or false as per your choice.</td>
</tr>
<tr>
<td><strong>Hyperlink target URL</strong></td>
<td>If non-blank, the Layer Name is displayed in the Legend as a hyperlink, and the setting in this field is the hyperlink target. The target URL can be relative (to the Exponare virtual directory) or absolute. If blank, the Layer Name is displayed as plain text. <strong>This setting is applicable to Rest Public only.</strong></td>
</tr>
<tr>
<td><strong>Icon</strong></td>
<td>The URL of an image to use as the icon for this Layer in the Legend panel. If blank, no icon is displayed. This URL can be either relative or absolute. Relative URLs are relative to the root of the Exponare virtual directory. For example: /images/street.gif is typically interpreted as <a href="http://localhost/Exponare/images/street.gif">http://localhost/Exponare/images/street.gif</a>. The image file must be web-readable by an anonymous user.</td>
</tr>
<tr>
<td><strong>Legend labels column</strong></td>
<td>If an auto-generated Legend image is being used, this property specifies the Workspace layer column that provides the text labels for the Legend. A Legend entry is provided for each unique value that exists in the specified column.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>User Control</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User can change auto-labeling</strong></td>
<td>If True, the user can change the auto-labelling of this Layer.</td>
</tr>
<tr>
<td><strong>User can change selectability</strong></td>
<td>If True, the user can change the selectability of this Layer.</td>
</tr>
<tr>
<td><strong>User can change visibility</strong></td>
<td>If True, the user can change the visibility of this Layer.</td>
</tr>
</tbody>
</table>
Chapter 20: Layer Settings

User can see layer in Enquiry Legend
If True, this layer is displayed to the user in the Legend panel.

User can see layer in Public Legend
If True, this layer is displayed to the user in the Legend panel.

User Layer Label Settings

<table>
<thead>
<tr>
<th>User selected layer label</th>
<th>The workspace layer column that provides the text labels for the labels on the map.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User selected layer label font</td>
<td>The font for the labels on the map.</td>
</tr>
<tr>
<td>User selected layer label font size</td>
<td>The font size for the labels on the map.</td>
</tr>
</tbody>
</table>

To set layer groups:

1. Expand Work Contexts.
2. Expand the desired Work Context.
3. Click Groups.
4. Click Add Item.
5. Adjust the desired settings on the right-hand panel.
6. Click Refresh Drop-Down Lists.
7. Expand Layer Settings.
8. Click the desired Layer.
9. Assign the layer to the desired group by using the **Group** drop-down menu on the right-hand panel.
10. Repeat step 8 to 9 for each layer you wish to add to the group.
11. Click **Save**.

Layer Group Expand

As an Administrator you will be able to specify whether the layer group is expanded or collapsed by default in Exponare Enquiry and Exponare Public. In Configuration Manager the Administrator can select True for Layer Group auto expanded and False for Layer Group collapsed.

- A row name Expand is added in the General section of created Group. The row Expand will have drop-down values True and False. The administrator can select any value from the drop-down list.

> False is the default selected value.
Layer Group Expand

- If the administrator sets the value of the row Expand as True then that group will appear auto expanded in the Exponare Enquiry as well as in Exponare Public. All the added layers under that group will be visible.

- If the administrator sets the value of the row Expand as False then the group by default is visible as collapsed in Exponare Enquiry as well as in Exponare Public. The users can manually expand it by clicking on the button of that Group.
Tile Layer

Exponare allows you to use tile server data within the product. If you add a tile server layer to the Exponare Configuration Manager, then the application takes care of fetching the appropriate tiles from the server and displaying them. Tile servers can be accessed from both Exponare Enquiry and Exponare Public.

In this chapter...

- Enhancing Map Data using a Mapping Tile Server
- Configuring Tile Layer Setup
- Adding a Tile Layer
Enhancing Map Data using a Mapping Tile Server

A tile server is a server that contains a collection of raster tile images. The tiles cover a given place on the earth. Tiles are organized in a row/column grid fashion. There are also multiple levels of tiles. Each level represents a different resolution of data, covering the same place on the earth. As you zoom in or out, the level of data may change. As you pan around, the specific tiles that are needed may change.

Exponare lets you use tile server data such as Bing Maps™, OpenStreetMap, and NearMap within the product. If you add a tile server layer to an Exponare map, then the application takes care of fetching the appropriate tiles from the server and displaying them. Once the layer settings have been configured, you can apply the tile layer of your choice in Enquiry and Public clients. It adds the tile server layer to the bottom of the current work context. You will need to ensure that you do not have Solid Fill patterns on the layers in the workspace or they will obscure the tile server. The use of transparency works well for layers that are shown over the top of the tile server layer.

Projection System for applying Tile Layer

To access a tile server layer in Exponare, you will need to change the projection of the workspace it is being added to. All commercial tile servers such as Bing Maps, Google Maps, NearMap, OpenStreetMap, etc use a single projection for the entire world called Popular Visualization CRS / Spherical Mercator coordinate reference system (EPSG:3857). The extents of all tiles as well as the zoom levels (resolution in meters per pixel) are predefined for the whole Earth. For more details about this projection system refer to OpenLayers website.

This coordinate system uses the Mercator projection with a spherical parameter instead of an ellipsoid. This allows map data to properly align with map tiles in Virtual Earth and Google Maps and other web and visualization applications. Thus, to properly overlay workspace data on top of the maps provided by the tile server providers, it is necessary to use this projection.

Impact of changing workspace to Popular Visualization

The Mercator projection has the following advantages:

1. It is a conformal projection, which means that it preserves the shape of relatively small objects. This is especially important when showing aerial view, because we want to avoid distorting the shape of buildings.
2. It is a cylindrical projection, which means that north and south are always straight up and down, and west and east are always straight left and right.

Although the Spherical Mercator projection significantly distorts scale and area, but the maximum impact of this is particularly near poles and its advantages outweigh the scale distortion. The Spherical Mercator projection causes approximately 0.33% scale distortion in the Y direction, which is not visually noticeable.

Changing the Projection system of the Work Context

1. Open the required workspace file (.mws) in Workspace Manager.
2. If the work context includes raster layers, go to the **Raster Reprojection** tab and check the **Raster Reprojection** option.

   ![Information icon]
   You can keep the re-projection default settings or alter them to suit your need.

3. Go to the **Coordinate System** tab in lower left panel.

4. Select the **Coordinate System** button to choose **Projections of the World > Popular Visualisation**.

5. Using the **Map > Change View** option you can change the units for zoom (window width) from the default “miles” to any other preferred unit.

6. Save the .mws file. Reset IIS if the work context is already added to the Exponare server.

### Configuring Tile Layer Setup

You can configure the desired tile layers available from internal and externally hosted tile servers using the Configuration Manager and pointing to the tile server URL. The steps for this are detailed below.

It is important to note that, tile layer configuration is different in case of fresh and upgrade install.

#### Fresh Install

In case of fresh install Tile layer comes with the 3 pre-configured Bing Service Provider nodes. The nodes added are as follows:

- Microsoft Bing Aerial
- Microsoft Bing Road
- Microsoft Bing Hybrid

An additional node "Service Provider" is added for the configuration of the Tile Layer. The user can choose from the predefined 5 options in the Configuration Manager. They are as follows:

1. Bing Aerial
2. Bing Road
Configuring Tile Layer Setup

3. Bing Hybrid
4. Near Map
5. Others

If user select from any of the settings of Bing i.e. Bing Aerial, Bing Road or Bing Hybrid, the copyright and Tile Server URL node gets disabled.

For upgrade user by default Service Provider would be “Others”.

Accessing Bing Tile Service

Now for setting the Tile Server for Bing Road, Bing Aerial or Bing Hybrid, User doesn't require Tile Server URL and the Copyright information. The user just requires the select the desired option from the Service Provider. As soon as the User selects the service provider URL for the Bing Aerial, Bing Road or Bing Hybrid the Copyright and Tile Server fields clears and gets disabled.

The User won't be able to apply the Bing Tile Layer on the map if you try to access old Bing URL like "http://ecn.t3.tiles.virtualearth.net/tiles/a{QUADKEY}.png?g=392" with "Others" option as Service Provider. If you have upgraded from 4.5 to later version, Bing Tile Server configured will also not be able to use them.

Changes in NearMap Tile Services

To access near map tiles for upgrade and fresh User you need to do the following steps:

1. Select the Service Provider as "NearMap" in the Configuration Manager.
2. Put the valid Tile Server URL for Near Map as http://www.nearmap.com/kh/?v=57&x={ROW}&s=&y={COL}&z={LEVEL}&nml=Vert in the Configuration Manager.
3. The User need to replace the "customername" with the valid user name and "customerpassword" with the valid password field in the Web.Config file present in the server as given screen shot in order to access NearMap tile service.
Adding a Tile Layer

If you want to add a new tile server URL, refer the following steps.

As an administrator you will need to create a Tile Layer under the Tile Layer node tree list.

1. Select the Tile layer node.

2. Click Add New Item to create a new Tile Layer.

3. Tile Layer Licensing and Copyright dialog appears.

   ![Image of Tile Layer Licensing and Copyright dialog]

   **Note:** Even if you know the URL for a tile server, access to it may not be free. Please contact the tile server provider to ensure you are appropriately licensed to use the tile server before setting it up in Exponare. Exponare users are permitted to use Bing Maps for internal use free of charge. For external use (on public web sites), Bing Maps is free for public sector clients. Commercial clients will need to pay a fee. Please contact your account manager or PBBI partner for details.


   Provide the credentials of the new user for the following fields:

   ![Image of Tile Layer configuration fields]

   **Client Type**
   
   The type of client to display this "Tile Layer" for. From this drop down menu you can select All/Enquiry/Public.

   - **Enquiry** This displays the Tile Layer in Exponare Enquiry only.
   - **Public** This displays the Tile Layer in Exponare Public only.
   - **All** This displays the Tile Layer both in Exponare Enquiry and Exponare Public.
Adding a Tile Layer

Copyright
Ensure you specify any necessary copyright information, as required by the Tile Layer vendor. Do not alter the Bing copyright information.

Name
The name of the Tile Layer as shown to the user. This name should be unique.

Tile Server URL
The address of the tile server.

For reference you can use the following URLs (if appropriately licensed):

- OpenStreetMap: http://tile.openstreetmap.org/(LEVEL)/(ROW)/(COL).png
- NearMap: http://www.nearmap.com/kh/?v=57&x={ROW}&s=&y={COL}&z={LEVEL}&nml=Vert

In case the Exponare server is using proxy setting then please talk to your IT team for granting the access to various tile servers.
Layer Settings Shortcuts

In this chapter…

- Introduction
- Creating a Layer Settings Shortcut
Introduction

A Layer Settings Shortcut is a quick way to invoke a group of changes to the layer settings shown in the Legend panel, including Layer Visibility, Layer Selectability, layer order, and auto labelling.

For example, you can define a Layer Settings Shortcut to bring all the roads Layers to the top of the layer list and make them visible. Another example is a shortcut that toggles the visibility of a number of raster Layers.

Creating a Layer Settings Shortcut

1. Select a Work Context.
2. Select Layer Settings Shortcuts.
3. Click Add New Item.
4. Complete the Layer Setting Shortcut properties.

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change layer ordering</td>
</tr>
<tr>
<td>If True, this Layer Settings Shortcut alters the position of one or more Layers (which may affect the map display and the Legend ordering). To cause layer re-ordering, set this property to True and add child nodes that describe the Layers and their new positions in the layer order.</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>The description of the Layer Settings Shortcut, shown in the status bar when the mouse is hovered over a Layer Settings Shortcut Name in the Shortcuts menu and used as tooltip text when the mouse is hovered over the Layer Settings Shortcut icon on the toolbar.</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>The name of the Layer Settings Shortcut as shown to the user in the Shortcuts menu.</td>
</tr>
<tr>
<td>Work Context auto labelling</td>
</tr>
<tr>
<td>How this Layer Settings Shortcut affects the auto-labelling for the entire Work Context. Auto labelling can be turned on, off, left unchanged, or toggled to the opposite of its current state.</td>
</tr>
<tr>
<td>Toolbar</td>
</tr>
</tbody>
</table>

*It is not applicable in Rest Public.*
Chapter 22: Layer Settings Shortcuts

Appears as Toolbar Shortcut
If True, this Layer Settings Shortcut appears as a shortcut button on the toolbar. Requires that the User Interface has a toolbar that includes the Layer Settings Shortcuts Menu Items command.

Icon
Exponare Enquiry only.
The image to use as the toolbar icon for this query.
The image should be present in the Default\RibbonSmall or Default\RibbonLarge folder under the theme based on your requirement.
If you wish to override this image, the override image of the same name should be added to the relevant theme folder.
If you wish to provide image outside the theme folder then you can give the relative path of the image placed in a virtual directory.
The image file should be web-readable by an anonymous user.
The relative path should have a forward slash.
The Format of path should be /[Web Application]/[virtual directory]/[image file (with extension)] e.g. /Exponare/Icon/Image.png
If left blank, the images used will be dependent on the Theme specified for the user interface, e.g. Query0.gif, Query1.gif etc.

5. Click **Save and Activate Settings**.

6. Add a Layer Settings for Shortcuts node for each layer that is to be altered by this shortcut as described below.

To add Layer Settings for Shortcuts:

1. Select a Layer Settings Shortcut node 🔄

2. Click **Add New Item** 🔄

3. Complete the Layer Settings for Shortcut properties.

<table>
<thead>
<tr>
<th>General</th>
<th>Should the layer be auto-labelled after this Layer Settings Shortcut is applied, chosen from &quot;yes&quot;, &quot;no&quot;, &quot;unchanged&quot;, or &quot;toggle&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-labelled</td>
<td>Should the row for this layer be &quot;rolled-down&quot; in the Legend after applying this Layer Settings Shortcut, chosen from &quot;yes&quot;, &quot;no&quot;, &quot;unchanged&quot;, or &quot;toggle&quot;.</td>
</tr>
<tr>
<td>Layer name</td>
<td>The layer whose properties are to be altered, selected from the list of configured Layers for this Work Context.</td>
</tr>
</tbody>
</table>
Layer Shortcut Button ON/OFF State Feature

<table>
<thead>
<tr>
<th>Selectable</th>
<th>The selectability of the Layer after this Layer Settings Shortcut is applied, chosen from &quot;yes&quot;, &quot;no&quot;, &quot;unchanged&quot;, or &quot;toggle&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>The visibility of the Layer after this Layer Settings Shortcut is applied, chosen from &quot;yes&quot;, &quot;no&quot;, &quot;unchanged&quot;, or &quot;toggle&quot;.</td>
</tr>
</tbody>
</table>

4. If necessary, adjust the position of the layer by using the position buttons in the command bar of the Configuration Manager.

5. Repeat steps 1 to 4 to add additional Layers.

6. Click **Save and Activate Settings**.

---

Work Context Auto Labeling, Appears as Toolbar Shortcut, Icon and Expand in Legend settings are not available in Rest public for Layer Settings Shortcut.

Layer Shortcut Button ON/OFF State Feature

A shortcut button is available to attain a visual feedback about the state of layer, whether the layers are currently ON or OFF.

As an Administrator/User you will be able to create the Layer Settings Shortcut Button so that it can be changed to toggle button. Administrator will have to setup the ON/OFF state and a default initial state for the button.

If Appear as Toolbar Shortcut is selected as True, it appears as a shortcut button on the toolbar. It requires that the User Interface has a toolbar that includes the Layer Settings Shortcut Menu Items command.
Parks Layer with Visibility set as Toggle

- Clicking the shortcut button, will turn ON the features on the map and the visibility of the button will be seen selected.
- On the other hand, clicking the shortcut button again, it will turn OFF the features on the map and the visibility of the button will be seen selected.
Layer Shortcut Button ON/OFF State Feature
SQL Support Tables

In this chapter…

- SQL Table Names
- SQL Support Tables
SQL Table Names

Exponare SQL can access data from SQL Support Table files (*.TAB) and workspace files (*.MWS). In each case, the name of the table (as used in SQL statements) is the name of the underlying file ignoring the extension. The "Name" property that is associated with a Work Context or an SQL Support Table configuration item is not used when specifying SQL statements.

If a table or workspace filename has unusual characters or spaces, you might want to rename it with a simpler name. If this is impractical, you can surround the name in double-quotation marks wherever it is used in a SQL statement.

For example, if you have a Work Context called "My Workspace" that is based on My Workspace.mws, this could be referred to in a SQL statement as "My Workspace":

```
Select * from "My Workspace" where ...
```

SQL Support Tables

Along with the data loaded through the configured workspace, you can also load in extra SQL Support Tables to be used by the Data Binds and Queries. This data is loaded along with the workspace file on a Work Context change and is available to be accessed by the data binds and Queries in the same way as the tables in the workspace.

An SQL Support Table is a MapInfo Professional TAB File (a .TAB file). The Tab file may refer to an external database table if required. For full details on the TAB file formats and referring to databases, see the MapInfo Professional documentation.

Creating an SQL Support Table

1. Create a MapInfo Professional TAB File that contains, or refers to, your data.

2. Select and open a Work Context.

3. Select SQL Support Tables.

4. Click Add New Item.

5. Complete the Support Table properties:
### Chapter 23: SQL Support Tables

#### General Description

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>The name for the SQL Support Table as shown to the user.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TAB filename</strong></td>
<td>The name of the TAB File that represents this SQL Support Table. This file can be specified as a relative path (relative to one of the directories in Application Settings&gt;Data directories or the Exponare virtual directory), an absolute path, or a UNC path. The TAB File must be readable by the Internet user.</td>
</tr>
</tbody>
</table>

6. Click **Save and Activate Settings**.
SQL Support Tables
This chapter explains the concepts of Data Binds using a number of examples. Data Bind Details and Data Bind Hyperlinks are covered too.

In this chapter...

- Background
- Configuring a Data Bind
- Data Bind Hyperlinks
You use a Data Bind to specify additional information to be displayed about a selected item on the map. A Data Bind is an SQL statement that is linked to a specific layer on the map, and whenever any Features are selected on that layer, the SQL statement is executed and the resulting information is displayed in the Selection Results panels (Feature Details and/or Data Bind Details).

To configure a Data Bind, the main task is to write an SQL Query that extracts Feature information. The Query can be run against any open tables in the Work Context—that is, any tables that are part of the workspace as well as any tables that have been configured as SQL Support Tables.

If the result of a Data Bind is a HTML snippet, it is displayed as literal text and is not interpreted or processed in any way.

Data Binds specified at the Work Context level take precedence over those specified at the Global Level.

The Exponare CD-ROM contains a reference manual for the MapInfo SQL language. This manual is also available in the Exponare server directory.

- The '_Selection' Table
- The 'mi_key' Field
- Table Joins
- The 'as' Syntax
- The 'order by' Syntax
- Uniqueness of Column Names
- Remote Data Binds
- Remote Data Binds

The '_Selection' Table

When a selection has been made on a layer, a new temporary table is created. This table has the same name as the table the selections have been made on, but with the addition of the string '_Selection' to the name. For example, if there is a table in the workspace called PropertyParcels and a selection has been made on that layer, then there will be a temporary table created called PropertyParcels_Selection, which contains a copy of all the items in the PropertyParcels layer that have been selected. This allows you to access the selected items in the SQL Query you define.

For example, if the PropertyParcels layer contains non-spatial data in the columns propertyId, owner_name and property_type that you want to view, you would configure a Query as follows:

```sql
Select
  mi_key, propertyId, owner_name, property_type
from
  PropertyParcels_Selection
```

Then, when any selections are made on the PropertyParcels layer, the information from the propertyId, owner_name and property_type fields are displayed in the info panel for all the selected items.
Chapter 24: Data Binds

The 'mi_key' Field

In the sample Query defined above, the first column name specified is a column called mi_key. This is a required column that must be the first column specified in all Data Bind SQL Queries as it is used to identify the spatial Feature information. If this column is missing from the SQL Query, or is not the first column specified in the SQL Query then the Data Bind will not return any information to the Feature Details and/or Data Bind Details panels.

The mi_key data is not displayed in the Feature Details or Data Bind Details panels.

Table Joins

Your SQL Query is executed against all the SQL Support Tables currently open. These include all tables that are part of the workspace file as well as all tables configured as an SQL Support Table, so your SQL Query can perform a join and return information from any of these tables.

For example, if you have a table called OwnerDetails with various columns containing non-spatial data and a foreign key column that points to the propertyId column of the previously-described PropertyParcels table, you can set up an SQL Query as follows:

```sql
Select
    PropertyParcels_Selection.mi_key,    
    OwnerDetails.owner_name,             
    OwnerDetails.owner_address
from
    PropertyParcels_Selection, OwnerDetails
where
    PropertyParcels_Selection.propertyId = OwnerDetails.propertyId
```

The mi_key column returned must be the mi_key column from the table on which the map selections have been made.

For full details of the SQL syntax available, consult the MapInfo SQL documentation.

The 'as' Syntax

The Selection Results Panel displays the results of each SQL Query as a table. The names of the columns of these tables are taken from the SQL Query you define. Therefore, you can alter the names displayed in the selection results panels using the as syntax of SQL to re-name the columns being returned. For example, if the above Query was written as follows:

```sql
Select
    PropertyParcels_Selection.mi_key,    
    OwnerDetails.owner_name as "Name of owner",  
    OwnerDetails.owner_address as "Address of owner"
from
    PropertyParcels_Selection, OwnerDetails
where
    PropertyParcels_Selection.propertyId = OwnerDetails.propertyId
```

the info panel displays the data returned in columns with the heading Name of owner and Address of owner.
The ‘order by’ Syntax

The order by syntax can be used to order the results in the Data Bind Details panel. For example, if a Query was written as follows

```sql
Select
    PropertyParcels_Selection.mi_key,
    OwnerDetails.ownersurname as "Name of owner",
    OwnerDetails.owneraddress as "Address of owner"
from
    PropertyParcels_Selection, OwnerDetails
where
    PropertyParcels_Selection.propertyId = OwnerDetails.propertyId
order by
    "Name of owner" ASC
```

then the results will be ordered by OwnerDetails.owner_name in ascending order in the data bind details panel. To order the results in descending order replace ASC with DESC. The order by syntax decreases performance of the Query as more work is required by the query engine in order to sort the results.
Uniqueness of Column Names

The names of the columns returned in the select statement must be unique, or the Data Bind results will not be displayed in the info panel. If the names of the specific columns on the SQL Support Tables from which the data is being returned are not unique, use the as syntax to rename columns to unique values. For example, the following SQL Query uses the as syntax to ensure uniqueness. The columns PropertyParcels.PropertyId and OwnerDetails.PropertyId would clash as they both reference columns named PropertyId; however, by aliasing them to Property Id and Owner Id respectively, uniqueness is preserved.

```sql
Select
  PropertyParcels_Selection.mi_key,
  PropertyParcels.PropertyId as "Property Id",
  OwnerDetails.PropertyId as "Owner Id",
  OwnerDetails.owner_name as "Name of owner",
  OwnerDetails.owner_address as "Address of owner"
from
  PropertyParcels_Selection, OwnerDetails
where
  PropertyParcels_Selection.propertyId = OwnerDetails.propertyId
```

Data Bind SQL Example

The following Query is a relatively complex example of a SQL Query for a Data Bind:

```sql
Select
  PropertyParcels_Selection.mi_key,
  PropertyParcels_Selection.PropertyId as "Property No",
  PropertyDetails.SPI as "Parcel ID",
  PropertyDetails.PFI as "Folio ID",
  PropertyDetails.Lot_Number as "Lot No",
  PropertyDetails.Plan_Number as "Plan No"
From
  PropertyParcels_Selection,
  PropertyDetails
Where
  PropertyParcels_Selection.PropertyId = PropertyDetails.PropertyId
```

Configuring a Data Bind

To configure a Data Bind:

1. Select a Work Context.
2. Select a Layer Setting.
3. Click Add New Item.
Configuring a Data Bind

4. Complete the Data Bind General properties:

<table>
<thead>
<tr>
<th>Description</th>
<th>The description of the <strong>Data Bind</strong> as shown to the user when the mouse is hovered over the <em>Data Bind</em> Name.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Execution Mode</th>
<th><strong>On Demand</strong> means the databind is executed when the Enquiry user performs an action to view the data of that databind. <strong>Always</strong> means the databind is executed as soon as the feature is selected on the map.</th>
</tr>
</thead>
</table>
Chapter 24: Data Binds

### General

| **Maximum Rows** | The maximum number of rows to be displayed. |
| **Name**         | The description of the Data Bind as shown to the user as a tab in the Data Bind Details panel. |

Don't use round brackets "()" in the name of Databind.

### SQL Query

A SQL Query that produces results based on a selection that has been made on the parent layer. Each of the values produced is listed in the Selection Results in a section for this Data Bind. If the Database Connection type is "Native", then the SQL Query is run against all currently open spatial tables and SQL Support Tables and must comply with the MapInfo SQL syntax. A special table is available called \[LAYER\]_Selection that provides the users selection set drawn from the workspace table. The field \[LAYER\] should be the name of the parent layer as it appears in the workspace. The first value produced by the Query must be the mi_key from the selection table, but this is not displayed to the user. For example, the SQL Query `Select mi_key, SP_UFI, Name, Type from Railways_Selection` creates a Data Bind that displays three values to the user for each Feature that has been selected on the Railways table. If the SQL Query returns multiple rows (most commonly from a join), the separate rows can be viewed by the user. All layer and column names should match those in the workspace file.

If the Database Connection type is not "Native", then the SQL Query is to be run in an external database server. In this case, the SQL syntax must comply with the syntax of the server it will be executed on. The Query should return all the values that are to be displayed in the Data Bind, as well as - in the first column - the values that are to be matched against the Bind column of the map layer to bind these rows to the spatial objects. This first column will not be displayed in the resulting Selection Results.

If you are running a Query on an external database server, the Remote Database properties must be entered:

### Remote Database

| **Bind Column** | The column of the map layer that contains the values to bind the database table(s) against. |
| **Database Connection** | The Database Connection to access for running this Query. See Database Connections |
Configuring a Data Bind

5. Click **Save and Activate Settings**.
6. If required, add **Data Bind Hyperlinks**.

Remote Data Binds

It is possible to specify a Data Bind to be a Remote Data Bind, which executes the Data Bind Query on a remote database server and bring the results back into Exponare. This is done by setting the Database Connection field to a non-native Database Connection. You must also define the Bind column which defines the map layer used to bind against, and modify the SQL syntax accordingly.

The Bind Column

The Bind column is the column on the map layer used to bind the results of the Query. The data in the first column returned by the SQL Query must contain values that are contained in the Bind column on the map layer and this first column must also have the same name as the Bind column.

The name in the Bind column setting is case-sensitive and must match the name of the column in the TAB File exactly.

The SQL Query Syntax

The SQL Query is executed on the remote database rather than inside Exponare. As a result, the syntax of the Query must be that used by the database server, and not the MapInfo SQL syntax used for internal Exponare SQL processing.

This means that the MapXtreme tables such as the \[layername\]\_Selection table are not available to be accessed by this Query, as the external database does not have access to the MapXtreme tables. Also, MapInfo SQL functions cannot be used in a Remote Data Bind as the external database does not implement MapInfo SQL, but its own flavour of SQL.

The first column returned by the SQL Query must have the same name as the Bind column. This can be done by aliasing (ie use of the as syntax) if the column name in the database does not have the same name as the Bind column.
Chapter 24: Data Binds

The Exponare.Ids Flag

The special key `Exponare.Ids` is used to represent the IDs of the selected items on the map in the SQL Query. This key must be present in the SQL Query, and when the Query is processed, the key is replaced with a list of all the values from the Bind column of the selected items on the map.

As an example, assume a map layer has a Bind column called `PropertyId`. The following SQL syntax would return Data Bind information from a SQL Server database that is bound to the spatial map objects through the unique column.

```sql
SELECT
  PropertyId, Owner_Name, Owner_Address, Owner_Type
FROM
  Owner_Details
WHERE
  PropertyId in (Exponare.Ids)
```

As a result of this Query, the Feature Details Panel displays the `Owner_Name`, `Owner_Address` and `Owner_Type` information for each selected item on the map.
Data Bind Hyperlinks

You can configure particular columns in a Data Bind to link to a web page. Links of this kind can be displayed as either a hyperlink or as a thumbnail. In either case, clicking on the link loads the associated URL in a new web browser window.

In Exponare Enquiry, thumbnail images in the feature details panel will be scaled down if they are wider than the available area, or if they are taller than 50 pixels. In the Data Bind details panel thumbnails will be scaled to fit in their cell.

To configure a hyperlink or thumbnail link, you must set up two columns of data in your Data Bind and configure a special column node. The first column should contain the item to be displayed in the Selection Results panels. To specify a textual hyperlink, the first column should contain the text to be displayed. For a thumbnail image hyperlink, the first column should contain a URL that points to the thumbnail image to be displayed. The second column should contain the associated URL.

The URLs specified can be either absolute URLs or relative URLs. If there is a leading forward slash, then the URL is treated as relative to the Web Server root. If there is no leading forward slash, then the URL is treated as relative to the Web Application root.

For example, if your machine server name is myServer and you have installed Exponare under the virtual directory Exponare, then URLs will translate as follows.

\images/.jpg   ->  http://myServer/Exponare/\images/.jpg

If you wish to create hyperlinks that are different for each record, you may find that using dynamic columns in your SQL Query is the best solution. A dynamic column is one that is calculated rather than read directly from an SQL Support Table. For example, if you wish to have a hyperlink for each Feature that opens an external web form for that property you have two options:

Option 1

Create an explicit column in an SQL Support Table that has the appropriate hyperlinks. For example a TAB File might contain the following data

<table>
<thead>
<tr>
<th>ID</th>
<th>...</th>
<th>URL</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID1</td>
<td></td>
<td><a href="http://server/page.aspx?feature=ID1">http://server/page.aspx?feature=ID1</a></td>
<td>&quot;Link to external form&quot;</td>
</tr>
<tr>
<td>ID2</td>
<td></td>
<td><a href="http://server/page.aspx?feature=ID2">http://server/page.aspx?feature=ID2</a></td>
<td>&quot;Link to external form&quot;</td>
</tr>
<tr>
<td>ID3</td>
<td></td>
<td><a href="http://server/page.aspx?feature=ID3">http://server/page.aspx?feature=ID3</a></td>
<td>&quot;Link to external form&quot;</td>
</tr>
</tbody>
</table>

and then create a special Data Bind with active column = "URL" and display column = "link".
Option 2
Create dynamic columns by using a Data Bind SQL Query such as:

```sql
Select
    mi_key, ...
    'http://server/page.aspx/?feature=' + ID as "URL",
    'Link to external form' as "Link"
From
    PropertyParcels_Selection
```

and specify active column = URL and display column = Link.

The dynamic hyperlink may be more convenient than having to create extra columns in your TAB Files just to enable a link to an external form.

To add Data Bind Hyperlinks

1. Select a Data Bind.
2. Click Add New Item.
3. Complete the Data Bind Hyperlink properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active column</td>
<td>The column in the Data Bind which contains the URL to be activated for this Data Bind Hyperlink. The column name must match the name as shown to the user (which differs to the workspace column name if an AS clause has been used). The URLs listed can either be relative (to the Exponare virtual directory) or absolute. The target of the URL must be web-readable by an anonymous user.</td>
</tr>
<tr>
<td>Display column</td>
<td>The column name of the Data Bind that contains the value to display for the Data Bind Hyperlink. The column name must match the name as shown to the user (which differs to the workspace column name if an AS clause has been used). The entry should contain the text to display, or a URL to a thumbnail. A thumbnail URL can be either relative (to the Exponare virtual directory) or absolute, and the thumbnail must be web-readable by an anonymous user. The type of this entry (either text or thumbnail) is specified in the Is thumbnail property.</td>
</tr>
<tr>
<td>Is thumbnail</td>
<td>If True, this Data Bind Hyperlink is displayed as a thumbnail hyperlink. If false, this Data Bind Hyperlink is displayed as a text hyperlink.</td>
</tr>
<tr>
<td>Name</td>
<td>The unique name of the Data Bind Hyperlink.</td>
</tr>
</tbody>
</table>

4. Repeat steps 1 through 3 to add additional Data Bind hyperlinks.
5. Click Save and Activate Settings.
Queries are one of two methods to select Features on a map, the other being the map selection tools such as rectangle select. The main benefit of Queries is that the user does not need to know ahead of time where exactly the Features are. The main drawback is that Queries can only make selections on a single layer at a time. That is, a single Query cannot select roads and houses simultaneously (unless both houses and roads were on the same map layer).

If a Query is run and it successfully selects Features on the map, Selection Results may be displayed that show details about those Features. The information is controlled by Data Binds that are configured for the corresponding map Layers. That is, the Query used to select the properties has no bearing on the Selection Results—the Selection Results produced by a Query are identical to those produced by manually selecting properties with the map selection tools.

In this chapter...

- Query Processing Overview
- Query Types and Parameters
- Creating a Query
Query Processing Overview

There are two stages to Query processing: user interaction, and SQL statement preparation. During the user interaction stage, a Query string is provided to the user that can contain one or more parameters. Once the user has chosen the values they want for the parameters, the user submits the Query. After submitting the Query, the parameters are extracted and a SQL statement is constructed to calculate the resulting selection set.

Configuring a Query is a two-step process:

1. Determine what the user will see and what parameters they can modify,
2. Define a SQL statement to make the selection.

The Query, as seen by the user, is defined by a user text template. A user text template is a string that may contain references to Query Parameters, for example

```
Select all properties with an SPI number of {SPI_Number}.
```

Note that a parameter is included in the template by using braces. The name of the parameter, in this case `SPI_Number`, must correspond to a Query Parameter. The Query Parameter must have the same name as the parameter in the template between the two braces. Thus for the example above, a Query Parameter would be created with the name `SPI_Number`.

When the user is shown the Query, the parameter `SPI_Number` will be accessed to determine how the parameter is displayed.

The Query, as used by the server, is defined by a SQL template. The SQL template can also reference the Query Parameters. For example the SQL template corresponding to the above user text template might be

```
Select mi_key from PropertyParcels where SPI = @SPI_Number
```

The parameter name used in the SQL Query should be identical to the name of the corresponding parameter, plus an additional character `@` first. This is standard SQL syntax to indicate a parameter in the Query.

The SQL string for a Query should be in the format:

```
SELECT mi_key FROM <Table_Names> [WHERE <conditions>]
```

A full MapInfo SQL reference is provided on the Exponare CD-ROM and in the documentation directory of the Exponare Server.

The Query is used to select spatial items on a map layer, so there is no data returned from the Query apart from the `mi_key` values which are used to select items on the map. The `Table_Names` list can contain any spatial or non-spatial tables that are open in the current Work Context. The `Table_Names` list must contain the name of the spatial table to select from, as this is the table from which the `mi_key` value will be drawn.

The optional WHERE condition is the place to use the parameters. You can configure a subset of the spatial objects to be selected depending upon the criteria entered by the user.

For example, assume your Work Context contains a spatial layer called `property` with a primary key field of `id` and a non-spatial layer called `property_data` with a foreign key field of `property_id`. Also assume that the table `property_data` has a field called `street_address`. 

240 Exponare 6.0
Chapter 25: Queries

To make a Query that allows the user to enter a street address value that will select all properties on the map, create a Query linked to the property layer that uses the following SQL template:

```
SELECT
  mi_key
FROM
  property, property_data
WHERE
  property.id = property_data.property_id AND
  property_data.street_address = @StreetAddress
```

The SQL parameter @StreetAddress is replaced by the value entered by the user. When executed, the results of the Query are selected on the map and the Selection Results are updated.

When using a like operator as part of the WHERE clause to filter the results of the Query, the user must enter a wildcard character in the input parameter. In the case of MapInfo SQL, the available wildcard character is % for a zero-or-more match.

The optional ORDER BY clause can be used to order the results of the Query. For example

```
SELECT
  mi_key, property_data.street_address
FROM
  property, property_data
WHERE
  property.id = property_data.property_id AND
  property_data.street_address = @StreetAddress
ORDER BY
  property_data.street_address ASC
```

will order the results based upon the property_data.street_address in ascending order. It is necessary to select any fields that are going to be used in ORDER BY clauses when using MapInfo SQL. Descending order can be specified by replacing ASC with DESC.

If no ORDER BY clause has been defined in the SQL Query property of the layer then this will affect the order of the Features in the feature picker drop-down. If no ORDER BY clause has been defined in the Data Binds for the selected layer then this will affect the order of the Features in the data bind details panel. This will only have an effect when a native database connection is being used.
Running a Query on a Remote Server

It is possible to run a Query on a remote database server. This is done by setting the database connection field to a non-native database connection. You must also define the bind column on the map layer that will be used to bind against, and modifying the SQL syntax accordingly.

The Bind Column

The bind column is the column on the map layer that is used to bind the results of the Query. The Query must return one column only, and the values in this column will be used to select items on the map by binding against the Bind Column.

The SQL Query Syntax

The SQL Query is executed on the remote database, and not inside Exponare. As a result, the syntax of the Query must be that used by the database server, and not the MapInfo SQL syntax used elsewhere. This affects such things as the syntax used to define a parameter in the SQL string (‘@’ is necessary as a prefix in many standard databases, while in Oracle ‘:’ is necessary as a prefix, and in ODBC connections it is sometimes necessary to only use ‘?’ as a parameter name), and the characters to use as wildcards for a like operator.

Query Types and Parameters

Exponare provides a variety of Query types to address different requirements.

<table>
<thead>
<tr>
<th>Parameterless Queries</th>
<th>A Query that has no user-editable parameters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Queries</td>
<td>A Query that has a fixed structure, but which contains one or more parameters.</td>
</tr>
<tr>
<td>Advanced Queries</td>
<td>A Query that has a user-editable structure that provide for complex user configurable Queries.</td>
</tr>
</tbody>
</table>

A list of Queries can be added to a menu, and a set of special Queries can be added to the toolbar. See Menus and Toolbars for more information.
Parameterless Queries

A parameterless Query cannot be modified by the user. Examples of parameterless Queries are: “Select all roads”, or “Select the Town Hall”.

For example, to create a Query for selecting all roads, the following might be appropriate:

<table>
<thead>
<tr>
<th>Query Property Name</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select all roads</td>
</tr>
<tr>
<td>User text template</td>
<td>Select all roads</td>
</tr>
<tr>
<td>SQL template</td>
<td>Select mi_key from Roads</td>
</tr>
</tbody>
</table>

Basic Queries

A Basic Query allows the users to specify one or more fixed parameters.

For example, “Select all roads that are in the Suburb Coburg.”, where “roads” and “Coburg” are parameters that can be altered by the user.

For example, to create the example Query above, use these settings:

<table>
<thead>
<tr>
<th>Query Property Name</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select all road types in a suburb</td>
</tr>
<tr>
<td>User text template</td>
<td>Select all {RoadType} in suburb {SuburbName}.</td>
</tr>
<tr>
<td>SQL template</td>
<td>Select mi_key from Roads where ROAD_TYPE=@RoadType and SUBURB=@SuburbName</td>
</tr>
<tr>
<td>Selection Layer</td>
<td>Roads</td>
</tr>
</tbody>
</table>

Basic queries should meet most requirements. You can skip the section on advanced queries unless you need queries that can have a variable number of parameters.

Query Parameters

• Basic Query Parameters
• Text Input Parameters
• Drop-Down List Parameters
• Dynamic Drop-Down List Parameter
Query Types and Parameters

**Basic Query Parameters**

A Basic Query Parameter is an item in a Basic Query that can be specified by the user. For example, a Query of the form

`Select all the [Feature type] within [Suburb Name]`

has two basic parameters: **Feature type** and **Suburb Name**.

If the example Query shown above was for a roadways map, the Feature types might be one of five values: streets, roads, highways, intersections or traffic lights. The various Suburb names might not be known and the user could be required to type in the name. Alternatively, the set of suburb names could be defined in a database table. These three different situations use three different Basic Query Parameters types. We discuss each below.

Each Basic Query Parameter is associated with a single Query and appears in the Configuration Manager as a child node of that Query. Each Query Parameter has a Name field which must be unique for its parent Query.

**Text Input Parameters**

A Text Input parameter is displayed to the user as a textbox. The user can type whatever they like into the textbox. Optionally, the administrator can declare the data type, such as numeric or date.

Text Input parameters are the most general type of Query Parameters, but they are also the most difficult for the user, as correct spelling and assumptions about the data are required. However, for many tasks, a textbox entry is convenient for both the administrator and the user.

A dynamic drop-down Text Input parameter gets its list of items by running a SQL select statement. If there is no parameter, the textbox works as a generic textbox.

For example, consider the Query: “Select all houses that have a dog of breed [DOG_BREED]". If there are many different dog breeds, and if they are already available in a table, then it is most convenient to refer to that table directly. For this example, the following SQL select statement might be appropriate

```
Select breed from Dogs group by breed
```

If the statement contains a reference to another parameter within the query, the filtering of the auto-suggest list can be configured to take this dependency into account. Then, it dynamically only shows auto-suggest items that fulfill both criteria.

- Find property by lot/plan number

  Search for a property using the Lot number and Plan number

  Select all properties with a lot number of 7 and plan number of PS43958.
Drop-Down List Parameters

Drop-down list parameters are used to give the user a fixed list of possibilities. This avoids the problem of the user typing in the wrong data.

The available options for the parameter are called static list items. The static list items are specified as a set of key/value pairs. The key is the text that the user sees. The value is used in the SQL template. The list of concatenators should look like:

key=value;key=value;

The Static list items for the example opposite were written as:

Male=M;Female=F;

If an equals sign is required as part of the items, use \\=. If a semicolon is required as part of the items, use \\;.

Find dogs by gender

Select all dogs with the given gender

Select all Female dogs.

Male
Female
Query Types and Parameters

Dynamic Drop-Down List Parameter

A Dynamic Drop-Down list parameter is also presented to the user as a drop-down list and has the same benefits as a drop-down list parameter. However, a dynamic drop-down list parameter gets its list of items by running a SQL select statement.

For example, consider the Query: “Select all houses that have a dog of breed [DOG_BREED]”. If there are many different dog breeds, and if they are already available in a table, then it is most convenient to refer to that table directly. For this example, the following SQL select statement might be appropriate:

```
SELECT breed FROM Dogs GROUP BY breed
```

The `GROUP BY` syntax is used to obtain a list that has each breed listed only once.

If the statement contains a reference to another parameter within the query, the filtering of the auto-suggest list can be configured to take this dependency into account. Then, it dynamically only shows auto-suggest items that fulfill both criteria.

It is possible to use a remote database to execute the Query used to get the values for a dynamic drop-down list parameter. Set the Database Connection to point to an external database server and ensure the SQL Query is in the correct syntax for that server. The Query must return a single column of values which is then used to populate the drop-down list for the parameter.
Advanced Queries

An Advanced Query allows the user to extend the Query so that it can be more specific.

For example, the initial Query might read:

\text{Select all houses that are in Coburg.}

The user might then extend it to read:

\text{Select all houses that are in Coburg and have street name like Robert St}

To allow the user to extend a Query, you must configure all of the possible options that the users can access. For each different parameter that the user can add, such as street name, you must create an advanced parameter.

We give special names to the four parts of the extended Query:

<table>
<thead>
<tr>
<th>Advanced Query Field</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concatenator</td>
<td>and have</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Street name</td>
</tr>
<tr>
<td>Comparison operator</td>
<td>Like</td>
</tr>
<tr>
<td>Value</td>
<td>Robert St.</td>
</tr>
</tbody>
</table>

The configuration of the Query includes the specification of the concatenators, such as “and have”, “or have” etc. The first row that the user adds can have a different set of concatenators to the subsequent rows. Also, the first row and all subsequent rows can have a default concatenator specified. You must specify a set of concatenators and first concatenators.

The concatenators are specified as a set of key/value pairs. The key is the text that the user sees. The value is used in the SQL template. The list of concatenators should look like:

\text{key=value;key=value;}

For example, a common set of concatenators would be

\text{and where=AND;or where=OR}

If an equals sign is required as part of the items, use "\text{"=}". If a semicolon is required as part of the items, use "\text{;}".

The first concatenators should generally be identical to the concatenators.

The SQL template for an Advanced Query should contain an \text{\{ADVANCED\}} parameter. The \text{\{ADVANCED\}} parameter (note that ADVANCED is case-sensitive) expands to SQL statements that correspond to all of the additional clauses that the user has added. The parameter expansion is achieved by concatenating the clauses and replacing the user-selected fields with appropriate SQL statements. The advanced parameter should be added either as a continuation of an existing \text{WHERE} clause or as a complete \text{WHERE} clause if one does not already exist in the template.
Query Types and Parameters

Any SQL clauses that normally come after the WHERE clause, such as ORDER BY or GROUP BY, should be placed after the {ADVANCED} parameter tag in the Query. Ordinarily, however, these clauses will not be relevant to a spatial Query on a spatial layer.

Advanced Query Parameters: Example 1

If the user enters two advanced clauses of the form:

```
street_name = 'Fitzroy st'
AND house_number < 21
```

and the SQL template is of the form:

```
SELECT mi_key FROM property {ADVANCED}
```

the resulting SQL Query is:

```
SELECT mi_key FROM property WHERE street_name = 'Fitzroy St' AND house_number < 21.
```

Advanced Query Parameters: Example 2

If the user enters two advanced clauses of the form:

```
OR street_name = 'Fitzroy st'
AND house_number < 21
```

and the SQL template was of the form:

```
SELECT mi_key FROM property WHERE owner_id = @OwnerId {ADVANCED} AND property_type = 'Residential'
```

the resulting SQL Query is:

```
SELECT mi_key FROM property WHERE owner_id = 'Fitzroy st' OR street_name = 'Fitzroy st' AND house_number < 21 AND property_type = 'Residential'
```

As a complete example, we would use the following configuration to create the first example Query in this section.

<table>
<thead>
<tr>
<th>Query Property Name</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select all houses</td>
</tr>
<tr>
<td>User text template</td>
<td>Select all houses that are in {SuburbName}.</td>
</tr>
<tr>
<td>SQL template</td>
<td>Select mi_key from Houses where SUBURB=@SuburbName {ADVANCED}</td>
</tr>
<tr>
<td>Selection layer</td>
<td>Houses</td>
</tr>
<tr>
<td>Concatenator operators</td>
<td>and have=AND; or have=OR</td>
</tr>
<tr>
<td>First concatenator operators</td>
<td>and have=AND; or have=OR</td>
</tr>
</tbody>
</table>
Chapter 25: Queries

Advanced Query Parameters

A more complex form of Query Parameter occurs in advanced queries. Each advanced parameter specifies a column of a database table that can be queried and gives the user the opportunity to enter a value to search by. For example, a single Advanced Query parameter gives rise to the following display to the user

And where Diameter (mm) is equal to 100

Each of the four parts of this Query fragment are configurable. The first is called the concatenator, such as “and where”, or “or where”. The second is the parameter name, which corresponds to a column in a database table. The third is the comparison operator, such as “is equal to”, “is not equal to”, “is similar to”. The final part is the value.

The advanced concatenators are specified in the configuration for the Query, as they apply to all of the advanced parameters. A separate advanced parameter should be created for each different column name that can be used for querying. The comparison operators are specified as a Drop-down list string, such as “is equal to=\=;is like=LIKE”. Finally, the value is a text-entry parameter and has an associated data type and default value.

Running a Query on a Remote Server

It is possible to run a Query on a remote database server. This is done by setting the Database Connection field to a non-native Database Connection. You must also define the bind column on the map layer which will be used to bind against, and modifying the SQL syntax accordingly.

Creating a Query

To create a Query:

1. Select a Work Context node.
2. Select Queries.
3. Click Add New Item.
4. Complete the Advanced Query properties if appropriate.
### Advanced

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concatenator operators</td>
<td>The list of concatenator operators used between each clause of the advanced section of the Query. Should be in the form 'displayname=SQLValue;displayname=SQLValue…'. You can select from a list of common values or enter your own.</td>
</tr>
<tr>
<td>Default advanced parameter</td>
<td>Optional - the advanced parameter to use as the default when an Advanced Query row is added by the user.</td>
</tr>
<tr>
<td>Default concatenator operator</td>
<td>The default concatenator to use between the advanced clauses in the Query. This setting should match the display value of the concatenator (not the SQL value). Common values are available in the drop-down list.</td>
</tr>
<tr>
<td>Default first concatenator operator</td>
<td>The default concatenator to use between the basic section and the advanced section of the Query. Should be the display value of the concatenator and not the SQL value. Common values are available in the drop-down list.</td>
</tr>
<tr>
<td>First concatenator operators</td>
<td>The list of concatenator operators used between the basic section and the advanced section of the Query. Should be in the form 'displayname=SQLValue;displayname=SQLValue…'. You can select from a list of common values or enter your own.</td>
</tr>
</tbody>
</table>

5. Complete the General properties:
## Chapter 25: Queries

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>After query is run, zoom to</strong></td>
<td>The default Zoom To behaviour when the query is run. Choose from Selection, Active selection, None. The default is Selection.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The description of the Query, shown in the status bar when the mouse is hovered over a Query Name in the Queries menu, used as tooltip text when the mouse is hovered over the Query icon on the toolbar and displayed in the Query panel.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The name of the Query as shown to the user in the Query drop-down list and the Queries menu.</td>
</tr>
<tr>
<td><strong>Selection layer</strong></td>
<td>The layer on which to select objects as a result of the Query.</td>
</tr>
<tr>
<td><strong>SQL template</strong></td>
<td>The SQL template used to generate the Query results. Native connection: this must be a valid SQL Query string consistent with MapXtreme 2005 SQL syntax. The Query must produce a set of mi_keys as its output. For a Basic Query, input parameters must use the standard SQL parameter syntax (the parameter name prefixed with an '@'). Remote server: the Query must be in the syntax required by the server. The Query must return a set of values that can be bound against the values in the Bind Column to select items on the map Advanced Query only: the location of Advanced Query Parameters within the template must be specified using {ADVANCED} - this is case-sensitive.</td>
</tr>
<tr>
<td><strong>User text template</strong></td>
<td>The text string that will be displayed to the user. This should be a natural-language version of the Query. Input parameter place-holders are defined by the name of the parameter surrounded by the '{' and '}' characters.</td>
</tr>
</tbody>
</table>
## Creating a Query

6. Complete the Remote Database Query properties if running a query on an external database.

<table>
<thead>
<tr>
<th>Remote Database</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bind Column</strong></td>
</tr>
<tr>
<td><strong>Database Connection</strong></td>
</tr>
</tbody>
</table>

7. Complete the Toolbar properties.

<table>
<thead>
<tr>
<th>Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Appears as Toolbar</strong></td>
</tr>
<tr>
<td><strong>Icons</strong></td>
</tr>
</tbody>
</table>

8. Click Save and Activate Settings

9. If creating a Basic or Advanced Query, add parameters as described below.
   - **Creating Advanced Parameters**
### Creating Advanced Parameters

### Creating Basic Parameters

10. Select a Basic Query or Advanced Query.

11. Select Query Parameters.

12. Click Add New Item.

4. Complete the Query Parameters properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data type</td>
<td>The data type of the input parameter.</td>
</tr>
<tr>
<td>Database connection</td>
<td>The Database Connection to access to run the SQL Query on.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value shown to the user.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the Query Parameter - used as tooltip text when the mouse is hovered over the parameter.</td>
</tr>
<tr>
<td>Input type</td>
<td>The input type of this parameter.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique Query Parameters name.</td>
</tr>
</tbody>
</table>

**Input type options:**
- Drop-Down List: produces a list that is populated from the Static list items.
- Dynamic Drop-Down: produces a list that is populated via the SQL select statement.
- Text Input: produces a textbox that the user can type into.
Creating a Query

**General**

SQL select statement

This field is used in conjunction with an Input type of Dynamic Drop-Down. This SQL Query should produce a list of values that are shown to the user as options in the drop-down list. Only the values in the first column of the result set will be used to populate the list.

Static list items

This field is used in conjunction with an Input type of Drop-Down List. The list should be in the form 
<display>=<value>;<display>=<value>;..., where <display> is the string to display to the user, and <value> is the actual value to place into the resulting Query on the server. For example, 'Name=name;Property Id=property_id;Unique identifier=SP_UFI'. A backslash can be used to escape the '=' and ';' characters in the string.

5. Repeat steps 2 through 4 to add additional parameters.

6. Click **Save and Activate Settings**.

Creating Advanced Parameters

1. Select an Advanced Query node.

2. Select **Advanced Query Parameters**.

3. Click **Add New Item**.

4. Complete the Advanced Query Parameter properties:

   **General**

   Advanced operators
   
   A list of all the comparison operators available for this parameter. Should be a list of the form 
<display>=<value>;<display>=<value>; where <display> is the string to display to the user, and <value> is the actual value to place into the resulting Query on the server. For example, 'less than=;greater than='.

   Column name
   
   The column name for this parameter. This should be the fully qualified column name as it appears in a table referenced in the Query.

   Data type
   
   The data type of the input parameter.

   Default comparison operator
   
   The default comparison operator. This should exactly match the display value of an AdvancedOperators entry.

   Default value
   
   The default value shown to the user.
## General

<table>
<thead>
<tr>
<th>Description</th>
<th>The description of the Advanced Query Parameter - used as tooltip text when the mouse is hovered over the parameter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the Advanced Query Parameter - used to populate the drop-down parameter list.</td>
</tr>
</tbody>
</table>

5. Repeat steps 2 through 4 to add additional parameters.
6. Click **Save and Activate Settings**.
Database Connections

This chapter discusses Database connections for Exponare. The database connections are the settings that define the connections to remote database servers.

In this chapter...

- Introduction
- Configuring a Database Connection
- Database Connection Types
Introduction

The database connections are the settings that define the connections to remote database servers. Remote database servers can be used for a number of different reasons in various parts of the application, including Data Binds, Queries, Application Link-Ins and Application Link-Outs.

The databases supported are as follows:

- Oracle v9i, 10G R2, 11G R2.
- ODBC drivers for SQLServer, Microsoft Access 2007 and , Oracle and Informix.
  
  **Note:** ODBC drivers require the installation of MDAC 2.6 or later. 2.7 is recommended.

- OLE providers – SQLOLEDB, MSDAORA and Microsoft.Jet.OLEDB.4.0.
  
  **Note:** ODBC and OLE drivers can access many different types of databases with a variety of flavours of SQL syntax. To use as a Data Bind connection in Exponare, the database used must support the following SQL syntax:
  
  ```sql
  IN (<param>, <param>, <param>)
  ```
  
  ie, an "IN" statement that requires comma-separated parameters.
  
  Parameterisation of queries consistent with the format used by either Oracle, SQLServer, ODBC or OLE SQL syntax.

Connecting to an external database may require certain client software to be installed on the machine hosting the Exponare Server. For example, to connect to an external Oracle database on another machine, it is necessary to install the relevant Oracle client software on the Exponare Server machine. Please consult the relevant documentation for the database being connected to.

Configuring a Database Connection

To configure a database connection:

1. Select the Database Connections node.
2. Click **Add New Item** to create a new connection or **click the Database Connection** node to update an existing connection.

3. Complete the Database Connection properties.

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection string</strong></td>
</tr>
<tr>
<td><strong>Connection Type</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
</tbody>
</table>

**Database Connection Types**

- Native
- ODBC
- OLE
- Oracle
- SQL Server

**Native**

The configuration must always contain one default **Database Connection** called ‘Native’. This connection is a dummy connection that does not point to any external database server. Since all **Data Binds** and **Queries** contain a **Database Connection**, this connection is used to indicate a **Data Bind** or **Query** that does not execute its SQL in an external database, but instead, uses only the native **TAB Files** available in the workspace and **SQL Support Tables**.

This type of connection string is included with the skeleton configuration file.
Database Connection Types

**ODBC**

Information about the values that can be given to the connection string for an ODBC connection type can be found on the Microsoft website.

**Informix Database Servers**

The following example illustrates a typical connection string to an Informix database using an ODBC connection string.

```
Driver={IBM INFORMIX ODBC DRIVER};
Host=<HostName>;
Server=<InformixServer>;
Service=<ServiceNameOrPortNumber>;
Protocol=olsoctcp;
Database=<DatabaseName>;
UID=<Username>;
PWD=<Password>;
```

**OLE**

Information about the values that can be given to the connection string for an OLE connection type can be found on the Microsoft website.

**Microsoft Access Databases**

The following example illustrates a typical connection string to an Access database using an OLE connection string.

```
PROVIDER=Microsoft.Jet.OLEDB.4.0;
DATA Source=<PathToAccess.mdbFile>
```
Oracle

Information about the values that can be given to the connection string for an Oracle connection type can be found on the Microsoft website.

The following example illustrates a typical connection string to an Oracle database.

```
Server=myServer; Integrated Security=True
```

where `myServer` is the name or IP address of the server hosting the Oracle database.

When connecting to an external Oracle database, it is sometimes necessary to perform extra steps to allow the ASP.NET user (ASPNET or Network Service accounts) to access the required components to access the Oracle Database. If the Oracle connection is not working and an error message similar to the form "Unable to load dll" or "System.Data.OracleClient requires Oracle client software v8.1.7 or v9i" is seen in the Event Log, then the permissions on the Oracle home directory need to be set to allow the ASP.NET user (ASPNET or Network Service accounts) read and execute permissions on the Oracle software. See Restarting the ASP.NET Process for the details of this procedure.

Troubleshooting

**MSDAORA provider is not registered on local machine (64-bit)**

**Symptom**

While running Exponare on 64-Bit machine, error "MSDAORA provider is not registered on local machine" is displayed.

**Resolution**

MSDORA Oracle provider is not supported on 64-Bit machine so ORAOLEDB provider is required. To use this add following string.

```
Provider=ORAOLEDB.ORACLE; OLEDB.NET=true; Data Source=EXPONARE; Password=EXPOTEST; User ID=EXPOTEST;
```

SQL Server

Information about the values that can be given to the connection string for an SQLServer connection type can be found on the Microsoft website.

The following example illustrates a typical connection string to a SQL Server database.

```
Integrated Security=SSPI;
database=northwind;
server=mySQLServer
```

where `mySQLServer` is the hostname or IP address of the machine that hosts the SQL Server database. This can be "localhost" if the SQL Server database is installed on the same machine as the Exponare Server.
Database Connection Types

Replace the name `northwind` with the name of the database you want to access inside the SQL Server database.

If you are running the SQL Server on a different machine than the Exponare Server, then there will be problems with using the setting "Integrated Security=SSPI". This is because the Exponare Server runs inside IIS as a special user called ASPNET, which the SQL Server does not recognize—therefore the SQL Server does not allow a connection to be made by this user. One way to resolve this issue is to configure the Exponare Server process to impersonate a different user that is recognized by the SQL Server. See Configuring ASP.NET Impersonation for details on how to do this.
Print Templates

This chapter discusses Print Templates for use with Exponare. Printing from Exponare means the automatic creation of either a Microsoft Word document or an HTML web page and PDF. If a Word document is created, it can be saved, edited, or sent to a printer. If an HTML document is created the user can see and print the document using Internet Explorer, Chrome or Firefox.

In this chapter...

- Introduction
- Creating a Microsoft Word Print Template
- Creating a PDF Print Template
- Creating a Mail Merge Print Template
- Creating a HTML Print Template
- Creating Rest Public HTML Print Template
- Configuring a Print Template
- Troubleshooting
Microsoft Word and HTML Print Templates can be added to a Work Context. Users select the template from the drop-down list in the Print Panel and enter any additional information that the template is designed to use.

The template will usually contain special tags that are replaced with information by Exponare.

Creating a print template is a two step process:

1. Create a new print template file (.dot, .dotm for Microsoft Word templates or .aspx for HTML templates).
2. Configure the print template for use in Exponare.

Creating a Microsoft Word Print Template

Microsoft Word Print Templates are created using Microsoft Word 2003, 2007 and 2010. The Print Template can contain any regular Microsoft Word formatting and content.

There are two exceptions to the creation of typical Microsoft Word documents that must be followed to create a Microsoft Word Print Template. Specifically:

1. The Microsoft Word document must contain a set of Exponare printing macros. These macros can be found in any of the sample Print Templates that are provided with Exponare. The macros, located in the module ExponareEnquiryProcedures, must be copied into each new Microsoft Word Print Template.

2. The Microsoft Word document must be saved as a Document Template (.dot, .dotm file) only in Microsoft Word.

Microsoft Word Print Tags

A Microsoft Word print template can contain special Exponare Print Tags. When a print template is processed by Exponare the print tags are replaced with Exponare content (eg. the map, zoom width, Legend, etc). Some Exponare print tags are simple, such as {UserName} and take no parameters. Others allow extra settings, such as {Map}, which can be specified with parameters such as {Map width=10 height=10}. The following Exponare print tags are available:
### Chapter 27: Print Templates

<table>
<thead>
<tr>
<th>Print Tag</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomTag</td>
<td>id</td>
<td>Inserts text specified by the Exponare Enquiry user in the print panel. The id is the name of the Custom Tag (as defined by the Exponare Administrator in the Exponare Configuration Manager). The id is case sensitive. If the name of the Custom Tag contains a space it must be surrounded by quotes (eg. <code>{CustomTag id=&quot;My Tag Name&quot;}</code>).</td>
</tr>
<tr>
<td>DateTime</td>
<td>No parameters</td>
<td>Insert the current date.</td>
</tr>
<tr>
<td>Legend</td>
<td>No parameters</td>
<td>Inserts the Legend.</td>
</tr>
<tr>
<td>Map</td>
<td>width, height, units, dpi, selection, active, scalebar, scalebarwidth, scalebarheight, scalebarsizeunits, scalebarx, scalebary, scalebarpositionunits</td>
<td>Inserts a map in the document. Use width, height and units to specify the physical size of the map, and dpi to specify the map resolution. See below for valid units. Set selection to “off” or “on” to specify that selections should be shown highlighted. Set active to “off” or “on” to specify that the Active Selection should be shown highlighted. The active parameter is used in mail merge templates - see Creating a Mail Merge Print Template for details. Set scalebar to “off” or “on” to specify that the Scale Bar should be shown on the map. If this tag is omitted the Scale Bar will have the same visibility as the current Exponare Enquiry instance. Use scalebarwidth, scalebarheight, and scalebarsizeunits to specify the physical size of the Scale Bar on the map. Use scalebarx, scalebary, and scalebarpositionunits to specify the physical position of the Scale Bar on the map.</td>
</tr>
<tr>
<td>ScaleText</td>
<td>No parameters</td>
<td>Inserts the scale of the printed map (eg. 1:500). A ScaleText tag must only be used after a map print tag. If used before or without a map print tag the scale text may not be accurate.</td>
</tr>
<tr>
<td>Table</td>
<td>table, macro</td>
<td>Inserts a single table. The table parameter is an Exponare Data Bind name that identifies the table to insert. To ensure this table exists in the Exponare selection when this template is printed an Exponare administrator can add the Data Bind name to the configuration of the print template in Exponare. The macro is the name of a Microsoft Word macro in the print template. The macro can be used to format the inserted table. When started the inserted table is selected.</td>
</tr>
</tbody>
</table>
Creating a Microsoft Word Print Template

<table>
<thead>
<tr>
<th>Print Tag</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>macro</td>
<td>Inserts all tables in the Feature Details panel into the document. The macro is the name of a Microsoft Word macro in the print template. The macro can be used to format the inserted tables. The macro is run once for each table inserted. When started the current table is selected.</td>
</tr>
<tr>
<td>UserName</td>
<td>No parameters</td>
<td>Inserts the Exponare user name.</td>
</tr>
<tr>
<td>ZoomUnits</td>
<td>No parameters</td>
<td>Inserts the units of the zoom width.</td>
</tr>
<tr>
<td>ZoomWidth</td>
<td>No parameters</td>
<td>Inserts the zoom width (only the number). A ZoomWidth tag must only be used after a map print tag. If used before or without a map print tag the zoom value may not be accurate.</td>
</tr>
</tbody>
</table>

Note: • Microsoft Word Print Templates can be stored anywhere on the Exponare Server that is accessible to the ASPNET user. For example, the sample Print Templates are stored in the directory [ExponareIISDir]/Printing by default.

• To use Microsoft Word templates, the Exponare Enquiry client needs to have full access to the user's Documents and Settings folder, as is standard for a Windows application.

• If you require the use of brace characters "{" and "}" for any other purpose in your Print Templates you must escape them with the "!" character. Any pair of braces (e.g. {Map} or {myTag}) can be added to the document as is by inserting a "!" immediately after the first brace (e.g. {!Map} or {!myTag}). The escape character "!" will be removed during print template processing.
Map and Scale Bar Size Units

The following table lists the units that can be specified for the map units and Scale Bar size units. The units are case-insensitive. Note that several variations can be used for the same unit.

<table>
<thead>
<tr>
<th>Unit</th>
<th>Variations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centimetre</td>
<td>centimeter, centimetres, centimeters, cm, cms</td>
</tr>
<tr>
<td>Foot</td>
<td>feet, ft, fts</td>
</tr>
<tr>
<td>Inch</td>
<td>inches, in, ins</td>
</tr>
<tr>
<td>Metre</td>
<td>meter, metres, meters, m, ms</td>
</tr>
<tr>
<td>Millimetre</td>
<td>millimeter, millimetres, millimeters, mm, mms</td>
</tr>
<tr>
<td>Pica</td>
<td>pc, p</td>
</tr>
<tr>
<td>Pixel</td>
<td>px</td>
</tr>
<tr>
<td>Point</td>
<td>pnt, pt</td>
</tr>
<tr>
<td>Twip</td>
<td>tp, t</td>
</tr>
</tbody>
</table>

Creating a PDF Print Template

Exponare Enquiry 5.0 and above has an add-on feature to print in PDF format using templates set up by the administrator. This feature is only available with Microsoft Word 2007 or 2010 and does not support Microsoft Word 2003. When a Word template is selected, Exponare will generate the document and open it in a PDF or Word. PDF can be generated by clicking on Print to PDF button.

Templates produce a section for each feature in the current selection, with that feature set as the active selection, in the resulting PDF document. You can now track the progress of print fired to PDF by the progress bar window that appears on the top of Enquiry window.

The user need not to manually install this feature. It is automatically installed with the setup. In case of any problem, User can manually install it from installed folder using this path...\ENG\Prerequisites\SaveAsPDF\SaveAsPDFandXPS.exe.

A PDF document will be created which looks similar to the template created, but has the date and user name included as a header instead of under the document's title.

Important Note: If Microsoft Word 2007 or 2010 is not installed on system, then this feature is not available and button will be disabled in that case.

Creating a Mail Merge Print Template

A mail merge print template produces a multiple page document, each of which is specific to a particular selected Feature. You must understand Microsoft Word mail merging to configure mail merging in Exponare.
Creating a Mail Merge Print Template

Microsoft Word mail merging involves a master document and a source document. The master document is a print template. This print template may use the same elements as a normal print template.

The source document is created by Exponare Enquiry each time a mail merge template is used. The source document is automatically populated with the information for each Feature contained in a single Data Bind as well as two additional special columns, the BindID column and the MI_Key column.

Merge fields can be added to the master document to inject information relating to the current Feature.

Information relating to the current Feature can be used in a special way with the Map print tag. It is possible to request the map rendered for the current Feature to highlight that Feature. This is done through the use of the active parameter. The active parameter for the map print tag is used in the following way:

\{Map active="<<BindID>>.<<MI_Key>>"\}.

Where <<BindID>> and <<MI_Key>> are merge fields.

To create a mail merge print template:

1. Create a standard print template.
2. Make a note of the structure of the Data Bind to be used in the mail merge.
3. Create a Microsoft Word document with a table that has two rows and two more columns than are in the data bind.
4. Fill in the first row of the table with the column headers. These should consist of the two special columns, BindId and MI_Key, followed by all the columns from the Data Bind.
5. Open the print template and using the standard Microsoft Word Mail Merge functionality set the merge source as the document created in step 3.
6. Using the Microsoft Word Insert Merge Field command, insert the columns in the merge source into the document.
7. Save the print template.

Tracking Printing Progress

You can now track the progress of print fired to Microsoft Word by the progress bar window that appears on the top of Enquiry window.
Chapter 27: Print Templates

Depending on the selection and print area some printing processes make take long or involve some prompts which needs to be addressed by users. These prompts are typically associated with data binds or spellchecks depending on the version of MSOffice used. In such cases, the printing progress would halt and thus a user is suggested to press Alt + Tab and look for any prompts awaiting user action. Once, a user action is taken on this, the printing progresses further. This is also suggested in the progress bar window.

Creating a HTML Print Template

A HTML print template is a Microsoft.NET ASPX page. For those new to this technology, a Microsoft.NET ASPX page is a type of dynamic HTML page.

Microsoft.NET ASPX pages can be created in any text editor (eg. Microsoft Notepad) or Integrated Development Environment (eg. Visual Studio.NET). The process to create a HTML print template in a text editor can be found below. While it is more common to create ASPX pages in an IDE the details of each IDE differ and so will not be discussed in this document. Refer to the documentation for your IDE for further information.

To create a HTML print template in a text editor:

2. Put the ASPX file in the Exponare Server directory. It can be either directly under the root or in a subdirectory structure.
3. Include generic HTML/ASPX document structure tags as shown below into the text file.
   ```html
   <HTML>
   <BODY>
   <FORM>
   </FORM>
   </BODY>
   </HTML>
   ```
4. Add support for Exponare print tags by including the following line at the top of the document (before the `<HTML>` tag).
   ```html
   <%@ Register TagPrefix="Exponare" Namespace="MapInfo.Exponare.Public"
   Assembly="ExponareCoreServices" %>
   ```
5. Immediately after the `<FORM>` tag include the following line.
   ```html
   <Exponare:ServiceManager id="ServiceManager1" runat="server"/>
   ```

Important Note: Code snippets above in steps 4 and 5 have altered since Exponare v2.4. HTML Print Templates using the historical snippets must be changed to use the new code shown above.
Creating a HTML Print Template

**HTML Print Tags**

HTML print template can contain any typical HTML and/or ASPX content. It can also be populated with special Exponare HTML print tags. The available print tags are:

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td><code>&lt;Exponare:CustomInfoLabel id=&quot;MySomeCustomTagName&quot; runat=&quot;server&quot; Font-Size=&quot;Large&quot; CustomTagName=&quot;SomeCustomTagName&quot;/&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Where SomeCustomTagName is a Custom Tag name as defined in the print template configuration within Exponare Enquiry.</td>
</tr>
<tr>
<td></td>
<td>All label tags can be customised in two ways. They may have any further properties set as would be possible in standard ASPX label controls. For example Font-Size=&quot;Large&quot; could be used to set the size of the text generated by the label. The custom tags may also have inner text which can be used to format the replacement label text. In this inner text the string <code>{0}</code> is used to specify where the replacement text should be inserted. For example:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;Exponare:CustomInfoLabel id=&quot;MyCustomTag&quot; CustomTagName=&quot;My Tag Name&quot; runat=&quot;server&quot;&gt;My custom tag value is </code>{0}<code>.&lt;/Exponare:CustomInfoLabel&gt;</code></td>
</tr>
<tr>
<td></td>
<td>would result in the replacement text appearing in the middle of the defined inner text.</td>
</tr>
<tr>
<td>Date and Time</td>
<td><code>&lt;Exponare:DateTimeLabel id=&quot;MyDateTimeLabel&quot; runat=&quot;server&quot;/&gt;</code></td>
</tr>
<tr>
<td>Information Results</td>
<td><code>&lt;Exponare:InfoResults id=&quot;MyInfoResults&quot; runat=&quot;server&quot; HeadingFormat=&quot;Table: {0} [Count: {1}, Base: {2}]&quot;&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;HeaderStyle Font-Bold=&quot;True&quot; ForeColor=&quot;White&quot; BackColor=&quot;Navy&quot;/&gt;</code></td>
</tr>
<tr>
<td></td>
<td>The heading format property is used to set the format of the heading for each table in the information results. In this text the reserved tags will be replaced as follows:</td>
</tr>
<tr>
<td></td>
<td>(0): The name of the Data Bind.</td>
</tr>
<tr>
<td></td>
<td>(1): The count of rows in the table.</td>
</tr>
<tr>
<td></td>
<td>(2): The count of selections in the base layer the table comes from.</td>
</tr>
<tr>
<td></td>
<td>The following additional properties, and their most common values, can also be specified for an Information Results tag:</td>
</tr>
<tr>
<td></td>
<td>BorderColor=&quot;Black&quot; HeadingForeColor=&quot;Navy&quot; BackColor=&quot;#C0C0FF&quot; HeadingFont-Bold=&quot;True&quot; HeadingFont-Italic=&quot;True&quot;</td>
</tr>
</tbody>
</table>
### HTML Tag Syntax/Comments

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td><code>&lt;Exponare:HtmlLegend id=&quot;MyHtmlLegend&quot; runat=&quot;server&quot; /&gt;</code></td>
</tr>
<tr>
<td></td>
<td>See The <a href="#">The MapHook Property</a> for further information.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Legend</strong> may have further properties set as would be possible in standard ASPX label control. These font settings are applied to the layer names within the printed Legend. For example <code>Font-Size=&quot;Large&quot;</code> could be used to set the size of the text generated for the layer names.</td>
</tr>
<tr>
<td>Main Map Coordinate System</td>
<td><code>&lt;Exponare:CoordSysLabel id=&quot;MyCoordSysLabel&quot; runat=&quot;server&quot; /&gt;</code></td>
</tr>
<tr>
<td>Map</td>
<td><code>&lt;Exponare:MapImage id=&quot;MyMapImage&quot; runat=&quot;server&quot; Width=&quot;20cm&quot; Height=&quot;5cm&quot; /&gt;</code></td>
</tr>
<tr>
<td></td>
<td>The following additional properties, and their most common values, can also be specified for a map tag:</td>
</tr>
<tr>
<td></td>
<td>DotsPerInch=&quot;96&quot; ScaleBarWidth=&quot;3cm&quot; Active=&quot;on&quot; or &quot;off&quot; ScaleBarHeight=&quot;1cm&quot; Selection=&quot;on&quot; or &quot;off&quot; ScaleBarX=&quot;0cm&quot; ScaleBar=&quot;on&quot; or &quot;off&quot; ScaleBarY=&quot;0cm&quot;</td>
</tr>
<tr>
<td></td>
<td>The units that can be used for the Width, Height, ScaleBarWidth, ScaleBarHeight, ScaleBarX and ScaleBarY properties are:</td>
</tr>
<tr>
<td></td>
<td>Centimetre cm Pica pc Inch in Point pt Millimetre mm Pixels px</td>
</tr>
<tr>
<td></td>
<td>The abbreviated form of the unit must be used.</td>
</tr>
<tr>
<td></td>
<td>Furthermore any properties able to be set for the standard ASPX control may be set. Some examples and possible common values are:</td>
</tr>
<tr>
<td></td>
<td>AlternateText=&quot;The map could not be displayed.&quot; BorderStyle=&quot;Solid&quot; BorderWidth=&quot;1px&quot;</td>
</tr>
<tr>
<td>Map Center</td>
<td><code>&lt;Exponare:MapCenterLabel id=&quot;MyMapCenterLabel&quot; runat=&quot;server&quot; /&gt;</code></td>
</tr>
<tr>
<td></td>
<td>See The <a href="#">The MapHook Property</a> for further information.</td>
</tr>
</tbody>
</table>
Creating a HTML Print Template

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview Map</td>
<td><code>&lt;Exponare:OverviewMap id=&quot;MyOverviewMapImage&quot; runat=&quot;server&quot; Width=&quot;5cm&quot; Height=&quot;5cm&quot;/&gt;</code></td>
</tr>
</tbody>
</table>

The map hook must be same as the id of a map tag located elsewhere on the ASPX page.

The following additional properties, and their most common values, can also be specified for a overview tag:

- `DotsPerInch="96"`

Furthermore any properties able to be set for the standard ASPX control may be set. Some examples and possible common values are:

- `AlternateText="The map could not be displayed."`
- `BorderStyle="Solid"`
- `BorderWidth="1px"`

See The [The MapHook Property](#) for further information.

| Overview Map Coordinate System | `<Exponare:OverviewCoordSysLabel id="MyCoordSysLabel" runat="server"/>` |
| Overview Map Zoom Width | `<exponare:overviewzoomwidthlabel id="MyOverviewZoomWidthLabel" runat="server"/>` |
| Scale Text | `<Exponare:ScaleTextLabel id="MyScaleTextLabel" runat="server"/>` |

See The [The MapHook Property](#) for further information.

| User Name | `<Exponare:UserNameLabel id="MyUserNameLabel" runat="server"/>` |
| Zoom Width | `<Exponare:ZoomWidthLabel id="MyZoomWidthLabel" runat="server"/>` |

See The [The MapHook Property](#) for further information.

### The MapHook Property

The MapHook property is an advanced property that can be used to bind a control to a map on a page in the rare case that more than one map is on a page. Controls which can be bound to a map are those which rely on the map for their state. Specifically these controls are:

- The **Legend** tag
- The **Map Center** tag
- The **Overview Map** tag
- The **Scale Text** tag
- The **Zoom Width** tag

The MapHook property can be specified as follows:

```xml
<Exponare:OverviewMap id="OverviewMap" runat="server" Width="3cm" Height="3cm" MapHook="MapImage"/>
```
Chapter 27: Print Templates

Where MapImage is the id of a map tag elsewhere on the page.

None of the tags with MapHook properties may be used before the map they list as their MapHook. If these tags do not specify a MapHook they must not be used before the first map on the page.

Creating Rest Public HTML Print Template

Exponare allows you to create and customize print templates in .html or .htm format.

You must have basic knowledge of HTML before creating print template that includes HTML tags like <div>, <tr>, <td> etc. The tags are written with a start tag and an end tag, with the content in between. All the templates can be placed at following location at server side.

Printing\RestPrintTemplates

You can use these print templates from Exponare Rest public under print navigation pane. For details refer to Print.

To create a Rest Public print template:

1. Create a text file with.htm or .html extension, e.g. Custom.htm.
3. Include generic HTML document structure tags as shown below into the text file.

```html
<HTML>
<BODY>
<FORM>
</FORM>
</BODY>
</HTML>
```

HTML Print Templates using the historical snippets must be changed to use the new code shown below specifically for Rest Public print template.

For using you own print template, you should include following JavaScript files in the order given below:

```html
<script src='../../scripts/RestPublic/OpenLayers/lib/OpenLayers.js' type='text/javascript'></script>
<script src='../../scripts/Proj4js/proj4js-combined.js' type='text/javascript'></script>
<script src='../../scripts/Proj4js/Proj4jsCodes.js' type='text/javascript'></script>
<script src='../../scripts/RestPublic/MapInfoRESTHandler.js' type='text/javascript'></script>
```
Creating Rest Public HTML Print Template

Apart from these there are two more files which you should include in custom files:-

For sample, refer to ExponareServer/Printing/RestPrintTemplates/CapabilityDemo

This file has two methods.

1. CreateLegend: To create Legend in Template
2. CreateDataBinds: For data bind information

In CreateLegend, you can change the number of columns from the line, if (legendCount % 3 == 0). By default it will display 3 columns. To increase or decrease number of columns, you can replace 3 with the number of columns required. For e.g. for 5 columns replace 3 with 5 and it will display 5 columns in legend panel.

In CreateDataBinds, you can only change the style of databind information. You can use the same class name, class="ui-state-default" and give your own corresponding styles in the style sheet. There are some more styles defined for even and odd tables of databind information <tr class="odd"> and <tr class="even">. You can also use these class names to give your own styles to databind information.

This style sheet includes all styles of map, legend and databind information. You can provide your own css class as per your choice and preferences, but class names should be same as given in this style sheet for reference.

You must include following tag. It will remove Bing terms of use as they are not required.

```
<style>
    .bingTermsOfUse
    {
        display: none !important;
    }
</style>
```

You can use mouse to pan the map and scroll to Zoom In/Zoom Out the map and change its scale. The current scale value is displayed under map, like:

Scale = 1: 3385
## HTML Print Tags

HTML print template can contain any typical HTML and/or ASPX content. It can also be populated with special Exponare HTML print tags. The available print tags are:

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
</table>
| Custom   | `<table id="tblTitle" cellspacing="1" cellpadding="1" width="100%" border="1">`<br>`<tr>`<br>`<td style="background-color: #000066; color: #ffffff;" id="customField1">`<br>`</td>`<br>`</tr>`<br>`</table>`<br>`<br>Where `customField1` is a Custom Tag name as defined in the print template configuration within Exponare Enquiry. For more than one custom field it will add one more id `customField2` to the table and so on. For example:<br>`<td style="background-color: #000066; color: #ffffff;" id="customField1">`<br>`<td style="background-color: #000066; color: #ffffff;" id="customField2">`<br>The custom fields added will be in the same order as given in configuration manager.<br>For example: If the Custom tag added in the Configuration manager is Map Title and Map Description then user need to add two tags in the Print template.<br>1. For Map Title the user needs to add an html tag with the `id="customField1"`<br>2. For Map Description the user needs to add another html tag with `id="customField2"`
### Creating Rest Public HTML Print Template

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
</table>
| **Information Results** | `<table id="Table6" bordercolor="#000066" cellspacing="1" cellpadding="1" width="100%" border="1">`<br>`<tr>`<br>`<td width="50%" bgcolor="#000066">`<br>`<font color="#ffffff">Info Results</font>`<br>`</td>`<br>`</tr>`<br>`</table>`<br>`<div id="infoResultDiv">`<br>`There are no selected items.`<br>`</div>`<br>`The `infoResultDiv` id is used for the information results called as Data Bind. This id is used to display all the information results. It is given under `<div>`. You can also use this with any other html tag which has `innerHTML` attribute. `InnerHTML` content will be displayed as the information result. The following additional style attributes given for header "Info Results" can also be changed as per your preference:<br>`<font color="#ffffff" bgcolor="#000066">`<br>`<br>`**Legend** | `<td align="top" width="100%">`<br>`<table id="Table4" cellspacing="1" cellpadding="1" width="100%" border="0">`<br>`<tr>`<br>`<td bgcolor="#000066">`<br>`<font color="#ffffff">Legend</font>`<br>`</td>`<br>`</tr>`<br>`</table>`<br>`<div id="legendDiv">`<br>`The `legendDiv` id is used for the legend information called as Legend. This id is used for populating values of legend in the Template. It is given under `<div>`. Similarly like information results, you can also change with other html tag which has `innerHTML` attribute. `InnerHTML` content will be displayed as the legend information. The font settings applied to the Legend header could also be changed to customize the color, font and other styles:<br>`<font color="#ffffff">Legend</font>`<br>`<br>`
<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Map</td>
<td>&lt;table id=&quot;tblCoordinates&quot; bordercolor=&quot;#000066&quot; cellspacing=&quot;1&quot; cellpadding=&quot;1&quot; width=&quot;100%&quot; border=&quot;1&quot;&gt;</td>
</tr>
<tr>
<td>Coordinate System</td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;td width=&quot;50%&quot; bgcolor=&quot;#000066&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;font color=&quot;#ffffff&quot;&gt;Coordinate Details&lt;/font&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/td&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;td&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;div id=&quot;coordHeader&quot; /&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/td&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;td&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;div id=&quot;coordinateDetails&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>There are no selected items.</td>
</tr>
<tr>
<td></td>
<td>&lt;/div&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/td&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/table&gt;</td>
</tr>
</tbody>
</table>

The `coordHeader` and `coordinateDetails` id are used to display all the coordinate related information including projection system and x, y coordinates for the selection done. `coordinateDetails` id is displayed when we do a coordinate export tool on the map. `coordHeader` id is displayed with the value for the current map projection.
## Creating Rest Public HTML Print Template

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map</td>
<td><code>&lt;table id=&quot;mapDiv&quot; cellspacing=&quot;1&quot; cellpadding=&quot;1&quot; width=&quot;100%&quot; border=&quot;1&quot;&gt;</code>&lt;br&gt;   <code>&lt;tr&gt;</code>&lt;br&gt;    <code>&lt;td valign=&quot;top&quot;&gt;</code>&lt;br&gt;   <code>&lt;table id=&quot;Table1&quot; cellspacing=&quot;1&quot; cellpadding=&quot;1&quot; width=&quot;100%&quot; border=&quot;0&quot;&gt;</code>&lt;br&gt;    <code>&lt;tr&gt;</code>&lt;br&gt;    <code>&lt;td bgcolor=&quot;#000066&quot;&gt;</code>&lt;br&gt;    <code>&lt;font color=&quot;#ffffff&quot;&gt;Map&lt;/font&gt;</code>&lt;br&gt;    <code>&lt;/td&gt;</code>&lt;br&gt;    <code>&lt;/tr&gt;</code>&lt;br&gt;    <code>&lt;/table&gt;</code>&lt;br&gt;    <code>&lt;/td&gt;</code>&lt;br&gt;    <code>&lt;/tr&gt;</code>&lt;br&gt;    <code>&lt;/table&gt;</code></td>
</tr>
</tbody>
</table>

The `mapDiv` id is used to display same view of map on the main screen with all selections, measurements and projections. You can pan, zoom in and zoom out the map using mouse movements.

The font settings applied to the Map header could also be changed to customize the color, font and other styles.

| Scale Text | `<td>`<br>   `<div id="mapScale"></div>`<br>    `</td>`                                                                                                                                 |

This tag will give the Scale value of current view of Map below the map section. It will change as you zoom in/zoom out the map.

| Measurement Text | `<td>`<br>   `<span id="measurementDiv"></span>`<br>    `</td>`                                                                                                                                 |

This tag will display the measurement value of selection done on Map below the map section. Measurement can be of distance or area in the units selected on main screen map.

| Coordinate Sys | `<td>`<br>   `<span id="coordSysDiv"></span>`<br>    `</td>`                                                                                                                                 |

This tag will display the coordinate System of current view of Map below the map section.
**HTML Tag Syntax/Comments**

<table>
<thead>
<tr>
<th>HTML Tag</th>
<th>Syntax/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Template to Printer for printing</td>
<td><code>&lt;input type=&quot;button&quot; id=&quot;printbutton1&quot; value=&quot;Print&quot; onclick=&quot;PrintPage();&quot; /&gt;</code></td>
</tr>
<tr>
<td></td>
<td>This tag includes Print button on start of Print Template. On clicking this</td>
</tr>
<tr>
<td></td>
<td>button, print window will open you can take the printout of this template.</td>
</tr>
<tr>
<td></td>
<td>One Print button is clicked, Close button will disappear and you cannot</td>
</tr>
<tr>
<td></td>
<td>make any further modifications to the template. Similar button has been</td>
</tr>
<tr>
<td></td>
<td>added to print the template from the end of page.</td>
</tr>
<tr>
<td></td>
<td><code>&lt;input type=&quot;button&quot; id=&quot;printbutton2&quot; value=&quot;Print&quot; onclick=&quot;PrintPage();&quot; /&gt;</code></td>
</tr>
</tbody>
</table>

| Close Print Template                    | `<input type="button" id="closebutton1" value="Close" onclick="ClosePage();" />` |
|                                         | This tag includes Close button next to Print button on the start of Print       |
|                                         | Template. On clicking this button, you can close the template and go back      |
|                                         | to the main screen. Similar button has been added to close the template        |
|                                         | from the end of page.                                                         |
|                                         | `<input type="button" id="closebutton2" value="Close" onclick="ClosePage();" />` |

### Configuring a Print Template

A print template configuration specifies the template file and associated settings.

**To configure a Print Template:**

1. Select **Print Templates**.
2. Click **Add New Item**.
3. Complete the Print Template properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow zoom to active selection</td>
<td>If True, the user can choose to have the map zoom to the Selection when printing.</td>
</tr>
<tr>
<td>Allow zoom to selection</td>
<td>If True, the user can choose to have the map zoom to the Selection when printing.</td>
</tr>
<tr>
<td>Data Bind</td>
<td>The <strong>Data Bind</strong> with which this Print Template is associated. The Print Template is not available in the list of templates shown to the user until this <strong>Data Bind</strong> contains selections. This property can be set to <code>&lt;none&gt;</code>, in which case the Print Template is always shown to the user.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the Print Template as shown to the user.</td>
</tr>
</tbody>
</table>
Configuring a Print Template

<table>
<thead>
<tr>
<th>Is merge template</th>
<th>If True, the template is a mail merge template. This setting only applies to Microsoft Word Print Templates (.dot,.dotm).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the Print Template as shown to the user.</td>
</tr>
<tr>
<td>Template filename</td>
<td>The name of the template file stored on the server. For HTML templates (.aspx extension), this file should be either directly under the root directory of the Exponare virtual directory, or in a subfolder under the root directory. Microsoft Word template files (.dot,.dotm extension) may be specified as a relative filename (to the Exponare virtual directory), an absolute filename, or a UNC filename. The file must be readable by the web-server users (this can be an issue for files on a network drive). The extension defines the template type—at present only.dot,.dotm and.aspx file types are valid. The .htm and html files are supported only for rest and not for any other client (Enquiry/Old Public). These templates must be placed in any folder under Printing folder in Exponare virtual dive. The default .htm templates are being stored in Exponare virtual directory\Printing\RestPrintTemplates folder. Path for default templates: Printing/RestPrintTemplates/Custom.htm Printing/RestPrintTemplates/ CapabilityDemo.htm</td>
</tr>
</tbody>
</table>

4. Click **Save and Activate Settings**.

5. If your template uses custom parameter tags, add as described below.

**To add Custom Parameter Tags:**

1. Select a print template

2. Click **Add New Item**

3. Complete the Custom Parameter Tags properties:

<table>
<thead>
<tr>
<th>General</th>
<th>The description of the Custom Tag as shown to the user.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the Custom Tag. This name is also used as the placeholder text in the print template.</td>
</tr>
</tbody>
</table>

4. If necessary, adjust the position of the Custom Parameter Tag by using the position buttons in the command bar of the Configuration Manager.

5. Repeat steps 1 through 3 to add additional parameters.

6. Click **Save and Activate Settings**.
Chapter 27: Print Templates

To make a Print Template available to a Work Context:

1. Select a **Work Context**.

2. Select **Print Templates**.

3. Click **Add New Item**.

4. Complete the Print Template property and click **Save and Activate Settings**.

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Template</td>
</tr>
</tbody>
</table>

**Troubleshooting**

**Application busy**

**Symptoms**

This issue can arise under circumstances where you are required to respond for a particular decision making while printing. For example - invalid or incomplete databinds attached with a particular template or spelling errors prompted before printing. Typically, this pop up might get hidden behind because of the user working on some other application and may remain unaddressed resulting in this error.

**Resolution**

If you notice a halt in printing progress then it is advised to press **ALT+TAB** to check if any word popup is already open. After responding to the prompt, Word printing would resume.
External Application Links

Exponare Enquiry features functionality that enables integration with one or more external applications. An external application may be a document management system, property and ratings system, other GIS application or any other arbitrary application that can be started from the command line. Bi-directional application integration is offered in Exponare Enquiry through Application Link-Ins and Application Link-Outs.

In this chapter...

- Application Link-Ins
- Application Link-Outs
Application Link-Ins

An Application Link-In is a means of starting Exponare Enquiry from an external application. Exponare Enquiry is also capable of receiving a description of a selection set when started by an external application. In this event Exponare Enquiry updates its current selection set to match the incoming selection description.

Enquiry Command Line Arguments

There are two Exponare Enquiry command line arguments that relate specifically to Application Link-In Enquiry startup. Further details on command line arguments can be found in Starting Enquiry from the Command Line.

The Reuse Command-Line Argument

When starting Enquiry via the command-line or through an Application Link-In, you can specify that you would either like Enquiry to reuse an open window, or to start a new window. The default behaviour is to open a new window. If you would like to reuse an existing Exponare Enquiry instance, include the parameter /reuse in the executable. For example:

`ExponareEnquiry.exe /reuse`

The LinkFile Command-Line Argument

If an external application is to pass a selection description to Exponare Enquiry, it must do so in the form of a Link File. A link file is a specially formatted file that either an external application must either know how to generate directly or that an external application must have a stepping-stone helper application to build on its behalf. Contact Pitney Bowes Software for assistance if you require a helper application.

Once generated, the path to the link file can be passed to Exponare Enquiry with the following specific command line syntax:

`ExponareEnquiry.exe /LinkFile:<link file name>`

Where `<link file name>` is the path and name of a link file. Note that if the path to the link file contains spaces, the argument must be surrounded by double quotes. For example:

`ExponareEnquiry.exe /LinkFile:'My Link'`

Configuring an Application Link-In

An external application can start Exponare Enquiry by running the Exponare Enquiry executable. For this simple form of application integration, that does not utilise selection synchronisation, no configuration is necessary.
Chapter 28: External Application Links

Configuring a Link-In Using a Selection Description

Some external applications have the concept of a selection set. Exponare Enquiry is capable of being configured to be passed a description of a selection set when started by an external application. In such an event Exponare Enquiry sets its current selection set to match the selection description.

Two things are required for selection description integration:

1. The external application and Exponare Enquiry must have a common key in their data so that identifiers that make up a selection description can be matched.

2. The external application must be capable of generating a selection description in the format that Exponare Enquiry understands. If this is not possible, you can use the Generic Link Framework to perform selection description translation.

3. Example link-in file:

```xml
<?xml version='1.0' ?>
<LinkDetails>
  <LinkId>Parks</LinkId>
  <ActiveSelectionId>8021978</ActiveSelectionId>
  <SelectionIds>
    <SelectionId>8021978</SelectionId>
    <SelectionId>8021983</SelectionId>
    <SelectionId>8020927</SelectionId>
  </SelectionIds>
</LinkDetails>
```

- The Link ID in External Application property
- The SQL Query property
- Configuring an Application Link-In Using A Remote Database Query

The Link ID in External Application property

The link id in external application is shared between Exponare Enquiry and an external application. It is used to uniquely identify an Application Link-In with Exponare Enquiry. For example a third party application may pass a link id of “Parks” to Exponare Enquiry as illustrated above. In this case Exponare Enquiry would locate the Application Link-In with the link id in external application setting of “Parks” and run that link.

The link id in external application setting must be unique within a Work Context. If several Application Link-Ins share the same link id in external application setting, the first such link will be invoked when an Application Link-In with that link id is run.

If more than one Work Context uses the same link id for an Application Link-In, the first link found in the Work Context tree will be invoked, regardless of the user’s default Work Context. To override this behaviour, use the command line’s context parameter.

For example, the user Lumberjack has a default work context of Vegetation, but can also see the Cadastre Work Context which is higher in the work context tree. Both the Vegetation and Cadastre Work Contexts have Application Link-Ins with a link id in external application setting of “Parks”. If the Link-In command line parameters are:

```
/Username:Lumberjack/password: /LinkFile:C:\MyParks.xml
```
Application Link-Ins

Lumberjack will be presented with the Cadastre Work Context. However, if the command line parameters are:

/Username:Lumberjack/password: /LinkFile:C:\MyParks.xml
/context:Vegetation

Lumberjack will be presented with their default Work Context of Vegetation.

However, if the /reuse parameter is used, the following scenarios are possible:

Typically the link id is fixed in an external application and must be discovered by an Exponare administrator. Once discovered it can be configured in Exponare.

The SQL Query property

An Application Link-In receives a set of common keys in the form of a selection description. These are used to select spatial Features in Exponare Enquiry by running an administrator defined Query. The SQL query should have the format:

```
SELECT <selection_table>.mi_key from <table names>
[WHERE <condition>]
```

The `<selection_table>` is the name of the spatial table to select the Features from. The `<table names>` is a list of all tables that are to be part of the SQL statement. The `<table names>` must include the spatial table on which the Features are being selected. The optional WHERE condition allows you to specify a join between the spatial table and any other SQL Support Tables open in the Work Context. If the Link-in id bind table configured above is different from the spatial table on which to be selected, then the join between the two tables must be specified here.
For example, if the Work Context contains a spatial table called 'properties' with a primary key called 'id' and a non-spatial table called 'property_data' with a foreign key called property_id, and the keys being passed in from the external application match the values in the property_data.property_id column, then an Application Link-In SQL Query could be specified as:

```sql
SELECT properties.mi_key FROM properties, property_data
WHERE properties.id = property_data.property_id
```

Exponare internally filters out a subset of the property_data such that only rows where the property_data.property_id value matches one of the incoming IDs is used in the Query.

When constructing a cross table SQL Query for an application link in, ensure that the layer name for the spatial layer is always specified first in the FROM section of the query.

Using the ORDER BY clause in Application Link-Ins is not supported.

### Configuring an Application Link-In Using A Remote Database Query

The Query for an Application Link-In can be run in a remote database. This can be used if the keys being passed in by the external application do not map directly onto values in any of the open TAB Files for the Work Context, and a further mapping needs to be done through an external database.

To do this:

1. Set the Database connection property to point to a non-native Database Connection.
2. Specify the Link-in id bind table which defines the map table against which to make selections.
3. Set the Link-in id bind column, which defines the column on the Link-in id bind table against which to bind.
4. Specify the SQL Query to be run.

   The SQL Query must map the keys being passed in by the external application to values that can be used to bind against the bind column of the bind table. The special keyword LinkIn.Ids is available for use in this query—when the query is processed, this keyword is replaced with a list of the ids that have been passed in. So a query of the form:

   ```sql
   SELECT Owner_Details.PropertyId FROM Owner_Details
   WHERE Owner_Details.Owner_Name in (LinkIn.Ids)
   ```

   maps the incoming Owner_Name values from the external database to PropertyId values that can be bound against a column on the map layer.

### Creating an Application Link-In

To create an Application Link-In:

1. Select a Work Context.
2. Select Application Link-Ins.
3. Click Add New Item.
4. Complete the Application Link-Ins properties and click Save and Activate Settings.
Application Link-Outs

An Application Link-Out is a means of starting an external application from within Exponare Enquiry. In the process of starting an external application Exponare Enquiry is capable of being configured to pass a description of the current selection set in XML format to the external application.

For example, a selection description can be passed to Microsoft Excel. When Excel is opened, the user can choose how to view the selection description.
Chapter 28: External Application Links

As an XML list

![XML list example]

As a read-only workbook

![Workbook example]

Use the XML Source task pane

![XML Source task pane]

If capable, the external application can synchronise its own selection set based on the selection description to provide a seamless workflow between applications.

Configuring a Link-Out Using the Selection Description

Some external applications have the concept of a selections set. Exponare Enquiry is capable of being configured to export a description of its current selection set for use by an external application.

Two things are required for selection description integration:

1. The external application and Exponare Enquiry must have a common key in their data so that identifiers that make up a selection description can be matched.
2. The external application must be capable of understanding Exponare Enquiry’s selection description ‘language’. If this is not possible, a stepping-stone helper application can be used.

Contact Pitney Bowes Software for assistance if you require a helper application.

To achieve the first of the above requirements, one or more Data Binds must be configured that include the common key before the Application Link-Out is configured. For details regarding Data Bind configuration see Data Binds.

- The Link ID in External Application property
- The LinkFileLoc Special Placeholder
Application Link-Outs

- Configuring an Application Link-Out Using a Remote Database Connection

The Link ID in External Application property

The Link ID in external application is shared between Exponare Enquiry and an external application. It is used to uniquely identify an Application Link-Out from Exponare Enquiry. For example a third party application may require a link id of "ASSET". In this case Exponare Enquiry would be configured with an Application Link-Out with the Link ID in external application setting of "ASSET". When run this link id would be passed to the external application.

The Link ID in external application setting should be unique within a Work Context. If several Application Link-Outs share the same Link ID in external application setting the first link will be used when an Application Link-Outs with that link id is run.

Typically the link id is fixed in an external application and must be discovered by an Exponare administrator. Once discovered it can be configured in Exponare.

The LinkFileLoc Special Placeholder

The command-line arguments to be sent to the external application can contain a special placeholder, [LinkFileLoc]. If this placeholder is included in the command-line arguments it will result in a file being generated that contains selection description information, called a link file. It will also result in the placeholder being replaced by the path to the created link file. For example the command line argument

SomeArgument="[LinkFileLoc]"

would result in the following

SomeArgument="C:\Documents and Settings\[windows user name]\Application Data\MapInfo\Exponare\HighLoadTransferFile.xml"

Note: • You must check the specifications for the application you are linking with to find the appropriate format for its command-line arguments. For example, Exponare Enquiry would require <LinkFile:[LinkFileLoc]].

• Given that the path to the link file typically contains spaces you will almost always need to enclose the [LinkFileLoc] tag in double quotes.

Configuring an Application Link-Out Using a Remote Database Connection

It is possible to run a Query on an external database when performing an Application Link-Out. This is useful, for example, if the values returned from the Data Bind column are not valid for the external application and need to be mapped to another set of values before being passed out.

To use an external database link, specify the Database Connection and enter the SQL Query (using the SQL syntax of the remote database). The special keyword LinkOut.Ids is available for this query - this keyword is replaced with the values from the Data Bind when the query is processed.

For example, the following Query

SELECT Owner_Name FROM OwnerDetails
WHERE PropertyId in (LinkOut.Ids)
transforms the PropertyId values from a Data Bind into their matching Owner_Name values and passes the Owner_Name values out to the external application.

The Link id in external application values in LinkOut.Ids are unique. However, it is possible that the SQL Query could return duplicate values. In the above example, an owner may have more than property, or share their name with another owner. If this occurs, there will be duplicate entries in the XML file.

Creating an Application Link-Out

1. Select a Work Context.
2. Select Application Link-Outs.
3. Click Add New Item.
4. Complete the Application Link-Out properties and click Save and Activate Settings.

### General

<table>
<thead>
<tr>
<th>Appears as Toolbar Shortcut</th>
<th>If True, this link appears as a shortcut button on the toolbar. Requires that the User Interface has a toolbar that includes the External Links Menu Items command.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application executable</td>
<td>The path name of the executable to run with this Link Out. This can either be a relative filename (relative to the Enquiry Program directory) or an absolute path name to the executable file. Click the button to browse for the executable.</td>
</tr>
<tr>
<td>Args</td>
<td>The command line arguments sent to the external application. If the special placeholder [LinkFileLoc] is used it will be replaced by the path to an XML file containing a description of the current selection.</td>
</tr>
<tr>
<td>Database connection</td>
<td>The Database Connection to access for running this link-out Query selected from a drop-down list. The Application Link-Out will not appear in the Enquiry Link-Out menu and/or on the toolbar if the default of &lt;none&gt; is retained, even if a database connection is not required. If no connection is required, select any Database connection.</td>
</tr>
</tbody>
</table>
## Application Link-Outs

### General

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>The description of the External Link Out, shown in the status bar when the mouse is hovered over a link <strong>Name</strong> or used as tooltip text when the mouse is hovered over the External Link Out icon on the toolbar.</td>
</tr>
<tr>
<td><strong>Link id in external application</strong></td>
<td>An identifier that is passed to the external system to uniquely identify this Link Out. This parameter has different uses depending on the external application.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The name of the External Link Out, shown to the user in the <strong>External Links Menu Items</strong> menu.</td>
</tr>
<tr>
<td><strong>SQL query</strong></td>
<td>If present, this SQL <strong>Query</strong> is executed on the database defined by the <strong>Database Connection</strong>, and the result passed to the external application.</td>
</tr>
</tbody>
</table>
### Chapter 28: External Application Links

#### Toolbar

<table>
<thead>
<tr>
<th>Appears as Toolbar Shortcut</th>
<th>If True, this link appears as a shortcut button on the toolbar. Requires that the User Interface has a toolbar that includes the External Links Menu Items command.</th>
</tr>
</thead>
</table>
| Icon                        | Exponare Enquiry only.  
The image to use as the toolbar icon for this query.  
The image should be present in the Default\RibbonSmall or Default\RibbonLarge folder under the theme based on your requirement.  
If you wish to override this image, the override image of the same name should be added to the relevant theme folder.  
If you wish to provide image outside the theme folder then you can give the relative path of the image placed in a virtual directory.  
The image file should be web-readable by an anonymous user.  
The relative path should have a leading forward slash.  
The Format of path should be /[Web Application]/[virtual directory]/[image file (with extension)]  
e.g. /Exponare/IconImage.png  
If left blank, the images used will be dependent on the Theme specified for the user interface, e.g. Link0.gif, Link1.gif etc. |

Add one or more Application Link-Out Data Binds as described below:

To Add Application Link-Out Data Binds:

1. 📖 If necessary, select a Work Context.
2. 📖 If necessary, select an Application Link-Out.
3. ➡️ Click Add New Item.
4. Complete the Application Link-Out Data Bind properties.

#### General

<table>
<thead>
<tr>
<th>Column name</th>
<th>The column of the Data Bind from which to extract Feature identifiers. This must be the visual name of the column, as shown to the user in the Selection Results panels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Bind</td>
<td>The Data Bind that provides Feature identifiers, selected from a list of configured Data Binds. It must be unique within this Application Link-Out.</td>
</tr>
<tr>
<td>Name</td>
<td>The name for the Data Bind.</td>
</tr>
</tbody>
</table>
Application Link-Outs

5. Repeat steps 3 and 4 to add additional Data Binds
6. Click Save and Activate Settings.
Watermarks

This chapter describes how to set up Watermarks.

In this chapter...

- About Watermarks
- Adding a Watermark
About Watermarks

A Watermark is an or defined set of text that will be drawn onto the map after the map data has been rendered. It is used for such things as placing a copyright message on top of protected data. You can define as many Watermarks as you want for a particular Work Context, and each of those Watermarks will then be rendered on top of the map data in the final map seen by the user. You can specify how transparent the Watermark is, from being completely transparent (and therefore invisible) through to being completely opaque and so covering all of the map information underneath.

Each Watermark can be either set to always be drawn on the map, or be linked to a specific layer in the Work Context. If a Watermark is linked to a layer, then it will only be rendered when that layer is visible on the map - ie when the layer is both set to visible in the Legend panel and is currently within zoom range.

You can move the Watermarks up and down in the list, and the order they have in the configuration is the order in which they are drawn on the map. Watermarks that are higher up the list will be drawn over Watermarks that are lower down the list.

You can define a Watermark as either an by pointing to the file you want to use on the server, or define it as text by setting the text you want to appear. You can also set other properties of the text, such as the colour, font to use and the font size. You can define both an and a text Watermark in the same Watermark configuration setting. If you define a text Watermark, be aware that the server will not perform any wrapping of the text. If you have a lot of text you need to use newline and other whitespace characters to make sure that all the text is visible on the map when rendered. Similarly, if you define a Watermark with a very large and set the display type to tile then across the map, you may not see more than one render of the Watermark on the map.

You can specify which type of client can see the Watermark - using it in Exponare Enquiry, Exponare Public, Exponare Rest Public or showing it for all clients.

You can specify how the Watermark is to be drawn on the map by setting the Display type property to one of the five following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed</td>
<td>Draw the Watermark on the map at the position specified in the X coordinate of the Watermark and Y coordinate of the Watermark properties.</td>
</tr>
<tr>
<td>Tile</td>
<td>Draw the Watermark repeatedly across the map from left to right and top to bottom.</td>
</tr>
<tr>
<td>Centre</td>
<td>Draw the Watermark at the centre of the map.</td>
</tr>
<tr>
<td>FullScreen</td>
<td>Expand the out to be as large as possible whilst still maintaining the aspect ratio. If the Watermark is larger than the map, this will shrink the to the largest possible size that still displays the entire and maintains the aspect ratio. If this is a text Watermark, this setting is identical to 'Centre'.</td>
</tr>
<tr>
<td>FullScreen Stretched</td>
<td>Expand the out to cover the entire map. This will not maintain the aspect ratio and so may distort the substantially. If this is a text Watermark, this setting is identical to 'Centre'.</td>
</tr>
</tbody>
</table>
Adding a Watermark

To add a Watermark to a Work Context

1. Select a Work Context node.
2. Select the Watermarks node.
3. Click Add New Item to add a Watermark.
4. Complete the Watermark properties and click Save and Activate Settings.

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alpha value</strong></td>
</tr>
<tr>
<td><strong>Client type</strong></td>
</tr>
<tr>
<td><strong>Display type</strong></td>
</tr>
<tr>
<td><strong>Image path</strong></td>
</tr>
<tr>
<td><strong>Layer</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Watermark text</strong></td>
</tr>
<tr>
<td><strong>Watermark text colour</strong></td>
</tr>
</tbody>
</table>
# Adding a Watermark

## General

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermark text font</td>
<td>The font to use for the Watermark text.</td>
</tr>
<tr>
<td>Watermark text size</td>
<td>The font size of the Watermark text.</td>
</tr>
<tr>
<td>X coordinate of the watermark</td>
<td>The x coordinate, in screen pixels, of where to place the Watermark on the map if the Display type field is set to 'Fixed'. A positive value refers to the number of pixels from the left-hand side of the ; a negative value from the right-hand side of the . Negative values will be incremented by one pixel, so that a value of -1 is flush with the right-hand-side of the .</td>
</tr>
<tr>
<td>Y coordinate of the watermark</td>
<td>The y coordinate, in screen pixels, of where to place the Watermark on the map if the Display type field is set to 'Fixed'. A positive value refers to the number of pixels from the top of the ; a negative value from the bottom of the . Negative values will be incremented by one pixel, so a value of -1 is flush with the bottom of the .</td>
</tr>
</tbody>
</table>
Coordinate Export

Exponare has tools to allow the user to draw an arbitrary shape on the current map view and export the coordinates describing that shape to a file (Exponare Enquiry) or to an external web application (Exponare Public). The user has the choice of three types of shapes to draw - a point, a polyline or a polygon. This chapter discusses how to set up and export coordinates from Exponare.

In this chapter...

- Configuration of Coordinate Export
- Coordinate Export - Exponare Enquiry
- Coordinate Export - Exponare Public
Configuration of Coordinate Export

Coordinate Export Tools

For both Exponare Enquiry and Exponare Public, you will need to add the relevant map tools to the Menu or the Toolbar or both. These are the tools that the User activates to define the coordinate(s) to be exported. The commands are:

- Coordinate Export - Point
- Coordinate Export - Polygon
- Coordinate Export - Polyline
Coordinate Export - Exponare Enquiry

To configure a coordinate export for Exponare Enquiry:

1. Add Coordinate Export Tools as discussed above.
2. Add a Coordinate Details Panel to the User Interface - it can appear in the left or bottom panel. See Chapter 15: User Interfaces.

Dropdowns for “Category” and “Coordinate system” allow users to choose the desired coordinate system. After selecting the coordinate system user can convert coordinates by clicking on Convert button. As the user clicks on this button results would be listed in the second window of the panel.

You can either copy the coordinates to the clipboard, or use the Export button to copy the coordinates to an xml or csv file.

Coordinate Export - Exponare Public

- Procedure
- The Hyperlink Target Field
- Passing the Coordinates to the External Web Application
- Accessing the Information Through Javascript
- Test Stubs
Coordinate Export - Exponare Public

Procedure

To create/update a coordinate export for Exponare Public:

1. Add Coordinate Export Tools as discussed above.
   
   **Note:** When activated, the tools allow the User to draw the appropriate shape on the map. The User can re-draw the shape as many times as they like until they are happy that the correct area has been identified. The shape is removed from the map as soon as another map tool (e.g. Zoom In) is used.

2. Add a Coordinate Export Menu Items command to the Public menu and/or toolbar. See List Commands

   ![The menu option/toolbar button will not be visible until an export coordinates selection is made.]

   The illustration shows that a point has been selected - it is displayed as a star.

3. Select a Work Context node.

4. Select the Coordinate Export Targets node.

5. Click Add New Item to create a new Coordinate Export or

6. Click the Coordinate Export Target node to update an existing Coordinate Export.

7. Complete the Coordinate Export Target properties.

---

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display text</strong></td>
</tr>
<tr>
<td><strong>Hyperlink target</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
</tbody>
</table>
Chapter 30: Coordinate Export

The Hyperlink Target Field

The value in this field should be set to a valid target for the **href** property of a Hyperlink Tag in HTML. This value will be placed into the target property of the Hyperlink that is generated on the Exponare Public interface, and can then be clicked by the User as a standard Hyperlink. An example target is as follows:

```
http://www.mapinfo.com
```

This target will cause the browser to re-direct to the Pitney Bowes Software website when the User clicks on that hyperlink. In this way, the User can access an external website, or web application, from Exponare.

Passing the Coordinates to the External Web Application

As well as being able to invoke an external website or web application, you can also configure the Hyperlink Target to pass out information about the Feature drawn on the map by the User. This is done in one of two ways.

Keywords

You can access information about the current Feature by placing special keywords into the Hyperlink Target value. These keywords will be replaced by the actual values when the hyperlink is rendered to the client, and so can be passed to the external web application as Query Parameters to the URL. The keywords available are:

- `{EXPONARE_X}` - this keyword will be replaced by the x coordinate of the point object drawn on the map. If the object on the map is a polyline or polygon, it will be the x coordinate of the centroid of the Minimum Bounding Rectangle of the object.
- `{EXPONARE_Y}` - this keyword will be replaced by the y coordinate of the point object drawn on the map. If the object on the map is a polyline or polygon, it will be the y coordinate of the centroid of the MBR of the object.
- `{EXPONARE_EPSG}` - this keyword will be replaced by the EPSG coordinate system of the map.

An example of how to use these keywords to pass the data in to an external web application is as follows:

```
http://www.external_server.com/WebApplication.aspx?id=Exponare&xCoord={EXPONARE_X}&yCoord={EXPONARE_Y}&coordSys={EXPONARE_EPSG}
```

This URL will fire up the hypothetical web application WebApplication.aspx running on the server www.external_server.com. The keywords in the URL will be replaced with the actual values from the Feature drawn on the map, and will be passed in as Query Parameters to the web application.

Accessing the Information Through Javascript

As well as the x and y coordinates and the EPSG coordinate system reference, you can also access a complete list of all the points in the Feature as well as an XML representation of the Feature. Because these two values are too large to fit in to a Query Parameter in a URL, they can be accessed through javascript as properties of the document object of the page. The properties are as follows:
Coordinate Export - Exponare Public

- `document.exponare_x` - this contains the x coordinate of the point Feature, or the x coordinate of the centroid of the Minimum Bounding Rectangle (MBR) of the polyline or polygon.
- `document.exponare_y` - this contains the y coordinate of the point Feature, or the y coordinate of the centroid of the MBR of the polyline or polygon.
- `document.exponare_epsg` - this contains the EPSG coordinate system reference for the map.
- `document.exponare_list` - this contains a list of all the points that make up the polyline or polygon as a comma-separated list of x, y value. If the Feature is a single point, this will contain the x and y coordinate of the point.
- `document.exponare_gml` - this contains an XML representation of the Feature on the map.

To access these values through javascript, you can set the Hyperlink Target to execute a javascript function when the User clicks the hyperlink as follows:

```javascript
javascript:myFunction()
```

This will cause the javascript function 'myFunction()' to run when the User clicks the link. You can then write the body of this function to access the properties described above and send them out to an external web application.

Test Stubs

The Exponare Server standard install contains test stubs that can be used to test the configuration of a Coordinate Export Target. There are two stubs.

**PublicLinkoutTest.aspx**

The Exponare Server contains an ASPX page called PublicLinkoutTest.aspx. This is a simple ASPX application that will display all the parameters passed in asQuery Parameters in the calling URL. To use this page to test your coordinate link-out, configure the Hyperlink Target of your link-out to point to this ASPX page and pass in the coordinate keywords as Query Parameters at the end of the URL. For example,

```html
http://myserver/Exponare/PublicLinkoutTest.aspx?id=Exponare&xCoord={EXPONARE_X}&yCoord={EXPONARE_Y}&coordSys={EXPONARE_EPSG}
```

When running this link-out you should see a web page that lists all the parameters passed in at the end of the URL.

**Javascript Function to Display Values**

Each of the four sample Public templates contain a definition of a javascript function called `display_points`. This function displays all of the values stored in javascript when running a coordinate link-out. To access this function set the Hyperlink Target of your link-out to

```javascript
javascript:display_points()
```

When running this link-out you should see a web page that lists all the parameters describing the Feature on the map.
Address Search

The Address Search panel allows the user to search for an address and show a marker on the map. Exponare uses the searching functionality of an external server to perform the Address Search, and so access to an Envisna Location Web Service or a MapMarker Web Service is required.

The configuration of the Address Search is global—that is, it is configured once and is the same across all users and all Work Contexts.

In this chapter...

- General Properties
- Input Field Labels
- Mandatory Fields
- Search Behaviour Properties
- Communication With The Server
## General Properties

The general properties are those pertaining to the Address Search Web Service and the way the results are displayed.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address search server type</td>
<td>The type of the Address Search server. Either Envinsa or MapMarker.</td>
</tr>
<tr>
<td>Country code</td>
<td>The ISO three-letter country code for the country in which the address is being searched for. For example, AUS.</td>
</tr>
<tr>
<td>Help text</td>
<td>The text to display at the top of the Address Search panel. This should contain instructions for the user on how to use the particular address panel the administrator has configured.</td>
</tr>
<tr>
<td>Marker symbol colour</td>
<td>The colour of the symbol used to display a found address point.</td>
</tr>
<tr>
<td>Marker symbol size</td>
<td>The font size for the symbol used to display an address point. A common setting is “24”.</td>
</tr>
<tr>
<td>Maximum results</td>
<td>The maximum number of matched addresses to return.</td>
</tr>
<tr>
<td>Password for address search server</td>
<td>The password to log into the Address Search server with. If the Address Search server is of type MapMarker, this field is not required.</td>
</tr>
<tr>
<td>URL of address search server</td>
<td>The URL of the Address Search server. This should be either a valid URL for a MapMarker Java servlet, or a valid URL for an Envinsa Location Utility service.</td>
</tr>
<tr>
<td>Username for address search server</td>
<td>The username to log into the Address Search server with. If the Address Search server is of type MapMarker, this field is not required.</td>
</tr>
<tr>
<td>Zoom unit</td>
<td>The unit of the zoom width, selected from a list of MapXtreme units.</td>
</tr>
<tr>
<td>Zoom width</td>
<td>The zoom width to use when displaying a found address point.</td>
</tr>
</tbody>
</table>
Input Field Labels

Exponare allows the user to enter search terms into up to 13 different fields.

To configure the Address Search interface, decide which of the input fields to display to the user, and what text label to place beside each input field. Each of the above-mentioned input types has a field in the Address Search configuration for setting the text the user sees. If the user text property for a search field is left blank, that input field is not shown to the user.

<table>
<thead>
<tr>
<th>Input Field Labels</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building name text</td>
<td>The label to display for the building name input field.</td>
</tr>
<tr>
<td>Building number text</td>
<td>The label to display for the building number input field.</td>
</tr>
<tr>
<td>Municipality sub-division text</td>
<td>The label to display for the municipality sub-division input field.</td>
</tr>
<tr>
<td>Municipality text</td>
<td>The label to display for the municipality input field.</td>
</tr>
<tr>
<td>Primary country sub-division text</td>
<td>The label to display for the primary country sub-division input field.</td>
</tr>
<tr>
<td>Primary postcode text</td>
<td>The label to display for the primary postcode input field.</td>
</tr>
<tr>
<td>Secondary country sub-division text</td>
<td>The label to display for the secondary country sub-division input field.</td>
</tr>
<tr>
<td>Secondary postcode text</td>
<td>The label to display for the secondary postcode input field.</td>
</tr>
<tr>
<td>Street directional prefix text</td>
<td>The label to display for the street directional prefix input field.</td>
</tr>
<tr>
<td>Street directional suffix text</td>
<td>The label to display for the street directional suffix input field.</td>
</tr>
<tr>
<td>Street name text</td>
<td>The label to display for the street name input field.</td>
</tr>
<tr>
<td>Street type prefix text</td>
<td>The label to display for the street type prefix input field.</td>
</tr>
<tr>
<td>Street type suffix text</td>
<td>The label to display for the street type suffix input field.</td>
</tr>
</tbody>
</table>

Mandatory Fields

A further option for the Address Search input is to specify which input fields, if any, are mandatory. A mandatory field is one for which the user must enter some data. If a mandatory field has no data entered when the user tries to search, the search is not performed and a message is displayed informing them that data is required.

<table>
<thead>
<tr>
<th>Mandatory Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input field as listed above</td>
<td>If True, this input field is mandatory.</td>
</tr>
</tbody>
</table>
Search Behaviour Properties

There are a number of options that can be set to influence how the search is performed. Each of these settings is a boolean flag. For a full description of these flags, please consult your Envisna or MapMarker documentation.

<table>
<thead>
<tr>
<th>Search Behaviour Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close matches only</td>
</tr>
<tr>
<td>Fallback to geographic location</td>
</tr>
<tr>
<td>Fallback to postal location</td>
</tr>
<tr>
<td>Must match address number</td>
</tr>
<tr>
<td>Must match country</td>
</tr>
<tr>
<td>Must match input</td>
</tr>
<tr>
<td>Must match main address</td>
</tr>
<tr>
<td>Must match municipality</td>
</tr>
<tr>
<td>Must match municipality sub-division</td>
</tr>
<tr>
<td>Must match postcode</td>
</tr>
<tr>
<td>Must match primary country sub-division</td>
</tr>
<tr>
<td>Must match secondary country sub-division</td>
</tr>
</tbody>
</table>
Communication With The Server

The functionality of the Address Search is provided by an Envinsa or MapMarker Server, rather than by the Exponare server itself. For this reason, Exponare has no control over the time taken to process an Address Search request and also has no ability to cancel a request before it has completed. Please note that over a slow connection, an Address Search request may take some time to complete.

Currently, Exponare Server is unable to provide detailed error messages about issues with connecting to the server, eg if you specify the Address Search server type as MapMarker but point to an Envinsa service. Please ensure you have verified the precise URL and type of the service independently of Exponare before configuring the Address Search functionality.
Communication With The Server
This chapter describes how to set up on-line help for Exponare Enquiry.

In this chapter...

- Introduction
- Customizing Exponare Help
Introduction

Exponare Enquiry includes a Help command which can be added to a menu and/or toolbar. When the user requests help, the file \texttt{Index.html} in the Help directory specified in the user interface is opened.

The Help command is not available for Exponare Public.

Customizing Exponare Help

When Exponare Server is installed, a default help system is provided in \texttt{Exponare\Server\Help\Default} and can be viewed when working with the sample data.

To customise Exponare Enquiry help:

1. Create a directory in which to store the file \texttt{Index.html}.
2. Create \texttt{Index.html} - this is the page that is opened when the Help command is invoked. In the supplied Help, this page is not seen by the user; the browser is directed to load \texttt{Overview.html}:

   ```html
   <!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
   <html>
   <head>
   <title>Exponare Online Help</title>
   <meta http-equiv="REFRESH" content="0;url=Overview.html">
   </head>
   <body>
   </body>
   </html>
   ```

3. Create the rest of your help system. The files do not need to be saved in the same directory as \texttt{Index.html}.
4. Ensure that you have a menu and/or toolbar incorporating the Help command. See \texttt{Menus and Toolbars}.
5. Set the appropriate User Interface Help directory property to point to the directory created in step 1.

   For example if you created a directory under the Exponare Help directory called MinimalHelp, you would enter MinimalHelp. If the directory was created outside the Exponare Help directory, you would enter the full URL, eg \texttt{http://localhost/MinimalHelp}

   See User Interfaces.
Views

This chapter describes how to create Views for a given Work Context and make them available to Enquiry and Public users.

In this chapter...

- Introduction
- Creating a View
Introduction

A View provides a quick way to set the zoom and pan of a map. For example, you can create a View that centres the map over a railway station with a zoom width of 200 metres.

You can access list of available Views for Exponare Public from the menu and the toolbar. For Exponare Enquiry, you can mark individual Views to appear as shortcut buttons on the toolbar for quick access.

Creating a View

To calculate the map centre point and zoom width settings for a View, use an external tool such as MapInfo Professional. The centre point and zoom width must be calculated in the same coordinate system used by the workspace.

Alternatively you can set a View to have the same centre point and zoom width as the current map view in Exponare Enquiry by using the Populate View button in the Configuration Manager. This button is only available when a View node is selected.

To create a View

1. Select a Work Context node to add the View to.
2. Select the Views node.
3. Click Add New Item to add a new View node
4. Optionally, click Populate View to open the Enquiry Selector window so that you can choose a map from which to populate the View properties.
5. Update the View properties and click Save and Activate Settings.
Chapter 33: Views

### General

<table>
<thead>
<tr>
<th>Coordinate System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Point</td>
<td>The View's coordinate system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exponare Enquiry and Rest Public only.</th>
</tr>
</thead>
</table>

The description of the View, shown in the status bar when the mouse is hovered over a View Name in the Views menu and used as tooltip text when the mouse is hovered over the View icon on the toolbar.

#### Name
The name of the View as shown to the user in the Views menu.

#### X coordinate of the map centre
The new X coordinate of the map after this View has been triggered.

#### Y coordinate of the map centre
The new Y coordinate of the map after this View has been triggered.

#### Zoom width of the map
The new zoom width of the map after this View has been triggered.

#### Zoom width unit of the map
The unit for the View zoom width, selected from a list of available units.

### Toolbar

<table>
<thead>
<tr>
<th>Appears as Toolbar Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponare Enquiry only.</td>
</tr>
</tbody>
</table>

If True, this View will appear as a shortcut button on the toolbar. This also requires that the User Interface has a toolbar that includes the Views Menu Items command. In Rest Public, it will appear if user added it in ToolBar for that user.

<table>
<thead>
<tr>
<th>Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponare Enquiry only.</td>
</tr>
</tbody>
</table>

The image to use as the toolbar icon for this query. The image should be present in the Default\RibbonSmallor Default\RibbonLarge folder under the theme based on your requirement.

If you wish to override this image, the override image of the same name should be added to the relevant theme folder. If you wish to provide image outside the theme folder then you can give the relative path of the image placed in a virtual directory.

The image file should be web-readable by an anonymous user.

The relative path should have a leading forward slash. The Format of path should be [Web Application]/[virtual directory]/[image file (with extension)] e.g. /Exponare/IconImage.png

If left blank, the images used will be dependent on the Theme specified for the user interface, e.g. View0.gif, View1.gif etc.
Global Views

Exponare now provides the facility to define views globally in configuration manager and admin can map them with work contexts as required. Global views contains all the information as Views. Admin can copy global views and paste in view node and vice versa.

Figure 33-1: Global Views

- Global Views can be created in the same manner as Views.
- This feature is supported in Rest Public Application and Enquiry only.
- In toolbar, Views and Global views are listed One after another respectively. If Global and Local views are given same name, local view will be loaded on the map.
Data Editing

As a user you can update the data displayed in the form of DataBind which gets populated upon any Map Selection activity. Updation has to be based upon User and particular data (i.e tables and its columns). This feature is meant for External Database usage only. It is not for native or .tab files.

In this chapter...
- Overview
- Configuration Manager Settings
- Log Functionality under Editing
Overview

Under the Database Edit settings node, Administrator can configure the respective user, its corresponding database connection, table and the column that can be edited by the user.

Configuration Manager Settings

In Configuration Manager, administrator can grant permissions to the user for editing the data using external databases only as shown below:

*Figure 34-1: Configuration Manager Settings*

Administrator giving access to a respective user from the drop-down menu

The admin node may hold more than one node as different DataBase Connections and all the tables upon which user is allowed to edit the data will be present under this DataBase Connections node.
Figure 34-2: DataBase Connections (Oracle) node

Under the Database Connections (Oracle) node Table Name is created. This is the table that can be edited by the user.

Table and column name has to be manually entered by the administrator.

Table Name PropertyParcels for which user is allow to edit the data mentioned under the DataBase Connection(Oracle) node.
Under the Table node (PropertyParcels), administrator can define the multiple columns of the Table Name which can be edited by user.

- Primary key column and Bind column cannot be made editable by the user even if it is mentioned here.
Chapter 34: Data Editing

Configuration Settings for the Column node:

Name
Column Name as shown in DataBind. There is a need to make sure that such column do exists in the table. As it may happen to use alias which makes the column to be non-existent in the table.

Input Type
Input type can be a drop down list or a text box for user to edit the value of the column.

Static List Items
This field is used in conjunction with an input type of drop down list with comma separated values.

User Interface
As the Editing tab page shows the data regarding the active selection only and to change the data of a different feature user is supposed to change the active selection so that data can be viewed in the Edit Tab.

Administrator will select the command Edit Data under user interface>Full Interface>Left Panels>Edit data to show a seperate edit data panel in Enquiry.
Log Functionality under Editing

Administrator can enable the settings of creating a log file in case there are any changes/updates made using Edit feature by the user, as shown below:

In Application Settings node, under General sections there are 2 rows for Log. One is for the name of the log file with .txt extension and other is for enabling the log with a Boolean value true. The default Enable Log value is False.
Chapter 34: Data Editing

After enabling the log with a value of True, respective log file (.txt) gets created under the folder structure.

Log File folder where the .txt file gets created
Log Functionality under Editing

Screen-shot of Log file

where fields of the log are given below,

1. Server Name = SQLServer Connection
2. Server Type = SQLServer
3. User Name = admin
4. Date/Time = 25/06/2010 17:26:40
5. Table Name = OwnerDetails
6. Column Name = House_Number
Adhoc Layers

As a user you can open an adhoc layer (user defined layer) so that it can be shown on the map and in the Legend of Exponare Enquiry.

In this chapter...

- Overview
- Configuration Manager Settings
Overview

Under the Adhoc Layers node, administrator can configure the user defined layers that needs to be shown on the map and in the legend.

Configuration Manager Settings

In Configuration Manager, administrator can configure the user defined layers under Adhoc Layers node.

**Figure 35-1: Administrator configuring Adhoc Layers**

Administrator needs to configure Adhoc Layers by clicking on `+` button on the toolbar. The admin needs to provide full path of the folder in 'Layer Path' field under which added layer tab files are present. File name should be same as layer tab file. For eg: Cat as Adhoc Layer.

Administrator can also add databinds using Native or External Database connection in Adhoc Layers and can perform selections on it.

- Adhoc layer only support vector data.

**Figure 35-2: Administrator Configuration - Adding Databinds**

If External database is used for adding databinds in Adhoc Layers, then users can also perform Data Editing functionality on it but setting needs to be configured under Database Edit settings for the same.
Administrator has a flexibility to drag layers from Work Context Layer Settings to Adhoc Layers but not from Adhoc Layers node to Layer Settings. Once administrator drag layers, then their respective databinds will also move which further needs to be modified by the administrator for settings like Layer Path, SQL query for which an identifier needs to be placed as '(Exponare.AdhocLayer)' in place of 'Layer_Selection'.

For example:

Select mi_key, "PropertyId" From "Cat_Selection" Order By "PropertyId" ASC will be replaced with

Select mi_key, "PropertyId" From "(Exponare.AdhocLayer)" Order By "PropertyId" ASC.

**Figure 35-3: Adhoc Layer Command**

Administrator can also add databinds in Adhoc Layers.

To add databind:

Configuration Manager -> Select Adhoc Layer node -> Click ‘+’ toolbar button to add Adhoc Layer ->
Click ‘+’ toolbar button to add databind.
Figure 35-4: Add New Databind in Adhoc Layers
Part 5: Exponare Public

The chapters in this section explain how to configure and start Exponare Public.

Topics

- Creating Exponare Public Pages
- Public and Rest Public Start-up Parameters
Creating Exponare Public Pages

This chapter discusses creating Exponare Public pages and includes a reference of the tags that can be used in ASP.NET pages.

In this chapter...

- Introduction
- Map
- Menu and Toolbar
- Banners
- Panels
- Status Area
- Setting Up Pages for Different Screen Resolutions
- Map Centre
Introduction

Configuration of the menu, toolbar and panel contents for Public follows the same process as for Enquiry. However, the location of the components can be altered for Public. This is possible because Public is an ASP.NET web application that is built by creating an ASP.NET file (.aspx extension). An ASPX file is an HTML file that includes special tags for processing on the server. Exponare Public has a set of special tags that are used to position the various components, such as the map, the toolbars, and so on.

Because the ASPX files are basically HTML files, other HTML or ASP.NET data can be added to display other information or images such as company banners, sitemaps, or documentation.

If you are editing or creating Public application pages, keep the following points in mind:

• Cascading stylesheets (.CSS files) are used to manage most of the structural and visual settings for the page components. All Public application pages require a CSS file that defines key settings.
• The Public application pages are ASP.NET pages and are processed by IIS and the ASP.NET Framework.
• An ASP.NET page can include regular HTML data.
• The TagPrefix setting at the top of the ASPX file defines the prefix used for the special ASP.NET tags (this is a standard ASP.NET setting).
• Both the menu and the toolbar control use extensive JavaScript to modify their appearance after being rendered. This modification can affect properties such as borders of the s, and so can result in a change in size of the menu or toolbar after the initial rendering. For this reason, it is important to check your ASPX page and css settings to ensure there is no visible ‘jump’ in the page as a result of the menu and/or toolbar re-sizing after the page has loaded.
• Special ASP.NET tags are used to include the core components of the Public application—these are listed under Exponare Public Page Tags.
Exponare Example Public Pages

This section explains the example pages that are installed with Exponare Server. Please review these before attempting to create a new Public application page.

Public User

The Public User can access Exponare Public pages without providing user credentials.

By default, the following files can be found in:
C:\Program Files\MapInfo\Exponare\Server

<table>
<thead>
<tr>
<th>Filename</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public.html</td>
<td>The shortcut to Exponare Public, found under Exponare Server 3.0, launches Public.html. The page contains links to the pages listed below.</td>
</tr>
</tbody>
</table>
| PublicApplication.aspx | **Windows Application Style**  
  A visual style with a similar look and feel to typical Windows applications. This is achieved through colour scheme choices, inclusion of a menu, toolbar and status bar as well as allowing the application to expand to fill the entire window.  
  Additionally, this visual style is consistent with Exponare Enquiry in its positioning of its banner and panels, making it ideal for minimising training for users who utilize both Exponare Enquiry and Exponare Public. |
| PublicApplication2.aspx| **Windows Application Style in a New Window**  
  This visual style is identical to the Windows Application Style (above) in all aspects except that Exponare Public is started in a new browser window that does not contain the typical Internet Explorer menu and toolbar. This further enhances the illusion of Exponare Public appearing as a typical Windows application. |
| PublicCustomLayout.aspx| **Simplified Layout with a Custom Colour Scheme**  
  A visual style that offers a simplified layout and a custom colour scheme. The absence of a menu and fixed size work area are more typical of web applications. The use of a custom colour scheme (i.e. one not consistent with the Windows colour scheme) is also more typical of web applications. |
| PublicCustomLayout2.aspx| **Alternative Colour Scheme**  
  This visual style is identical the one above in all aspects except for the use of an alternative custom colour scheme. |
### Named Users

Named users must be authenticated before they can access Exponare Public pages. The files used to illustrate named access to Exponare Public are listed below.

<table>
<thead>
<tr>
<th>Path</th>
<th>Filename</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponare</td>
<td>Login.html</td>
<td>Allows for redirection using IIS by the Administrator. By default the installer will set this to redirect to the Login.aspx page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Login.html is required by Exponare, as it is used by the code during Log Off.</td>
</tr>
<tr>
<td>Exponare\Authorised</td>
<td>PublicApplication.aspx</td>
<td>These are copies of the files listed under Public User.</td>
</tr>
<tr>
<td></td>
<td>PublicApplication2.aspx</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PublicCustomLayout.aspx</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PublicCustomLayout2.aspx</td>
<td></td>
</tr>
<tr>
<td>Exponare\Login</td>
<td>Login.aspx</td>
<td>The login page. On a successful login, the PublicApplication.aspx page in the Exponare\Authorised is loaded.</td>
</tr>
</tbody>
</table>

**Note:**
- We recommend that you use SSL to encrypt the communication for the Login virtual directory, as without SSL, the username and Password will be sent as clear text.
- By default, Exponare uses Forms based authentication so that multiple browsers can be supported. However, if you are deploying Exponare Public on an intranet, you could consider using Windows authentication with Internet Explorer.
- The login.aspx page can be modified so that users are redirected to an alternative page upon successful authentication. This is done by modifying the DestinationPageUrl property on the login control on the login.aspx page.
Chapter 36: Creating Exponare Public Pages

Login to Public - Named Users

Figure 36-1: Login to Public - Named User

Exponare Public Page Tags

- Map
- Menu and Toolbar
- Banners
- Panels
- Status Area
Exponare Public Page Tags

Map

The Map tag places the main map onto the web page. The map size is fixed and the width and height attributes must be set explicitly. Specifying the height and width in pixel units is generally most convenient. Whichever units you use must be included in the attribute value.

Tag:

```
<cc1:mapcontrol>
```

Map Tag Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Unique Id for the control, eg “MapControl1”</td>
</tr>
<tr>
<td>Runat=&quot;Server&quot;</td>
<td>Mandatory</td>
</tr>
<tr>
<td>Height=&quot;XX&quot;</td>
<td>Height of the map, eg height=&quot;500px&quot;</td>
</tr>
<tr>
<td>Width=&quot;XX&quot;</td>
<td>Height of the map, eg width=&quot;600px&quot;</td>
</tr>
</tbody>
</table>

Example:

```
<cc1:mapcontrol id="MapControl1" runat="server" height="500px" width="600px"></cc1:mapcontrol>
```

Menu and Toolbar

The Menu and Toolbar tag causes the Exponare web page scripter to insert the menu or toolbar as configured by the administrator in the Configuration Manager.

Tag:

```
<cc1:MenuToolbarScripter>
```

Menu and Toolbar Mandatory Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Unique Id for the control, eg “Menu”</td>
</tr>
<tr>
<td>Runat=&quot;Server&quot;</td>
<td>Required by the ASP.NET Framework</td>
</tr>
<tr>
<td>MapId</td>
<td>Unique ID of the Map component for this application</td>
</tr>
<tr>
<td>ItemType</td>
<td>Menu or Button</td>
</tr>
</tbody>
</table>

Example 1:

```
<cc1:MenuToolbarScripter id="M" runat="server" MapId="MapControl1" ItemType="Menu"></cc1:MenuToolbarScripter>
```

Example 2:

```
<cc1:MenuToolbarScripter id="T" runat="server" MapId="MapControl1" ItemType="Button"></cc1:MenuToolbarScripter>
```
Chapter 36: Creating Exponare Public Pages

**Banners**

Two types of banners are allowed, one that fills horizontally and one that fills vertically. The banners are essentially the same as for Enquiry. To make a banner visible, you must also set the banner visibility in the Configuration Manager.

**Tags:**

```xml
<cc1:TopBannerScripter>
<cc1:LeftBannerScripter>
```

**Banner Mandatory Attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Unique Id for the control, eg “TopBannerScripter1”</td>
</tr>
<tr>
<td>Runat</td>
<td>Required by the ASP.NET Framework</td>
</tr>
</tbody>
</table>

**Example 1:**

```xml
<cc1:TopBannerScripter id="TopBannerScripter1" runat="server"></cc1:TopBannerScripter>
```

**Example 2:**

```xml
<cc1:LeftBannerScripter id="LeftBannerScripter1" runat="server"></cc1:LeftBannerScripter>
```

**Panels**

This tag causes Exponare to add the panels configured in the administration tool to the web page. There are currently no bottom panels for Exponare Public, so no Bottom Panel Scripter tag is provided.

**Tags:**

```xml
<cc1:LeftPanelScripter>
```

**Panel Mandatory Attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Unique Id for the control, eg “LeftPanelScripter1”</td>
</tr>
<tr>
<td>Runat</td>
<td>Required by the ASP.NET Framework</td>
</tr>
</tbody>
</table>

**Example:**

```xml
<cc1:LeftPanelScripter id="LeftPanelScripter1" runat="server"></cc1:LeftPanelScripter>
```

**Status Area**

A status area that displays messages to the user can be included. Status bar commands such as View/Set Zoom cannot be included in the Public Status area.
Setting Up Pages for Different Screen Resolutions

Tags:
<cc1:StatusBar>

Status Area Mandatory Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Unique Id for the control, eg “StatusBar1”</td>
</tr>
<tr>
<td>Runat=”Server”</td>
<td>Required by the ASP.NET Framework</td>
</tr>
<tr>
<td>MapId</td>
<td>Unique Id of the Map component for this application</td>
</tr>
</tbody>
</table>

Example:
<cc1:StatusBar id="StatusBar1" runat="server" MapId="MapControl1"/>

Setting Up Pages for Different Screen Resolutions

You can set up your Exponare Public pages to be optimised for different resolutions. For example, if you set up a page to be viewed at 800*600 screen resolution and one to be viewed at 1024*768, then your site can be properly viewed by most computer users. On the Public page, the user will see a Page Selector, which allows them to choose one of the options you have set up, for example ‘Large’ or ‘Wide’. Set up each webpage template (aspx) optimised for the desired screen resolution by adjusting the width and height of the top-level table and the map control.

Screen Resolution Mandatory Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>The text that is displayed on the Public page. This allows the user to choose the desired screen resolution. For example, Large or Wide.</td>
</tr>
<tr>
<td>Value</td>
<td>The name of the page template. For example, PublicApplication_1280X1024.aspx.</td>
</tr>
</tbody>
</table>

Example:
<span id="labelResolution" class="MenuTE" style="float:left;">Page Selector: </span>
<span id="Span1" class="MenuTE" style="float:left;">
<asp:DropDownList ID="resolutionDropDown" runat="server" AutoPostBack="true" OnSelectedIndexChanged="resolutionDropDown_OnSelectedIndexChanged" CssClass="drpPageSelector">
<asp:ListItem Value="PublicApplication.aspx" Text = "Normal" Selected="True"/>
</asp:ListItem>
</span>
Map Centre

Another new toolbar tag added in the .aspx pages in order to reposition the map by specifying X & Y coordinates by the user.

Figure 36-2: Map Centre

![Map Centre: X: 315200.947648176  Y: 5813772.94491366]

Tags:

<cc1:MapRecenter ID="Recenter" runat="server" />

On Public page, user will see the new map centre by specifying X & Y coordinates, which allows them to reposition the map.
Public and Rest Public
Start-up Parameters

Exponare Public and Rest Public can be configured to perform certain actions on start-up such as loading a specific Work Context, running a Query, setting a View, or applying a layer shortcut. This chapter discusses the techniques and parameters used to control the start-up behaviours of Exponare Public.

In this chapter...

- Introduction
- Run Query
- Page To Load
- Change Work Context
- Run Address Search
- Run View
- Run Layer Shortcut
You can tell the Public Application to perform certain actions on start-up so that the User is given a different starting point in the system than the default behaviour. For example, you might want to start the application on a different Work Context than the default when starting it from a particular webpage, or you might want to perform a particular Query when the application starts up so that a selection is present from the beginning.

You can do this by specifying certain parameters when starting the Public Application that cause it to perform specified actions before returning the first page to the user. These parameters are added to the URL request the web browser sends to the server in one of two standard ways.

1. As a GET request, where the parameters are appended to the end of the URL that is typed into the browser, or set up as a link from another page.

2. As a POST request, where an HTML input form on the page is used to send the request to the server, and the additional parameters are added in as input fields in the form.

To send these parameters to the Public Application, run an invoker page that passes the parameters through to the Public Application start-up page you require. This invoker page is an ASPX page that is installed in the web root of the Exponare Server Web Application, and is invoked using the GET request as follows.

```
```

The same invocation can be run as a POST request using the following HTML.

```
<form action="http://localhost/Exponare/PublicInvoker.aspx">
  <input type="text" name="page" value="PublicApplication.aspx">
  <input type="text" name="Context" value="Sewerage">
  <input type="text" name="View" value="Footscray">
  <input type="submit">
</form>
```

If you require your user to login to Public, specify a page in the Authorised folder. This will redirect the user to the Login Page, then once the user has logged in, the PublicApplication page will be loaded using the arguments passed in.

The parameter names and the values they can be given are described in detail below. In all cases the values passed in to the parameters must conform to HTML standards for passing in Query parameters—eg white-space characters, escape characters, and other characters that are considered special to an HTTP request must be correctly escaped. The names of the parameters are case-insensitive, however the values to be passed in may not be. The documentation for an individual parameter describes which are and which are not case-sensitive.

The parameters can be put in any order, and any combination of parameters can be used, subject to individual requirements specified for a given parameter. Duplicate parameters are not supported, and if used, behaviour varies depending on the parameter that is duplicated.
Run Query

These parameters are used to execute a **Query** with specific **Query Parameters** on start-up. The 'QueryName' parameter defines which Query is to be run, and the other parameters define the Query Parameters to pass in to that Query. Only the basic parameters for a Query can be passed in on the startup list; advanced parameters cannot be set at all.

There are two extra input parameters to define for each Query Parameter that is defined for the **Query**. The first, `ParamName<number>`, defines the name of the Query Parameter and the second, `ParamValue<number>`, defines the value to pass in for that Query Parameter. `<number>` is the zero-indexed position of the Query Parameter in the list of Query Parameters linked to the Query in the configuration.

For example, if the Query is called “Search Parks” and it contains three parameters, “Park Name”, “Park Code”, and “Owner Name”, the input parameters to trigger this Query look similar to the following:

```html
<form action="http://localhost/Exponare/PublicInvoker.aspx">
    <input type=text name="page" value="PublicApplication.aspx">
    <input type=text name="QueryName" value="Search Parks">
    <input type=text name="ParamName0" value="Park Name">
    <input type=text name="ParamValue0" value="Wattle Park">
    <input type=text name="ParamName1" value="Park Code">
    <input type=text name="ParamValue1" value="023">
    <input type=text name="ParamName2" value="Owner Name">
    <input type=text name="ParamValue2" value="County Council">
    <input type=submit>
</form>
```

If the **Query** is not in the default Work Context, then the Change Work Context parameter must be used to change to the required Work Context for the Query.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>QueryName</td>
<td>The name of the <strong>Query</strong> as specified in the configuration. This is case-sensitive.</td>
</tr>
<tr>
<td>ParamName0</td>
<td>The name of the first Basic Query parameter as specified in the configuration. This is case-insensitive.</td>
</tr>
<tr>
<td>ParamValue0</td>
<td>The value to enter for the first Basic Query parameter. This is case-sensitive.</td>
</tr>
<tr>
<td>ParamName1</td>
<td>The name of the second Basic Query parameter. This is case-insensitive.</td>
</tr>
<tr>
<td>ParamValue1</td>
<td>The value to enter for the second Basic Query parameter. This is case sensitive.</td>
</tr>
<tr>
<td>...</td>
<td>...additional name and value parameters as required...</td>
</tr>
</tbody>
</table>

Administration Guide 343
Page To Load

This parameter specifies the name of the main page to load for the Public Application. This field is compulsory when using the PublicInvoker.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>The name of the ASPX page to load to run the main application. The name of the page is case-insensitive.</td>
</tr>
</tbody>
</table>

Change Work Context

This parameter specifies the name of the Work Context to load when starting up.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context</td>
<td>The name of the Work Context to change to. This is case insensitive.</td>
</tr>
</tbody>
</table>

Run Address Search

These parameters are used to run an Address Search when starting up the application. As with any other use of the Address Search functionality, they require the configuration to be set up to point to a valid, live geocoding server; without this, the Address Search functionality cannot be used.

The values that can be passed in are any or all of the 13 input parameters available to the Address Search functionality. The exact values that can be entered for each of these parameters depend on how the external geocoding server is configured, and therefore cannot be fully detailed here. For a complete explanation of which values can be passed into these parameters, please refer to the accompanying documentation for the MapMarker Server or the Envinsa geocoding service.
Chapter 37: Public and Rest Public Start-up Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS0</td>
<td>The building number parameter.</td>
</tr>
<tr>
<td>AS1</td>
<td>The building name parameter.</td>
</tr>
<tr>
<td>AS2</td>
<td>The street directional prefix parameter.</td>
</tr>
<tr>
<td>AS3</td>
<td>The street type prefix parameter.</td>
</tr>
<tr>
<td>AS4</td>
<td>The street name parameter.</td>
</tr>
<tr>
<td>AS5</td>
<td>The street directional suffix parameter.</td>
</tr>
<tr>
<td>AS6</td>
<td>The street type suffix parameter.</td>
</tr>
<tr>
<td>AS7</td>
<td>The primary postcode parameter.</td>
</tr>
<tr>
<td>AS8</td>
<td>The secondary postcode parameter.</td>
</tr>
<tr>
<td>AS9</td>
<td>The municipality parameter.</td>
</tr>
<tr>
<td>AS10</td>
<td>The municipality subdivision parameter.</td>
</tr>
<tr>
<td>AS11</td>
<td>The country subdivision parameter.</td>
</tr>
<tr>
<td>AS12</td>
<td>The country secondary subdivision parameter.</td>
</tr>
</tbody>
</table>

This feature is not supported in Rest Public.

**Run View**

This parameter tells the server to run a specific View on start-up.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>The name of the View to run. This is the name of the View as specified in the configuration and is case-sensitive.</td>
</tr>
</tbody>
</table>
Run Layer Shortcut

This parameter tells the server to run a specific layer shortcut on start-up.

ℹ️ If the layer shortcut is not in the default Work Context, then the Change Work Context parameter must be used to change to the required Work Context for the layer shortcut.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LayerShortcut</td>
<td>The name of the layer shortcut to run. This is the name of the layer shortcut as specified in the configuration and is case-sensitive.</td>
</tr>
</tbody>
</table>
Part 6: New Enquiry Interface

The chapters in this section explain how to use the Enquiry Interface.

Topics

- Ribbons
- Application Menu
- Quick Access Toolbar
- Themes
- Improved Panels
- New Icons
Ribbons

This chapter discusses the new and rich Ribbon user interface for users.

In this chapter...

- Introduction
- Ribbon Toolbar: Configuration Options
Introduction

Ribbons are the modern way to help users find, understand and use commands efficiently and directly with minimum number of clicks.

A ribbon is a command bar that organizes various features into a series of tabs at the top of a window. Using a ribbon increases usability of features and functions, enables quicker learning of the program as a whole, and makes users feel more comfort with help of rich user experience. Figure below displays the ribbon toolbar in a freshly installed Exponare. In a fresh setup, commands have been logically grouped together under various tabs.

**Figure 38-1: Ribbon Toolbar**

For upgrade users, all the commands are seen to fit in a single tab called "Default". Administrator can configure these tabs for different users using the Configuration Manager. Refer the section "Ribbon Toolbar: Configuration Options" for further details.

**Figure 38-2: Ribbon Toolbar - Upgrade**

Ribbon Toolbar: Configuration Options

Below are the steps for adding new tab and underlying commands.

1. Go to Configuration Manager.
2. Go to ribbon toolbar and click on plus sign in order to add new tab as shown in the below .

**Figure 38-3: Ribbon Tab**
3. Give a suitable name to the tab.

**Figure 38-4: Ribbon Tab Name**

4. Add new group under the newly defined tab. Users can add multiple groups under a single tab e.g. Group1 and Group2.

5. As a next step, a user needs to pick commands from the toolbar listed in the "Menu & Toolbars" and assign them to the respective tabs/groups.

6. Open Full toolbar (or "Toolbar" corresponding to the user interface type) corresponding to which the Ribbon Toolbar is to be created.

**Figure 38-5: Full Toolbar**

7. In the below window users, other than selecting the commands, administrator can also,
   - Assign a command to the selected Tab->Group
Ribbon Toolbar: Configuration Options

- Choose icon size. The use of "Large" and "Small" icons provides users the flexibility to accommodate different icons in the available tab area.
- Show/hide the caption to be displayed on the ribbon.

Figure 38-6: Ribbon Group - Test Group1

8. Save the changes, made to the toolbar.

Any commands that have not be assigned to any group, would be added to the "Default" tab.

9. Start Exponare Enquiry and notice that the settings would have taken effect.

10. The configuration manager allows users to rearrange tabs or groups on the ribbon as shown in the below screen shot.

Figure 38-7: Ribbon Tab - Text
11. Save and start Exponare Enquiry in order to see the changes.  

**Figure 38-8: Exponare Enquiry - Test**

12. Users can also minimize the ribbon; by right click on the ribbon toolbar area.  

**Figure 38-9: Exponare Enquiry - Minimize Ribbon**

Notice the minimized ribbon toolbar, to give users and expanded map view in the below screen shot

The minimized state can be restored by either unchecking the "Minimised the Exponare Ribbon Toolbar" state or by choosing a command/icon from the tabs.  

**Figure 38-10: Restore Exponare Ribbon Toolbar**
This chapter explains the new and rich Application Menu.

In this chapter...

- Introduction
- Configuration Settings
- Using Hotkeys
Introduction

The Application Menu is composed of a drop-down control that displays a menu containing commands that are associated with each work context, such as File, Tools, Queries, Favorites, Links and access to the Configuration Manager for administrators.

What's new in the Application Menu?

Previously the application menu looked like this:

**Figure 39-1: Exponare Enquiry - Previous Application Menu**

The entry point into the Application Menu is a distinctive blue button that appears as the first item in the top left corner of the Enquiry window. When clicked, this button displays the rich menu that is shown in the following screen shot.

**Figure 39-2: Exponare Enquiry - New**

The new application menu looked like this:

**Figure 39-3: New Application Menu**

The application menu comes with an enhanced tool tip feature. This allows the Exponare administrator to provide information to the users such as the name and description of each tool or command.
Configuration Settings

The arrangement of commands under the "Menus and Toolbars" > "Full menu" is honored. The commands appear in the same order as configured for the user.
Using Hotkeys

Exponare Enquiry supports the hotkeys functionality to access the application menu. An important change in the configuration here is the use of “-” instead of “&” to assign a hotkey. This is particularly important for upgrade users as the pre-configured hot keys with “&” will not work. To activate the menu, press Alt + A on your keyboard and then choose the corresponding alphabet keys for the desired operation.

Figure 39-6: Hot Keys
Quick Access Toolbar

This chapter discusses Quick Access Toolbar that allows users to access frequently used commands irrespective of their location in the various tabs.

In this chapter...

- Introduction
- Default Settings in Quick Access Toolbar
- Customizing the Quick Access Toolbar
Default Settings in Quick Access Toolbar

Introduction

Exponare Enquiry supports a Quick Access Toolbar. This allows users fast access to frequently used commands irrespective of their location in the various tabs. By default, some commands are directly added from the Configuration Manager, while others can be added by customization options.

The screen shot below illustrates the default loading of the quick access toolbar.

Figure 40-1: Quick Access Toolbar

Default Settings in Quick Access Toolbar

By default, the quick access toolbar has these six commands as shown in the above screen shot. These six default commands are decided on the basis of the first six commands configured in the toolbar for that user profile.

For instance, if the user "Admin" refers to a profile of "Full Interface", which refers to the toolbar "Full Toolbar", then the default list generated in Quick Access Toolbar will have the first six commands listed in the "Full Toolbar".

Figure 40-2: Quick Access Toolbar - Full toolbar

The drop-down button opens options to turn on and off these commands by checking and un-checking each item.

Figure 40-3: Quick Access Toolbar - Drop-down
Quick Access Toolbar settings are maintained at the user level and preserved for each unique user profile on the client machine.

When you switch off any of the default commands they are removed from quick access toolbar, but they remain in the list. If checked on again, the commands are added towards the end of the list.

Customizing the Quick Access Toolbar

If you would like to add more commands or reorder the commands listed in the Quick Access Toolbar, use the "Customize" button available at the bottom of the list.

Figure 40-4: Quick Access Toolbar - Customize

Users can add commands to list by using either - "Add" button or double clicking on the command name. Similarly, removal is enabled by "Remove" button or double click on the command name.

Figure 40-5: Quick Access Toolbar - Add or Remove
Customizing the Quick Access Toolbar

grade users as the pre-configured hot keys with "&" will not work. To activate the menu, press Alt + A
In the below, the selected commands have been added.

Figure 40-6: Quick Access Toolbar - Add Command

Commands that have a drop down option list such as measure area units, change work context etc.
are not available for listing in the Quick Access Toolbar.
This chapter discusses three new themes for customizing different colors and skins to give modern look and feel.

**In this chapter...**

- Introduction
- Customizing Themes
**Introduction**

Exponare interface now offers Themes (or skins) to give better look and feel. The new user interface provides three new themes with each theme having different colours and skins configurable as per user's choice. The design provides users complete set of new colours applied to the Exponare Enquiry.

This allows users in simplifying the process of creating matching, professional-looking client by selecting any of the four themes available in Application menu. Applying a new theme changes the skin of your client but no effects are applied to titles. It has nothing to do with Configuration Manager and no changes will be done at Administrative Level. All the changes made will be saved on local system till next session.

**Figure 41-1: Themes**

By default, Blue coloured theme is applied to the Exponare Client giving it a feel of traditional Windows application for your desktop computer.
Customizing Themes

You can change skin and colours of Exponare client by choosing from any of the other three themes—Silver, SteelBlue and Olive. To change the default theme to Silver, select File -> Themes -> Silver and it will customize the look and feel of Exponare to “Silver” colour. The snapshot below shows how Silver theme looks.

Figure 41-3: Theme - Silver Color

On applying “SteelBlue”, user interface will be changed to “SteelBlue” colour.

Figure 41-4: Theme - Steel Blue

And lastly, on choosing “Olive” theme, user interface will be changed to “Olive green” colour.
Customizing Themes

Figure 41-5: Theme - Olive

The changes made with each theme are applied only at Exponare Client.
This chapter discusses improved panel controls and navigation for easier access.

In this chapter...

- Introduction
- Improved Panel controls
- Bottom Panel
Introduction

In Exponare Enquiry, panel controls and navigation options are designed in a way that ensures ease of access and also imparts a modern look and feel to the application. You can minimize the navigation panel to enlarge the map area, while still keeping the controls handy.

In previous versions of Exponare Enquiry, tabs were aligned horizontally in left panel. Below is the screen shot highlighting the classic behavior of this panel:

**Figure 42-1: Exponare Enquiry - Horizontal Panel**

In Exponare Enquiry, tabs in left panel are organized vertically. Below is the screen shot highlighting the new behavior:

**Figure 42-2: Exponare Enquiry - Vertical Panel**
Improved Panel controls

The panel controls such as form buttons/drop downs have been modernized. The screenshot below shows how print panel has been updated to reflect the modernised controls.

Figure 42-3: Controls

Bottom Panel

In Exponare Enquiry, the bottom panel is designed to show all data binds in a single view.
This eliminates the need to scroll through the various data binds, making all data binds readily accessible.
New Icons

This chapter discusses new icons pack that has been added to compliment the ribbon toolbar.

In this chapter…

- Introduction
- Large and Small New Icons
- Configuring New Icons
**Introduction**

With Exponare Enquiry, icons pack with compatible sizes are added to compliment the ribbon toolbar. Only the icons have been replaced with the old ones and there is no change in functionality. User can choose from additional two types of icons:

1. Ribbon Large
2. Ribbon Small

**Large and Small New Icons**

These two set of icons are available at default path of Server
```
...\Server\Themes\Default\RibbonLarge and ...\Server\Themes\Default\RibbonSmall
```

Below is the screenshot of new set of Large icons for Ribbon toolbar available at server by default

*Figure 43-1: Ribbon Toolbar - Large Icons*

Set of Small New icons for Ribbon toolbar:

*Figure 43-2: Ribbon Toolbar - Small Icons*

The size of icons can be changed as per below screenshot for better clarity:

*Figure 43-3: Size of Icon*

<table>
<thead>
<tr>
<th>DPI</th>
<th>Small Image</th>
<th>Large Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>96</td>
<td>16x16 pixels</td>
<td>32x32 pixels</td>
</tr>
<tr>
<td>120</td>
<td>20x20 pixels</td>
<td>40x40 pixels</td>
</tr>
<tr>
<td>144</td>
<td>24x24 pixels</td>
<td>48x48 pixels</td>
</tr>
<tr>
<td>192</td>
<td>32x32 pixels</td>
<td>64x64 pixels</td>
</tr>
</tbody>
</table>
Chapter 43: New Icons

Configuring New Icons

The Configuration Manager allows users to configure new icons on ribbon toolbar. They can be configured from File-> Configuration Manager-> Full Toolbar. Ribbon Group is set to the group name to which individual command will be assigned. Below is the screenshot of Configuration Manager for New icons:

![Figure 43-4: Configuring New Icons](image)

Depending on whether user wants large or small icons, size can be set accordingly to Large or Small Image.

![Figure 43-5: Selecting Large or Small Icons](image)

Save the settings in Configuration manager and new set of icons of new size can be seen on ribbon toolbar.

New Split Buttons

For better usability Enquiry now offers Split buttons which contains a tool and drop-down in single button.
New Split Buttons

Each split button has following two parts:

1. Top Part: This part contains the direct tool to assign to a button.
2. Bottom Part: This part contains a drop-down menu to support the tool assigned in the top part.

Figure 43-6: Split Button
Part 7: Rest Public and Mobile

The chapters in this section explain how to configure and start Rest Public and Mobile.

Topics
- Rest Public
- Exponare Mobile
Rest Public

This chapter describes the Rest Public interface based on OpenLayers architecture. In case you are a win 2003 user, you would need to alter the current IIS settings to use Rest public. For IIS settings, refer to IIS settings to configure Rest Public.

In this chapter...

- Introduction
- Rest Public Features
- Administration Properties
Rest Public Features

Introduction

Rest Public interface is based on the OpenLayers architecture. It can be viewed on most recent web browsers, with no server-side dependency. It supports various features of Exponare public such as, selections, queries, views and other features like tile based rendering, and intuitive base layer options etc. to bring the best of both the offerings.

This release of Rest Public is well tested to support Firefox, Google chrome, IE 8, 9, 10, 11 and Safari browsers.

Some of the distinguished key features of Rest Public are:

- Tile based map rendering
- Set layer translucency on the fly
- Drag and drop to order layers
- Draw and print annotations
- Intuitive slide able/ dock able panels
- Print measurement records
- Support for Google chrome
- Base layer options

Figure 44-1: Rest Public

Rest Public Features

Rest Public offers following features:

- Map Toolbar
- Working with Toolbar Option
- Left Panel Controls
- Themes
- Watermarks
Map Toolbar

Exponare Rest Public toolbar is located at the top left corner of the viewport. Based on the menus
and toolbar preferences selected in the Configuration Manager, you can hide or un-hide toolbar
options. Toolbar icons can also be customized on the basis of theme selected in Configuration
Manager. You will see the change in cursor type on the map as soon as you select the tool from the
toolbar.

You can resize and drag toolbar inside viewport. For dragging, hold the Press and Drag icon provided at the upper right corner of the toolbar and resize the toolbar from the right corner of the
toolbar. Toolbar can be reset by clicking on reset icon.

The table below lists all the available toolbar icons and its name.

<table>
<thead>
<tr>
<th>Toolbar Icons</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Home Icon" /></td>
<td>Home</td>
</tr>
<tr>
<td><img src="image" alt="View history backward Icon" /></td>
<td>View history backward</td>
</tr>
<tr>
<td><img src="image" alt="View history forward Icon" /></td>
<td>View history forward</td>
</tr>
<tr>
<td><img src="image" alt="Zoom in Icon" /></td>
<td>Zoom in</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out Icon" /></td>
<td>Zoom Out</td>
</tr>
<tr>
<td><img src="image" alt="Pan Icon" /></td>
<td>Pan</td>
</tr>
<tr>
<td><img src="image" alt="Info tool Icon" /></td>
<td>Info tool</td>
</tr>
<tr>
<td><img src="image" alt="Line Selection Icon" /></td>
<td>Line Selection</td>
</tr>
<tr>
<td>Toolbar Icons</td>
<td>Name</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Rectangle Selection" /></td>
<td>Rectangle Selection</td>
</tr>
<tr>
<td><img src="image" alt="Unselect All" /></td>
<td>Unselect All</td>
</tr>
<tr>
<td><img src="image" alt="Measure Distance" /></td>
<td>Measure Distance</td>
</tr>
<tr>
<td><img src="image" alt="Measure Area" /></td>
<td>Measure Area</td>
</tr>
<tr>
<td><img src="image" alt="Point Coordinate Export" /></td>
<td>Point Coordinate Export</td>
</tr>
<tr>
<td><img src="image" alt="Polyline Coordinate Export" /></td>
<td>Polyline Coordinate Export</td>
</tr>
<tr>
<td><img src="image" alt="Polygon Coordinate Export" /></td>
<td>Polygon Coordinate Export</td>
</tr>
<tr>
<td><img src="image" alt="Draw Line" /></td>
<td>Draw Line</td>
</tr>
<tr>
<td><img src="image" alt="Draw Polygon" /></td>
<td>Draw Polygon</td>
</tr>
<tr>
<td><img src="image" alt="Draw Text Annotation" /></td>
<td>Draw Text Annotation</td>
</tr>
<tr>
<td><img src="image" alt="Draw Symbol Annotation" /></td>
<td>Draw Symbol Annotation</td>
</tr>
<tr>
<td>Toolbar Icons</td>
<td>Name</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td></td>
<td>ClearAnnotations</td>
</tr>
<tr>
<td></td>
<td>Zoom to Selections</td>
</tr>
<tr>
<td></td>
<td>Zoom to Active Selection</td>
</tr>
<tr>
<td></td>
<td>Views List</td>
</tr>
<tr>
<td></td>
<td>Layer Setting Shortcut</td>
</tr>
<tr>
<td></td>
<td>Show/Hide Markers on Map</td>
</tr>
<tr>
<td></td>
<td>Fullscreen</td>
</tr>
<tr>
<td></td>
<td>Restore</td>
</tr>
<tr>
<td></td>
<td>Help</td>
</tr>
</tbody>
</table>

The toolbar options are available on the basis of menus and toolbar preferences selected in the Configuration manager settings. Some users may not have all of these toolbar options. The toolbar options will be displayed in order as they are added in Configuration Manager.

To configure toolbar icons, refer [Customizing Toolbar Icons in Rest Public](#).

**Working with Toolbar Option**

You can use following toolbar options while working on maps.
Rest Public Features

- Home
- Selections
- Selectability
- Annotations
- Text Annotations
- Measurement
- Back/Forward
- Layer Shortcut
- Views
- Label Layer Tool

Home
The Home button resets the view to the starting view for the Work Context. Selections are not affected.

On change of work context, previous work context zoom level settings is preserved and the map load at same zoom level for new work context. If bounds of work contexts are different then a message will be displayed to user and new work context will be displayed at its Home view.

Selections
There are following types of selections available in Rest Public toolbar:

1. **Point Selection (Info tool)** - Selects all the features under a single point.
2. **Multiple Selections** - It includes Rectangle and Polyline selection.
3. **Zoom to Selections** - Adjust the zoom view so that all selected items fit within the map window.
4. **Zoom to Active Selection** - Adjust the zoom view to fit the extents of the active selected item.

You can use Show/Hide Marker option on the toolbar to display markers on your selection.

Figure 44-2: Selection
Chapter 44: Rest Public

Point Selection (Info tool)

Rest Public allows users to select all the features under a single point by using Info tool. You can see information of the features selected by Info tool in the left pane called search results. Info marker is drawn exactly at the location where you click on the map.

Multiple Selections

It includes Rectangle selection and Polyline selection. The Rectangle selection selects all the features that lie within a rectangle and Polyline selection selects all the features that lie within polyline.

In case of multiple selections, the active selection can be distinguished by using color and marker.

Please wait for the map to load completely before making selections. You can perform selections, once the map loading is complete.

Zoom to Selections

It adjust the zoom view to fit the extents of the currently selected item. It changes the map view to nicely fit the selected Features, plus an additional area as defined by the Administrator.

When Zoom to Selections is activated, you can zoom to selections by using drop down option and previous and next button in the search results window.

Zoom to Active Selection

It adjusts the zoom view to fit the extents of the currently active selected item. It changes the map view to nicely fit the Active Selection, plus an additional area as defined by the Administrator.

When Zoom to Active Selection is activated, you can zoom to active selections by using drop down option and Next and Previous button in the search results window.

Hover Over

Rest Public now supports hover over feature for the selections drawn on map. You can use Show\Hide Marker option on the toolbar to show or hide markers for the selections drawn on map.

• Hover over, blue markers are seen for all selections for a layer selected in left Information panel drop down and red marker is seen for a current active feature in left Information panel.
• When a mouse cursor moves over selected feature, that feature is highlighted and first data bind information is seen over map. When mouse cursor moves to a different selected feature, another feature is highlighted and that's feature first data bind information is seen over map.
• On click inside selected feature for layer selected seen in Left panel drop down, the feature will get active and a red marker and data bind information is updated in left Information panel.
• On click inside selected feature for the layer unselected in Left panel drop down, new selection will be drawn on map.
Rest Public Features

- If selections is available on map, and User chooses to perform another operation on map such as measure controls, coordinate export, draw operations (draw symbol, polyline, polygon), text annotations than hover over features are disable. User has to make fresh selections to enable hover over features.
- The state of markers on map is maintained on changing work context.

> Hover over feature will only work if information (Feature Details) panel is set in public interface in configuration manager.

Administration Settings

Given below are selections administration settings for Rest Public.

Color Settings for Selection

The color settings are picked from the Configuration Manager for the selected work context. The settings are Active Selection highlight color and Selection Highlight color. The other setting for the selection i.e. the selection line width, style, interior style fill are not honored in Rest Public application.

Hover Over Settings

A bool property 'Hoverover' is placed in RestPublicApplication.aspx for the user to show/hide hover over features for selections drawn on map. By default 'isHoverover' is set to true, so hover over features is enabled on map. User can set 'isHoverover' to false to hide hover over features on map.

Other Settings

- The Active Selection is displayed on the basis of the drop-down change of databind. The marker is moved to the active selected geometry and the color of the active selection geometry changes as per the color defined in Configuration Manager.
- If the Databind are produced under any other case other than point select then the bubble is displayed inside the active geometry on the map if the center of the geometry lies inside the geometry otherwise the bubble is displayed on the first point of the geometry. The maximum number of selection can be set in the configuration manager for the work context.
- Selection layer does not change on the basis of zoom in/ out or on the visibility change of the layer.

> Selection layer should be retained when changing the work context provided if the layer is present in the current work context.

Selectability

Databind results depend on selectability of a layer. Selections on map can be performed using any of the selection tools (Point Select, Polyline select and Rectangle select) or through running a query. Databind results is seen on the 'Search Results' tab in the left panel of Rest Public application page.

1. You can select a layer only if it is visible on the map.
2. Various levels of selectability control are provided in workspace and configuration manager. For more details refer to Layer Settings. The selection settings are honored exactly the way they are honored in Enquiry and Old Public.

3. You can change the visibility of the layer from layer panel but you cannot change the selectability directly.

4. Specific settings such as, zooming to different levels (zoom in/out and applying views) can impact visibility and in turn impact the selectability of the layer.

In Internet Explorer (IE) 8 browser, at certain zoom levels the selected feature does not render complex region objects (such as regions with greater than 10,000 nodes).

Annotations

Rest Public allows users to draw annotations like point, line and polygon. It also allows user to print annotations. Below is the screen shot which highlights different types of annotations and clear annotation.

**Figure 44-3: Annotations**

![Annotations](image)

You can use clear annotations map operation to clear drawn annotations.

Text Annotations

The text annotation allows you to write text on the map.

To add text annotation:

1. Click on the text annotation button to add text to the map. The text annotation pane appears in left side pane.
2. Now, click on the map where you want to write a text. A bubble text box appear on the map.

   Figure 44-4: Text Annotations

   ![Image of text annotations]

3. Enter the text in Bubble Text box and click Go. The bubble text box disappear and the text is visible on the map.

   Only one bubble text box is available at a time on the map. The default text in the text box is the last text entered by you. You cannot use shortcut keys like Enter for Go button. You will have to click on text box for writing text in it.

   You can remove text annotations by clicking clear annotations button on the toolbar.

   You can change the properties of text annotation, font, color, indentation from text annotation pane on the left control panel. For details, refer to Annotation Panel.

**Measurement**

Public Rest allows users to measure distance and area in desired units like inches and square inches. Below is the screen shot highlighting the unit drop-down for length.
Figure 44-5: Measure Distance and Measure Area

Figure below displays the screen shot highlighting the Measurement values being rendered on the fly along with geometry.

Figure 44-6: Measurement Values

Back/Forward

The Back and Forward buttons are for navigation history control. These are used to restore previous and next history states. The previous and next controls becomes active when there are available states to restore and it becomes deactivate when there are no states to restore.
Rest Public Features

Layer Shortcut

A Layer Shortcut is a quick way to invoke a group of changes such as layer visibility, layer selectability and layer order to the layer settings shown in the Legend panel.

**Figure 44-7: Layer Shortcut**

For example, you can define a Layer Shortcut to bring all the parks layers to the top of the layer list and make them visible. Another example is a shortcut that toggles the visibility of a number of raster layers.

For more information on layer setting shortcut, refer to [Creating a Layer Settings Shortcut](#).

---

**i** Work Context Auto Labeling, Appears as Toolbar Shortcut, Icon, Auto-labeled and Expand in Legend settings are not available in Rest public for Layer Settings Shortcut.

Views

A View provides a quick way to set the zoom and pan of a map. For example, you can create a View that centers the map over a railway station with a zoom width of 200 meters.

You can access list of available Views from the Exponare Rest Public toolbar.

**Figure 44-8: Views List**
Chapter 44: Rest Public

For more information on creating views, refer to Creating a View.

The views feature in Rest Public comes with a limitation enforced upon by use of OpenLayers because of which it cannot zoom to the exact value as specified in configuration manager. It zooms to the nearest possible level hence slight mis-match between a view rendered in Enquiry (or Public) vs the Rest Public can be expected.

- Use of OpenLayers allow us to go to a specific levels of minimum and maximum zoom hence the minimum and maximum zoom level settings specified in configuration manager are not honored.
- Similarly, unlike Exponare Enquiry and Exponare Public, it also allows us to switch to locations outside of work context boundary. Hence, the issue of centroid lying outside work context boundary is not observed.

Label Layer Tool

In the previous versions of Exponare, label layer settings follows the same rule set as that of feature layer. If feature layer is not visible or not in zoom range than its label layer also become unavailable.

In this version, label layers are independent of the feature layer settings. A label tool is shown on the map to enable/disable label layers. Each individual label can be turned on/off using this user interface tool. Now multiple labels are supported for a layer in Rest Public.

Label tool is available below the scale bar on right side of the viewport.

Figure 44-9: Label Layer Tool

If no label is defined for the work context in Workspace manager, then label layer and label layer tool does not appear on map.

The visible zoom range for label layer updates label layer on map but it doesn't update label
Rest Public Features

layer check boxes in label layer tool.

Reordering of layers in Legend panel doesn't reorder label layer in label layer tool panel.

Work Context auto-labeling setting in Layer Settings Shortcuts in Configuration Manager is not implemented for Rest Public.

Label themes (Individual & Ranged) are not supported in Rest Public.

Left Panel Controls

The left panel controls in Rest Public can be made available to users based on the basis of user interface preferences selected in the Configuration Manager.

Rest Public provides following panels on left side of the map.

- Legends
- Queries
- Information
- Coordinate Export
- Print
- Annotation Panel

In IE, you can not select any drop down item from left panel when it is in floating mode, for this you have to pin down the left panel.

The left panel controls are available on the basis of user interface preferences selected in the Configuration manager settings. Some users may not have all of these panels. The Left Panel controls will be displayed in order as they are added in Configuration Manager. In case no panel item is added for a user, then left panel will not be displayed.

Legends

Layers listed in the configuration manager are listed under legend and displays all settings defined in configuration manager.

Checking and un-checking against a layer can control visibility of a layer. The below highlights the controls to make layers visible /invisible.
Figure 44-10: Layers

Legend

Layout of legend is flexible. It allows you to pin and unpin and also resize as per the need. Below are the pin and unpinned images.

Figure 44-11: Legends - Pin and Unpinned Images

Translucency

Translucency of a layer can be adjusted by using translucency slider which will appear after right clicking on a layer. The image below highlights the slider to adjust layer translucency.
Base Layer Choice

Base map layers provide map layer functionality designed to enhance visualization experience by underlying reference layers. In Rest Public there is an option for base layers inside layers tab. The image below highlights the user selected base layer.

Figure 44-13: Base Layer

Only one layer at a time can be applied by clicking on the check box. Choosing a Bing layer as reference would change the projection system of the map to “Popular Visualization” if no base layer is required from the available list of Bing layers, user can switch to “None” option.

Layer Ordering

The order of layers can be changed by dragging and dropping a layer.
Figure 44-14: Layer Ordering

Layer can be reordered within the group but layer cannot be added to a previously created group by drag and drop. No layer can be added to "Base Layer" group.

Custom Legend URL

Custom legend URL contains a small image for each unique visual feature in the Layer and a short textual description. It allows you to see a greater level of detail about the layers.
Rest Public Features

Figure 44-15: Custom Legend URL

The layers with an arrow indicates that images are associated with it. You can expand and collapse these images.

ℹ️ If layer is not visible on the map it will not show the custom legend URL.

**Thematic**

Layer can have one or more associated thematics which can be used to alter their appearance. If a layer shows a thematics, it is displayed under Thematic box. Click on the Thematics button to see a list of available thematics. You can show or hide the theme for the work context by checking/un-checking the items in this list.
MapInfo Rest Public supports only three types of themes i.e. Ranged Theme, Dot Density and Individual Value.

If no themes are present in the MWS file (above mentioned 3) then the thematic button will not appear in the legend for the current work context.

Themes honor zoom range layering i.e. both the map as well the legend will be updated accordingly.

The thematic header can be governed by the localization.

The color of the thematic header and panel changes are governed by the Rest Public themes available to the user.

**Administration Settings**

If the value of Expand Custom roll down is true in configuration manager layer settings, it will show custom Legend URL in expanded state. When the map is loaded for the first time, all the layers visible on map will honor the Configuration manager settings. For more details, refer to Expand Custom roll down.

Layer can be also visible for the first time in various forms like layer shortcuts, views, queries and zoom visibility. You can change the way it is displayed and after that the settings that you made are maintained.

Custom Roll down for a layer appears only if zoom layer visibility and layer visibility (check box) for a layer is visible/available on the map.
Rest Public Features

Queries

Rest Public allows you to search various information. To execute search:

1. Click on Search in the left pane.
   The search dialog box appears on the left pane.
   Figure 44-17: Query

   ![Queries](image)

   All query types that work for Exponare Enquiry and Exponare public are also supported.

   1. Once you have selected search, click on the submit button to view the selected feature on map.
      Figure below is highlighting the selected feature.
Even if the layer is made invisible then also users will be able to see query selection.

**Information**

After successful execution, the results of search appear on search results page. The Information results are the non-spatial data associated with selected features on the map. The information panel displays the Feature Details View.

The Feature Details Panel displays data associated with the active feature. Various categories of information (called Data Binds) can be opened or closed. If multiple records of information exist in any one Data Bind for the active feature they can be navigated through using the Data Bind record selector.

The Feature Details Panel can be used to change the active feature either by choosing another layer with the layer selector drop-down option or another feature in the current layer with the feature selector drop-down option. When a new feature is chosen the information for that feature will be displayed and the map will update and highlight the feature as the active selection.

You can navigate to next selection by using Next and Previous button on the feature selector bar. You can also expand and collapse property details by using plus/minus button on the Feature selector bar.
Rest Public Features

Figure 44-19: Information - Search Results

Information window can be pinned and unpinned as per need. The panel can be expanded and collapsed at the click of the navigation button located that top right corner of the panel. Also, the user continues to have the flexibility of stretching the panels as per need.

A bubble will be displayed on the map for the current active selection. The active color selection will be displayed as per the Configuration manager setting.

In case there are more than one feature underneath the selection, the selection color would change to active selection based on active selection feature and switching between different layers.

Coordinate Export

Rest Public allows users to export line, polyline and polygon coordinates and view the same in export coordinates tab in right pane. Figure below displays export coordinate tab.
Print

It allows you to print annotations, export coordinates, measured distance and measured area. It provides print templates in .html or .htm format. It also allows you to preview your map before printing.

Printing also provides options to print at different scale levels. The scale levels can be defined in configuration manager or you can give your own scale at which map should be zoomed on printing. In case No specific scale is given, it will print at the level on which map is zoomed. On scaling it will maintain the center of the map. It will not scale the map to exact level but to the nearest zoom level.

If the print scale value entered or selected does not exist in map then the map scale will be adjusted to the nearest possible scale.

Print Preview

To preview the map before printing:

1. Click on the Print Panel on the left pane to open the print options.
2. Select Print template from Print drop-down list. For details on creating Rest Public HTML print template, refer to Creating Rest Public HTML Print Template.

3. Select from Print Scale options to print at the nearest scale of the given scale:
   - Print at current zoom - allows printing at scale which is defined on map.
   - Print at scale - give options to print at the scale level defined in Configuration manager. Select scales from drop-down list. You can select any one scale for printing and it will print at the nearest scale available.
   - Print at exact scale - allow user to manually give any value and on clicking Print it will print at the nearest scale available.

   In case you have not given any value in Print at exact scale option, an error message will appear “The scale you specified was incorrect. Please try again”.

4. Enter the title in the Map Tile text box.
5. Click **Print** to see print preview.

   The Print preview window appears. It displays map, legends and data bind information about items selected on map before printing.

   **Figure 44-22: Print Preview**

The print preview window allows you to:

1. Pan the map
2. Zoom in and zoom out of the map by scrolling the mouse.

   **Note:** The zoom seen in the Print preview window is dependent on the size assigned to map division (div). This value can be altered by the administrator to match the default map zoom requirements.

6. Click **Print** to print the map.

**Print Map to PDF**

You can Print your map to PDF from supported browsers like Chrome and Mozilla Firefox 14.0 and above.

**Chrome**
Rest Public Features

To print the web page you’re viewing in Chrome, press Ctrl+P. For more information on Printing through Chrome browser, refer to their website.

Once you select print to pdf option in the Chrome browser, it does not allow further zooming and panning in the print preview window.

Firefox 14 and above

To print the web page you are viewing in Firefox, click on the Firefox button at the top of the Firefox window, (File menu in Windows XP) and select Print. For more information on Printing through Firefox browser, refer to their website.

Annotation Panel

The text annotation pane allows you to change the properties for text annotation. To change the properties for annotation:

1. Click on the arrow at the bottom of the left pane to open the annotation dialog box.

   The annotation box appears.

   ![Figure 44-23: Annotation Text Properties](image-url)
2. Under Text Properties, you can change Font Family, Font Size, Style of the text. It allows you to align your text to left, center and right. You can also change font color. By default it is brown.

Font options listed here do not comply to the setting mentioned in configuration manager.

Themes

MapInfo Exponare provides Themes (also called "Skins") at the bottom left corner of view port. It provides three new themes with each theme having different colors and skins. You can change colour of panels and controls with Themes option.

Figure 44-24: Rest Public - Themes

MapInfo Exponare Rest Public provides following three themes:

1. Blue
2. Default
3. Gray

When the map is loaded for the first time, “Default” theme is applied to the Exponare Rest Public. You can select and apply different Themes from drop-down list.

Theme is not applied to Welcome Admin and Log Out button at the top of the screen.
Themes are controlled at CSS level. More themes with different colors and styles are configurable at the administrative level by editing styles available at:\Exponare\Server\StyleSheet\restpublictheme.

## Watermarks

Exponare Rest Public now supports watermarks. A Watermark is an or defined set of text that will be drawn onto the map after the map data has been rendered. It is used for placing a copyright message on top of protected data. You can define as many Watermarks as you want for a particular Work Context or layers, and each of those Watermarks will then be rendered on top of the map data in the final map seen by the user.

For more information on Watermarks, refer to [Watermarks](#).

### Administration Properties

Given below are the administration properties.

- Authorized Rest Public Pages
- Configurable Features
- Public Vs Rest

### Authorized Rest Public Pages

Named users must be authenticated before they can access Exponare Rest Public pages. The files used to illustrate named access to Exponare Rest Public are listed below:

<table>
<thead>
<tr>
<th>Path</th>
<th>Filename</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponare\Authorised</td>
<td>RestPublicApplication.aspx</td>
<td>Rest Public pages displayed to logged in user.</td>
</tr>
</tbody>
</table>

> Pages in this folder will require the user to be authorised. If not, IIS will redirect to Login.aspx.
Login to Rest Public

Figure 44-25: Login to Rest Public

Configurable Features

Table below displays the configurable features.

**Configurable controls for Rest Public**

<table>
<thead>
<tr>
<th>S.No</th>
<th>Configurable features</th>
<th>What can be configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Work Context Level</td>
<td>• Default work context</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Layer ordering</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Layer visibility settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Layer visible in legend</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Layer legend icons</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Layer groups</td>
</tr>
<tr>
<td>2</td>
<td>Info Tool</td>
<td>All data binds</td>
</tr>
<tr>
<td>3</td>
<td>Queries</td>
<td>• Advanced query</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Basic Query</td>
</tr>
</tbody>
</table>
Administration Properties

<table>
<thead>
<tr>
<th>S.No</th>
<th>Configurable features</th>
<th>What can be configured</th>
</tr>
</thead>
</table>
| 4    | Measurement           | • Work context level measurement unit  
|      |                       | • Default area measurement unit       
|      |                       | • Default length measurement unit     
|      |                       | • Measure tool color                  
|      |                       | • Measure tool width                  |
| 5    | Coordinate Export     | • Marquee color settings       |
| 6    | Layer shortcuts       | • Change selectability          
|      |                       | • Visibility                        
|      |                       | • Layer ordering                   |
| 7    | Views                 | • Zoom width                     
|      |                       | • Zoom unit                        
|      |                       | • Map center settings              |
| 8    | Custom Roll Down      | • Layer has legend settings       
|      |                       | • Expand Custom Roll down          
|      |                       | • Custom legend URL                |
| 9    | Visibility & Selectability | • User can change selectability  
|      |                       | • User can change visibility setting |

Public Vs Rest

Table below lists Exponare Public vs Exponare Rest Public features.

<table>
<thead>
<tr>
<th>Features</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Tile based map rendering</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>2  Set layer translucency on the fly</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>3  Drag and drop to order layers</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>4  Draw and print Annotations</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>5  Intuitive dock able panels</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>6  Print measurement records</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>7  Support for Google Chrome</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>8  Base layer options</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>9  Switch over projection systems in client</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>10 Rectangle, Polyline, Polygon Select tool</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11 Zoom to selections</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>12 Zoom to active selection</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>13 Configuring menu and toolbar</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Chapter 44: Rest Public

<table>
<thead>
<tr>
<th>Features</th>
<th>Public</th>
<th>Rest Public</th>
</tr>
</thead>
<tbody>
<tr>
<td>14 Full screen</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>15 Apply Thematic</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>16 Show label</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>17 Clear labels</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>18 Toggle auto-labels</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>19 Layer Shortcuts</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>20 Views</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>21 Configurable Left Panel</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
This chapter discusses how to access mapping and business data on your mobile browser.

In this chapter…

- Introduction
- Home
- Quick Info Tool
- Watermarks
- Geolocate
- Authorized Mobile Pages
Exponare on mobile is a map service that allows users to access mapping and business data at the convenience of your mobile browser. Though this service is designed to run on all Android and iOS mobile browsers, but with Exponare 5.0 and above it has been tested and verified for iPhone and iPad default browser. It can be run on a mobile browser with a URL:

http://<Exponare machine IP address or name>/<virtual root directory of exponare in IIS or server>/Mobile.aspx

The new interface provides the user with the following:-

- **Authorized Access** - Exponare mobile now also comes with authorized access. You have to give user name and password to access the authorized application. Public Users can keep accessing the old mobile URL as they use to do it earlier.

- **OpenLayers** - Integrating OpenLayers architecture and MapXtreme as an underlying engine, the map is ready for analysis. Now you can instantly access and analyze your data with reference layers of choice on mobile itself.

- **Home** - The Home button resets the view to the starting view for the Work Context.

- **Quick Info** - Quick Info is similar to "Point Select" in Exponare Enquiry where detailed information is displayed for the selected feature on the map.

- **Layer** - The Layer tab displays information for all of the layers loaded in the current work context. User can control settings for visibility of these layers. The base layer can also be changed to the Bing Aerial, Bing Road, Bing Hybrid and None as desired by the user.

- **Query** - Queries tab allow you to make selections based on criteria, rather than having to point and click to select features visually. If you make selections by running a query, the information is displayed on the maps.

- **Measure** - This tab is used to measure both distances and area on the map. Calculated distance or area will be displayed on top of the map.

- **Search Results** - This functionality provides information for data queried or map features selected using Info Select. Each data bind is a set of data that describes the feature, such as its owner, planning details or spatial information.
Below is the default view when user hits the Exponare mobile:

**Figure 45-1: Exponare Mobile**

The Home button resets the view to the starting view for the Work Context. Selections are not affected.

- **On change of work context, previous work context zoom level settings is preserved and the map load at same zoom level for new work context. If bounds of work contexts are different then a message will be displayed to user and new work context will be displayed at its Home view.**
Quick Info Tool

Quick Info tool is used to highlight map object of interest and to retrieve the information available for those map object. Information of the selected feature is displayed as data bind in Results tab of the bottom panel.

Each time a new feature is clicked on, that feature is selected and highlighted. The previous feature that was selected is now no longer highlighted.

Figure 45-2: Quick Info Tool
Layers Tab

The Layer tab displays information for all of the layers loaded in the current work context. Visibility of a layer can be controlled by checking and unchecking against a layer. Similarly, you can change work context from Layers drop-down.

Figure 45-3: Layers Tab
There is option for base layers inside Layers Tab. Only one layer at a time can be applied by clicking on the check-box as shown in the below figure.

**Figure 45-4: Base Layers**

---

**Search Tab**

Search allow you to make selections based on criteria, rather than having to point and click to select features visually. If you make selections by running a query, the information is displayed in the search results panels exactly the same as if you had selected the features with the info tool.
On the Search panel, you can select - then fire query. This will show you only the features returned by the query on the layer on which query was fired and other layer settings will remain as it is. Click “Reset Features” button to view the whole layer on which query was fired along with the selected features.

Figure 45-5: Query Tab

The results are displayed in selection result panel.
The drop-down menu displays the same list of queries available in the Queries menu.

Figure 45-7: Query - Search Results
Measure Tab

Measure tab is used to measure both Distances and Area on the map. A blue line will appear representing the distance or area to be measured. The distance is shown on the status bar which is located at the top of the window.

Units for measurement will be used based on the values set in CM against a particular workcontext.

Figure 45-8: Measure Tab

The drop-down menu displays the list to select Measure Area or Distance.

Figure 45-9: Measure Distance
Search Results Tab

This functionality provides information for data queried or map features selected using Info Select and in response to the queries. Each data bind is a set of data that describes the feature, such as its owner, planning details or spatial information in tabular format.

A drop-down menu displays the lists of layers on the basis of current selection. In this scenario all the selections for all layers underlying the info tool are seen.

Figure 45-10: Search Results
Click on the "Plus" buttons to expand the different data binds. Each data bind is a set of data that describes the feature, such as its owner, planning details or, as illustrated below, spatial information.

**Figure 45-11: Property Parcel Details**

---

**Watermarks**

Exponare Mobile now supports watermarks. A Watermark is an or defined set of text that will be drawn onto the map after the map data has been rendered. It is used for placing a copyright message on top of protected data. You can define as many Watermarks as you want for a particular Work Context or layers, and each of those Watermarks will then be rendered on top of the map data in the final map seen by the user.

For more information on Watermarks, refer to [Watermarks](#).

**Geolocate**

Geolocation is the detection of the real-world geographic location of mobile phone, computer, networking device and equipment. It enables device location based on geographical coordinates and measurements. It commonly uses global positioning system (GPS) and other related technologies to assess and specify a geographical location.

The Geolocate feature in Exponare mobile allows you to view your current location on the map. The Geolocate button is available on the map.

To view your current position:

1. Open Exponare Mobile on iPad or iPhone.
2. Click on the Geolocate button on the map.
   The button is activated and current location appears on the map with a red-cross symbol. It also shows radius around your current location.

   **Figure 45-12: View Current Location**

3. On clicking the Geolocate button again the layer disappears from the map and the Geolocate button gets deactivated.

**Authorized Mobile Pages**

Named users must be authenticated before they can access Exponare Mobile Public pages. The files used to illustrate named access to Exponare Mobile Public are listed below:
### Chapter 45: Exponare Mobile

<table>
<thead>
<tr>
<th>Path</th>
<th>Filename</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponare\Authorised</td>
<td>Mobile.aspx</td>
<td>Mobile Public pages displayed to logged in user.</td>
</tr>
</tbody>
</table>

- Pages in this folder will require the user to be authorised. If not, IIS will redirect to Login.aspx.

---

**Login to Exponare Mobile Application**

*Figure 45-13: Login to Exponare Mobile*

![Diagram of Login to Exponare Mobile Application](image-url)
Part 8: Supporting Information

Topics

- Appendix A: Feature Usage Guidelines
- Appendix B: Raster Images
- Appendix C: Support for Workspace Files
- Appendix D: Workspace Manager
- Appendix E: Line Styles and Fill Patterns
- Appendix F: Confirm Integration
Feature Usage Guidelines

To maximize the performance of Exponare, follow the guidelines laid out here.

In this appendix...

- Feature Usage Guidelines
Feature Usage Guidelines

The following are Exponare Usage Guidelines which form the basis of Exponare's user interface and performance design objectives.

These guidelines are not hard system constraints nor can they take into consideration your particular environment, data sets, hardware, or business case. However, they should help you to create a satisfying user experience.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Guideline</th>
<th>Reasoning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layers</td>
<td>Limit the number of Layers in any workspace to 20.</td>
<td>The number of Layers directly affects the time it takes to create the Legend panel in both Exponare Enquiry and Exponare Public. It also affects the time it takes to render a map. The time required to render a map is inversely proportionate to the number of users that can be served by the Exponare Server.</td>
</tr>
<tr>
<td>Workspaces</td>
<td>Keep the combined number of visible Features from all Layers below 2000 for any given map. Setting the appropriate zoom level restrictions for each layer should help with this.</td>
<td>The more Features there are on a map, the longer it will take to render. The time required to render a map is inversely proportionate to the number of users that can be served by the Exponare Server.</td>
</tr>
<tr>
<td>Drop-downs</td>
<td>Keep the total number of options in all configurable drop-downs below 20.</td>
<td>Drop-downs are designed for small sets of data. Having a large amount of data increases the time it takes to send information between the client and the server.</td>
</tr>
<tr>
<td>Remote Data Binds</td>
<td>Keep the total number of Remote Data Binds for all concurrently selected Layers at 4 or below.</td>
<td>The more Remote Data Binds there are, the longer the response times will be for the end user.</td>
</tr>
</tbody>
</table>
## Appendix A: Feature Usage Guidelines

<table>
<thead>
<tr>
<th>Feature</th>
<th>Guideline</th>
<th>Reasoning</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Databases</td>
<td>Ensure any query written for an external database can be executed in under 100ms in the native query environment for that database.</td>
<td>Long queries will increase the response time of each request, and will also reduce the number of users that can be served by your Exponare Server.</td>
</tr>
<tr>
<td>Application Link-Outs using an External Database Connection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application Link-Ins using an External Database Connection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Queries</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selections</td>
<td>The maximum number of selections should be set at 100 or below.</td>
<td>The more selections a user makes the longer it takes to evaluate them, and the longer it takes to render a map. The time required to render a map is inversely proportionate to the number of users that can be served by the Exponare Server.</td>
</tr>
<tr>
<td>Print Templates</td>
<td>The DPI setting of Print templates should be set at or below 400.</td>
<td>The higher the DPI setting, the more memory, and more time is required to render a map. The time required to render a map is inversely proportionate to the number of users that can be served by the Exponare Server.</td>
</tr>
<tr>
<td></td>
<td>The maximum size of a print template should be 1280 x 1024 pixels.</td>
<td>The larger the map is, the more memory, and more time it takes to render. The time required to render a map is inversely proportionate to the number of users that can be served by the Exponare Server.</td>
</tr>
<tr>
<td></td>
<td>Mail merge Print Templates should only result in 10 maps or less when executed.</td>
<td>The more maps there are when a mail merge is run, the longer it takes for the mail merge to be run. Running mail merge Print Templates with a large number of maps reduces the number of users that can be served by your Exponare Server.</td>
</tr>
<tr>
<td>Adhoc Layers</td>
<td>Limit the number of Adhoc Layers to 10.</td>
<td>The number of Adhoc Layers directly affects the time it takes to create the Legend panel in Exponare Enquiry. It also affects the time it takes to render a map. The time required to render a map is inversely proportionate to the number of users that can be served by the Exponare Server.</td>
</tr>
</tbody>
</table>
In this appendix...

- About Raster Images
- Supported Raster Imagery File Types
About Raster Images

A raster image is a type of computerized picture consisting of a matrix of dots (pixels). Raster images are sometimes known as bitmaps. Aerial photographs and satellite images are common types of raster data found in GIS. The picture below, taken from Exponare’s sample data, is an example of a raster image.

Raster imagery Layers, by their very nature, impose higher demands on Exponare than regular, non-raster maps. Performance will be negatively affected depending on the raster Layers format, size, resolution and zoom visibility settings. It is highly recommended that response times, server load and memory usage are carefully monitored when introducing raster imagery Layers.
## Supported Raster Imagery File Types

<table>
<thead>
<tr>
<th>extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.bil</td>
<td>Spot</td>
</tr>
<tr>
<td>.bmp</td>
<td>Windows Bitmap</td>
</tr>
<tr>
<td>.ecw</td>
<td>ECW</td>
</tr>
<tr>
<td>.emf</td>
<td>Windows Enhanced Metafile</td>
</tr>
<tr>
<td>.gen</td>
<td>CADRG - Compressed ARC Digitized Raster Graphics</td>
</tr>
<tr>
<td>.gif</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>.jpeg</td>
<td>Joint Photographic Experts Group</td>
</tr>
<tr>
<td>.jpg</td>
<td>JPEG2000</td>
</tr>
<tr>
<td>.j2k</td>
<td>NITF - National Imagery Transmission Format</td>
</tr>
<tr>
<td>.ntf</td>
<td>PCX</td>
</tr>
<tr>
<td>.pcx</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>.png</td>
<td>Photoshop</td>
</tr>
<tr>
<td>.psd</td>
<td>MrSID</td>
</tr>
<tr>
<td>.sid</td>
<td>Targa</td>
</tr>
<tr>
<td>.tga</td>
<td>Tagged Image File Format (includes GeoTIFF)</td>
</tr>
<tr>
<td>.tif</td>
<td>Windows Metafile</td>
</tr>
<tr>
<td>various</td>
<td>ADRG - ARC Standard Raster Product</td>
</tr>
<tr>
<td>various</td>
<td>CIB - Controlled Image Base</td>
</tr>
</tbody>
</table>
Support for Workspace Files

The core data definition file for Exponare is the MapInfo Workspace (.MWS) File. This appendix contains a description of those features in the Workspace file that are used by Exponare and explores the differences in the way MWS files are created using MapInfo Professional and the Workspace Manager.

In this appendix...

- MWS Features Supported by Exponare
- Creating MWS files in MapInfo Professional
MWS Features Supported by Exponare

Maps
The core data object of a Workspace File is a map. A single Workspace file can contain more than one map definition, however Exponare will only use the first map definition it comes across in the Workspace file. Exponare uses MapXtreme 2005 as its rendering engine, and so is capable of rendering any map definition that can be rendered in MapXtreme 2005.

Coordinate Systems
It is recommended that all Layers in a workspace are created in the same coordinate system for optimal performance. If a raster layer is included in a workspace then the workspace will be loaded in the coordinate system of that raster layer even if the coordinate system is different to that of the workspace.

Exponare does not support two or more raster Layers that use different coordinate systems being configured in the one Work Context.

Layers
Exponare can use any layer definition that is used by MapXtreme. Specifically, Exponare exposes and uses the following features of a layer.

- Visibility
- Zoom Visibility
- Auto Labels
- Selectability
- Individual Value Themes
- Ranged Themes
- Dot Density Themes
- Zoom layering of the above themes
- Style overrides
- User friendly layer names
- Label Layers
- Layer Ordering

Themes
Three theme types are supported as thematic overlays on Layers. These are individual value themes, ranged themes and dot density themes. The other three core Thematic Maps that can be configured in a workspace file will not be treated as thematic overlays on a layer and will not be represented in the Legend at all.

Other MWS Features
The Workspace file can be used by many different applications for a number of different purposes, and so can contain definitions for a number of different data objects that are not relevant to Exponare. Some of these data objects may be used implicitly by Exponare, whilst other features in
the mws will not be used by Exponare at all, such as Group Layers or Legend definitions.

Limitations on Names of MapInfo Professional TAB Files

The data defining a map layer is commonly held in a file called a TAB File, which is a Pitney Bowes Software data format for storing spatial data. Exponare has a constraint that the names of these TAB Files must be unique - you cannot use two separate TAB Files for your server that have the same file name.

So, for example, if you have one workspace that uses the following three physical TAB Files

D:\MyData\World.TAB
D:\MyData\Countries.TAB
D:\MyData\Cities.TAB

and you have another workspace that uses the following two TAB Files

D:\MyOtherData\Extra\WorldTimeZones.TAB
D:\MyOtherData\Extra\Countries.TAB

your system would show errors due to having two separate files that have the name 'Countries.TAB'. These problems will occur whether the TAB Files are referenced in the same workspace file or in a different workspace file.

This restriction also applies to TAB Files that are loaded in as SQL Support Tables.

Creating MWS files in MapInfo Professional

A workspace file (.wor) can be saved as a MWS file in MapInfo Professional, however, the information contained within MWS files created from MapInfo Professional and those created by the MapXtreme Workspace Manager can sometimes vary and thus cause problems with the Exponare Configuration.

Selectable State of Layers

When MapInfo Professional saves a WOR file in MWS format, it does not describe the selectable state of a layer. If you have created an MWS file in MapInfo Professional, you may need to use the MapXtreme Workspace Manager to set the selectable state for each layer. By default, all Layers are flagged as Selectable when you first load an MWS file created in MapInfo Professional into the Workspace Manager.
Creating MWS files in MapInfo Professional

To set the selectable state of MWS layers:

1. Launch the MapXtreme Workspace Manager.
2. Open the MWS file.
3. Click on a layer.
4. If necessary, click the Options tab.
5. If necessary, check/uncheck the Selectable check box.
6. Repeat steps 3 through 5 as required.
7. Save the file.
8. Restart IIS for the new settings to take effect.

 Saving an MWS file created by MapInfo Professional in Workspace Manager will also update Auto Label settings (see below).

Autolabel Differences

Unlike the MapXtreme Workspace Manager, MapInfo Professional does not have a Create Labels Automatically checkbox. For Exponare, this means that depending on whether you create the MWS file in MapInfo Professional or using the MapXtreme Workspace Manager the Auto Labels will behave differently.

In Workspace Manager, a label layer has a Visible check box and also a Create labels automatically checkbox. This gives the following scenarios:

<table>
<thead>
<tr>
<th>Visible</th>
<th>Create labels automatically</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>✔️</td>
<td>Auto Labels are available and are turned on by default.</td>
</tr>
<tr>
<td></td>
<td>✔️</td>
<td>Auto Labels are available and are turned off by default</td>
</tr>
<tr>
<td>✔️</td>
<td></td>
<td>Auto Labels are not available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Auto Labels are not available.</td>
</tr>
</tbody>
</table>
In MapInfo Professional, a layer’s Auto Label has only Visibility options. This gives the following scenarios:

<table>
<thead>
<tr>
<th>Auto Label</th>
<th>Visibility</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>On On Off</td>
<td>Auto Labels are available and are turned on by default.</td>
</tr>
<tr>
<td>✔️</td>
<td>On On Off</td>
<td>Auto Labels are available and are turned off by default.</td>
</tr>
<tr>
<td></td>
<td>On On Off</td>
<td>Auto Labels are not available.</td>
</tr>
<tr>
<td></td>
<td>On On Off</td>
<td>Auto Labels are not available.</td>
</tr>
</tbody>
</table>

However, if you open a MapInfo Professional MWS file in the Workspace Manager, Create Labels Automatically will take on the setting of Auto Label and Visible will take on the setting of Visibility. This gives the following scenarios:

<table>
<thead>
<tr>
<th>MapInfo Professional MWS file</th>
<th>After opening in Workspace Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Label</td>
<td>Visibility</td>
</tr>
<tr>
<td>✔️</td>
<td>On On Off</td>
</tr>
<tr>
<td>✔️</td>
<td>On On Off</td>
</tr>
<tr>
<td></td>
<td>On On Off</td>
</tr>
<tr>
<td></td>
<td>On On Off</td>
</tr>
</tbody>
</table>
Troubleshooting

Transparent background fills not displayed as transparent

**Symptoms**
When an MWS file is created in MapInfo Professional and a layer uses a style which has a transparent background (no background), once the MWS is loaded into Exponare an opaque background is applied to the style.

**Resolution**
The workaround for this problem is similar to the selectability problem. You must open the MapInfo Professional MWS in the Workspace Manager and set the style to have a transparent background again and re-save the configuration.
The Workspace Manager is an additional component that is installed with Exponare Server. It is not part of the Exponare suite of products, but is a separate utility for creating workspace files (.mws files) that is shipped with a number of products. The following documentation is a complete reference for the use of the Workspace Manager and as such contains references to functionality that may not be accessible in Exponare.

See also Altering 'Live' Workspace and TAB Files.

In this appendix...

- Features of the Workspace Manager
- Workspace Format and Contents
- Workspace Manager Menu Commands
- Layer Control
Features of the Workspace Manager

The Workspace Manager allows you to control most, but not all, of the settings that can be stored in a workspace file. For example, a workspace can contain information about cartographic legends and adornments; however, the Workspace Manager does not provide any options for creating cartographic legends or adornments. To create cartographic legends or adornments, use the API.

Figure D-1: Workspace Manager

Through the Workspace Manager, you can:

- Load XML workspaces, tables, geosets, and workspaces (.mws not .wor files).
- Save workspaces as .MWS.
- Control which tables are opened as part of a workspace.
- Create and load named connections using the Named Connection Manager.
- Add, remove, and view one or more maps.
- Set properties for map and layer visibility, layer and label styles, and themes with the built in layer control.
- Add, remove, or alter custom labels.
- Create group layers, which allow you to organize your layers into logical groupings, so that you can show or hide the entire group with a single click.
- View multiple next and previous map views.
Appendix D: Workspace Manager

- Use map tools for navigation and manual label placement, and use selection tools to verify that layer selectability settings are correct.
- Preview and print maps.
- Quickly open recent workspaces from the recent file list.

Workspace Format and Contents

The workspace file is an XML document (.MWS extension) that contains the locations of the descriptions and metadata of all the maps, tables, layers, and settings that make up the workspace. Because it is XML, the workspace is portable, which means that you can share the workspace with other users working on different computers, on different networks, across locales.

In Exponare, the portability of the XML workspace is implemented with named connections. Named connections enable you to define alternative drive, path, and database connection information based on your own environment, so that you can use workspaces created by others. All paths and connection strings are resolved when the workspace is opened. You can set up named connections directly in the Workspace Manager (File > Manage Named Connections).

Workspace Manager Menu Commands

This section explains each menu command available in the Workspace Manager.

File Menu Commands

The commands in the File menu provide all the standard File menu capabilities, such as opening, saving and printing files, as well as some features unique to the Workspace manager. Each command is described below.

New

Creates a new empty map to which you can then add tables using either the Add tool in layer control or the Open Tables command from the File menu. If changes have been made to the current workspace, you will be asked if you want to save the changes before the new workspace is created.

Open Workspace

Opens an existing workspace. If changes have been made to the current workspace, you will be asked if you want to save the changes before the existing workspace is opened.

Open Tables

The Open Tables command enables you to open one or more tables and add them to your map.

Save

Saves your map as a workspace.
Workspace Manager Menu Commands

Save As
Save a copy of the workspace to a new filename.

Close All Tables
The Close All Tables command closes all of the open tables.

Manage Tables
The Manage Tables command displays a dialog box that lists the tables that make up the map and enables you to open additional tables for possible inclusion in the map. Click **Open** to display the Open dialog box and open a table. The table you opened is added to the list of open tables in the Manage Tables dialog box. Then you can add the table to the map using the Add tool, which is located over the Workspace Manager layer control window.

![Figure D-2: Manage Tables](image)

To close a table, click a table from the list to highlight it. The **Close** button is activated. Click **Close** to close the table. Layers referencing the table you closed are removed from the map.

Manage Named Connections
A named connection describes a connection to a data source using an alias. You can create the following types of named connections: FilePath, DatabaseSource, ODBC, or Oracle OCI. After you specify the connect string or file path, you can save it as XML for later retrieval. You can set a default connection so that when you run Workspace Manager, the connection to your data source is available. Named connections are also saved to the workspace.
Page Setup

The Page Setup command enables you to specify the paper size, orientation, and margins of the printed map. You can also use this option to access printer-specific settings.

Print

The Print command enables you to print your map to paper or file output. In the Print dialog box, specify the printer to use, the page range you want to print if your job is multiple pages, and the number of copies to print. Printer properties enable you to set layout and other options that are specific to the printer you are using. The Print to file check box enables you to print your output to a file.

Print Preview

Use the Print Preview command to see how your output is going to look before you print it.

Recent Workspaces

Recent Workspaces shows a list of recently opened workspaces.

Map Menu Commands

Use the commands in the Map menu to add and remove maps, manipulate the view of the map, and create thematic maps. The view commands are also available in a popup menu. Right-click in the Workspace Manager map window to display the menu.
Workspace Manager Menu Commands

Add New Map
The Add New Map command enables you to create a new map window using the tables that are currently open.

Select Map
The Select Map command enables you to select which map to view in the Workspace Manager.

Remove Current Map
Removes the current map from the Workspace Manager view and deletes it from the workspace.

Change View
The Change View command enables you to change the current view of the map—that is, what area of the map is currently displayed in the window. You can change the zoom and scale of the map to your own settings. You can also set the center of the map window, or change the rotation angle.

The Change View dialog box allows you to choose the units (miles, kilometers, etc.) for the zoom width and for the center X/Y coordinates (meters, degrees, etc.). Whatever units you choose in the Change View dialog box are also used in the layer control. For example, if you want all distances in the layer control to be displayed in kilometers instead of miles, display the Change View dialog box and choose kilometers from the units list that appears next to the Zoom field.

![Figure D-4: Change View](image)

View Entire Layer
Use the View Entire Layer command to see an entire layer, or all the layers in the map. The View Entire Layer dialog box shows a list of the layers that make up the map. Select the desired layer from the list, or choose All Layers so that all the layers are completely in view, and click OK. The map redraws to display the entire layer.

Previous View
Use the Previous View command to return to the previous view of your map.
Next View
The Next View command is available after you have used Previous View. Use it to redisplay the view of the map that was on the screen before you used the Previous View command.

The Previous View and Next View commands can be used together to toggle back and forth between two views of your map. These commands are also available as tools on the toolbar.

Preserve Scale/Zoom
Use the Preserve Scale and Preserve Zoom commands to keep the zoom and/or the scale the same as you change the size and shape of the map.

Redraw
Use the Redraw command to redraw the map.

View Selection
Use the View Selection command to zoom in or out on a selected object or objects.

Create Thematic
You can create feature themes and label themes via the Map > Create Thematic menu. Feature themes include ranged, individual value, dot density, graduated symbol, and pie and bar charts. Label themes include ranged and individual value.

If your map includes at least one set of labels (which are displayed in a label layer, you can create a label theme. A label theme assigns different label styles (different colors, etc.) to each label, based on the data in your table. For example, use a label theme to show the prominence of locations over others. A ranged label theme groups labels based on a similar data value, such as population. Cities that fall within a certain population range are labeled using one style, while cities in other ranges are labeled in another style, typically a less prominent style to indicate city size without having to label using the population value.

The Create Thematic command opens the Create Theme wizard where you can easily create a theme step by step.

To create a theme:
1. Choose Map > Create Thematic.
   The Create Theme: Step 1 of 3 dialog box appears.
2. Select either a Feature theme or a label theme, and choose the type of theme you want to create.
3. Click Next.
   The Create Theme: Step 2 of 3 dialog box appears.
4. Select the table you want to shade.
5. Choose the data you want to use. Select either a column from the table that contains the data, or select Expression to use an expression to derive the data you want from the table.
Workspace Manager Menu Commands

6. Click Next.
   The Create Theme: Step 3 of 3 dialog box appears. Here you can customize theme type settings, styles, and the legend. (See How to Apply Translucent Effects to Themes for instructions on applying translucency effects to a thematic map.)

7. Click Apply to apply the customized settings.

8. Click OK when you are finished.

Theme Wizard

The “Ignore Zero” check box in the Create Theme Step 2 of 3 in the Theme Wizard in Workspace Manager now works correctly. This option is available when creating Pie and Bar chart themes and IndividualValue themes on Features or Labels. Note that when this option is set, the performance of the theme building operation in Workspace Manager may be affected.

Tools Menu Commands

The Workspace Manager’s Tools menu provides access to the map tools via menu commands. These tools enable you to zoom in and out on the map, change the position of the map, and select map objects in various ways. These same tools are also available on the Workspace Manager toolbar. Each tool is explained below.

Zoom In

Use the Zoom In tool to get a closer area view of your map. To zoom in on a map:

1. Choose Tools>Zoom In to activate the tool.
   Your cursor changes to a magnifying glass with a plus sign in it.

2. Click on your map.
   The map redraws at a closer area view, centering itself at the point you clicked.

Zoom Out

Use the Zoom Out tool to get a wider area view of your map. To zoom out on a map:

1. Choose Tools>Zoom Out to activate the tool.
   Your cursor changes to a magnifying glass with a minus sign in it.

2. Click on your map.
   The map redraws at a wider area view, centering itself at the point you clicked.

Pan

Use the Pan tool to reposition your map without changing the zoom level. For example, you might want to redirect the view of your map so that a certain country or city is in the center. To pan your map:

1. Choose Tools>Pan to activate the tool.
   Your cursor changes to a hand icon.
2. Click on the map, and while holding down the mouse button, drag the map to the desired position.
   The map redraws reflecting the new position.

Select
Use the Select tool to select objects one at a time or to select all objects that are generally in the same area.

To select an object using the Select tool:
1. Choose Tools>Select to activate the tool.
   The cursor changes to an arrow.
2. Click the object on the map you want to select.
   The selected object is highlighted.

Labeling
T20011 NCLabeling in Workspace Manager has been fixed so labels can be dragged and dropped with the Select tool.

Radius Select
Use the Radius Select tool to select all objects that fall within a given radius. For example, you have a table of blood donors and a table of blood donation sites. Using the Radius Select tool, you could create a temporary list of blood donors that live within a one-half-mile radius of each blood donation site.

Note that the Radius Select tool selects all objects whose centroid falls within the circle. The object does not have to be completely bounded by the circle. To select objects within a radius:
1. Choose Tools > Radius Select to activate the tool.
   The cursor becomes a hand when moved over the map.
2. Click a place on the map that you would like to use as the center point of your radius search. For example, if you want to select all the fire hydrants that fall within two miles of a fire station, click the fire station and use that as the center point.
3. Hold down the mouse button and drag the mouse away from the center point.
   The Workspace Manager draws a circle around the point and reports the radius of the circle in the StatusBar (lower left corner of the screen).
4. When you have the desired radius release the mouse button.
   Workspace Manager highlights all map objects that fall within that circle.

Rectangle Select
Use the Rectangle Select tool to select objects within a rectangle. By clicking and dragging using the Rectangle Select tool, you create a dotted rectangle, or marquee box around objects you want to select.
Layer Control

Note that the Rectangle Select tool selects all objects whose centroid falls within the rectangle. The object does not have to be completely bounded by the rectangle. To select objects within a rectangle:

1. Choose Tools > Rectangle Select to activate the tool. The cursor becomes a hand when moved over the map.
2. Click a place on the map outside of the area you want to include in the marquee box.
3. Hold down the mouse button and drag the mouse to form a dotted rectangle around the points you want to select.
4. When you have reached the desired rectangle size release the mouse button. Workspace Manager highlights all map objects that fall within that rectangle.

Polygon Select

The Polygon Select tool selects map objects within a polygon that you draw on a map.

To select objects with the Polygon Select tool:

1. Choose Tools>Polygon Select to activate the tool.
   The cursor becomes a pointing hand when moved over the map.
2. Click the map location at which you want to place the first end point of the polygon. Move the cursor over your map in any direction.
   Workspace Manager draws a line from the point where you clicked to the cursor.
3. Click to create another endpoint. Continue to move the cursor and click until you have the desired number of sides to your polygon.
4. To close the polygon, make your last click as close as possible to the first click.
   Workspace Manager closes the polygon and selects the objects that are within it.

Layer Control

The Workspace Manager application window is divided into two main sections. The layer control window and commands are located on the left, and the map window is on the right. The layer control window displays the opened map(s) and all of its accompanying layers.

The layer control features of the Workspace Manager enable you to assemble the layers of your map and apply settings to individual layers or the entire map that govern how the layer(s) or map display.
Layer Control Tools

The tools across the top of the layer control window allow you to add, move, and remove layers from the layer control window easily:

- The Add tools allows you to open tables, and insert group layers and label layers into your map.
- The Remove Selected Item tool removes the selected layer from the map.
- The Up and Down toolbar buttons enable you to move layers up and down the layer list, changing the order in which they are displayed.

Layer Tree

The layer control displays a tree showing the map and all layers in the map, as well as other map elements such as themes and labels. The layer tree allows you to perform these operations:

Displaying Layers

The check box next to each layer on the layer tree allows you to toggle the visibility of a layer with a single click.
Layer Control

Changing the Layer Order

To change the order of the layers, you can select a layer and click the Up or Down toolbar button. Alternately, you can drag a layer up or down to change its position in the list.

There are several special cases that involve drag-and-drop actions:

- To move a layer into a group layer, drag the layer onto the group.
- To add a new label source to a label layer, drag a layer onto the label layer.
- To copy a style override to another layer, drag the style override node to a layer that is a comparable type (that is, you cannot drag a raster style override onto a vector layer).

If you do not want to move a layer into a group—if, instead, you want to reposition the layer so that it is located above the group layer—hold down the Shift key before completing the drag-and-drop action. Similarly, if you do not want to add a new label source to a label layer, hold down the Shift key.

Displaying Context Menus

Each item in the layer tree has a context menu. To display a layer’s context menu, right-click on the layer, or press Shift+F10 to display the menu for the currently-selected layer.

The items on the context menu depend on the type of layer specified. In particular, note the following:

- To add a style override to a layer, display the context menu and choose Add Style Override. Note that each layer can have multiple style overrides, each with a different zoom range; this allows you set up the map so that points appear to grow larger, and roads appear to grow wider, as you zoom in.
- To rename any item in the layer tree, right-click the item and choose Rename. Alternately, you can press F2 to rename the selected item. Note that renaming a layer in this manner does not rename the original table; the rename operation simply changes the text that is displayed in the layer tree. The information is stored in the workspace file when the workspace is saved.
- By default, a layer is selectable when it is added to a map. This is controlled by the Selectable check box of the Options tab in Layer Control (see Options). However, you can designate it as the only selectable layer, and all other layers will be set to unselectable. This is very convenient if you have a map with many layers but only want one layer to have selectable features. To specify only one layer as selectable:
  a. Right-click the layer name in the Layer Control or access the context menu.
  b. Select Make This the Only Selectable Layer. This single map layer now has selectable features. That is, you can use any of the selection tools to select objects on the map. All other map layers will be unselectable.

Layer Control Tabs

The layer control tabs provide additional settings and controls that you can apply to the map as well as to each layer in the map. The tabs change depending on the type of layer it is and whether a layer or the map is highlighted in the layer control window. Sets of dialog box tabs control the map, label layers, layers, and themes. The options in each of the tabs are explained below.
Map Settings

When you select a map in the layer control window, the following tabs are available: View, Editing, Tools, Style, Coordinate System, and Extents.

**View**

The View tab enables you to control the overall appearance of the map. You can set the zoom level, scale, a center point (in degrees), and a rotation angle. Click the **Apply** button to apply your settings.

**Editing**

The options in the Editing tab enable you to control certain map editing tasks such as the styles used for drawing objects (if your application uses drawing tools), resizing objects, and moving and deleting object nodes.

The style boxes enable you to specify the default styles of any drawing tools that your application uses. Click on a box to open the corresponding style dialog box. The settings you select are saved in the workspace. When a user opens the workspace in an application that uses drawing tools, the application uses these style settings when the user draws objects on the map.

You can also specify whether you want to delete or move an object’s nodes.

Finally, you can specify an Edit mode for the map:

- None—No editing can be done on the map.
- Allow moving and resizing—Objects can be moved and resized.
- Allow node editing—Nodes can be moved or deleted.
- Allow node adding—You can add nodes to objects.

The Edit mode you select applies to all editable layers in the map.

**Tools**

The Tools tab enables you to control the display of InfoTips, activate Snap to Nodes and set a snap tolerance, and activate Dynamic Selection tools.

The Show InfoTips checkbox controls whether information about the feature displays in a pop-up when you hover over the feature with a select tool. See Options.

The Dynamic Selection Tools check box controls whether features are selected immediately (while you are using the selection tool) or selected when you release the mouse button to finish using the selection tool.
Layer Control

If the Dynamic Selection Tools check box is not selected, selection tools do not actually select any features on the map until you finish using the tool. For example, the Radius Select tool will not select any features until you specify a radius and release the mouse button.

If the Dynamic Selection Tools check box is selected, features become selected or de-selected dynamically as you drag the mouse. For example, if you use the Radius Select tool, you will see more features become selected as you drag the mouse to enlarge the radius.

If the Snap To Nodes check box is selected, map tools such as the Select tool will automatically search for nodes that are nearby. If a node is nearby, a crosshair will appear to indicate the position of the nearest node. For example, you might want to select the Snap To Node check box if you are using the Radius Search tool, and you want to make sure that the search is centered at the exact location of a point feature on your map. The Snap To Node feature is particularly important in applications that provide drawing tools, because users often need to draw features at the exact location of existing features.

The Snap Tolerance setting specifies how far the tools will search for “snappable” nodes. You can choose which layers use the Snap to Node feature. For example, you might want to turn on Snap To Node, but only have the snap crosshair appear when the cursor is near a feature in a particular layer. To turn the Snap To Node feature on or off for a specific layer, select the layer in the layer tree, then select or clear the Snap To Node check box in the Options tab.

Style

The options in the Style tab enable you to control translucency and anti-aliasing properties.

**Figure D-6: Style**

- **Use Anti-Aliasing**—Use this option to smooth jagged edges of lines, curves, and region borders when representing a high-definition rendition at a lower resolution. When you select Use Anti-Aliasing, Enable Translucency is also selected automatically. Whenever Enable Translucency is deselected, Use Anti-Aliasing is automatically deselected.
Appendix D: Workspace Manager

- **Enable Translucency**—Use this option to allow translucent values in style colors and layers when drawing the map onto the screen, printer, or file export. When translucency is enabled, you can use the translucency trackbar in style dialogs. This property has no effect on raster translucency.

  Rendering higher quality maps by enabling translucency and anti-aliasing, particularly in a map with three or more transparent layers, will often result in a slower rendering speed.

**Coordinate System**

The Coordinate System tab indicates the coordinate system of the map, and enables you to change the coordinate system.

To do this:

1. Click the **Coordinate System** button to display the Choose Coordinate System dialog box.
2. Select a coordinate system from the list, and click **OK**.

**Extents**

In the map, the Extents tab shows the extents of the current map view. Click the **View Entire Map** button to see all of the map.

**Layer Settings**

When you highlight one of the layers that make up the map, four tabs appear: Visibility, Options, Extents, and Information.

**Visibility**

Select the **Visible** check box to make the map layer visible. Selecting the check box next to the layer in the layer tree has the same effect.

Select the **Display Within Range** check box to specify either a zoom range or scale range in which the layer appears. If you select a zoom range, specify the minimum and maximum zoom in miles. The layer appears within this range. If you select a scale range, specify the closest and farthest scale. The layer appears within this scale range.

You can also select **Show Nodes**, **Show Centroids**, and **Show Line Direction** to display these items on the map layer. Nodes are the points that define segments of a line or multi-line or polygon. A centroid is the center of a map object. Line direction is the direction in which the line was drawn (this is helpful on street layers to indicate the proper addressing sequence). Display these elements when you wish to edit map features. The Editable checkbox is located on the Options tab.

**Options**

The Options tab check boxes facilitate editing and customizing a feature layer:

- **Selectable**—When the Selectable check box is selected, objects in the layer can be selected using either the Tool menu commands or the Selecting tools in the toolbar. Clear the Selectable check box for any layer you do not want to select from.
Layer Control

- **Editable**—Select the check box to make the layer editable.
- **Drawing Tools can add features to this layer**—Select this check box if you are preparing this workspace for use in an application that provides drawing tools, and you want the drawing tools to create new features in this layer.
- **Show InfoTips**—Select the Show InfoTips check box to display InfoTips when you hover over map objects in the selected layer. The InfoTip text consists of the result of the expression in the InfoTip Expression field. For example, if the expression is a column in your table, the InfoTips comprise the values from that column. If the expression is a calculation that uses column information in your table, the InfoTips comprise the results of that calculation.
- **Snap to Nodes**—Select to turn the Snap To Node feature on or off for a specific layer, select the layer in the layer tree, then select or clear the Snap To Node check box.

**Extents**

For a layer, the Extents tab shows the extents of the selected layer. Click the **View Entire Layer** button to see all of the layer, or click **View Default Area** to see the default view of the layer.

**Information**

The Information tab provides information about the selected layer. It gives the name of the table and its path, the type of table and its coordinate system.

**Theme Settings**

**Visibility**

When a theme layer is selected, the Visibility tab options control the display of the selected theme. Select the Visible check box to display the theme layer; clear the check box to turn off the theme display.

Select the **Display Within Range** check box to specify either a zoom range or scale range in which the theme appears. If you select a zoom range, specify the minimum and maximum zoom distance. Your theme appears within this range. If you select a scale range, specify the closest and farthest scale. Your theme appears within this scale range.

**Theme**

The Theme tab indicates the type of thematic map and the expression used to obtain the values. The Theme tab also enables you to modify your thematic map. Click **Modify Theme** to change the styles or legend.

**How to Apply Translucent Effects to Themes**

You can apply translucent effects to thematic maps. The following example shows a ranged theme applied to a city boundary layer. The layer is positioned on top of the rest of the layers.
If translucency is enabled, you can select a translucent value for the start and end theme ranges (bins), and automatically spread the color. This will also automatically spread the translucent value between the start and end theme bins. For example, the theme in the above map has a translucency value of 75% for the start bin (gray) and 50% for the end bin (red). Since this theme has 3 bins, the middle bin is automatically given a translucency value of 63% (50 through 75 spread equally).

**Label Settings**

When you select a label layer in the layer control window, the Visibility tab is available. When you expand the label layer to see the label sources, additional tabs display that control the appearance and content of labels in label sources: AutoLabel, Style, Text, Position, and Rules.

**Visibility**

When a label layer is selected, the options in the Visibility tab control the display of labels. Select the **Visible** check box to display labels; clear the check box to turn off label display.

Select the **Display Within Range** check box to specify either a zoom range or scale range in which the labels display. If you select a zoom range, specify the minimum and maximum zoom distance. Your labels display within this range. If you select a scale range, specify the closest and farthest scale. Your labels display within this scale range.
Layer Control

Click **Clear Label Modifications** to return the labels to their default state. This button removes individual labels that were manually added with the Label tool and restores labels to their original position.

AutoLabel

The AutoLabel tab enables you to create and manage the display of autolabels. Select the **Create labels automatically** check box to generate autolabels for your map. Select the **Display Within Range** check box to specify either a zoom range or scale range in which the autolabels display. If you select a zoom range, specify the minimum and maximum zoom distance. If you select a scale range, specify the closest and farthest scale. Your autolabels display within this scale range.

![Figure D-8: Auto Label](image)

**Style**

The Styles tab controls the style of label text and label lines. For label text, use the Text style box to access the Text Style dialog box. You can specify the font, color, background, and other text effects for the labels. For label lines, use the Line style box to access the Line Style dialog box, where you set the style of the label lines. In the Label Lines group, choose whether you want no label lines, simple lines, or lines with an arrow.

**Text**

The Text tab enables you to specify an expression that produces the label text from a column or derived information in the table.

**Position**

Use the settings in the Position tab to set the orientation, offset, and rotation of the labels.

The label's orientation is the label's position relative to its anchor point. Click one of the buttons to select an orientation.

Label offset is how far away a label is from its anchor point in pixels.
Appendix D: Workspace Manager

The label rotation is the angle at which the label is drawn. There are three Rotation settings:

- **Parallel to one segment**—Select this option if you are labeling line features such as highways, and you want each label to be drawn at an angle that will make the label run parallel to the nearest segment of the highway.

- **Parallel to multiple segments**—Select this option if you are labeling line features such as highways, and you want the label text to follow the shape of the highways (that is, you want curved labels). Turning anti-aliasing on via the Style tab in Layer Control will improve the look of the resulting curved labels.

- **Specific angle**—Specify an angle in degrees, such as zero degrees to make all labels horizontal.

**Figure D-9: Position Tab**

---

### Creating Curved Labels

To position labels along a curve:

1. In Workspace Manager, open the map you want to change the labels for.
2. Highlight the layer source that contains the labels you want to change.
3. Verify that the labels are visible.
4. Click the Position tab. In the Rotation section, select **Parallel to multiple segments** to display the labels along the curve of the line.

---

Administration Guide 457
5. If necessary, use the Orientation buttons on the Position tab to set the label’s position relative to its anchor point. When you select:

- **Left**, the curved labels are left-justified starting at the beginning of the arc/polyline
- **Center**, the curved labels are centered on the midpoint of the arc/polyline
- **Right**, the curved labels are right-justified at the end of the arc/polyline

**Note:** The length of the polyline(s) affect how the label is positioned. The longer the polyline(s), the more predictably the labels display.

**Repositioning Curved Labels**

You can use the Label tool on the Main toolbar to reposition curved labels. Make sure you have already selected the **Parallel to multiple segments** option on the Position tab for the label source you want to change.

1. Highlight the layer you want to move the labels for in the list.
2. In the Options tab, select the **Selectable** check box.
3. Highlight the label source where you want to move curved labels.
4. Click **Label** (the Label tool) on the Main toolbar.
5. Click the line on which you want to reposition the label.
6. Click the new location for the label until the label is positioned where you want it.

ℹ️ If the segment you select does not have a label name associated with it in the data, no label is displayed.
Appendix D: Workspace Manager

Rules

The Rules tab enables you to set certain conditions for displaying labels on your map:

Allow Duplicate Text  Select the Allow Duplicate Text check box to allow duplicate labels for different objects to display, e.g., Portland, OR and Portland, ME. This option is also used with street maps to label street segments individually.

Allow Overlapping Text  Select the Allow Overlapping Text check box to allow labels to be drawn on top of each other. Some labels do not display because they overlap labels that have been given higher priority on the map.

Label Partial Objects  Select the Label Partial Objects check box to label polylines and objects whose centroids are not visible in the Map window.

Figure D-11: Rules Tab

Per-Label Priority Expression  This expression field is optional. If you leave this expression field blank, features within a single label source are labeled in an unpredictable manner. For example, you might find that some small cities are labeled, while some major cities are not labeled because there is not enough room. If you specify an expression (which must be numeric), then the expression will be calculated for each feature on the visible portion of the map, and features that have a larger value will be given a higher labeling priority. To specify an expression, click the Set button.

For example, suppose you are configuring the labels for the WorldCapitals layer, which contains point features that represent cities. You probably want the cities with the largest population to have the highest labeling priority. In this case, you would specify a labeling expression such as:

\[ \text{cap}_\text{pop} \]

The \text{cap}_\text{pop} column represents the population of each capital city. When you specify a Per-Label Priority Expression of \text{cap}_\text{pop}, you are specifying that the cities with the largest population should have the highest labeling priority. As a result, the most populous cities will be labeled first, while other cities will be labeled only if there is enough room left over.

Per-Table Priority Expression  This expression field is optional. A label layer can contain multiple label sources; for example, you might have one label source representing a set of labels for World Countries, and another label source representing a set of labels for World Capitals (cities). By default, the label source at the top of the list has the highest priority. If you want to assign a higher priority to a label source, you can either move that label source up (in the layer control’s list of label sources), or you can specify a Per-Table Priority Expression for each label source.
Layer Control

For example, if you give the World Countries label source a per-table priority expression of 10, and give the World Capitals label source a per-table priority expression of 5, country labels will have priority over capital city labels.
Line Styles and Fill Patterns

In this appendix...

- Line Styles
- Fill Patterns
<table>
<thead>
<tr>
<th>Line Style</th>
<th>Number</th>
<th>Line Style</th>
<th>Number</th>
<th>Line Style</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>1</td>
<td>-----------</td>
<td>2</td>
<td>-----------</td>
<td>3</td>
</tr>
<tr>
<td>............</td>
<td>4</td>
<td>---------</td>
<td>5</td>
<td>---------</td>
<td>6</td>
</tr>
<tr>
<td>- - - - -</td>
<td>7</td>
<td>- - - -</td>
<td>8</td>
<td>- - - - -</td>
<td>9</td>
</tr>
<tr>
<td>- - - - -</td>
<td>10</td>
<td>- - - -</td>
<td>11</td>
<td>- - - -</td>
<td>12</td>
</tr>
<tr>
<td>- - - -</td>
<td>13</td>
<td>- - - -</td>
<td>14</td>
<td>- - - - -</td>
<td>15</td>
</tr>
<tr>
<td>- - - -</td>
<td>16</td>
<td>- - - -</td>
<td>17</td>
<td>- - - -</td>
<td>18</td>
</tr>
<tr>
<td>- - - -</td>
<td>19</td>
<td>- - - -</td>
<td>20</td>
<td>- - - -</td>
<td>21</td>
</tr>
<tr>
<td>- - - -</td>
<td>22</td>
<td>- - - - -</td>
<td>23</td>
<td>- - - - -</td>
<td>24</td>
</tr>
<tr>
<td>- - - -</td>
<td>25</td>
<td>+ + + +</td>
<td>26</td>
<td>+ + + +</td>
<td>27</td>
</tr>
<tr>
<td>- + + + +</td>
<td>28</td>
<td>+ + + +</td>
<td>29</td>
<td>+ + + +</td>
<td>30</td>
</tr>
<tr>
<td>- + + +</td>
<td>31</td>
<td>- + + +</td>
<td>32</td>
<td>- + + +</td>
<td>33</td>
</tr>
<tr>
<td>- + + +</td>
<td>34</td>
<td>- + + +</td>
<td>35</td>
<td>- + + +</td>
<td>36</td>
</tr>
<tr>
<td>- + + +</td>
<td>37</td>
<td>- + + +</td>
<td>38</td>
<td>- + + +</td>
<td>39</td>
</tr>
<tr>
<td>- + + +</td>
<td>40</td>
<td>- + + +</td>
<td>41</td>
<td>- + + +</td>
<td>42</td>
</tr>
<tr>
<td>- + + +</td>
<td>43</td>
<td>- + + +</td>
<td>44</td>
<td>- + + +</td>
<td>45</td>
</tr>
<tr>
<td>- + + + + + + + + + + + + + + + + +</td>
<td>46</td>
<td>- + + +</td>
<td>47</td>
<td>- + + +</td>
<td>48</td>
</tr>
<tr>
<td>- + + + + + + + + + + + + + + + + +</td>
<td>49</td>
<td>- + + +</td>
<td>50</td>
<td>- + + +</td>
<td>51</td>
</tr>
<tr>
<td>52</td>
<td>52</td>
<td>- + + +</td>
<td>53</td>
<td>- + + +</td>
<td>54</td>
</tr>
<tr>
<td>55</td>
<td>55</td>
<td>- + + +</td>
<td>56</td>
<td>- + + +</td>
<td>57</td>
</tr>
<tr>
<td>58</td>
<td>58</td>
<td>- + + +</td>
<td>59</td>
<td>- + + +</td>
<td>60</td>
</tr>
</tbody>
</table>
## Appendix E: Line Styles and Fill Patterns

<table>
<thead>
<tr>
<th>Line Style</th>
<th>Number</th>
<th>Line Style</th>
<th>Number</th>
<th>Line Style</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>←→</td>
<td>61</td>
<td>——</td>
<td>62</td>
<td>——</td>
<td>63</td>
</tr>
<tr>
<td>——·</td>
<td>64</td>
<td>——</td>
<td>65</td>
<td>——</td>
<td>66</td>
</tr>
<tr>
<td>——··</td>
<td>67</td>
<td>——</td>
<td>68</td>
<td>——</td>
<td>69</td>
</tr>
<tr>
<td>——····</td>
<td>70</td>
<td>——·</td>
<td>71</td>
<td>——·</td>
<td>72</td>
</tr>
<tr>
<td>——·····</td>
<td>73</td>
<td>——·</td>
<td>74</td>
<td>——·</td>
<td>75</td>
</tr>
<tr>
<td>——······</td>
<td>76</td>
<td>——··</td>
<td>77</td>
<td>——··</td>
<td>78</td>
</tr>
<tr>
<td>····</td>
<td>79</td>
<td>·····</td>
<td>80</td>
<td>·····</td>
<td>81</td>
</tr>
<tr>
<td>······</td>
<td>82</td>
<td>······</td>
<td>83</td>
<td>······</td>
<td>84</td>
</tr>
<tr>
<td>········</td>
<td>85</td>
<td>·······</td>
<td>86</td>
<td>·······</td>
<td>87</td>
</tr>
<tr>
<td>·········</td>
<td>88</td>
<td>········</td>
<td>89</td>
<td>········</td>
<td>90</td>
</tr>
<tr>
<td>··········</td>
<td>91</td>
<td>·········</td>
<td>92</td>
<td>·········</td>
<td>93</td>
</tr>
<tr>
<td>········</td>
<td>94</td>
<td>········</td>
<td>95</td>
<td>········</td>
<td>96</td>
</tr>
<tr>
<td>··········</td>
<td>97</td>
<td>·········</td>
<td>98</td>
<td>·········</td>
<td>99</td>
</tr>
<tr>
<td>···········</td>
<td>100</td>
<td>··········</td>
<td>101</td>
<td>··········</td>
<td>102</td>
</tr>
<tr>
<td>···········</td>
<td>103</td>
<td>··········</td>
<td>104</td>
<td>··········</td>
<td>105</td>
</tr>
<tr>
<td>···········</td>
<td>106</td>
<td>··········</td>
<td>107</td>
<td>··········</td>
<td>108</td>
</tr>
<tr>
<td>···········</td>
<td>109</td>
<td>··········</td>
<td>110</td>
<td>··········</td>
<td>111</td>
</tr>
<tr>
<td>···········</td>
<td>112</td>
<td>··········</td>
<td>113</td>
<td>··········</td>
<td>114</td>
</tr>
<tr>
<td>···········</td>
<td>115</td>
<td>··········</td>
<td>116</td>
<td>··········</td>
<td>117</td>
</tr>
<tr>
<td>············</td>
<td>118</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Fill Patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Number</th>
<th>Pattern</th>
<th>Number</th>
<th>Pattern</th>
<th>Number</th>
<th>Pattern</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(None)</td>
<td>1</td>
<td></td>
<td>2</td>
<td></td>
<td>3</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td></td>
<td>6</td>
<td></td>
<td>7</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td></td>
<td>13</td>
<td></td>
<td>14</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td></td>
<td>17</td>
<td></td>
<td>18</td>
<td></td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td></td>
<td>21</td>
<td></td>
<td>22</td>
<td></td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>24</td>
<td></td>
<td>25</td>
<td></td>
<td>26</td>
<td></td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>28</td>
<td></td>
<td>29</td>
<td></td>
<td>30</td>
<td></td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>32</td>
<td></td>
<td>33</td>
<td></td>
<td>34</td>
<td></td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>36</td>
<td></td>
<td>37</td>
<td></td>
<td>38</td>
<td></td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td></td>
<td>41</td>
<td></td>
<td>42</td>
<td></td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>44</td>
<td></td>
<td>45</td>
<td></td>
<td>46</td>
<td></td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>48</td>
<td></td>
<td>49</td>
<td></td>
<td>50</td>
<td></td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>52</td>
<td></td>
<td>53</td>
<td></td>
<td>54</td>
<td></td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>56</td>
<td></td>
<td>57</td>
<td></td>
<td>58</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>Pattern</td>
<td>Number</td>
<td>Pattern</td>
<td>Number</td>
<td>Pattern</td>
<td>Number</td>
<td>Pattern</td>
<td>Number</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td><img src="image1" alt="Pattern Image" /></td>
<td>60</td>
<td><img src="image2" alt="Pattern Image" /></td>
<td>61</td>
<td><img src="image3" alt="Pattern Image" /></td>
<td>62</td>
<td><img src="image4" alt="Pattern Image" /></td>
<td>63</td>
</tr>
<tr>
<td><img src="image5" alt="Pattern Image" /></td>
<td>64</td>
<td><img src="image6" alt="Pattern Image" /></td>
<td>65</td>
<td><img src="image7" alt="Pattern Image" /></td>
<td>66</td>
<td><img src="image8" alt="Pattern Image" /></td>
<td>67</td>
</tr>
<tr>
<td><img src="image9" alt="Pattern Image" /></td>
<td>68</td>
<td><img src="image10" alt="Pattern Image" /></td>
<td>69</td>
<td><img src="image11" alt="Pattern Image" /></td>
<td>70</td>
<td><img src="image12" alt="Pattern Image" /></td>
<td>71</td>
</tr>
<tr>
<td><img src="image13" alt="Pattern Image" /></td>
<td>72</td>
<td><img src="image14" alt="Pattern Image" /></td>
<td>73</td>
<td><img src="image15" alt="Pattern Image" /></td>
<td>74</td>
<td><img src="image16" alt="Pattern Image" /></td>
<td>75</td>
</tr>
<tr>
<td><img src="image17" alt="Pattern Image" /></td>
<td>76</td>
<td><img src="image18" alt="Pattern Image" /></td>
<td>77</td>
<td><img src="image19" alt="Pattern Image" /></td>
<td>78</td>
<td><img src="image20" alt="Pattern Image" /></td>
<td>79</td>
</tr>
<tr>
<td><img src="image21" alt="Pattern Image" /></td>
<td>80</td>
<td><img src="image22" alt="Pattern Image" /></td>
<td>81</td>
<td><img src="image23" alt="Pattern Image" /></td>
<td>82</td>
<td><img src="image24" alt="Pattern Image" /></td>
<td>83</td>
</tr>
<tr>
<td><img src="image25" alt="Pattern Image" /></td>
<td>84</td>
<td><img src="image26" alt="Pattern Image" /></td>
<td>85</td>
<td><img src="image27" alt="Pattern Image" /></td>
<td>86</td>
<td><img src="image28" alt="Pattern Image" /></td>
<td>87</td>
</tr>
<tr>
<td><img src="image29" alt="Pattern Image" /></td>
<td>88</td>
<td><img src="image30" alt="Pattern Image" /></td>
<td>89</td>
<td><img src="image31" alt="Pattern Image" /></td>
<td>90</td>
<td><img src="image32" alt="Pattern Image" /></td>
<td>91</td>
</tr>
<tr>
<td><img src="image33" alt="Pattern Image" /></td>
<td>92</td>
<td><img src="image34" alt="Pattern Image" /></td>
<td>93</td>
<td><img src="image35" alt="Pattern Image" /></td>
<td>94</td>
<td><img src="image36" alt="Pattern Image" /></td>
<td>95</td>
</tr>
<tr>
<td><img src="image37" alt="Pattern Image" /></td>
<td>96</td>
<td><img src="image38" alt="Pattern Image" /></td>
<td>97</td>
<td><img src="image39" alt="Pattern Image" /></td>
<td>98</td>
<td><img src="image40" alt="Pattern Image" /></td>
<td>99</td>
</tr>
<tr>
<td><img src="image41" alt="Pattern Image" /></td>
<td>100</td>
<td><img src="image42" alt="Pattern Image" /></td>
<td>101</td>
<td><img src="image43" alt="Pattern Image" /></td>
<td>102</td>
<td><img src="image44" alt="Pattern Image" /></td>
<td>103</td>
</tr>
<tr>
<td><img src="image45" alt="Pattern Image" /></td>
<td>104</td>
<td><img src="image46" alt="Pattern Image" /></td>
<td>105</td>
<td><img src="image47" alt="Pattern Image" /></td>
<td>106</td>
<td><img src="image48" alt="Pattern Image" /></td>
<td>107</td>
</tr>
<tr>
<td><img src="image49" alt="Pattern Image" /></td>
<td>108</td>
<td><img src="image50" alt="Pattern Image" /></td>
<td>109</td>
<td><img src="image51" alt="Pattern Image" /></td>
<td>110</td>
<td><img src="image52" alt="Pattern Image" /></td>
<td>111</td>
</tr>
<tr>
<td><img src="image53" alt="Pattern Image" /></td>
<td>112</td>
<td><img src="image54" alt="Pattern Image" /></td>
<td>113</td>
<td><img src="image55" alt="Pattern Image" /></td>
<td>114</td>
<td><img src="image56" alt="Pattern Image" /></td>
<td>115</td>
</tr>
<tr>
<td><img src="image57" alt="Pattern Image" /></td>
<td>116</td>
<td><img src="image58" alt="Pattern Image" /></td>
<td>117</td>
<td><img src="image59" alt="Pattern Image" /></td>
<td>118</td>
<td><img src="image60" alt="Pattern Image" /></td>
<td>119</td>
</tr>
</tbody>
</table>
### Fill Patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Number</th>
<th>Pattern</th>
<th>Number</th>
<th>Pattern</th>
<th>Number</th>
<th>Pattern</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Pattern" /></td>
<td>120</td>
<td><img src="image2" alt="Pattern" /></td>
<td>121</td>
<td><img src="image3" alt="Pattern" /></td>
<td>122</td>
<td><img src="image4" alt="Pattern" /></td>
<td>123</td>
</tr>
<tr>
<td><img src="image5" alt="Pattern" /></td>
<td>124</td>
<td><img src="image6" alt="Pattern" /></td>
<td>125</td>
<td><img src="image7" alt="Pattern" /></td>
<td>126</td>
<td><img src="image8" alt="Pattern" /></td>
<td>127</td>
</tr>
<tr>
<td><img src="image9" alt="Pattern" /></td>
<td>128</td>
<td><img src="image10" alt="Pattern" /></td>
<td>129</td>
<td><img src="image11" alt="Pattern" /></td>
<td>130</td>
<td><img src="image12" alt="Pattern" /></td>
<td>131</td>
</tr>
<tr>
<td><img src="image13" alt="Pattern" /></td>
<td>132</td>
<td><img src="image14" alt="Pattern" /></td>
<td>133</td>
<td><img src="image15" alt="Pattern" /></td>
<td>134</td>
<td><img src="image16" alt="Pattern" /></td>
<td>135</td>
</tr>
<tr>
<td><img src="image17" alt="Pattern" /></td>
<td>136</td>
<td><img src="image18" alt="Pattern" /></td>
<td>137</td>
<td><img src="image19" alt="Pattern" /></td>
<td>138</td>
<td><img src="image20" alt="Pattern" /></td>
<td>139</td>
</tr>
<tr>
<td><img src="image21" alt="Pattern" /></td>
<td>140</td>
<td><img src="image22" alt="Pattern" /></td>
<td>141</td>
<td><img src="image23" alt="Pattern" /></td>
<td>142</td>
<td><img src="image24" alt="Pattern" /></td>
<td>143</td>
</tr>
<tr>
<td><img src="image25" alt="Pattern" /></td>
<td>144</td>
<td><img src="image26" alt="Pattern" /></td>
<td>145</td>
<td><img src="image27" alt="Pattern" /></td>
<td>146</td>
<td><img src="image28" alt="Pattern" /></td>
<td>147</td>
</tr>
<tr>
<td><img src="image29" alt="Pattern" /></td>
<td>148</td>
<td><img src="image30" alt="Pattern" /></td>
<td>149</td>
<td><img src="image31" alt="Pattern" /></td>
<td>150</td>
<td><img src="image32" alt="Pattern" /></td>
<td>151</td>
</tr>
<tr>
<td><img src="image33" alt="Pattern" /></td>
<td>152</td>
<td><img src="image34" alt="Pattern" /></td>
<td>153</td>
<td><img src="image35" alt="Pattern" /></td>
<td>154</td>
<td><img src="image36" alt="Pattern" /></td>
<td>155</td>
</tr>
<tr>
<td><img src="image37" alt="Pattern" /></td>
<td>156</td>
<td><img src="image38" alt="Pattern" /></td>
<td>157</td>
<td><img src="image39" alt="Pattern" /></td>
<td>158</td>
<td><img src="image40" alt="Pattern" /></td>
<td>159</td>
</tr>
<tr>
<td><img src="image41" alt="Pattern" /></td>
<td>160</td>
<td><img src="image42" alt="Pattern" /></td>
<td>161</td>
<td><img src="image43" alt="Pattern" /></td>
<td>162</td>
<td><img src="image44" alt="Pattern" /></td>
<td>163</td>
</tr>
<tr>
<td><img src="image45" alt="Pattern" /></td>
<td>164</td>
<td><img src="image46" alt="Pattern" /></td>
<td>165</td>
<td><img src="image47" alt="Pattern" /></td>
<td>166</td>
<td><img src="image48" alt="Pattern" /></td>
<td>167</td>
</tr>
<tr>
<td><img src="image49" alt="Pattern" /></td>
<td>168</td>
<td><img src="image50" alt="Pattern" /></td>
<td>169</td>
<td><img src="image51" alt="Pattern" /></td>
<td>173</td>
<td><img src="image52" alt="Pattern" /></td>
<td>174</td>
</tr>
<tr>
<td><img src="image53" alt="Pattern" /></td>
<td>175</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Confirm Integration

In this appendix...

- Introduction
- Confirm Integration Feature
MapInfo Exponare now allows Confirm product to use Exponare. Exponare will return a GIF format of the map to confirm product. Exponare Public user will be used for this integration.

Confirm Integration Feature

The Confirm will integrate with Exponare by using the following URL:

http://<machine ip address or name>/<virtual root directory of Exponare in IIS or server>/PublicInvoker.aspx?page=Invoker.aspx&context=$WC$&xCoordinate=$XCOORD$&yCoordinate=$YCOORD$&mapHeight=$HEIGHT$&mapWidth=$WIDTH$&zoomWidth=$ZOOM$

For example, the URL that will be accessed by Confirm will be:

http://152.144.214.251/exponare/PublicInvoker.aspx?page=Invoker.aspx&context=Cadastre&xCoordinate=315054.120350467&yCoordinate=5813911.23594152&mapHeight=500&mapWidth=500&zoomWidth=2

This URL is not accessible directly in Internet Explorer (IE browser).

The following are the mandatory parameters:
1. Context
2. xCoordinate
3. yCoordinate

If the value of "context", "xCoordinate" or "yCoordinate" is missing or any of them is not used as parameter then a "gif" format with error message is displayed.

The following are optional parameters:
1. mapHeight
2. mapWidth
3. zoomWidth

If "mapHeight" or "mapWidth" parameter is missing or any of them is not used, then both will be set to 500px.
If "zoomWidth" parameter is missing or is not used, then it will not be applied.

• If specified work context in value of "context" is not found in Exponare, then default work context for the public user will be displayed.
Appendix F: Confirm Integration

- If a specified Map bound in value of "xCoordinate" and "yCoordinate" doesn't lie in Work Context Zoom Range, then a Gif format will be returned that will display the appropriate error message.
- If any error occurs while getting the GIF format from the Exponare, then a GIF format will be returned that will display the appropriate error message.
- "zoomWidth" parameter value will always be taken in kilometers (KM), and Zoom width will be applied based on the range settings available in Configuration Manager for that Work Context.
- If "mapHeight" or "mapWidth" parameters are provided with a garbage value then both will be set to 500px.
- If "zoomWidth" parameter is provided with garbage value then it will not be applied.
- If "mapHeight" or "mapWidth" parameters are provided with any value less than 1 i.e. any negative value or zero then that value will be set to 1px.
Activation Key
A unique code that the Administrator uses to activate various components of Exponare.

Active Selection
A Feature in the current selection of Features that is designated as the active, or current, Feature. A user can change which Feature in the selection of Features is the Active Selection.

Address Search
An Exponare feature used to locate an address on the map based on address details entered by a user. Exponare can be configured by an Administrator to use one of two Pitney Bowes Software technologies, Envinsa or MapMarker, as the Address Search Engine.

Administration Guide
A document that contains the information needed by an Administrator to configure Exponare.

Administrator
A person with Exponare administration rights. An administrator can:

- Change the Exponare Configuration by logging in to Exponare Enquiry through a User Profile which has administration rights. Such accounts have access to the Configuration Manager.
- Modify Exponare Server components and security settings through the Windows file system, registry settings, database settings, IIS settings, etc.

Advanced Query
A Query that can be modified by a user to contain additional parameters. An Advanced Query might also contain existing fixed parameters like a Basic Query.

Annotation
A Temporary Feature drawn on the map by the user. An Annotation can either be a simple shape or a piece of text. Typically one or more Annotations are used in conjunction with printing to add custom information to a printed map.

Application Link
4. The general concept of enabling communication between Exponare and third-party applications to transfer information such as current selections.

5. A specific implementation of the above.
**Application Link Tester**
The Application Link Tester provides the ability to develop and test an Application Link without access to Exponare.

**Application Link-In**
Configuration of an Application Link and of Exponare Enquiry for an Application Link that is initiated by a third-party application to Exponare.

**Application Link-Out**
Configuration of an Application Link and of Exponare Enquiry for an Application Link that is initiated by Exponare to a third-party application.

**Auto Label**
An Auto Label provides textual information about a Feature. The textual information, displayed on the map, comes from one of the columns of data associated with the Feature. Eg. The names associated with road Features.

**Auto Label Zoom Visibility Range**
The range of Zoom Width values for which a given map Layer's Auto Labels is visible. By default, Auto Labels are set to be on and as a result are visible at all Zoom Widths.

**Basic Query**
A Query that contains a fixed set of parameters.

**Configuration Manager**
The tool used to configure Exponare. The Configuration Manager displays the Exponare Configuration and allows the Administrator to modify and save the Configuration.

**Coordinate Export**
An Exponare feature that allows a user to define a temporary shape on the map and export the coordinates of that shape to an external application or file.

**Custom Tag**
A Custom Tag is a special Print Template Tag that provides a mechanism for users to insert additional text into a Print Template. Text to be added to a Print Template is specified by a user in either the Exponare Enquiry or Exponare Public Print Panels.

**Data Bind**
A Data Bind is a Query on a data source, such as a TAB File, that associates textual information with Features in a Layer on the map. Exponare displays the textual information associated with a Feature when the Feature is selected. Textual information is displayed in either a Data Bind Details view or a Feature Details view.

**Data Bind Details**
A tabular view of textual information associated with selected Features on the map. The textual information is organized into separate tables for each Data Bind associated with the selected Features. Compare with Feature Details.
Data Bind Hyperlink
An or text hyperlink associated with a Feature. The hyperlink is displayed in the Data Bind Details and Feature Details relating to the Feature.

Database Connection
A definition of a link to an external database, so that the data in that database can be used as a data source for things such as Queries and Data Binds.

Drop-Down List Query Parameter
A Query Parameter that allows the user to choose from a fixed set of options. The Administrator defines available options.

Dynamic Drop-Down Query Parameter
A Query Parameter that allows the user to choose from a dynamic set of options. The available options are generated by running an Administrator defined Query to retrieve a set of values from a data source.

Exponare
The collective name for the group of components that make up the Exponare Product Suite.

Exponare Configuration
The collection of settings which specify the behavior and appearance of Exponare. Administrators access the Exponare Configuration through the Configuration Manager. Eg. Work Context details, User Profile access rights, etc.

Exponare Enquiry
The name of the Exponare desktop client.

Exponare Hardware Identity Generator
A tool used by Exponare customers to assist them in making an Exponare License Request.

Exponare License
A file (lic file) that unlocks an Exponare installation for a given hardware configuration. An Exponare License File is received in response to an Exponare License Request. A trial license is installed if a valid MapXtreme 2005 license cannot be found and is valid for 60 days.

Exponare License Request
An application for an Exponare License File. Requests are sent to Pitney Bowes Software via email or fax.

Exponare Module
The generic name for one of the components that make up the Exponare Product Suite. eg Exponare Public.

Exponare Public
The name of the Exponare web browser client.

Exponare Serial Number
The alpha-numeric code printed on the underside of the Exponare product packaging.
**Exponare Server**
The name of the Exponare service provider for both Exponare Enquiry and Exponare Public.

**Exponare Trial License**
An Exponare License file that is effective for the first 60 days after Exponare installation. An Exponare Trial License is created automatically on installation of Exponare.

**Favourite**
A Favourite is a collection of settings describing the View, selection, Active Selection and Layer Settings. A user can save or export a Favourite. A user can open or import existing Favourites to apply the settings in the Favourite to their Exponare Enquiry session. Exported favourites can be sent to and used by other Exponare Enquiry users.

**Feature**
A spatial object shown on the map. Eg. a street, a property boundary, an address point, etc.

**Feature Details**
A view of the textual information associated with the Active Feature on the map. The textual information is organised so that information from all Data Binds associated with the Active Feature are shown. The Feature Details Panel can be used to change the Active Feature to any selected Feature. Compare with Data Bind Details.

**HTML Print Template**
A Print Template that will produce a web page to be viewed in the user's web browser. Once shown the HTML Print Template can be printed from the web browser.

**IIS**
Acronym for Internet Information Services. Microsoft's web server application.

**Image Watermark**
A Watermark to be added to the map that consists of an Image. This Image is overlaid on the map in the manner defined by the Administrator.

**Layer**
A map is composed of multiple Layers that are overlaid on top of each other. For example, a map might consist of a Layer which shows the land area and water areas, plus another Layer which contains the road network, plus another Layer which contains the national parks, etc. A user of the system may, if the Administrator allows it, be able to manipulate these Layers to change which ones are being displayed on the map, or which order the Layers are displayed in.

**Layer Auto Labels**
The setting that determines if Auto Labels associated with spatial features in a given map Layer are visible if the Layer is within its Auto Label Zoom Visibility Range. Typically an Exponare user can change the Layer Auto Labels setting for various Layers on the map.

**Layer Icon**
A small Icon associated with a Layer on the map. The Icon is displayed in the Legend.
Layer Rolldown Image
A large image associated with a Layer on the map. The image is visible in the Legend if a user chooses to roll down the row in the Legend that represents the Layer. Typically a Layer Rolldown Image contains a small image for each unique visual feature style in the Layer and a short textual description.

Layer Selectability
The setting that determines if spatial features in a given map Layer can be selected by an Exponare user. Typically an Exponare user can change the Layer Selectability setting for various map Layers.

Layer Settings
The current state of the Layers on the map. This includes the order of Layers on the map as well as the Layer Visibility, Layer Selectability and Layer Auto Labels state for each Layer.

Layer Settings Shortcut
A Layer Settings Shortcut allows the user to quickly make a set of changes to the Layer Settings in a single action. The Administrator defines what changes a specific Layer Settings Shortcut will perform.

Layer Visibility
The setting that determines if spatial features in a given map Layer are visible if that Layer is within its Zoom Visibility Range. Typically an Exponare user can change the Layer Visibility setting for various map Layers.

Legend
A tool that displays information about the current Layer on the map and allows users to alter the current Layer Settings to cause changes on the map. Eg. Change a Layer's Layer Visibility setting.

Map context menu
The menu that is displayed when the user clicks the alternative mouse button over a map.

Mail merge
A process or mechanism to create several documents based on a common document template and individual data. Exponare offers a feature called Microsoft Word Mail Merge.

Map Scale
The size of the map compared to the actual area it represents. For example, a Scale of 1:1000 means that viewed map is 1000 times smaller than the real-life area it is represents.

MapInfo Workspace (.MWS) File
An XML file that is used by Pitney Bowes Software products to define a map or maps and associated features such as labels, Legends etc. As well as the Workspace Manager that is installed with Exponare Server, a number of other tools can also create and manipulate Workspace files, such as MapInfo Professional. As such, the Workspace file can contain descriptions of a number of different features, not all of which are relevant to, or used by, Exponare.

Microsoft Office
A suite of productivity programs created by Microsoft.

Microsoft Visual Studio .NET
An integrated development environment by Microsoft.
Microsoft Word
Microsoft Word is a word processor program from Microsoft.

Microsoft Word Print Template
A Print Template that will produce a Microsoft Word document to be viewed in Microsoft Word. Once shown the Microsoft Word Print Template can be printed from within Microsoft Word.

Overview Map
A map that indicates the area currently shown on the main map. It can also be used to quickly reposition the view of the main map.

Parameterless Query
A Query that has no input parameters. A Parameterless Query can be executed by a user without providing additional information. For example, a spatial buffering Query does not require any user input.

Print Template
A document containing Print Template Tags that can be requested by a user. Print Templates can either be HTML Print Templates or Microsoft Word Print Templates.

Print Template Tag
A place holder added to a Print Template by an Administrator that is replaced with content from Exponare when requested by a user. Eg. A map Print Template Tag would be replaced with the current Exponare map.

Property and Ratings System
The most common category of Application Links. Such systems are mainly used by Councils.

Query
A search for one or more Features and their associated textual information based on criteria specified by a user.

Query Parameter
A Query Parameter allows the user to enter information to be part of a Query used to select Features on the map.

Remote Data Bind
A Data Bind that brings information back from an external database rather than from a TAB File.

Scale Bar
An Exponare feature that displays the current scale of the map graphically. The Scale of the map indicates how large the displayed area is in the real world.

Selection Results
The combined result of all Data Binds associated with selected Features.

SQL Support Table
A TAB File that is not visible on the map but that is used as a data source for Data Binds and/or queries. A SQL Support Table is not part of the workspace that describes the map.
TAB File
The file format that contains the description of a Layer, the Features in a Layer and the data associated with those Features. This format can be generated and updated by MapInfo Professional. This format has a file extension of '.tab'.

Text Input Query Parameter
A Query Parameter that allows the user to enter free-form search criteria for a Query.

Text Watermark
A Watermark to be added to the map that consists of textual information. This text overlaid on the map in as defined by the Administrator.

Thematic Layer
A Layer on the map that has had its visual style altered to represent data associated with that map Layer. For example, a Layer might contain suburb boundaries and have associated information about the total population of each suburb. A Thematic can be applied to this Layer so that each suburb is displayed in a different colour depending on how large the population of the suburb is.

Thematic Map
A map that contains one or more Thematic Layers.

User Interface Configuration
The collection of settings in the Exponare Configuration that define the make-up and visual style of an Exponare Enquiry or Exponare Public session.

User Profile
User profiles specify the connection information such as login name, authentication method, and administrator status for a user or group of users. User Profiles also specify the user interface, user interface theme, and the available Work Context Groups.

View
A unique description of an area of a map. The user can select a View and go directly to that part of the map without having to use any of the map navigation tools.

Visual Theme
A collection of artwork, such as, toolbar images, mouse cursors, and application banners, used to give an Exponare a certain 'look'.

Watermark
A visual or text that is overlaid on the map. Typically Watermarks are used to add either copyright information or a corporate logo to a map.

Work Context
A set of related functional items (eg. Queries, Data Binds, Views, etc) in Exponare that belong to a common business-level group.

Work Context Group
Work Contexts are assigned to one or more groups. These groups are then linked to User Profiles, and so are used to define which User Accounts have access to which Work Contexts.
**Workspace Definition File**
The MapInfo Workspace (.MWS) File that is used in a work context.

**Workspace Manager**
The Workspace Manager is a tool that ships with Exponare. It is used to create, modify and maintain workspace Files.

**Zoom to Active Selection**
Change the map view to nicely fit the Active Selection, plus an additional area as defined by the Administrator.

**Zoom to Selections**
Change the map view to nicely fit the selected Features, plus an additional area as defined by the Administrator.

**Zoom Visibility Range**
The range of Zoom Width values a given map Layer is visible at, defined as an upper and lower boundary. By default a map Layer has no Zoom Visibility Range and as a result is visible at all Zoom Widths.

**Zoom Width**
The distance, in world units, across the main map, measured horizontally at the vertical centre of the map. A low Zoom Width indicates the map is showing a small area in high detail, whereas a high Zoom Width indicates the map is showing a larger area in less detail. Zoom Width is inversely proportional related to the scale of the map.
Index

Symbols
_Selection Table 228
.MWS
  creating in MapInfo Professional 435
  troubleshooting transparent backgrounds 438
[LAYER]_ table 233
[LAYER]_Selection 204
[LinkFileLoc] 290

A

Access database
  connection string 260
AccessKeys.xml 62
activation keys
  registering 50
  requesting 49
active selection
  zoom to 251
adding
  Global Layer Groups to a Work Context 172
  layers to a workspace 113
  themes to User Interfaces 149
  Work Context Groups to a user profile 159
Address Search 305–309
  command 148
  parameters 344
admin user 48, 156
administrator
  Is administrator property in user profile 158
Annotation
  command 148
  properties 118
anti-aliasing
  enabling in Workspace Manager 452
  with curved labels 457
Appearance
  properties in Work Contexts 127
Application Link-Out Data Binds 293
  adding 293
Application Settings 117–123
ASP.NET
registration 25
restarting 63
authentication
process 160
auto-generated legend
font 127
autolabels
MapXtreme vs MapInfo Professional 436
Workspace Manager 456
auto-logins
Can auto-login Enquiry property in user profile 158
expiry time 120

B
Back/Forward Steps 121
Banners
tag in Exponare Public page 337
banners
adding to a User Interface 147
bind column
and Remote Data Binds 234

C
CD contents 22
changing
live workspace and TAB files 60
user passwords 103
column names
in SQL queries 231
COM+ error 71
commands 136–143
corresponding to work panels 147
Exponare Enquiry vs Exponare Public 16
configuration files 99
importing 104
Configuration Manager
menu bar 103
Configuration menu 104
File menu 103
Help menu 105
toolbar 106–107
Configuration.xml
cannot set permissions error 42
empty configuration 61
coordinate export 299–304
symbol size 119
coordinate systems 434
Coordinates
work panel 17, 148
coordinates
tile servers 212

copying
  Data Binds 174

creating
  Global Layer Groups 170
  workspaces using Workspace Manager 440

curved labels
  creating 457
  repositioning 458

Custom Legend URL 393

customer name
  specifying 120

D

Data Bind Details
  command 148

Data Bind Hyperlinks 234
  adding 237

Data Binds 227–237
  copying 174
  Helper 111
  overview 13

Data Binds and Global Layer Settings 172

data directories
  and network shares 71
  specifying path for 120

Database Connections 177, 211, 257–261

DBMS
  dDrivers 178

DBMS tables
  spatial index columns 183
  storing and retrieving spatial objects 178
  storing coordinate values 183

Delete History dialog box 104

deleting
  configuration files 104
  layers from a workspace 113

dialog boxes
  Delete History 104

documentation 5
  changes from Exponare v2.5 6
  Release Notes 5

drop-downs
  recommended maximum number of options 426

E

EnableTranslucency property 453

Enquiry User Guide 156

Envinsa 305

Event Log 35
  and duplicate layers 174

Exponare Clients
overview 11
Exponare Configuration Manager
starting 98
Exponare Enquiry
features 16
installing 47
starting from the command line 84
troubleshooting 84
uninstalling 58
upgrading 56
User Guide 49
Exponare files
AccessKeys.xml 62
Configuration.xml
 cannot set permissions error 42
export 104
Configuration.xml, empty configuration 61
Exponare.asmx 78, 115
ExponareEnquiry.exe 84
ExponareEnquiry.exe.config 48
Public .aspx 115
PublicLinkoutTest.aspx 304
web.config 62
Exponare Public
features 16
Exponare Server
file permissions 63
installing 24
licence 34
overview 10
troubleshooting 70
uninstalling 58
upgrading 54
Exponare.asmx 78
Exponare.Ids flag 235
ExponareEnquiry.exe.config 48
expressions
label priority 459
External Application Links 283–294
External databases
guidelines 427
External Link-Outs
and reorganising data 173
external user authentication 121, 157

F

Feature Details
command 148
work panel 17
Feature Usage Guidelines 425–428
Features
overview 13
features
  Exponare Enquiry vs Exponare Public 16
file paths
  properties 116
file permissions
  data 39
  Exponare Server 63
files
  configuration 99
  location of Help 120
Fill Patterns 464
  Helper 111
  in selections 127
FrontPage Server Extensions 25

G
Global Layer Groups 169
  adding to a Work Context 172
  creating 170
Global Layer Settings
  and Data Binds 172
  overriding 172

H
Hardware Identity Generator 35
Help 311–312
Help files
  location 120
Help menu
  About 105
  Help 105
Help Panel
  resizing 98
Helpers
  Colour 111
  Data Bind 111
  Fill Pattern 111
  Layer Settings 112
  Line Styles 113
  List 114
  Multi-Value 114
HTML Data
  in Exponare Public 18
HTML Print Tags 270–272, 275
Hyperlink target 303

I
IIS reset 54
images
  banner 147
  panel specific 148
importing
  configuration files 104
Index.html 312
Informix database
  connection string 260
installing
  Exponare Enquiry 47
  Exponare Server 24
  sample data 46

K
Key concepts 12

L
Label tool
  in Rest Public 389
  in Workspace Manager 456, 458
labels
  curved 457–458
  priority expressions 459
  styles 456
  Workspace Manager 455–456, 459
Layer Control
  Workspace Manager 448–451, 453, 455
Layer Settings 201–205
  adding Data Binds 236
  Helper 112
Layer Settings for Shortcuts
  adding to Layer Settings Shortcut 219
Layer Settings Helper 113
Layer Settings Shortcuts 217–220
  start-up parameter 346
Layer Shortcut 388
Layers 434
  duplicate 174
  missing 174
  order 202
  overview 13
  selectable state 435
Legend
  command 148
  work panel 17, 202, 218
licence file 88
  location 38
Line Styles 462
  Helper 113
LinkIn.Ids 287
LinkOut.Ids 290
Lists
  Helper 114
login
  process 160
  property in user profile 158

M
machine.config
  timeout setting 64
Map
  tag in Exponare Public page 336
MapInfo SQL 6
  Reference Manual 6
MapInfo Workspace format (.MWS) 440
MapInfo-L Archive Database 8
MapMarker 305
MapXtreme
  licence files for web farm environment 88
  pool size 60
Maximum Back/Forward Steps 121
maximum selections
  settings in Work Contexts 127
Menus and Toolbars 135
  configurable components in the User Interface 147
  Exponare Public vs Exponare Enquiry 18
mi_key 204, 229, 240
Microsoft .NET Framework 24
Microsoft Word Templates
  location 120
Microsoft.NET files
  InstallSqlState.SQL 89
Multi-Value Helper 114
.mws
  MapInfo Workspace format 440

N
named connections
  types 442

O
OLE
  connection string 260
Oracle
  connection string 261
Overriding
  Global Layer Settings 172

P
Page
  Public start-up parameter 344
Panels
  tag in Exponare Public page 337
panels
Exponare Enquiry vs Exponare Public 17
in User Interface 147

parameters
Query
  - Drop-Down List 245
  - Dynamic Drop-Down List 246
  - Text Input 244
Start-up
  - Address Search 344
  - Context 344
  - LayerShortcut 346
  - Page 344
  - Query 343
  - View 345

passwords
  - admin user 156
  - changing from Exponare Configuration Manager 103
  - Exponare proxy user 119
  - Guest user 157
  - Public user 156
  - Public user 156
  - User 157

Pitney Bowes MapInfo
  - MapInfo-L Archive Database 8
  - Technical Support 7

platform requirements 23
Point selection 382
Print
  - command 148
  - Print Map to PDF 401
  - Print Preview 399
Print template
  - scale options 121
Print Templates 263–281
  - recommended feature guidelines 427

properties
  - URL 115
Properties Grid
  - resizing 98
proxy user
  - for external authentication 119
Public
  - users 156

Q
Queries 239
  - command 148
  - overview 13
  - start-up parameters 343
  - work panel 17
raster images  
defined 430  
quality properties 121  
supported file types 431

Release Notes 5
Remote Data Binds 234  
recommended maximum 426
remote database tables  
storing and retrieving spatial objects 178  
storing coordinate values 183
required skills 6
requirements  
platform 23  
software 24
resizing  
Configuration Manager Tree, Grid and Help Panel 98

sample data  
installing 46  
uninstalling 58  
upgrading 55  
user accounts 49
saving  
configuration file conflicts 101
Search 396
Selectability 384
Selection 381  
Point selection 382
Selections  
Color Settings for Selection 384  
style 127
selections  
overview 13  
recommended maximum 427  
zoom to 251
server  
for external authentication 119  
name 35  
timeout 64
skills  
Exponare administrator 7  
Exponare users 6
software requirements 24
SQL  
GROUP BY syntax 246  
LIKE operator 241  
MapInfo SQL Reference Manual 6  
ORDER BY syntax 204, 230, 241
SQL Scripts  
InstallExponare.SQL 88

Administration Guide 487
InstallSqlState.SQL 89
SQL Support Tables 223
overview 13
SQL Template 240
starting
Exponare Configuration Manager 98
Exponare Enquiry from the command line 84
Exponare Public 41
Status Area
tag in Exponare Public page 337–339
styles
label 456
Workspace Manager 456
Stylesheets
folder 54
support
MapInfo-L archive database 8

T
TAB files
altering 60
and SQL support tables 224
filename limitations 435
updating 60
tables, remote database
storing and retrieving spatial objects 178
storing coordinate values 183
tags
Banners 337
Map 336
Menu and Toolbar 336
Panels 337
print 264–266
Status Area 337–339
Technical Support 7
Text Annotations 385
Annotation Panel 402
Themes 434
themes
adding to User Interface 149
Green 149
Purple 149
Workspace Manager 445, 454
thumbnail image 237
tile servers
about 212
Toolbar
Configuration Manager 106–107
images 147
tools
Workspace Manager 446–448
Translucency 391
translucency
   enabling in Workspace Manager 453

Tree
   resizing 98

Tree View 108

troubleshooting
   .MWS transparent backgrounds 438
   Exponare Enquiry 84
   Exponare Server 70

U

uninstalling
   Exponare Enquiry 58
   Exponare Server 58
   sample data 58

upgrading
   Exponare Enquiry 56
   Exponare Server 54
   sample data 55

URL properties 115

User Guide
   Exponare Enquiry 49

user impersonation 40

User Interfaces 145
   configurable components 147
   Exponare Public vs Exponare Enquiry 17–18
   User Interface property in user profile 159

user types
   defined 156

users 155–162, 317, 325
   admin 48, 156
   authentication 121
   configuring external authentication for 157
   Guest 157
   passwords 160
   Public 156
   User 157

utilities
   Workspace Manager 440

V

viewing configuration changes 99

Views 313, 388

virtual directories
   reviewing before installation 27

visible features
   recommended maximum 426

W

Watermarks 295

Web Farm Environments 87–93

web.config 62
timeout setting 64
Windows Event Log 35
Work Context Groups 133–134
  adding to user profile 159
Work Contexts 125–132
  adding Data Binds 236
  adding Global Layer Groups 172
  adding Print Templates 281
  adding Queries 249
  adding to Work Context Groups 134
  adding Views 314
  adding Watermarks 297
  and Layer Settings 205
  Default Work Context property in user profile 159
  overview 12
work panels
  adding to User Interface 153
  Can store panel state property in user profile 158
Workspace Manager 439–460
  feature summary 440–441
  labels 456
  Layer Control 448, 450–451, 453, 455
  Layer Control tools 449, 451
  menu commands 441–443, 445, 447–448
  named connections 442
  save as XML 440
  themes 454
  tools menu commands 446
Workspaces
  altering live files 60
  overview 12
  updating 60
  XML format 441

X

XML files
  Workspace format (.MWS) 440

Z

zoom
  setting after a query is run 251
  Zoom width command 148
Zoom to Selections 383